Legal Notices

For information about legal notices, trademarks, disclaimers, warranties, export and other use restrictions, U.S. Government rights, patent policy, and FIPS compliance, see https://www.microfocus.com/company/legal/.

Copyright © 2018 Micro Focus Software Inc. All rights reserved.
3 Using Imaging

3.1 Imaging Devices ................................................................. 93
  3.1.1 Using ZENworks Control Center for Imaging ......................... 94
  3.1.2 Using the Command Line for ZENworks Imaging ...................... 102
  3.1.3 Setting Up Disconnected Imaging Operations ....................... 113

3.2 Understanding the Sandboxing Behaviour for Preboot Bundles ............ 118
  3.2.1 Scenario: Taking or Restoring the ZENworks Image for Registered Devices (with or without Rule-Based Imaging) ..................... 118
  3.2.2 Scenario: Restoring an Image on Unmanaged Devices By Using a Hardware Rule . .. 119
  3.2.3 Scenario: Configuring Multicasting Device Images .................. 119
  3.2.4 Scenario: Restoring a Bundle on a Test or Non-Test Device Booted in the Manual Mode .............................................. 120
  3.2.5 Scenario: Applying the Published Version of Both the Preboot Bundle and the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device ...................... 120
  3.2.6 Scenario: Applying the Published Version of the Preboot Bundle and the Sandbox Version of the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device ...................... 120
  3.2.7 Scenario: Applying the Sandbox Version of Both the Preboot Bundle and the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device ...................... 120
  3.2.8 Scenario: Applying the Sandbox Version of the Preboot Bundle and the Published Version of the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device ...................... 121

3.3 Multicasting Images for ZENworks Imaging ................................ 121
  3.3.1 Using ZENworks Control Center to Multicast an Image ............... 121
  3.3.2 Using the Command Line to Multicast an Image ..................... 126

3.4 Configuring Imaging Script Bundles for ZENworks Imaging ................. 131

3.5 Configuring the AutoYaST Bundle ........................................... 132

3.6 Configuring the Kickstart Bundle .......................................... 137

3.7 Using Dell Configuration Bundles .......................................... 139
  3.7.1 Creating Dell Configuration Scripts and Files ..................... 140
  3.7.2 Configuring the DellDTK Configuration Bundle ..................... 142

3.8 Configuring MDT Deployment Bundles ..................................... 144
  3.8.1 Content Replication for MDT Deployment Action .................. 145
  3.8.2 MDT Deployment Functionality ...................................... 147

3.9 ISDTool ................................................................. 148

3.10 Assigning Preboot Bundles ................................................. 149
  3.10.1 Using the Devices Tab to Assign Bundles ......................... 149
  3.10.2 Assigning Devices to Bundle Groups ................................ 149
  3.10.3 Using the Bundles Tab to Assign Bundles ......................... 150
  3.10.4 Assigning Bundles to Non-Registered Devices .................... 151

3.11 Editing Imaging Work ...................................................... 151

3.12 Managing Preboot Bundles .................................................. 153
  3.12.1 Configuring Settings for a Preboot Bundle ......................... 153
  3.12.2 Managing Bundle Variables .......................................... 154
Contents

6 Imaging Utilities and Components 223
C Third-Party Imaging 207
B Replicating the TFTP Directory 199
A File Sets and Image Numbers 197

5.10 Action - Kickstart ............................................................................. 193
5.10.1 Adding a New Kickstart Bundle Action ........................................ 193
5.10.2 Editing an Existing Kickstart Bundle Action .................................. 194

D Imaging Utilities and Components 223
D.1 Image Explorer (zmgexp) ................................................................. 223
D.1.1 Starting Image Explorer on ZENworks Server .................................. 223
D.1.2 Installing and Starting the Image Explorer on a Standalone Device .... 224
D.1.3 Determining the Image Explorer Version ....................................... 225
D.1.4 Image Explorer versus Windows Explorer ..................................... 225
D.1.5 Opening an Image ......................................................................... 225
D.1.6 Saving Image Changes and Exiting the Utility ................................. 226
D.1.7 Managing Image Properties .......................................................... 226
D.1.8 Image File Operations .................................................................... 229
D.1.9 Modifying Image Content ............................................................... 233
D.1.10 Creating a New Image File ........................................................... 235
D.2 Novell ZENworks Configuration Management Imaging Agent (novell-ziswin) .................................................................................. 236
D.3 Novell ZENworks ISD Service (novell-zisdservice) ............................ 238
D.3.1 Understanding the SID .................................................................... 239

5.9.1 Adding a New DellDTK Configuration Bundle Action .................... 192
5.9.2 Editing an Existing DellDTK Configuration Bundle Action .............. 193
5.9.10 Creating a New Image File ............................................................ 234

5.10 Action - Kickstart ............................................................................. 193
5.10.1 Adding a New Kickstart Bundle Action ........................................ 193
5.10.2 Editing an Existing Kickstart Bundle Action .................................. 194

A File Sets and Image Numbers 197
A.1 File Sets ............................................................................................ 197
A.2 Image Numbers .................................................................................. 198

B Replicating the TFTP Directory 199
B.1 Configuring the TFTP Directory Replication Settings at the Management Zone Level ................................................................. 199
B.2 Configuring the TFTP Directory Replication Settings at the Folder Level ................................................................. 201
B.3 Configuring the TFTP Directory Replication Settings at the Device Level ................................................................. 203
B.4 Understanding the TFTP Replication Schedule Types ....................... 204
B.4.1 Date Specific ................................................................................. 204
B.4.2 Recurring ....................................................................................... 204
B.5 Resolving Circular Dependency on the Master Primary Server ........... 205
B.5.1 Resolving Circular Dependency at the Management Zone Level ........ 206
B.5.2 Resolving Circular Dependency at the Folder Level ......................... 206
B.5.3 Resolving Circular Dependency at the Device Level ......................... 206

C Third-Party Imaging 207
C.1 Third-Party Imaging Highlights in ZENworks ................................... 207
C.2 Things to Know Before Working on ZENworks Third-Party Imaging .... 208
C.3 Performing ZENworks Third-Party Imaging by Using ZENworks Control Center ................................................................. 208
C.4 Setting Up Preboot Services for ZENworks Third-Party Imaging ......... 208
C.5 Performing ZENworks Third-Party Imaging in the Maintenance Mode .. 212
C.5.1 Launching the ZENworks Third-Party Imaging Utility ..................... 212
C.5.2 Taking an Image of a Device and Storing it Locally .......................... 212
C.5.3 Taking an Image of a Device and Storing it in a Remote Repository .... 213
C.5.4 Restoring a Locally Stored Image .................................................... 214
C.5.5 Restoring an Image to a Device on a Shared Network Location ......... 216
C.5.6 Adding, Deleting, or Activating Disk Partitions ................................. 217
C.5.7 Querying for the Third-Party Imaging Work .................................... 219
C.6 Configuring Third-Party Script Bundles .......................................... 219
C.7 Configuring the Destination Disk Structure Before Restoring a WIM Image ................................................................. 221

D Imaging Utilities and Components 223
D.1 Image Explorer (zmgexp) ................................................................. 223
D.1.1 Starting Image Explorer on ZENworks Server .................................. 223
D.1.2 Installing and Starting the Image Explorer on a Standalone Device .... 224
D.1.3 Determining the Image Explorer Version ....................................... 225
D.1.4 Image Explorer versus Windows Explorer ..................................... 225
D.1.5 Opening an Image ......................................................................... 225
D.1.6 Saving Image Changes and Exiting the Utility ................................. 226
D.1.7 Managing Image Properties .......................................................... 226
D.1.8 Image File Operations .................................................................... 229
D.1.9 Modifying Image Content ............................................................... 233
D.1.10 Creating a New Image File ........................................................... 235
D.2 Novell ZENworks Configuration Management Imaging Agent (novell-ziswin) .................................................................................. 236
D.3 Novell ZENworks ISD Service (novell-zisdservice) ............................ 238
D.3.1 Understanding the SID .................................................................... 239
E  ZENworks Imaging Engine Commands

E.1 Help Mode ........................................................................................................... 266
  E.1.1 Using the ZENworks Imaging Engine Menu for Help ....................................... 266
  E.1.2 Using the Imaging Maintenance Mode Prompt for Help .................................. 266
E.2 Automatic (Query for Work) Mode ......................................................................... 267
  E.2.1 Using the ZENworks Imaging Engine Menu to Query for Work .................... 267
  E.2.2 Using the Imaging Maintenance Mode Prompt to Query for Work ................ 267
E.3 Make Mode ............................................................................................................ 268
  E.3.1 Make Locally .................................................................................................... 268
  E.3.2 Make to Proxy ................................................................................................ 271
E.4 Restore Mode ......................................................................................................... 274
  E.4.1 Restore from Local .......................................................................................... 275
  E.4.2 Restore from Proxy ........................................................................................ 278
E.5 Session Mode (Multicast Image Set) ........................................................................ 282
  E.5.1 Multicasting Using the ZENworks Imaging Engine Menu ............................. 282
  E.5.2 Multicasting Using the Imaging Maintenance Mode Prompt ....................... 283
E.6 Partition Operations Mode ....................................................................................... 285
  E.6.1 Using the ZENworks Imaging Engine Menu to Partition ............................... 285
  E.6.2 Using the Imaging Maintenance Mode Prompt to Partition .......................... 286
  E.6.3 Using the WinPE Maintenance Mode Prompt to Partition ............................ 288
E.7 ZENworks Partition Management Mode .................................................................. 290
  E.7.1 Using the ZENworks Imaging Engine Menu to Manage a Partition .......... 290
  E.7.2 Using the Imaging Maintenance Mode Prompt to Manage a Partition .......... 291
E.8 Dump Mode ............................................................................................................ 291
  E.8.1 Using the ZENworks Imaging Engine Menu to View Partition Information .... 291
  E.8.2 Using the Imaging Maintenance Mode Prompt to View Partition Information ... 292
E.9 Information Mode .................................................................................................. 292
  E.9.1 Using the ZENworks Imaging Engine Menu to View Device Information .... 293
  E.9.2 Using the Imaging Maintenance Mode Prompt to View Device Information ... 293
E.10 Return Codes Generated by ZENworks Imaging Engine (img) ............................... 294
  E.10.1 Connection or Socket Error Codes .............................................................. 295
  E.10.2 File Error Codes .......................................................................................... 295
  E.10.3 Error Codes Exchanged Between Client and Server ................................... 295
  E.10.4 General Error Codes .................................................................................... 296
  E.10.5 Error Codes Used by the DS Library .......................................................... 296
  E.10.6 Error Codes Used Locally Between Functions ............................................ 296
  E.10.7 Error Codes for Command Line Arguments ............................................... 296
  E.10.8 Error Referral List ....................................................................................... 296

D.4 Novell ZENworks Linux Management Imaging Agent (novell-zislnx) ................. 243

D.8 Logging configuration parameter (novell-prebootlookup.conf) ......................... 252

D.5 Image-Safe Data Viewer and Editor (zisview and zisedit) ..................................... 244
  D.5.1 Information Displayed by the Image-Safe Data Viewer .............................. 245
  D.5.2 Using the Image-Safe Data Viewer ................................................................ 246
  D.5.3 Using the Image-Safe Data Editor .................................................................. 247
D.6 ZENworks Imaging Media Creator (zmediacreator) ............................................... 249

D.9 Imaging Boot Parameter for PCMCIA Cards ......................................................... 253

D.7 Imaging Configuration Parameters (settings.txt) .................................................. 249

D.10 Imaging Server .................................................................................................... 253
  D.10.1 Initiating the Imaging Processes .................................................................. 254
  D.10.2 Viewing Information About Imaging Requests .......................................... 263
  D.10.3 Starting a Manual Multicast Session .......................................................... 264

D.10.3 Starting a Manual Multicast Session ............................................................ 264

D.3.2 Understanding the ZENworks SIDchanger ..................................................... 239

D.3.3 Disabling the SIDchanger .............................................................................. 240

D.10 TFTP Client for WinPE ......................................................................................... 264

D.10.1 Initiating the Imaging Processes .................................................................. 254

D.10.2 Viewing Information About Imaging Requests .......................................... 263

D.10.3 Starting a Manual Multicast Session .......................................................... 264

D.10.3 Starting a Manual Multicast Session ............................................................ 264

D.3.2 Understanding the ZENworks SIDchanger ..................................................... 239

D.3.3 Disabling the SIDchanger .............................................................................. 240

E  ZENworks Imaging Engine Commands

E.1 Help Mode ............................................................................................................ 266
  E.1.1 Using the ZENworks Imaging Engine Menu for Help ............................... 266
  E.1.2 Using the Imaging Maintenance Mode Prompt for Help ............................ 266
E.2 Automatic (Query for Work) Mode ......................................................................... 267
  E.2.1 Using the ZENworks Imaging Engine Menu to Query for Work ............. 267
  E.2.2 Using the Imaging Maintenance Mode Prompt to Query for Work .......... 267
E.3 Make Mode ............................................................................................................ 268
  E.3.1 Make Locally ................................................................................................ 268
  E.3.2 Make to Proxy .............................................................................................. 271
E.4 Restore Mode ......................................................................................................... 274
  E.4.1 Restore from Local ....................................................................................... 275
  E.4.2 Restore from Proxy ...................................................................................... 278
E.5 Session Mode (Multicast Image Set) ........................................................................ 282
  E.5.1 Multicasting Using the ZENworks Imaging Engine Menu ..................... 282
  E.5.2 Multicasting Using the Imaging Maintenance Mode Prompt .................. 283
E.6 Partition Operations Mode ....................................................................................... 285
  E.6.1 Using the ZENworks Imaging Engine Menu to Partition ......................... 285
  E.6.2 Using the Imaging Maintenance Mode Prompt to Partition ....................... 286
  E.6.3 Using the WinPE Maintenance Mode Prompt to Partition ....................... 288
E.7 ZENworks Partition Management Mode .................................................................. 290
  E.7.1 Using the ZENworks Imaging Engine Menu to Manage a Partition ....... 290
  E.7.2 Using the Imaging Maintenance Mode Prompt to Manage a Partition ....... 291
E.8 Dump Mode ............................................................................................................ 291
  E.8.1 Using the ZENworks Imaging Engine Menu to View Partition Information .... 291
  E.8.2 Using the Imaging Maintenance Mode Prompt to View Partition Information ... 292
E.9 Information Mode .................................................................................................. 292
  E.9.1 Using the ZENworks Imaging Engine Menu to View Device Information .... 293
  E.9.2 Using the Imaging Maintenance Mode Prompt to View Device Information ........ 293
E.10 Return Codes Generated by ZENworks Imaging Engine (img) ............................... 294
  E.10.1 Connection or Socket Error Codes .............................................................. 295
  E.10.2 File Error Codes .......................................................................................... 295
  E.10.3 Error Codes Exchanged Between Client and Server ................................... 295
  E.10.4 General Error Codes .................................................................................... 296
  E.10.5 Error Codes Used by the DS Library .......................................................... 296
  E.10.6 Error Codes Used Locally Between Functions ............................................ 296
  E.10.7 Error Codes for Command Line Arguments ............................................... 296
  E.10.8 Error Referral List ....................................................................................... 296

Contents 7
About This Guide

This ZENworks Preboot Services and Imaging Reference includes information to help you successfully use Preboot Services and Imaging in a ZENworks system.

The information in this guide is organized as follows:

- Chapter 1, “Overview,” on page 11
- Chapter 2, “Setting Up Preboot Services and Imaging,” on page 41
- Chapter 3, “Using Imaging,” on page 93
- Chapter 4, “Imaging Operations in a ZENworks Asset Management Agent and ZENworks Desktop Management Agent Coexistence Environment,” on page 179
- Chapter 5, “Preboot Actions,” on page 183
- Appendix A, “File Sets and Image Numbers,” on page 197
- Appendix B, “Replicating the TFTP Directory,” on page 199
- Appendix C, “Third-Party Imaging,” on page 207
- Appendix D, “Imaging Utilities and Components,” on page 223
- Appendix E, “ZENworks Imaging Engine Commands,” on page 265
- Appendix F, “Updating ZENworks Imaging Resource Files,” on page 299
- Appendix G, “Dell DTK,” on page 315
- Appendix H, “Supported Ethernet Cards,” on page 319
- Appendix I, “Accessing IP Addresses for Devices Running Dual NICs,” on page 321
- Appendix J, “Troubleshooting Preboot Services and Imaging,” on page 323
- Appendix K, “Documentation Updates,” on page 343

Audience

This guide is intended for ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation.

Additional Documentation

ZENworks is supported by other documentation (in both PDF and HTML formats) that you can use to learn about and implement the product. For additional documentation, see the ZENworks documentation web site.
In ZENworks, Preboot Services provides functionality that allows you to perform automatic imaging tasks on managed devices (Windows/ Linux Primary Servers and workstations) before their operating systems boot. You can also perform manual imaging operations on these devices, as well as any other device with the supported file system, such as legacy Windows workstations.

The following sections provide an overview of Preboot Services:

- Section 1.1, “Support Matrix for ZENworks Imaging,” on page 11
- Section 1.2, “Brief Overview,” on page 12
- Section 1.3, “What Is the Preboot Execution Environment (PXE)?,” on page 16
- Section 1.4, “Preboot Services Functionality,” on page 18
- Section 1.5, “The Preboot Services Processes,” on page 27
- Section 1.6, “Preboot Strategies,” on page 35

1.1 Support Matrix for ZENworks Imaging

The following table shows the items that are supported for ZENworks imaging.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Items supported for ZENworks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed disk types</td>
<td>• Basic disks</td>
</tr>
<tr>
<td></td>
<td>• Solid State drives</td>
</tr>
<tr>
<td></td>
<td>• Advanced Format drives</td>
</tr>
<tr>
<td>Fixed disk controller types</td>
<td>• IDE</td>
</tr>
<tr>
<td></td>
<td>• SATA</td>
</tr>
<tr>
<td>Firmware interface</td>
<td>• BIOS is supported on 32-bit and 64-bit platforms.</td>
</tr>
<tr>
<td></td>
<td>• UEFI 2.3.0 and above is supported on 32-bit and 64-bit platforms.</td>
</tr>
<tr>
<td></td>
<td>• 32-bit UEFI device Imaging is supported only through Third-Party Imaging.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: Imaging operations for Linux are not supported on the UEFI firmware.</td>
</tr>
<tr>
<td>Disk partition type</td>
<td>• MBR (Master Boot Record based partitioning for systems using the BIOS firmware)</td>
</tr>
<tr>
<td></td>
<td>• GPT (GUID Partition Table)</td>
</tr>
</tbody>
</table>
NOTE: Micro Focus offers only experimental support for Imaging devices on virtual machines. Micro Focus may not respond personally to all support requests regarding Imaging devices on virtual machines.

1.2 Brief Overview

The following provides a brief overview of Preboot Services:

- Section 1.2.1, “Preboot Services Functionality,” on page 12
- Section 1.2.2, “Preboot Services Strategies,” on page 13
- Section 1.2.3, “Preboot Bundles,” on page 13
- Section 1.2.4, “Configuring Preboot Services,” on page 14
- Section 1.2.5, “Setting Up Devices to Use Preboot Bundles,” on page 15

1.2.1 Preboot Services Functionality

Preboot Services allows you to automatically or do any of the following to a Windows or Linux device when it boots:

- Make an image of the device’s hard drives and other storage devices
- Restore an image to the device
- Apply an existing image to multiple devices
- Run Imaging scripts on the device
- Run AutoYaST and kickstart installations
- Configure Dell devices
- MDT Deployment

To accomplish these tasks automatically by using ZENworks Control Center, you simply need to have PXE (Preboot Execution Environment) enabled on your devices, then have Preboot bundles configured and assigned to the devices. The devices automatically execute these bundles when they boot.

Preboot Services utilizes the following to make its imaging functions possible:

- PXE (Preboot Execution Environment): An Intel specification that allows a device to boot from the network, instead of its hard drive or other local media. ZENworks can use PXE to launch Preboot Services.
- Preboot Services Bootable CD or DVD: Used where PXE is not installed or where you want to perform a Preboot Services operation. This is applicable only for ZENworks Imaging.
- ZENworks Partition: Enables you to set up a device for unattended imaging operations where the device is not PXE-enabled or does not have access to PXE network services. This is applicable only for ZENworks Imaging.
- USB Boot: You can perform Imaging operations by creating a bootable USB drive to boot systems with BIOS and UEFI firmware.

For more information on these methods, see Chapter 3, “Using Imaging,” on page 93.

1.2.2 Preboot Services Strategies

Following are some of the uses of Preboot Services:

- Create and Restore Standard Images: Create base images from existing devices, as well as restore images to any manageable device.
- Set Up Devices for Future Reimaging: Set up devices so that the next time they reboot, they do the imaging work that is contained in their assigned Preboot bundle.
- Multicast Device Images: Apply an image of one device to many other devices. This is an excellent feature for initially setting up a lab.
- Restore Devices to a Clean State: Quickly and efficiently reset devices to an initial state, such as in a lab.
- Automate Linux installations: Automate kickstart or AutoYaST installations.
- MDT Deployment: Automate Windows desktop and server deployment.
- Configure Dell devices: Configure basic boot settings on Dell devices.

For more information on these strategies, see Section 1.6, “Preboot Strategies,” on page 35.

1.2.3 Preboot Bundles

In ZENworks Control Center, Preboot Services tasks are contained in Preboot bundles. The following Preboot bundle types are available:

- Empty Bundle: A bundle with no initial tasks. You can quickly create this bundle without performing all of tasks in the Create New Bundle wizard. Later, you can edit its details to add assignments, actions, and so forth.
- **AutoYaST Bundle:** A bundle that contains the location and access protocol of an AutoYaST configuration file and network installation directory for SUSE Linux. This bundle allows you to launch an automated installation of SUSE Linux using Preboot Services. This is only available for Linux devices that are PXE-enabled. AutoYaST bundles cannot be run using a boot CD, a ZENworks partition, or a bootable USB.

- **DellDTK Configuration:** A bundle that contains the location of files and scripts for configuring Dell servers. This bundle allows you to use Preboot Services to configure the BIOS, BMC, RAID, and DRAC for settings and to create a new Dell Utility partition. You can also identify another Preboot bundle to be run immediately after these configurations have completed. This is only available for Linux devices that are PXE-enabled. Dell Configuration bundles cannot be run using a boot CD, a ZENworks partition, or a bootable USB.

- **Imaging Script Bundle:** Allows you to write a custom Linux Imaging script. This provides detailed control over ZENworks imaging operations, as well as most Windows-based preboot tasks. This is applicable only for ZENworks Imaging.

- **Kickstart:** A bundle that contains the location and access protocol of a KickStart configuration file for Red Hat Linux. This bundle allows you to launch an automated installation of Red Hat Linux using Preboot Services. This is only available for Linux devices that are PXE-enabled. Kickstart bundles cannot be run using a boot CD, a ZENworks partition, or a bootable USB.

- **MDT Deployment:** A bundle which supports the deployment of the Windows operating system using Microsoft Deployment Toolkit (MDT). This bundle enables you to upload and replicate the MDT WIM files to the required Primary and Imaging Satellite servers.

- **Multicast Image Set Bundle:** Specifies an image that can be sent through the multicast protocol. This bundle allows you to send an image to a large number of devices in a single operation, which minimizes network traffic. It is ideal for labs, classrooms, and staging areas. This is applicable only for ZENworks Imaging.

- **Third-Party Image Bundle:** Allows you to specify the third-party images that can be restored on a device.

- **Third-Party Script Bundle:** Allows you to write custom WinPE imaging scripts that can be executed in the WinPE distro.

- **ZENworks Image Bundle:** Lists one or more ZENworks images (base plus add-ons) that can be restored on a device. This bundle allows you to define simple imaging operations.

To create one of these bundles: in ZENworks Control Center, click Bundles in the left pane, in the Bundles panel click New > Bundle > Preboot Bundle > Next, then select a bundle type.

For more information on these bundles, see Section 1.4.1, “Preboot Bundles,” on page 19.

### 1.2.4 Configuring Preboot Services

In ZENworks Control Center, you can set up default Preboot Services configurations for all of your devices. Some settings can be overridden at the device, group, and folder levels.

You can configure the following settings per ZENworks Management Zone:

- **Novell Preboot Services Menu Options:** The menu contains five options: 1) Start ZENworks Imaging (automatically executes the bundle); 2) Start ZENworks Imaging Maintenance (accesses the imaging maintenance mode prompt); 3) Disable ZENworks Partition; 4) Enable ZENworks Partition; and, 5) Exit (resumes booting). You can configure whether the menu is displayed upon booting, not displayed, or displayed only when Ctrl+Alt is pressed during booting.

- **Non-Registered Device Settings:** You can use Preboot Services to automatically name your non-registered devices, using such criteria as prefixes, BIOS information (such as asset tags or serial numbers), DNS suffixes, and you can set up DHCP or IP addresses.
• **Device Imaging Work Assignment:** Work assignment rules are used to determine which bundle should be applied to which device. The work rules use logic to determine whether a device meets the requirements for applying the Preboot bundle. A rule is made up of filters that are used to determine whether a device complies with the rule. The AND and OR logical operators are used for creating complex filters for the rule.

• **Server Referral List:** When a device boots, it is necessary for it to find its home Management Zone to get its assigned imaging work. If multiple Management Zones exist on the network, server referral lists provide a method for allowing a managed device to find its home zone.

• **Intel Active Management Technology (AMT):** Intel AMT provides Preboot Services with persistent device identification.

• **Third-Party Imaging Settings:** You can upload WinPE (Windows Preboot Environment) and third-party Imaging tools such as Microsoft Imaging engine (imagex.exe) and Symantec Ghost (ghost32.exe). Before configuring the third-party imaging settings, ensure that Microsoft Windows Automated Installation Kit (WAIK) or Windows Assessment and Deployment Kit (WADK) is installed on the device running the ZENworks Control Center.

When you are upgrading to a newer version of ZENworks, make sure that you re-upload the WinPE distribution (winpe.wim) under Third-Party Imaging Settings in ZCC, to see the latest zenworktodo application in the WinPE environment.

• **TFTP Replication Settings:** You can replicate the changes made to the tftp directory on other Imaging servers (Primary Servers or Satellites with the Imaging role). The tftp directory contains files such as configuration files and binaries used by ZENworks to perform imaging tasks. The directory is located on the Imaging server in /srv/ on Linux and in %ZENWORKS_HOME%\share\ on Windows.

• **Third Party NTFS Driver Settings:** You can download the latest high performance NTFS driver and save it on your system. You can view content replication status across all Primary and Satellite Servers with the Imaging role in the management zone. You can start the Imaging operation when the status is Available. When you are updating to the latest version of ZENworks or imaging driver update, and upload the new Tuxera driver.

To configure these settings, click **Configuration** in the left pane to display the **Configuration** tab. If it’s not expanded, click **Management Zone Settings**, then click **Device Management > Preboot Services** to display the Preboot Services page.

For more information, see Section 1.4, “Preboot Services Functionality,” on page 18.

### 1.2.5 Setting Up Devices to Use Preboot Bundles

In order for a device to automatically use an assigned Preboot bundle, you must complete two tasks:

- “Setting Up the Device to Apply the Bundle” on page 15
- “Assigning a Bundle” on page 16

#### Setting Up the Device to Apply the Bundle

Preboot Services utilizes PXE and other boot mechanisms and media to trigger the imaging work. For information, see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46.
Assigning a Bundle

The following paths represent many of the methods for assigning bundles to devices, or devices to bundles:

- Click Devices > Servers > select the check boxes next to one or more servers, then click Action > Assign Bundle.
  
  You can assign bundles to all selected servers.

- Click Devices > Workstations > select the check boxes next to one or more workstations, then click Action > Assign Bundle.
  
  You can assign bundles to all selected workstations.

- Click Devices > Servers > select a server, then click Advanced (in Imaging Work on the Summary tab).
  
  You can assign a specific bundle to the server.

- Click Devices > Workstations > select a workstation, then click Advanced (in Imaging Work on the Summary tab).
  
  You can assign a specific bundle to the workstation.

- Click Bundles > Servers > select the check box next to a server, then click Action > Assign Bundle.
  
  You can assign multiple bundles to the server.

- Click Bundles > Workstations > select the check box next to a workstation, then click Action > Assign Bundle.
  
  You can assign multiple bundles to the workstation.

- Click Bundles > select the check boxes next to one or more bundle names, then click Action > Assign Bundle to Device.
  
  You can assign the selected bundles to the devices that you select in the wizard.

1.3 What Is the Preboot Execution Environment (PXE)?

The following sections provide information on using PXE in ZENworks:

- Section 1.3.1, “Understanding How Preboot Services Uses PXE,” on page 16
- Section 1.3.2, “Understanding the ZENworks NBPs,” on page 17
- Section 1.3.3, “Preparing to Use PXE,” on page 18

1.3.1 Understanding How Preboot Services Uses PXE

PXE uses DHCP (Dynamic Host Configuration Protocol) and TFTP (Trivial File Transfer Protocol) to locate and load bootstrap programs from the network. The PXE environment is loaded from the BIOS on the NIC.

Preboot Services uses PXE to discover if there is Preboot Services work specified for a device and to provide the device with the files necessary to execute the assigned work.

Using Preboot Services, you can automatically place an image on a device, even if the device’s hard disk is blank. You do not need to use a CD, DVD, ZENworks partition, or a bootable USB on the device.
1.3.2 Understanding the ZENworks NBPs

The Intel PXE specification defines mechanisms and protocols that allow PXE devices to use their network interface cards (NICs) to find bootstrap programs located on network servers. In the PXE specification, these programs are called Network Bootstrap Programs (NBPs).

NBPs are analogous to the bootstrap programs found in the Master Boot Records (MBRs) of other boot media, such as hard drives, floppy disks, CDs, and DVDs. The purpose of a bootstrap program is to find and load a bootable operating system. MBRs on traditional boot media accomplish this by locating the necessary data on their respective media. NBPs accomplish this by using files found on network servers, usually TFTP servers.

ZENworks Preboot Services uses separate NBPs working together:

- "nvlnbp.sys" on page 17
- "pxelinux.0" on page 17
- "nvlnbp64.efi or nvlnbpia32.efi" on page 18
- "bootx64.efi" on page 18

**nvlnbp.sys**

This NBP has the following responsibilities:

- Detect various SMBIOS parameters and local hardware
- Read the ZENworks identity information from the hard drives
- Communicate with novell-zmgprebootpolicy to determine if there is any preboot work applicable to the device
- Present and manage the Novell Preboot Services Menu
- If necessary, launch pxelinux.0 to execute the assigned preboot work

**pxelinux.0**

The primary purpose of this NBP is to load the operating system that is required to execute the assigned preboot work.

The pxelinux.0 file is a modified version of part of an open source project called syslinux. Although pxelinux.0 is primarily a Linux loader, it is capable of loading other operating systems. It operates by using configuration files located on a TFTP server to provide boot instructions. The various pxelinux.0 configuration files used by ZENworks can be found on your Imaging Server in the /srv/tftp directory on Linux or the %ZENWORKS_HOME%/share/tftp directory on Windows, where %ZENWORKS_HOME% is the complete path of the ZENworks installation directory.

In ZENWorks, when PXE devices are assigned preboot work, they are also told which pxelinux.0 configuration file they should use to execute that work. Similarly, when using the Novell Preboot Services Menu, each menu option corresponds to a pxelinux.0 configuration file. For more information, see Section 2.4.4, "Editing the Novell Preboot Services Menu," on page 67.

For more information on pxelinux.0 and its configuration files, see the syslinux home page.

For a copy of the Novell modifications to the syslinux open source project, see Novell Forge.
nvlnbp64.efi or nvlnbpia32.efi

This NBP has the following responsibilities:

- Detect various SMBIOS parameters and local hardware
- Read the ZENworks identity information from the hard drives
- Communicate with novell-zmgprebootpolicy to determine if there is any preboot work applicable to the device
- Present and manage the Novell Preboot Services Menu
- If necessary, launch pxelinux.0 to execute the assigned preboot work

bootx64.efi

The primary purpose of this NBP is to load the operating system that is required to execute the assigned preboot work.

The pxelinux.0 file is a modified version of part of an open source project called syslinux. Although pxelinux.0 is primarily a Linux loader, it is capable of loading other operating systems. It operates by using configuration files located on a TFTP server to provide boot instructions. The various pxelinux.0 configuration files used by ZENworks can be found on your Imaging Server in the /srv/tftp directory on Linux or the %ZENWORKS_HOME%\share\tftp directory on Windows, where %ZENWORKS_HOME% is the complete path of the ZENworks installation directory.

In ZENworks, when PXE devices are assigned preboot work, they are also told which pxelinux.0 configuration file they should use to execute that work. Similarly, when using the Novell Preboot Services Menu, each menu option corresponds to a pxelinux.0 configuration file. For more information, see Section 2.4.4, “Editing the Novell Preboot Services Menu,” on page 67.

For more information on pxelinux.0 and its configuration files, see the syslinux home page (http://syslinux.zytor.com/pxe.php).

For a copy of the Novell modifications to the syslinux open source project, see Novell Forge (http://developer.novell.com/wiki/index.php/Novell_Forge).

1.3.3 Preparing to Use PXE

Before you can use Preboot Services with PXE, you need to do the following:

1. Install ZENworks. For more information, see the ZENworks Server Installation Guide.
2. Enable PXE on your ZENworks devices. For more information, see Section 2.7, “Enabling PXE on Devices,” on page 89.
3. Have a standard DHCP server, either on your ZENworks Imaging Server or on another network server where ZENworks is not installed. For more information, see “Configuring LAN Environments for Preboot Services” on page 60.

1.4 Preboot Services Functionality

Review the following sections to understand Preboot Services functionality:

- Section 1.4.1, “Preboot Bundles,” on page 19
- Section 1.4.2, “Preboot Services Menu,” on page 22
- Section 1.4.3, “Non-Registered Device Settings,” on page 23
1.4.1 **Preboot Bundles**

ZENworks uses Preboot bundles to apply Preboot Services work to devices. For example, Preboot bundles can contain tasks, such as restoring an image, that are performed at the time a device boots.

In order for a device to utilize a Preboot bundle, the bundle must be assigned to the device, its group, or its folder.

**NOTE:** .zmg files are not replicated to any of the Primary or Secondary or Satellite Servers.

The available Preboot bundles are:

- Empty Bundle
- AutoYast Bundle
- DellDTK Configuration
- Imaging Script Bundle
- Third-Party Script Bundle
- Kickstart Bundle
- Multicast Image Set Bundle
- Third-Party Image Bundle
- ZENworks Image Bundle
- MDT Deployment Bundle

### Empty Bundle

This bundle contains no initial tasks. You can quickly create this bundle without performing all of tasks in the Create New Bundle Wizard. Later, you can edit its details to add assignments, actions, and so forth. For example, you could create an empty bundle, then in the bundle's properties add the **Linked Application Bundle** action as its only action.

### AutoYaST Bundle

This bundle contains the location and access protocol of an AutoYaST configuration file and network installation directory for SUSE Linux. This bundle allows you to launch an automated installation of SUSE Linux using Preboot Services on PXE-enabled devices.

For more information, see Section 3.5, “Configuring the AutoYaST Bundle,” on page 132.
DellDTK Configuration

This bundle contains the location of files and scripts for configuring Dell servers. This bundle allows you to use Preboot Services to configure the BIOS, BMC, RAID, and DRAC for settings and to create a new Dell Utility partition. You can also identify another Preboot bundle to be run immediately after these configurations have completed.

For more information, see Section 3.7.2, “Configuring the DellDTK Configuration Bundle,” on page 142.

Imaging Script Bundle

Allows you to write a custom Linux script that is executed on the assigned devices. This provides detailed control over ZENworks imaging operations, as well as most Linux-based preboot tasks.

For more information, see Section 3.4, “Configuring Imaging Script Bundles for ZENworks Imaging,” on page 131.

Third-Party Script Bundle

Allows you to write custom third-party scripts that are executed in the WinPE distro on PXE enabled devices.

For more information, see Configuring Third-Party Script Bundles in Appendix C, "Third-Party Imaging," on page 207.

Kickstart Bundle

This bundle contains the location and access protocol of a KickStart configuration file for Red Hat Linux. This bundle allows you to launch an automated installation of Red Hat Linux using Preboot Services on PXE-enabled devices.

For more information, see Section 3.6, “Configuring the Kickstart Bundle,” on page 137.

Multicast Image Set Bundle

Specifies an image that can be sent using the multicast protocol. This bundle allows you to send an existing image to a large number of devices in a single operation. It is ideal for labs, classrooms, and staging areas.

For more information, see Section 1.6.6, “Multicasting Device Images,” on page 38 and Section 3.3, “Multicasting Images for ZENworks Imaging,” on page 121.

Benefits

You can image multiple devices with the least amount of overhead. Devices to be imaged can have a variety of operating systems installed on them, or even no operating system installed.

Using the multicast capabilities of your network, you minimize network traffic by sending the image file across the network once for all devices to be imaged, rather than individually per device.
Limitations

Using the same image on multiple devices means they all have the same network identities. However, you can install the ZENworks Configuration Management Imaging Agent on these devices prior to performing the multicast, because this agent saves each device’s network identity settings and restores them after the multicast image is applied.

Third-Party Image Bundle

Allows you to specify the third-party images to be restored on a device. ZENworks supports:

- Microsoft ImageX that uses the WIM image file format and WinPE as the distro.

  Microsoft ImageX that uses the WIM image file format and WinPE as the distro. The distro is available as WADK (Windows Assessment and Deployment Kit) or WAIK (Windows Automated Installation Kit), which can be downloaded from Microsoft Download Center Web site (http://www.microsoft.com/downloads/) or through Microsoft’s Business Desktop Deployment (BDD).

- Symantec Ghost that uses the GHO image file format and WinPE as the distro.

The ZENworks Third-Party Imaging supports only PXE as the boot mechanism.

For more information, see Section 3.1.1, “Using ZENworks Control Center for Imaging,” on page 94.

ZENworks Image Bundle

Lists one or more ZENworks images that can be restored on a computer. This bundle allows you to quickly define simple image restoration operations.

For more information, see Section 3.1.1, “Using ZENworks Control Center for Imaging,” on page 94.

Scope

You can restore the image of hard disks, specific add-on images, and file sets of a device.

Boot Manager Limitation

If the device you want to image has an unsupported boot manager running, such as System Commander, you must disable or remove it before attempting to image those devices. This is because boot managers create their own information in the MBR and overwrite the ZENworks boot system, preventing ZENworks imaging from being performed.

Base Images

A base image contains descriptions of all partitions and files on a hard drive. When it is restored, all existing partitions are deleted, new partitions are created from the descriptions in the base image, and all files are restored from the image.

Base images are created by taking an image of a device. You can use an option in ZENworks Control Center or you can use imaging commands at the imaging maintenance mode prompt to create a base image.

In ZENworks, image files are automatically saved to the following location, which cannot be changed:

Windows: %ZENWORKS_HOME%\work\content-repo\images

where %ZENWORKS_HOME% is the complete path of the ZENworks installation directory.
Linux: /var/opt/novell/zenworks/content-repo/images

If you need more disk space for large imaging files than is available in your current content repository location, you can change this location to a different partition. For more information, see “Content Repository” in the ZENworks Primary Server and Satellite Reference.

Add-On Images

These images are a collection of files added non-destructively to existing partitions. The existing partitions and files are left intact, except for any files that the add-on image might update.

Add-on images allow you to customize a device after a base image is restored. This allows you to use a base image for multiple purposes.

You can create add-on images by using the Image Explorer utility.

MDT Deployment

A bundle which supports the deployment of the Windows operating system using Microsoft Deployment Toolkit (MDT). This bundle enables you to upload and replicate the MDT WIM files to the required Primary and Imaging Satellite servers.

For more information on MDT Deployment, see Section 3.8, “Configuring MDT Deployment Bundles,” on page 144.

1.4.2 Preboot Services Menu

Where PXE is enabled on a device, the Novell Preboot Services Menu can be displayed during the boot process. The following menu choices are displayed on the menu:

- **Start ZENworks Imaging**: Executes the effective Preboot Services preboot bundle.
- **WinPE Maintenance Mode**: Loads WinPE and starts the ZENworks Third-Party Imaging utility. You can use the utility to perform the third-party imaging operations.
- **Start ZENworks Imaging Maintenance**: Displays the imaging maintenance mode prompt, where you can execute imaging commands.
- **Disable ZENworks Partition**: Prevents an existing ZENworks partition from being used during booting to execute the assigned Preboot bundles.
- **Enable ZENworks Partition**: Allows an existing ZENworks partition to be used during booting to execute the effective Preboot bundle.
- **Exit**: Resumes normal booting of the device.
- **Start DELL DTK**: Starts the Dell OpenManage Deployment Toolkit (DTK) v2.1 in the automated mode where assigned work is automatically performed.
- **Start DELL DTK (Maintenance Mode)**: Starts the DTK in the maintenance mode, where you can use the DTK bash prompt to configure the scripts and files used by the Dell Configuration bundle.

You can use ZENworks Control Center to configure whether this menu should be displayed on a PXE-enabled device by selecting one of the following options:

- **Always Show Imaging Menu**
- **Never Show Imaging Menu**
- **Show Imaging Menu if CTRL+ALT Is Pressed**
NOTE: On a device that has UEFI firmware and an USB keyboard attached to the device, you cannot use the CTRL+ALT function key to launch the PXE menu. You will get a pop-up prompting you to press <Enter> key and launch the PXE menu with a time-out of three seconds. This option is also applicable to 64-bit devices.

For the procedures in configuring the menu’s display, see Section 2.5.1, “Configuring Novell Preboot Services Menu Options,” on page 72.

1.4.3 Non-Registered Device Settings

Devices that are new to the Management Zone and have received their first image need certain IP configuration information to successfully access the network and network services. You can use Preboot Services to automatically name your non-registered devices, using such criteria as prefixes, BIOS information (like asset tags or serial numbers), DNS suffixes, and you can set up DHCP or IP addresses.

For example, the device needs a unique IP address and the address of at least one DNS name server. In many networks, this information is distributed through the DHCP services, but it can also be configured through the default Preboot Services configuration settings in ZENworks Control Center.

After a device has registered with ZENworks, its configuration is set and the non-registered device settings in the Management Zone no longer apply to it, because the ZENworks server now knows its identity. Whether it becomes a member of the zone or continues to be a non-registered device depends on whether the image applied to the device contains the ZENworks Configuration Management Imaging Agent, novell-zisdservice for Windows devices and novell-zislnx for Linux devices.

The settings that can be adjusted for a Management Zone are:

- **DNS suffix**: Provides a suffix for all of your devices’ names. For example, provo.novell.com.
- **Workgroup**: The Windows workgroup that you want the device to be a member of.
- **Name Servers**: Controls which DNS servers a device uses. You can specify multiple DNS name servers.
- **Device Name**: Configured device names can include a prefix, the BIOS asset tag, the BIOS serial number, or none of these.
- **IP configuration**: For the IP configuration, you can specify to use DHCP or a specific IP address. If you select to use IP addresses, you can provide a range of addresses in a list, or you can specify certain IP addresses. As devices are registered, they assume one of the available addresses. For IP addresses, you can also specify a subnet mask and a default gateway.

NOTE

- When a device is registered to a Management Zone, the Imaging tasks configured for the device are applicable. You can make hardware rules applicable to registered devices by assigning the Apply Rule-Based Imaging Bundle to the devices. If the devices match the hardware rules configured for the bundle, the imaging bundle is assigned to them.
- When a device is registered to a different Management Zone, neither the hardware rules for the device nor the Imaging tasks are applicable.

For the procedures in configuring defaults for non-registered devices, see Section 2.5.2, “Configuring Non-Registered Device Settings,” on page 73.
1.4.4 Device Imaging Work Assignment

You can determine what imaging work is to be performed on a device when it boots, based on a set of hardware rules. This configuration section lets you specify a particular bundle for each set of hardware rules. The Custom Hardware Types section allows you to provide specific data for a Hardware Type hardware rule option.

Rules and custom types configured here are applied globally to all non-managed devices. You can also apply them to managed devices in the Management Zone by assigning those devices to the bundle that is selected for the rule. Only those devices that exactly match the rule and its custom types have the assigned bundle applied to them when they boot.

- “Hardware Rules” on page 24
- “Custom Hardware Types” on page 25
- “Allowing Overwrites” on page 25

For the procedures in configuring work assignment rules, see Section 2.5.3, “Configuring Device Imaging Work Assignments,” on page 76.

Hardware Rules

You can set up hardware-based rules for your Preboot bundles. Work assignment rules are used to apply bundles to devices with specific hardware, or to match a broad set of hardware requirements.

For example, you can create a rule that applies a bundle to any device with a specific MAC address or BIOS serial number. Rules like this can only match to a single device. On the other hand, you can create a rule that applies to any device with at least 512 MB of RAM and 150 GB of hard drive space.

A work rule is comprised of filters that are used to determine whether a device complies with the rule. The rules use logic to determine whether a device meets the requirements for applying the Preboot bundle. The AND and OR logical operators are used for creating complex filters for the rule.

When a device is seeking work to be done, it scans the rules until it finds a rule where all of the rule’s filters match the device, then executes the bundle assigned to the rule.

Filter information that you can provide:

- **Device component**: Any of the following:
  
  BIOS Asset Tag  
  BIOS Serial Number  
  BIOS Version  
  CPU Chipset  
  Hard Drive Controller  
  Hard Drive Size  
  Hardware Type  
  IP Address  
  MAC Address  
  Network Adapter  
  Product Name  
  RAM  
  Sound Card  
  System Manufacturer  
  Video Adapter
• **Relationship:** This defines the relationship for a filter between the **Device component** field and the value you specify for it.

  Possibilities for the **Hard drive size** and **RAM** fields:
  
  < (less than)  
  > (greater than)  
  = (equal to)  
  >= (greater than or equal to)  
  <= (less than or equal to)  
  <> (not equal to)  

  Possibilities for all other device components:
  
  Contains  
  Equal To  
  Starts With  
  Ends With  

• **Component Value:** This corresponds to the match you want for the component. For example, you select **RAM (in MB)** for the filter and enter 512 for its value. Then, the relationship you select determines whether it’s less than, less than or equal to, equal to, not equal to, greater than or equal to, or just greater than 512 MB.

You can have multiple filters and sets of filters in a single rule, using the AND and OR operators, and you can have multiple rules associated with the same Preboot bundle. This allows you to specify exactly which can receive a particular Preboot bundle.

### Custom Hardware Types

Custom hardware types enable you to include any devices matching your custom type to have the bundle assigned to the hardware rule applied to them when the devices boot. For example, you can create a rule that applies the bundle to any device that is a laptop by entering the applicable string as a custom hardware type, selecting **Hardware Type** in the **Rule Construction** dialog box, then selecting your custom type.

The **Hardware Type** option does not display in the Rule Construction dialog box until at least one custom type has been configured.

### Allowing Overwrites

Select the **Allow Preboot Services to Overwrite Existing Files when Uploading** check box if you want existing .zmg files to be overwritten by a newer version when the image is taken.

### 1.4.5 Server Referral List

When a PXE device boots, it makes a broadcast request on the network for PXE services. The ZENworks Proxy DHCP server (novell-proxydhcp) responds to this request with information that includes the IP address of an Imaging Server where the device can send requests for assigned imaging work.

Because PXE devices can exist in an environment with both newer and older ZENworks systems running concurrently, the device can fail to determine its assigned imaging work if it cannot find the Imaging Server for its own ZENworks version.
In ZENworks, devices can exist in multiple Management Zones. It is essential that the PXE device contact PXE services assigned to its home zone so that it can correctly determine if there is any imaging work assigned to it. When there is only a single Management Zone, this is easy to do because all Proxy DHCP servers provide addresses to services that belong to the same zone. Any device can request imaging work from any Imaging Server in the same zone and get the same response.

The PXE device’s initial request for PXE services is sent as a broadcast to the network, and all Proxy DHCP servers respond with information pertaining to their respective zones (in ZENworks Configuration Management). Since it is impossible to determine which Proxy DHCP server responds first (if multiple Proxy DHCP servers respond), or which server’s response is used by the device, it is impossible to ensure that each PXE device will contact servers in its home zone.

For a ZENworks environment that has PXE services, the Server Referral List configuration section provides a method for getting PXE devices to connect with their proper Imaging Servers. Server referral lists are only used by PXE devices, and in ZENworks Configuration Management only one Management Zone needs to have an active Proxy DHCP server and server referral list. Because you can only have one referral list active in a network segment, if you have ZENworks Linux Management running with a referral list configured, you’ll need to disable the Proxy DHCP service for Linux Management. This allows the Configuration Management referral list to be used by all PXE devices.

A server referral list allows you to ensure that all devices contact their home zone or tree for device imaging work assignments. The list should contain the IP address of an Imaging Server in each known Management Zone or older ZENworks system’s tree. When a device requests device imaging work from a server, the server first determines if the device belongs to the same zone or tree as the server. If it does not, that server refers the request to each server in its server referral list until it finds the device’s home zone or tree. The device is then instructed to send all future requests to the correct novell-proxydhcp.

For the procedures in configuring referral lists, see Section 2.5.4, “Configuring the Server Referral List,” on page 86.

### 1.4.6 Intel Active Management Technology (AMT)

The Intel AMT functionality allows you to accurately identify devices, even if they have had physical drive replacements. This provides ZENworks Preboot Services with persistent device identification by providing ZENworks with nonvolatile memory for storing the unique device identity.

With AMT and Preboot Services, if a device has a new, unformatted hard drive, ZENworks can instantly and accurately identify the device and apply the appropriate Preboot bundle. If a device’s hard drive is inactive or its drive is replaced, ZENworks can automatically identify the device in a preboot environment and provide the appropriate ZENworks-created image during a system rebuild.

AMT with ZENworks also provides easier hardware upgrading capability. For example, to upgrade applications, some of your device hardware might not meet the minimum requirements. With AMT and Preboot Services, as soon as the hard drives are replaced and before any agents or operating systems are installed, you can continue to assign Preboot bundles using the device’s ZENworks identity without having to re-register the device.

If you are using Intel AMT, support for it should be enabled in the novell-zmgprebootpolicy.conf file.

For more information on Intel AMT, see the Intel Web site (http://www.intel.com/technology/platform-technology/intel-amt/).
1.5 The Preboot Services Processes

The following sections explain how the Preboot Services processes work:

- Section 1.5.1, “A Typical Preboot Services Operation,” on page 27
- Section 1.5.2, “Illustrating the Preboot Services Processes,” on page 28

1.5.1 A Typical Preboot Services Operation

A typical Preboot Services operation flows as follows:

1. A Preboot bundle is created in ZENworks Control Center and assigned to a PXE-enabled device.
2. The PXE-enabled device starts to boot.
3. The device sends a DHCP discovery request to determine the IP address of the Preboot Services Imaging Server.
4. The DHCP server responds with an IP address for the device to use.
5. Novell-proxydhcp responds with the IP addresses of the TFTP server, as well as the filename of the Preboot Services bootstrap program (nvlnbp.sys or nvlnbpdx64.efi).
6. The PXE device downloads the Preboot Services bootstrap program using novell-tftp.
7. After the Preboot Services bootstrap program is downloaded and executed, the device checks novell-zmgprebootpolicy to see if there is any imaging work to do.
8. If there is imaging work to do (as contained in a Preboot bundle that is assigned to the device), the device performs the following task
   - **ZENworks Imaging:** Downloads the Configuration Management imaging environment from the server so that the it can be booted to Linux.
   - **Third-Party Imaging:** Downloads the WinPE environment from the server.
9. Any imaging tasks contained in the Preboot bundle are performed.
10. If there are no imaging tasks to perform, files are not downloaded and the device proceeds to boot to its operating system.

In addition to using PXE for automation, you can also execute Preboot work using one of the following:

- Preboot Services Menu (if enabled for the device)
- Preboot Services bootable CD or DVD
- ZENworks partition
- Bootable USB

For more information, see Section 3.1.2, “Using the Command Line for ZENworks Imaging,” on page 102.
1.5.2 Illustrating the Preboot Services Processes

The following illustrations show the interaction between a Preboot Services (PXE) device and a Preboot Services Imaging Server, starting when the PXE device is turned on and begins to boot, and ending when imaging work begins on that device.

The following example assumes that the devices and Imaging Servers are in the same network segment.

- “Phase 1: Beginning the Process” on page 28
- “Phases 2 through 8: Continuing the Process” on page 30

Phase 1: Beginning the Process

Depending on whether novell-proxydhcp is configured on the same server as the standard DHCP server or on a different server, the imaging process begins differently. The following sections illustrate how the process begins for each configuration, then the phases illustrated in “Phases 2 through 8: Continuing the Process” on page 30 are the same for them.

- “Standard DHCP and Novell Proxy DHCP Configured on Separate Servers” on page 28
- “Standard DHCP and Novell Proxy DHCP Configured on the Same Server: Part A” on page 29
- “Standard DHCP and Novell Proxy DHCP Configured on the Same Server: Part B” on page 30

Standard DHCP and Novell Proxy DHCP Configured on Separate Servers

For this example, the DHCP server and the Preboot Services Imaging Server are two separate servers on the network.

Figure 1-1 DHCP Configuration on Separate Servers

Processes:

1. When the device boots, the PXE BIOS issues a DHCP request with PXE extensions. The request is broadcast on port 67.
2. The DHCP server responds with IP configuration information on port 68, and the Proxy DHCP server responds on port 68 with the name of the bootstrap program (nvlnbp.sys or nvlnbpx64.efi) and the IP address of the TFTP service or daemon where it can be found.


**Standard DHCP and Novell Proxy DHCP Configured on the Same Server: Part A**

For this example, the DHCP server and the Preboot Services Imaging Server are configured on the same server on the network. See “Standard DHCP and Novell Proxy DHCP Configured on the Same Server: Part B” on page 30 for the second part of this example.

*Figure 1-2  DHCP Configuration on the Same Server, Part A*

Processes:

1. When the device boots, the PXE BIOS issues a DHCP request with PXE extensions. The request is broadcast on port 67.

2. The DHCP server responds with IP configuration information on port 68, including tag 60 for PXEClient, which indicates that novell-proxydhcpc is running on the same server.
Processes:

1. When the device sees tag 60 in the DHCP response, the PXE BIOS reissues the DHCP request on port 4011.
2. The Proxy DHCP server responds on port 68 with the name of the bootstrap program (nvlnbp.sys or nvlnbp64.efi) and the IP address of the TFTP service or daemon where it can be found.

Phases 2 through 8: Continuing the Process

The following sections explain how the Preboot Services process continues after Phase 1:

- “Phase 2” on page 31
- “Phase 3” on page 31
- “Phase 4” on page 32
- “Phase 5” on page 32
- “Phase 6” on page 33
- “Phase 7” on page 33
- “Phase 8” on page 34
Phase 2

*Figure 1-4  Phase 2 of the Preboot Services Process*

- Processes:
  1. The PXE BIOS requests `nvlnbp.sys` from the TFTP server.
  2. The TFTP server sends `nvlnbp.sys` to the PXE device.
  3. The PXE device loads `nvlnbp.sys` into memory.

Phase 3

*Figure 1-5  Phase 3 of the Preboot Services Process*

- Processes:
  1. Hardware detection is performed by `nvlnbp.sys` and it reads the image-safe data.
  2. `nvlnbp.sys` requests the Novell Preboot Services Menu configuration from the Data Model via `novell-zmtprebootpolicy`.
  3. `novell-zmtprebootpolicy` returns the Novell Preboot Services Menu configuration. In this case, the menu described in `pxemenu.txt` is displayed when a user presses the hot key.
Phase 4

*Figure 1-6 Phase 4 of the Preboot Services Process*

Processes:

1. Assuming no Novell Preboot Services Menu is displayed, the device asks the Data Model (via novell-zmgprebootpolicy) if any work is assigned.
2. Assuming work is assigned, novell-zmgprebootpolicy responds with the name of the configuration file to use in performing the preboot work (*z_auto.cfg* for ZENworks Imaging as shown in the above illustration and *winpe.cfg* for ZENworks Third-Party Imaging).

Phase 5

*Figure 1-7 Phase 5 of the Preboot Services Process*

Processes:

1. The PXE device requests *pxelinux.0* from the TFTP server.
2. The TFTP server sends *pxelinux.0* to the device.
Phase 6

Figure 1-8  Phase 6 of the Preboot Services Process

Processes:

1. Pxeboot.0 requests and receives /boot/preboot.0 from the TFTP server.
2. Pxeboot.0 requests and receives /boot/bootMgr.exe from the TFTP server.
3. Pxeboot.0 requests and receives /boot/root from the TFTP server.
4. Pxeboot.0 requests and receives /boot/updateDrivers.tgz from the TFTP server, but is denied because the file does not exist (it is used to provide post-release software updates).

Processes for ZENworks Third-Party Imaging:

1. Pxeboot.0 requests and receives /boot/preboot.0 from the TFTP server.
2. Pxeboot.0 requests and receives /boot/bootMgr.exe from the TFTP server.

Phase 7

Figure 1-9  Phase 7 of the Preboot Services Process

Processes for ZENworks Imaging (as shown in the above illustration):

1. Pxeboot.0 requests and receives /boot/kernel from the TFTP server.
2. Pxeboot.0 requests and receives /boot/initrd from the TFTP server.
3. Pxeboot.0 requests and receives /boot/root from the TFTP server.

Processes for ZENworks Third-Party Imaging:

1. Pxeboot.0 requests and receives /boot/preboot.0 from the TFTP server.
2. Pxeboot.0 requests and receives /boot/bootMgr.exe from the TFTP server.
3. The boot manager loads /boot/bcd.
4. The boot manager finally receives and loads /boot/bsdi and /boot/winpe.wim.

Phase 8

**Figure 1-10** Phase 8 of the Preboot Services Process for ZENworks Imaging

Processes for ZENworks Imaging:

1. SUSE Linux Enterprise Server (SLES) is loaded and run on the device.
2. The ZENworks Imaging Engine (`img`) requests the assigned Preboot Services work details and performs the work.
3. The image is laid down on the device and it automatically reboots.

**Figure 1-11** Phase 8 of the Preboot Services Process for ZENworks Third-Party Imaging

Processes for ZENworks Third-Party Imaging:

1. WinPE distro is loaded and run on the device.
2. The Novell ZENworks Third Party Imaging utility requests the assigned Preboot Services work details and performs the work.
3. The image is laid down on the device and it automatically reboots.
1.6 Preboot Strategies

The following sections present possible approaches to using Preboot Services. Use the following sections to determine which procedures to perform. The steps are documented in subsequent sections.

- Section 1.6.1, “Automating Installations and Imaging Tasks,” on page 35
- Section 1.6.3, “Reimaging Corrupted Devices,” on page 36
- Section 1.6.4, “Restoring Lab Devices to a Clean State,” on page 36
- Section 1.6.5, “Setting Up Devices for Future Reimaging,” on page 37
- Section 1.6.6, “Multicasting Device Images,” on page 38

1.6.1 Automating Installations and Imaging Tasks

You can automate Linux installations and imaging tasks using Preboot Services in the following ways:

- **SUSE Linux installation:** The AutoYaST bundle can automate installation of SUSE Linux on a Linux device.
- **Red Hat Linux installation:** The kickstart bundle can automate installation of Red Hat Linux on a Linux device.
- **Imaging Script Execution:** The Imaging Script bundle can automate execution of Imaging Script on a managed device, including imaging commands. This is applicable only for ZENworks Imaging.
- **Device Imaging:** The ZENworks Image bundle can be used to place an image on a device.
- **Imaging Multiple Devices:** The Multicast Image Set bundle can be used to place an image on multiple devices with one pass of the image file over the network, such as in resetting lab devices. This is applicable only for ZENworks Imaging.
- **MDT Deployment:** The MDT Deployment bundle can automate installation or deployment of Windows desktop and server.

All you need to do to accomplish any of these actions is to create and configure one of the Preboot bundle types, then assign the bundle to the desired devices. When a device boots, the assigned bundle is automatically applied before the device’s operating system starts.

You can also accomplish these tasks per device using the Novell Preboot Services Menu’s Start ZENworks Imaging Maintenance option to access the imaging maintenance mode prompt, if you have enabled the menu for the device. Or, you can use a Preboot Services bootable CD or DVD, or bootable USB, which does not require PXE to be enabled on the device. For more information, see Section 3.1.2, “Using the Command Line for ZENworks Imaging,” on page 102.

1.6.2 Creating, Installing, and Restoring Standard Images

As new devices are purchased and before deploying them, you can install a standard software platform and enable the device for future unattended reimaging.

1. Create a model device of each type that you intend to deploy.
2. Create an image of each model device on a ZENworks Imaging Server. For more information, see “Manually Taking an Image of a Device” on page 103.
These images should include the Novell ZENworks Configuration Management Imaging Agent (novell-zisdservice).

3. Optionally, you can create a preboot bundle for this image. This allows the image to be assigned automatically for later use.

4. If you are using Preboot Services, install Configuration Management on a server, which makes it an Imaging Server. For more information, see Section 2.1, “Preparing a Preboot Services Imaging Server,” on page 41.

   or

   If you are using a bootable CD or DVD, a ZENworks partition, or a bootable USB, create a boot CD or DVD that points to the ZENworks Imaging Server where the model images are stored. For more information, see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46.

As each new device comes in, do the following if you are using Preboot Services:

1. Make sure the device is PXE capable. Enable PXE if it isn't enabled by default. For more information, see Section 2.7, “Enabling PXE on Devices,” on page 89.

2. Physically connect the device to the network.

3. Boot the device from the Preboot Services Imaging Server.

If you are not using Preboot Services, boot the device with the imaging boot CD or DVD and consider installing the ZENworks partition to enable auto-imaging without the CD or DVD. For more information, see Step 3 on page 52 of Section 2.8.2, “Enabling a Device for Imaging Operations,” on page 91. After you have installed the partition, reboot the device from the ZENworks partition.

### 1.6.3 Reimaging Corrupted Devices

Without data loss or undue disruption to users, you can fix devices that have become misconfigured or corrupted.

1. When a device needs to be fixed, have the user back up any files to the network that he or she wants to keep (if possible).

2. Create and/or assign an appropriate Preboot bundle to the device.

3. If it is a device with a ZENworks partition or if it is PXE-enabled, the user should boot the device from the ZENworks partition or the Preboot Services Imaging Server (via PXE) to find and execute the assigned bundle. If you are using PXE, make sure that Preboot Services is installed on your server to make it an Imaging Server. For more information, see Chapter 3, “Using Imaging,” on page 93.

   or

   If the device does not have a ZENworks partition and is not PXE-enabled, the user should boot the device with the imaging boot CD or DVD, or a bootable USB, and restore the appropriate images.

4. After the image is laid down, restore any user files that were backed up to the network.

### 1.6.4 Restoring Lab Devices to a Clean State

You can restore devices to a clean state, removing any changes or additions made since the last time you restored the image on that device. This is useful for updating lab devices.

For a method to initially set up a lab, see Section 1.6.6, “Multicasting Device Images,” on page 38.
The following steps assume that the devices are unregistered.

1. Create an image of a clean model device and store it on a ZENworks Imaging Server. For more information, see “Manually Taking an Image of a Device” on page 103.

2. If you are using Preboot Services, make sure that Configuration Management is installed on your server to make it an Imaging Server. For more information, see Section 2.1, “Preparing a Preboot Services Imaging Server,” on page 41.

3. If you are using Preboot Services and the devices are PXE capable, make sure that PXE is enabled. For more information, see Section 2.7, “Enabling PXE on Devices,” on page 89.
   or
   If you are not using Preboot Services or the ZENworks partition, create an imaging boot CD, DVD, or bootable USB that points to the ZENworks Imaging Server where the clean image is stored. For more information, see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46.

Deploy each lab device as follows:

1. Physically connect the device to the lab network.
2. If you are using Preboot Services, boot the device from the Preboot Services Imaging Server.
   or
   If you are not using Preboot Services, boot the device with the imaging boot CD, DVD or bootable USB and install the ZENworks partition. For more information, see Step 3 on page 52 of Section 2.8.2, “Enabling a Device for Imaging Operations,” on page 91. After you have installed the partition, reboot the device from the ZENworks partition.
3. At the end of each lab session, assign the Preboot bundle to the lab devices.
4. Reboot each device and let it be auto-imaged by its assignment to a ZENworks Preboot bundle.

1.6.5 Setting Up Devices for Future Reimaging

With minimal disruption to users, you can enable existing devices for future reimaging.

This process might need to be phased in by local administrators. Each administrator can do the following:

1. Install the Novell ZENworks Configuration Management Imaging Agent, novell-zisdservice on Windows devices and novell-zislnx on Linux devices.
2. If the devices are PXE-capable, make sure PXE is enabled (see Section 2.7, “Enabling PXE on Devices,” on page 89) and make sure that Configuration Management is installed on your server to make it an Imaging Server (see Section 2.1, “Preparing a Preboot Services Imaging Server,” on page 41).
   or
   Prepare a few sets of imaging CDs or DVDs, or bootable USB that users can use when they have difficulty (see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46). These devices should point to an Imaging Server that contains the same clean images used for new devices.
3. If a user has difficulty, use the strategy for reimaging corrupted devices. For more information, see Section 1.6.3, “Reimaging Corrupted Devices,” on page 36.
Multicasting Device Images

The following sections explain the multicasting images feature for ZENworks Imaging:

- “Understanding Multicasting” on page 38
- “Practical Uses For Multicasting” on page 39
- “Automatic Multicasting Example” on page 39

For instructions on using multicasting, see Section 3.3, “Multicasting Images for ZENworks Imaging,” on page 121.

Understanding Multicasting

Multicasting is a way to send the same image to multiple devices without sending that image multiple times across the network. It is done by inviting participants to join a multicast session. Multicasting is similar to broadcasting on the network, because you send the image once to the network and only those devices belonging to the multicast session can see and receive it. This saves on network bandwidth usage.

For example, if you have 10 devices in the multicast session and the image is 3 GB in size, your network experiences only 3 GB of network traffic to image all 10 devices. Without multicasting, the network experiences 30 GB of network traffic to image all 10 devices individually.

The devices to be imaged must be physically connected to the network. They can be devices with existing operating systems of any kind, or they can be new devices with no operating system installed.

IMPORTANT: For multicasting to work properly, all routers and switches on the network must have their multicast features configured. Otherwise, multicast packets might not be routed properly.

Multicasting can be done automatically or:

- “Automatic Multicasting” on page 38
- “Manual Multicasting” on page 39

Automatic Multicasting

In ZENworks Control Center, multicasting is accomplished by configuring a Multicast Image Set bundle. The bundle contains a base image that is taken previously from a device and is stored on an Imaging Server. This base image is applied to all multicast session participants.

When using a Preboot bundle to perform multicasting, the Imaging Server is the session master, which sends the .zmg image file to the session participants. Novell-pbserv is used in this process. All problems are reported to Novell-pbserv, which is the session master device in this case.

For more information, see Section 3.3, “Multicasting Images for ZENworks Imaging,” on page 121.
Manual Multicasting

At the imaging maintenance mode prompt, you can enter commands to configure and initiate a multicasting session. You enter the appropriate commands on the prompt at each device, specifying one of them to be the session master. An image of the session master's hard drive is sent to each of the session participants.

For more information on the imaging commands, see Section E.5, “Session Mode (Multicast Image Set),” on page 282.

If you plan to set up multicasting by visiting each device, you need either an imaging boot CD or DVD, bootable USB, or the devices must be PXE-enabled. For more information, see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46.

Practical Uses For Multicasting

Multicasting is ideal for labs, classrooms, and staging areas, or for any place where you need to quickly create the same configuration on multiple devices, instead of taking the time to set up each device individually.

Benefits of Multicasting Images

Multicasting is the way to use ZENworks Imaging Engine for mass reimaging with the least amount of overhead. It is useful if you have one device with a clean software configuration that you want to duplicate on several other devices, or if you have a single image that you want to set up on multiple devices.

Limitations of Multicasting Images

One significant limitation of using multicast without installing any Configuration Management software is that it results in a set of devices that have duplicate network identities. The IP addresses (if the network is using static IP addressing) and device hostname are all the same and can cause conflicts if deployed on the network without change.

For a handful of devices, this might not be a problem. But for a larger number of devices, you should install the Novell ZENworks Configuration Management Imaging Agent (novell-zisdservice) on each device before doing the multicast (see Section 2.8.2, “Enabling a Device for Imaging Operations,” on page 91). The Imaging Agent saves the device’s network identity settings before the multicast session and restores them afterwards.

Automatic Multicasting Example

To automatically multicast an image to multiple devices using ZENworks Control Center:

1. In ZENworks Control Center, create a Multicast Image Set bundle using a wizard.
2. Specify the source image for the bundle.
   You can multicast an existing image from your Imaging Server.
3. Configure the trigger for multicasting the bundle, as in the following examples:
   - **Client Count**: When the specified number of clients specified in the bundle have booted and registered, the multicast session begins.
   - **Time Count**: When the specified length of time has passed with no new clients having registered, the multicast session begins regardless of the number of client participating.
   The first trigger to be realized causes the multicast session to begin.
4. Assign the Multicast Image Set bundle to the desired devices.

ZENworks Control Center provides a way to enable or disable a Multicast Image Set bundle, allowing you to temporarily stop the bundle from executing. This is more efficient than unassigning the bundle from many devices.

5. Wait for the trigger to happen.

Each device booting into the session has its boot process delayed until the session begins, which is determined by fulfillment of one of the triggers.

The multicast happens automatically when a device assigned to the Multicast Image Set bundle boots, according the configuration you set up for the Multicast Image Set bundle and for the devices you assigned to the bundle. This bundle is applied to each session device before it boots its operating system. The ZENworks Multicast Image Set bundle is sent over the wire just once, using the multicast capability of your network, and executed simultaneously on all participating devices.
2 Setting Up Preboot Services and Imaging

The section provides instructions for setting up Preboot Services in ZENworks:

- Section 2.1, “Preparing a Preboot Services Imaging Server,” on page 41
- Section 2.2, “Preparing a Satellite with the Imaging Role,” on page 42
- Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46
- Section 2.4, “Deploying and Managing Preboot Services,” on page 54
- Section 2.5, “Configuring Preboot Services Defaults for ZENworks Imaging,” on page 72
- Section 2.6, “Overriding Preboot Services Defaults,” on page 88
- Section 2.7, “Enabling PXE on Devices,” on page 89
- Section 2.8, “Setting Up Devices for ZENworks Imaging,” on page 90

**IMPORTANT:** The Preboot Services software is automatically installed when you install ZENworks.

### 2.1 Preparing a Preboot Services Imaging Server

When you install Novell ZENworks on a server, the Preboot Service service or daemon (novell-pbserv) makes all Primary Servers an Imaging Server. To avoid confusion, the Proxy DHCP service or daemon (novell-proxydhcp) is installed, but not enabled. For PXE devices to be able to communicate with Preboot Services, this service or daemon must be started on at least one server on each network segment. Exactly how many servers and which specific servers should run this service or daemon is dictated by your network topology. As a rule of thumb, for every DHCP server deployed in your network, you should have a corresponding Proxy DHCP server. PXE requires that the firewall is either turned off or configured pass the DHCP traffic.

For information on setting up management of your devices, see Section 2.4, “Deploying and Managing Preboot Services,” on page 54 and Section 2.5, “Configuring Preboot Services Defaults for ZENworks Imaging,” on page 72.

In addition to the specific hardware requirements for a ZENworks Server, the server used to store image files must meet the following requirements:

- **Fixed IP Address:** When you connect to the Imaging Server during an imaging operation, you must do so using the fixed IP address or DNS name of the Imaging Server.

- **Enough Space to Store Device Images:** Unless you use compression (which is enabled by default) for your device images, they are nearly the same size as the data on the device hard disk, which could be many gigabytes.

  If you want to store an image locally (on a CD, DVD, or hard disk) rather than on an Imaging Server, see “Using a CD, DVD or bootable USB for Disconnected Imaging Operations” on page 113 and “Using a Hard Disk for Disconnected Imaging Operations” on page 115.
2.2 Preparing a Satellite with the Imaging Role

A Satellite is a managed device that can perform certain roles that a ZENworks Primary Server normally performs. A Satellite can be any managed device (server or workstation). When you configure a Satellite, you specify which roles it performs (Imaging, Collection, or Content). A Satellite can also perform roles that might be added by third-party products that are snap-ins to the ZENworks framework.

The following sections provide detailed information:

- Section 2.2.1, “Understanding the Imaging Role,” on page 42
- Section 2.2.2, “Configuring the Imaging Role to the Satellite,” on page 42
- Section 2.2.3, “Illustrating the Preboot Services Processes on the Imaging Satellite,” on page 43

2.2.1 Understanding the Imaging Role

The Imaging role installs the Imaging services and adds the Imaging role to the device. The Satellite with the Imaging role is called Imaging Satellite. The Imaging Satellite requires both Proxy DHCP and DNS server to be running in the Imaging environment.

The Imaging roles allows you to:

- Perform all the Imaging operations on the device by using it as an Imaging server. The operations includes taking an image and applying an image within as well as across subnets by using unicast or multicast imaging.
- Achieve load balance for the Primary Server.
- Replicate TFTP folder and add-on images from Primary Server to Satellite Server.

The Satellite communicates with the Primary Server for the Imaging operations.

On the managed device, the Imaging module is inactive until you promote the managed device to be a Satellite with the Imaging role or the Imaging role is added to an existing Satellite. This activates the Imaging services on the device, and enables you to perform the Imaging operations in auto and maintenance mode.

The Imaging components installed on the device include Novell ZENworks PXE Client Files, Novell ZENworks PXE Update Files, and Novell ZENworks Multicast Application (zmgmcast). The Imaging services installed on the device include Novell TFTP, ZENworks Preboot Policy (zmgpbpolicy), ZENworks Preboot (pbserv), and Novell Proxy DHCP. All services, except for proxy DHCP, are automatically started. You can start or stop the proxy DHCP service from ZENworks Control Center.

2.2.2 Configuring the Imaging Role to the Satellite

You can configure the Imaging role to the Satellite by using ZENworks Control Center or the zman command line utility.

To configure the Imaging role by using the zman command line utility, see “Satellite Commands” in the ZENworks Command Line Utilities Reference.
2.2.3 Illustrating the Preboot Services Processes on the Imaging Satellite

A typical Preboot Services operation for Imaging Satellite flows as follows:

1. A Preboot bundle is created in ZENworks Control Center and assigned to a PXE-enabled device.
2. The PXE-enabled device starts to boot.
3. The device sends a DHCP discovery request to determine the IP address of the Imaging Satellite.
4. The DHCP server responds with an IP address for the device to use.
5. Novell-proxydhcpp responds with the IP addresses of the TFTP server, as well as the filename of the Preboot Services bootstrap program (nvlnbp.sys or nvlnbpx64.efi).
6. The PXE device downloads the Preboot Services bootstrap program by using novell-tftp on Imaging Satellite.
7. After the Preboot Services bootstrap program is downloaded and executed, the device checks for the novell-zmgprebootpolicy on Imaging Satellite to see if there is any imaging work to do.
8. If there is imaging work to do (as contained in a Preboot bundle that is assigned to the device), the device downloads the WinPE environment from the server.
9. Any imaging tasks contained in the Preboot bundle are performed.
10. If there are no imaging tasks to perform, files are not downloaded and the device proceeds to boot to its operating system.

All database transactions for assigned imaging tasks are performed through a web request from the Imaging Satellite to the Primary Server.

The following sections explain how the Preboot Services work for PXE boot, ZENworks Imaging, and third-party imaging on the Imaging Satellite:

- “Illustrating the Preboot Services Process for PXE Boot on the Imaging Satellite” on page 43
- “Illustrating the Preboot Services Process for ZENworks Imaging on the Imaging Satellite” on page 44
- “Illustrating the Preboot Services Process for Third-Party Imaging on the Imaging Satellite” on page 45

Illustrating the Preboot Services Process for PXE Boot on the Imaging Satellite

The following example assumes that the devices and Imaging Servers are in the same network segment.
Processes:

1. When the device boots, the PXE BIOS issues a DHCP request with PXE extensions. The request is broadcast on port 67.

2. The DHCP server responds with IP configuration information on port 68, and the Proxy DHCP server on Imaging Satellite responds on port 68 with the name of the bootstrap program (nvlnbp.sys or nvlnbpvx64.efi) and the IP address of the TFTP service or daemon where it can be found.

**Illustrating the Preboot Services Process for ZENworks Imaging on the Imaging Satellite**

The following example assumes that the devices and Imaging Servers are in the same network segment.
Processes:

1. SUSE Linux Enterprise Server (SLES) is loaded and run on the device.
2. The ZENworks Imaging Engine (img) requests the assigned Preboot Services work details and performs the work.
3. The image is laid down on the device and it automatically reboots.

Illustrating the Preboot Services Process for Third-Party Imaging on the Imaging Satellite

For ZENworks Third-Party imaging, you must upload the third-party tools on the Primary Server. For more information, see Section C.3, “Performing ZENworks Third-Party Imaging by Using ZENworks Control Center,” on page 208. This automatically replicates the required imaging distro and tools from the Primary Server to the corresponding tftp directory on the Imaging Satellite. The imaging process on the Imaging Satellite is similar to the process on the Primary Server. For more information on the imaging process on the Primary Server, see, Section 1.5, “The Preboot Services Processes,” on page 27.

The following example assumes that the devices and Imaging Servers are in the same network segment.
2.3 Setting Up the Preboot Services Methods for ZENworks Imaging

The Novell ZENworks Imaging Engine that performs the actual imaging of a device is a Linux application. Unless you use automated Preboot Services with PXE-enabled devices, you need to prepare a boot medium that has the Linux kernel, ZENworks Imaging Engine, and network drivers installed.

The following sections contain additional information:

- Section 2.3.1, “Using Preboot Services (PXE),” on page 47
- Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47
- Section 2.3.3, “Creating Bootable USB Drives for Imaging,” on page 51
- Section 2.3.4, “Managing ZENworks Partitions,” on page 52
2.3.1 Using Preboot Services (PXE)

Preboot Execution Environment (PXE) is an Intel specification that allows a device to boot from the network, instead of its hard drive or other local media. ZENworks can use PXE to launch Preboot Services.

Preboot Services uses PXE to find out if there is imaging work specified for a device and to provide the device with the files necessary to boot to the ZENworks imaging environment.

Before you can use Preboot Services with automated Preboot bundles, you need to do the following:

1. Install ZENworks on your Imaging Server.
2. Enable PXE on the device.
3. Have a standard DHCP server, either on your Imaging Server or on another network server.

Automated Preboot Services functions can also be performed using a ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

Manual Preboot Services functions can be performed using CDs or DVDs, or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.

2.3.2 Preparing Imaging Boot CDs, DVDs or bootable USB

If you have software for burning CDs, DVDs or bootable USBs, you can create an imaging boot CD, DVD or bootable USB for imaging operations.

- “Creating a Boot CD, DVD or bootable USB with Additional Files” on page 47
- “Alternate procedure for creating a Boot CD, DVD or bootable USB with Additional Files” on page 49
- “Creating a Boot CD or DVD without Additional Files” on page 50
- “Modifying Kernel Boot Parameters for ZENworks Imaging” on page 50
- “Creating a Tuxera Boot CD” on page 51

For information on how to use the CD, DVD or bootable USB to perform disconnected imaging operations, see Section 3.1.3, “Setting Up Disconnected Imaging Operations,” on page 113.

Creating a Boot CD, DVD or bootable USB with Additional Files

This section describes how to create an imaging CD, DVD or bootable USB that contains more than the files provided in the bootcd.iso image.

This method allows you to include the settings.txt file on the boot CD, DVD or bootable USB to provide the required imaging parameters. For more information on the settings.txt file, see Section D.7, “Imaging Configuration Parameters (settings.txt),” on page 249.

This method also allows you to add other files and drivers that you need to do the imaging.

To create an imaging boot CD, DVD or bootable USB that includes settings.txt and other files:

1. Copy the bootcd.iso file to a temporary location.

   On the Imaging Server where ZENworks is installed, the bootcd.iso file is located in:

   **Windows:** \%ZENWORKS_HOME\%bin\preboot\%
   **Linux:** /opt/novell/zenworks/preboot/bin/winutils/
2 In an ISO editor, open the temporary copy of the bootcd.iso file.
If you experience ISO corruption after adding files into the ISO, such as a checksum error, use a more reliable ISO editor. Also, some ISO editors do not work very well with DVDs.

3 Using the temporary bootcd.iso file, copy the settings.txt file to the root of the bootcd.iso image.
On the Imaging Server where ZENworks is installed, the settings.txt file is located in:

Windows: %ZENWORKS_HOME%\bin\preboot\n
Linux: /opt/novell/zenworks/preboot/bin/winutils/

4 Copy any other files or drivers that you want included on the CD, DVD or bootable USB to the addfiles directory in the temporary bootcd.iso image.
Any files or subdirectories that you add under the /addfiles directory are placed at the root of the client when booting the CD, DVD or bootable USB.

**IMPORTANT:** When booting from the CD, DVD or bootable USB, the imaging engine is read into RAM. Because the imaging engine uses some of the RAM that exists on the client device, the combined size of any files that you add under the addfiles directory cannot exceed the amount of remaining RAM.

5 Save the updated bootcd.iso image file to its temporary location.

6 Use your software for burning CDs or DVDs to burn the updated bootcd.iso image onto the CD, DVD or bootable USB.

7 Boot the device to be imaged from your newly created imaging boot CD, DVD or bootable USB.
Booting from a SCSI CD-ROM device is currently not supported.

To create an imaging boot CD, DVD or bootable USB by changing the default menu option in the /boot/i386/loader/isolinux.cfg file.

1 Copy the bootcd.iso file to a temporary location.
On the Imaging Server where ZENworks is installed, the bootcd.iso file is located in:

Windows: %ZENWORKS_HOME%\bin\preboot\n
Linux: /opt/novell/zenworks/preboot/bin/winutils/

2 In an ISO editor, open the temporary copy of the bootcd.iso file.
If you experience ISO corruption after adding files into the ISO, such as a checksum error, use a more reliable ISO editor. Also, some ISO editors do not work very well with DVDs.

3 In the temporary bootcd.iso file, open the isolinux.cfg file located in the /boot/i386/loader directory.

4 Edit the isolinux.cfg file to change the following line
   default linux
   to
   default manual

5 Save the updated bootcd.iso image file to its temporary location.

6 Use your software for burning CDs or DVDs to burn the updated bootcd.iso image onto the CD, DVD or bootable USB.

7 Boot the device to be imaged from your newly created imaging boot CD, DVD or bootable USB.
Booting from a SCSI CD-ROM device is currently not supported.

The zmgbootcd imaging utility is a part of the following MSI/RPM files:
Alternate procedure for creating a Boot CD, DVD or bootable USB with Additional Files

You can create an Imaging boot CD, DVD or bootable USB by changing the default menu option in the /boot/i386/loader/isolinux.cfg file.

To create a boot CD, DVD or bootable USB:

1. Unzip the bootcd.zip file to the following locations:
   - **Windows**: `%ZENWORKS_HOME%\bin\preboot\`. For example, `C:\Program Files (x86)\Novell\ZENworks\bin\preboot`
   - **Linux**: `/opt/novell/zenworks/preboot/bin/winutils/`
2. Take backup of the settings.txt and other files.
3. Modify the settings.txt or add files to bootcd. The settings.txt is located at files/settings.txt. Insert other files or copy the files to the files/addfiles folder.
4. Create a new bootcd.zip file from modified folder files.
   - **Windows**: Use any Windows tool to create bootcd.zip file
   - **Linux**:
     ```
     #zip bootcd.zip -r files
     #chown zenworks:zenworks bootcd.zip
     ```
5. Delete the extracted files directory.
6. To create bootcd_tntfs.iso:
   - **For Windows**: 
     1. Open the command prompt as an administrator.
     2. Type the `cd C:\Program Files (x86)\Novell\ZENworks\bin\preboot` command.
     3. Execute the bootcd-editor.bat script with the required parameter. 
        ```
        bootcd-editor.bat <path to Tuxera driver folder> <output directory>
        ```
        For example, `C:\Program Files (x86)\Novell\ZENworks\bin\preboot>bootcd-editor.bat "C:\Program Files (x86)\Novell\ZENworks\share\tftp\11.3"
   - You can see the following message on the console:
     ```
     C:\Program Files (x86)\Novell\ZENworks\bin\prebootprocessing....... Done..
     Injected bootcd => C:\bootcd_tntfs.iso
     Bootcd iso file is created at the output directory as bootcd_tntfs.iso
     ```
   - **For Linux**: 
     1. Execute the bootcd-editor.sh script with the required parameter for creating the bootcd.
        ```
        bootcd-editor.sh <path to tuxera driver folder> <output directory>
        ```
        For example, `/bootcd-editor.sh /srv/tftp/11.3/ /tmp`
        The Bootcd ISO file is created at the output directory as bootcd_tntfs.iso.

**NOTE:** The bootcd_tntfs.iso file creation fails on RHEL Servers having the tntfs.zip file. For more information, see ZENworks Readme.
Creating a Boot CD or DVD without Additional Files

If you do not want to include the `settings.txt` file or any other files or drivers in the imaging boot CD or DVD, you can simply create the imaging boot CD or DVD from the `bootcd.iso` image provided with ZENworks.

However, you need to provide the `settings.txt` file to provide the required imaging parameters. For more information on the `settings.txt` file, see Section D.7, “Imaging Configuration Parameters (settings.txt),” on page 249.

To create an imaging boot CD or DVD that contains only the `bootcd.iso` image:

1. Copy the `settings.txt` file containing the settings you want for the imaging boot process onto a floppy diskette.
   
   On the Imaging Server where ZENworks is installed, the `settings.txt` file is located in:
   
   **Windows:** `%ZENWORKS_HOME%\bin\preboot\`
   
   **Linux:** `/opt/novell/zenworks/preboot/bin/winutils/`

2. Use your software for burning CDs or DVDs to burn the `bootcd.iso` image onto the CD or DVD.
   
   On the Imaging Server where ZENworks is installed, the `bootcd.iso` file is located in:
   
   **Windows:** `%ZENWORKS_HOME%\bin\preboot\`
   
   **Linux:** `/opt/novell/zenworks/preboot/bin/winutils/`

3. Boot the device to be imaged from your newly created imaging boot CD or DVD.
   
   You will be prompted for the diskette that contains the `settings.txt` file.
   
   Booting from a SCSI CD-ROM device is currently not supported.

Modifying Kernel Boot Parameters for ZENworks Imaging

Modify the Boot parameters using any of the following options:

**Adding the boot parameter using the imaging bootcd**

Add a boot parameter of your choice while selecting the boot mode (Automatic or Manual) from the ZENWorks Preboot Options screen.

**Adding the boot parameter using PXE Options**

1. Go to Configuration>Device Management>Preboot Services>PXE Options.
2. In the PXE Kernel Boot Parameters field add the boot parameter.

**Adding the boot parameters in the respective configuration files**

This procedure should be followed to set the `vga=` parameter in place of the `vga=0x314` parameter which is set by default.

The configuration files end with extension *.cfg (for BIOS) or *.conf (for UEFI) For example, `z_auto.cfg`, and `z_maint.conf`. The path to configuration files in the server is as follows:

- **BIOS:** `$TFTP_ROOT/`
- **UEFI:** `$TFTP_ROOT/efi/x86_64/`
Creating a Tuxera Boot CD

Tuxera Boot CD, or the `bootcd_tntfs.iso` file is generated whenever you import the Tuxera driver. You can create a Tuxera bootcd ISO file from the `bootcd-editor` script.

1. On the ZENworks server, browse to the `winutils` folder.
2. Run the following command to create the `bootcd_tntfs.iso` file:
   - **Windows**:
     ```bash
     bootcd-editor.bat <location of the downloaded tuxera driver folder> <destination to the save the ISO file>
     ```
   - **Linux**:
     ```bash
     ./bootcd-editor.sh <location of the downloaded tuxera driver folder> <destination to the save the ISO file>
     ```

2.3.3 Creating Bootable USB Drives for Imaging

You can create a bootable USB flash drive for booting either BIOS or UEFI firmware to perform Imaging operations.

1. Boot a system by using the Imaging boot CD.
2. At the # prompt, run the `ZENUsbcreator` command. You can see the following menu options:
   1. Create bootable USB for 32-bit BIOS machines
   2. Create bootable USB for 64-bit BIOS machines
   3. Create bootable USB for 64-bit UEFI machines
   4. Upgrade bootable USB
   5. Clear all the partitions on the USB device

3. Use the following options to create a USB drive to boot systems:
   - Create bootable USB for 32-bit BIOS machines: Enter 1
   - Create bootable USB for 64-bit BIOS machines: Enter 2
   - Create bootable USB for 64-bit UEFI machines: Enter 3
   - Upgrade bootable USB: Enter 4
   - Clear all the partitions on the USB device: Enter 5

To upgrade a bootable ZEN USB: Enter 3.

You can see a list of detected USB drives. In the following example, there are two detected USB devices. Enter 1 to select a Transcend device and enter 2 to select a SanDisk.

Detected USB device(s):
******************************************************************************
<table>
<thead>
<tr>
<th>Device</th>
<th>Vendor</th>
<th>Model</th>
<th>Size(Bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. /dev/sdb</td>
<td>JetFlash Transcend_16GB</td>
<td>1621937356bB</td>
<td></td>
</tr>
<tr>
<td>2. /dev/sdc</td>
<td>SanDisk CruzerBlade_16GB</td>
<td>1621937356bB</td>
<td></td>
</tr>
</tbody>
</table>
******************************************************************************

4. Select Yes or No, when you are prompted to continue or exit. The selected device will be formatted and partitioned.

The command execution completes processing the USB drive with 160 MB boot partition and the rest of the disk space can be used for second partition to store images or data.
NOTE: On a Windows device you can access the second NTFS partition only if you are using a USB hard drive. You cannot access the second NTFS partition on a flash drive because a Windows device cannot recognize more than one partition on a USB flash drive.

To access the second NTFS partition on a flash drive, use a Linux device that supports NTFS file access.

### 2.3.4 Managing ZENworks Partitions

A ZENworks partition is used by a device when booting for automated Preboot Services work when the device does not have PXE available. The following sections explain how to manage ZENworks partitions:

- "Creating a ZENworks Partition" on page 52
- "Disabling a ZENworks Partition" on page 53
- "Removing a ZENworks Partition" on page 53

#### Creating a ZENworks Partition

If you want to set up a device for unattended imaging operations and are unable to use Preboot Services (PXE), you can create a ZENworks partition on the hard disk. If you make the partition large enough, you can even store an image of the device’s hard disk, which can be useful if the device becomes misconfigured or corrupted when the network connection is lost.

**WARNING:** Installing the ZENworks partition destroys all data on that hard drive. Use this only on devices where you plan to reinstall the operating system and software programs.

1. Boot the device with the imaging CD, DVD or bootable USB, then select **Install/Update ZEN partition** from the menu.

   This starts the process of creating the ZENworks partition in the first partition slot. It destroys all existing partitions, except an existing ZENworks partition or the Dell or Compaq configuration partitions. By default, the ZENworks partition size is 150 MB.

   If the ZENworks partition already exists, it is upgraded, and your existing partitions are left intact.

**NOTE:** You can also update an existing ZENworks partition by running the following commands:

   ```
   #img -a
   # /bin/update.s
   # /bin/grub.s
   #reboot
   ```

2. After the ZENworks partition is installed or updated, remove the CD, DVD or bootable USB and press any key to continue.

3. After removing the CD, DVD or bootable USB and reboot the device, install the operating system on the device.

**IMPORTANT:** During installation of the operating system, you must install the boot loader where the root (/) partition is being installed. In other words, the active partition must be the root partition. You can use `fdisk` to verify that the active partition is root.
4 To take an image of the device using the ZENworks partition, see "Using the Imaging Maintenance Mode Prompt to Create an Image" on page 115.

5 When the imaging maintenance mode prompt is displayed, reboot the device. The device should boot to Linux.

Disabling a ZENworks Partition

If you decide to enable PXE on a device, but have previously installed a ZENworks partition on it, you can disable or delete the partition, because it is no longer necessary. For information on deleting the partition, see "Removing a ZENworks Partition" on page 53.

When you boot to Linux using any imaging boot device or method other than booting from the ZENworks partition, you can disable (or enable) the ZENworks partition. Just select the menu option to do so when the Novell Preboot Services Menu is presented.

Removing a ZENworks Partition

Because you should not delete the ZENworks partition if you booted using the partition, you should boot the device from an imaging boot method other than the ZENworks partition.

WARNING: After you have deleted the ZENworks partition, you need to make sure that the image you place on the device was made on a device without a ZENworks partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the device fails to boot. You should only remove the ZENworks partition if you are going to restore an image that does not have the partition to the device.

The following are ways you can remove a ZENworks partition from a device:

- “Using an Imaging CD, DVD or bootable USB” on page 53
- “Using Imaging Script Bundle” on page 54
- “Using Fdisk” on page 54

Using an Imaging CD, DVD or bootable USB

If you cannot perform a full restoration of the ZENworks partition at this time, you should consider removing it.

To remove a ZENworks partition:

1 Boot the device using the ZENworks imaging CD, DVD or bootable USB.
2 Select the Manual mode option.
3 At the imaging maintenance mode prompt, enter:
   
   img -zenpart -remove
   
4 After the removal is complete, eject the CD, DVD or bootable USB (if you are not going to use it to reimage the device).
5 If you want to restore an image before rebooting, enter the following at the prompt:
   
   unset ZENDEVICE
   
   Otherwise, reboot the device when ready.
6 Restore an image or install an operating system.
When the device boots, its ZENworks partition is removed, then the device can be imaged from the CD, DVD or bootable USB without a ZENworks partition.

If the device is assigned to a Preboot bundle, it is imaged according to that bundle.

**Using Imaging Script Bundle**

If you are using Preboot Services, but formerly booted from the ZENworks partition on the device, you can delete the ZENworks partition at the same time you restore an image. However, the new image should not contain a ZENworks partition.

For example, you can do the following:

1. In ZENworks Control Center, create a Imaging Script bundle.
2. In the **Script text** field in the Create New Bundle Wizard, enter:
   ```
   img -zenpart -remove
   ```
3. In the **Script text** field (after the above command), enter the other commands necessary for the imaging work you want for the device.
   For more information, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.
4. On the Summary page of the wizard, click **Finish** (not **Next**).
5. Reboot the device.

**Using Fdisk**

You can remove a ZENworks partition by simply using `fdisk` to reconfigure the device’s hard drive. Then, you can either image the device using a ZENworks imaging CD, DVD or bootable USB, or enable PXE on the device and assign a Preboot bundle to it, then reboot it to use that bundle.

### 2.4 Deploying and Managing Preboot Services

The following sections explain how to set up, deploy, and manage Preboot Services, and how to set up standard DHCP and novell-proxydhcp on the same server.

- Section 2.4.1, “Checking the Preboot Services Imaging Server Setup,” on page 54
- Section 2.4.2, “Deploying Preboot Services in a Network Environment,” on page 56
- Section 2.4.3, “Administering Preboot Services,” on page 64
- Section 2.4.4, “Editing the Novell Preboot Services Menu,” on page 67

For information on using Preboot, see Chapter 3, “Using Imaging,” on page 93.

#### 2.4.1 Checking the Preboot Services Imaging Server Setup

This section provides information on how to check the configuration of Preboot Services after it is installed.

- “Overview of Preboot Services Components” on page 54
- “Checking the Setup” on page 55

**Overview of Preboot Services Components**

The following components are installed as part of Preboot Services:
Table 2-1  Preboot Service Components

<table>
<thead>
<tr>
<th>Windows Executable and Service Names</th>
<th>Linux Daemon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>novell-pbserv.exe</td>
<td>novell-pbserv</td>
<td>Provides imaging services to devices.</td>
</tr>
</tbody>
</table>

Novell ZENworks Preboot Service

| novell-proxydhcp.exe                | novell-proxydhcp | Runs alongside a standard DHCP server to inform PXE devices of the IP address of the TFTP server. The Proxy DHCP server also responds to PXE devices to indicate which bootstrap program (nvlnbp.sys or nvlnbpx64.efi) to use. |

Novell Proxy DHCP Service

| novell-tftp.exe                     | novell-tftp      | Used by PXE devices to request files that are needed to perform imaging tasks. The TFTP server also provides a central repository for these imaging files, such as the Linux kernel, initrd, and nvlnbp.sys or nvlnbpx64.efi.
A PXE device uses this server to download the bootstrap program (nvlnbp.sys or nvlnbpx64.efi). |

Novell TFTP Service

| novell-zmgprebootpolicy.exe         | novell-zmgprebootpolicy | The PXE devices use this to check if there are any Preboot bundles that are assigned to the device. |

Novell ZENworks Preboot Policy Service

Novell-proxydhcp must be started and does not need to be run on all Imaging Servers.

**TIP:** To automatically start novell-proxydhcp on server start-up, run the following command as root: chkconfig novell-proxydhcp on. For more information, see “Unable to use chkconfig with the novell-proxydhcp init script on SLES 11 or SLED 11” on page 336.

While taking an image, the novell-pbserv service must be running on the server where the ZENworks image is to be stored. During restoring the image, the novell-pbserv service must be running on the server where the ZENworks image is located.

The other three services are started automatically when installing ZENworks, or any time the server is rebooted, and must run on all Imaging Servers.

For more information, see Section D.10, “Imaging Server,” on page 253.

**Checking the Setup**

After the Preboot Services components are installed, the following should be installed and running on the server. You can use these methods to check their status:
Table 2-2  Preboot Services Or Daemons

<table>
<thead>
<tr>
<th>Service</th>
<th>Method to Check Its Status</th>
</tr>
</thead>
</table>
| novell-pbserv         | Windows: In the Services dialog box, review the Status column of Novell ZENworks Preboot Service.  
                           Linux:/etc/init.d/novell-pbserv status |
| novell-tftp           | Windows: In the Services dialog box, review the Status column of Novell TFTP Service.  
                           Linux:/etc/init.d/novell-tftp status |
| novell-zmgprebootpolicy | Windows: In the Services dialog box, review the Status column of Novell ZENworks Preboot Policy Service.  
                             Linux:/etc/init.d/novell-zmgprebootpolicy status |

NOTE: To check the status of Preboot services on SLES12 OS onwards, use the systemctl command:

- systemctl status novell-pbserv.service
- systemctl status novell-tftp.service
- systemctl status novell-zmgprebootpolicy.service

You should not change the default configuration of these services.

If the server where the Preboot Services components are installed is also a DHCP server, see “Configuring LAN Environments for Preboot Services” on page 60.

2.4.2 Deploying Preboot Services in a Network Environment

To implement the network deployment strategies outlined in this section, you must have a solid understanding of the TCP/IP network protocol and specific knowledge of TCP/IP routing and the DHCP discovery process.

Deploying Preboot Services (with PXE) in a single network segment is a relatively simple process. However, Preboot Services deployment in a multi-segment network is far more complex and might require configuration of both the Preboot Services services or daemons and the network switches and routers that lie between the server and the PXE devices.

Configuring the routers or switches to correctly forward Preboot Services network traffic requires a solid understanding of the DHCP protocol, DHCP relay agents, and IP forwarding. The actual configuration of the switch or router must be performed by a person with detailed knowledge of the hardware.

We strongly recommend that you initially set up Preboot Services in a single segment to ensure that the servers are configured correctly and are operational.

This section includes the following information:

- “Server Configuration” on page 57
- “Network Configuration” on page 58
- “Configuring Filters on Switches and Routers” on page 63
- “Spanning Tree Protocol in Switched Environments” on page 64
Server Configuration

There are three important points about configuring servers for Preboot Services:

- **DHCP Server**: The Preboot Services environment requires a standard DHCP server. It is up to you to install your standard DHCP server.

- **Preboot Services or Daemons**: The four Preboot Services services or daemons (novell-pbserv, novell-tftp, novell-proxydhcp, and novell-zmgprebootpolicy) are all installed on the Imaging Server when you install ZENworks. These services or daemons must run together on the same server.

- **Imaging Server**: The Preboot Services services or daemons can be installed and run on the same or different server than DHCP.

The following sections give general information about these services:

- “The DHCP Server” on page 57
- “Novell-pbserv” on page 57
- “Novell-proxydhcp” on page 57
- “Novell-tftp” on page 58
- “Novell-zmgprebootpolicy” on page 58

It is seldom necessary to make changes to the default configuration of these services. However, if you need more detailed configuration information, see “Configuring Preboot Services Imaging Servers” on page 64.

**The DHCP Server**

The standard DHCP server must be configured with an active scope to allocate IP addresses to the PXE devices. The scope options should also specify the gateway or router that the PXE devices should use.

If Preboot Services (specifically novell-proxydhcp) is installed on the same server as the DHCP server, the DHCP server must be configured with a special option tag. For more information, see “Configuring LAN Environments for Preboot Services” on page 60.

**Novell-pbserv**

Provides imaging services to devices.

This includes sending and receiving image files, discovering assigned Preboot bundles, acting as session master for multicast imaging, and so on.

**Novell-proxydhcp**

The Preboot Services Proxy DHCP server runs alongside a standard DHCP server to inform PXE devices of the IP address of the TFTP server, the IP address of the server where novell-zmgprebootpolicy is running, and the name of the network bootstrap program (nvlnbp.sys or nvlnbpx64.efi).
**Novell-tftp**

Used by PXE devices to request files that are needed to perform imaging tasks. The TFTP server also provides a central repository for these files.

A PXE device uses one of these servers to download the network bootstrap program (nvlnbp.sys or nvlnbp64.efi).

**Novell-zmgprebootpolicy**

PXE devices use novell-zmgprebootpolicy to check if there are any imaging actions that need to be performed on the device. It forwards requests to novell-pbserv on behalf of PXE devices.

If you are using Intel AMT, support for it should be enabled in the novell-zmgprebootpolicy.conf file, which is located at:

**Windows:** `%ZENWORKS_HOME%\conf\preboot`

**Linux:** `/etc/opt/novell/zenworks/preboot/`

**Network Configuration**

The configuration required to run Preboot Services in your network depends on your network setup. Design your network so that PXE devices can effectively connect to the server where the Preboot Services services or daemons are running. Make sure you consider the number of PXE devices to be installed on the network and the bandwidth available to service these devices. To understand how the devices and servers need to interact during the Preboot Services process, see Section 1.5, “The Preboot Services Processes,” on page 27.

You can configure Preboot Services where Preboot Services and DHCP are running on the same server or on different servers in both LAN and WAN/VLAN environments:

- “Understanding Preboot Services in LAN and WAN/VLAN Environments” on page 58
- “Comparing Preboot Services Setups in LAN and WAN/VLAN Environments” on page 59
- “Configuring LAN Environments for Preboot Services” on page 60
- “Configuring a WAN/VLAN with Preboot Services and DHCP Running on the Same Server” on page 61
- “Configuring a WAN/VLAN With Preboot Services and DHCP Running on Separate Servers” on page 61

**Understanding Preboot Services in LAN and WAN/VLAN Environments**

Imaging servers should be installed so that PXE devices have access to imaging services within their LAN. A good design ensures that a client does not need to connect to imaging services through a slow WAN link.

Although you can have any number of Imaging Servers, generally only one Proxy DHCP server should be enabled per DHCP server scope.

In a WAN, the PXE device is usually separated from the Proxy DHCP and DHCP servers by one or more routers. The PXE device broadcasts for DHCP information, but by default the router does not forward the broadcast to the servers, causing the Preboot Services session to fail.

In a VLAN (Virtual LAN) environment, the PXE device is logically separated from the Proxy DHCP server and the DHCP server by a switch. At the IP level, this configuration looks very similar to a traditional WAN (routed) environment.
In a typical VLAN environment, the network is divided into a number of subnets by configuring virtual LANs on the switch. Devices in each virtual LAN usually obtain their IP address information from a central DHCP server. In order for this system to work, it is necessary to have Bootp or IP helpers configured on each gateway. These helpers forward DHCP requests from devices in each subnet to the DHCP server, allowing the DHCP server to respond to devices in that subnet.

**Comparing Preboot Services Setups in LAN and WAN/VLAN Environments**

The following illustrates the differences for a LAN configuration between installing Preboot Services on the same server as DHCP, or on a separate server. In this case, only the PXE devices on the LAN connect to the Preboot Services Imaging Server.

### Table 2-3  LAN Configuration Differences Between the Same and Separate Servers

<table>
<thead>
<tr>
<th>Information</th>
<th>On the Same Server</th>
<th>On Separate Servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Because Preboot Services and DHCP are running on the same server, option tag 60 must be set on the DHCP server. For information on setting this tag, see “Configuring LAN Environments for Preboot Services” on page 60.</td>
<td>None required.</td>
</tr>
<tr>
<td>Advantages</td>
<td>• Easy installation and setup.</td>
<td>• Easiest installation and setup.</td>
</tr>
<tr>
<td></td>
<td>• No network configuration is required.</td>
<td>• No network configuration is required.</td>
</tr>
<tr>
<td></td>
<td>• No DHCP server configuration is required.</td>
<td>• No DHCP server configuration is required.</td>
</tr>
<tr>
<td>Disadvantages</td>
<td>• DHCP server configuration is required (option tag 60).</td>
<td>• Limited use, because a single-LAN environment only exists in small lab-type networks.</td>
</tr>
<tr>
<td></td>
<td>• Limited use, because a single-LAN environment only exists in small lab-type networks.</td>
<td></td>
</tr>
</tbody>
</table>

The following illustrates the differences for a WAN/VLAN configuration between installing Preboot Services on the same server as DHCP, or on a separate server. In this case, all PXE devices over the entire WAN/VLAN connect to the Preboot Services Imaging Server.

### Table 2-4  WAN/VLAN Configuration Differences Between the Same and Separate Servers

<table>
<thead>
<tr>
<th>Information</th>
<th>On the Same Server</th>
<th>On Separate Servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>The routers/switches have been configured with IP helpers to forward network traffic to the DHCP server. Because Preboot Services and DHCP are running on the same server, option tag 60 is set on the DHCP server. For information on setting this tag, see “Configuring a WAN/VLAN with Preboot Services and DHCP Running on the Same Server” on page 61.</td>
<td>A DHCP relay agent or IP helper is configured on the router/switch serving the subnet that the PXE device belongs to. The helper is configured to forward all DHCP broadcasts that are detected in the subnet to the DHCP and Proxy DHCP servers. This normally requires two helpers to be configured: the first to forward DHCP broadcasts to the DHCP server, and the second to forward the DHCP broadcasts to the Proxy DHCP server.</td>
</tr>
</tbody>
</table>
Configuring LAN Environments for Preboot Services

If you have Preboot Services and DHCP running on separate servers, no network configuration is required.

If you have Preboot Services and DHCP running on the same server, option tag 60 must be set on the DHCP server. Do the following according to the server’s platform:

- **Linux DHCP Server**: Do the following to set up standard DHCP and Proxy DHCP on the same Linux server:
  1. Stop the DHCP services on the Linux Imaging Server.
  2. On this server, open `/etc/dhcpd.conf`, the DHCP configuration file, in an editor.
  3. Insert the following line in the file:

        option vendor-class-identifier "PXEClient";

  4. Save the file.
  5. Restart the DHCP service.

- **Windows DHCP Server**: Do the following to set up standard DHCP and Proxy DHCP on the same Windows server:
  1. At the command prompt, enter `netsh`.
  2. At the `netsh` prompt, enter `dhcp server`.
  3. At the `dhcp server` prompt, enter the following:

         add optiondef 60 ClassID STRING 0 PXEClient
         set optionvalue 60 STRING PXEClient
         show optionvalue all
         exit

  4. Add the definition type in the DHCP setup menus.

### Advantages

- No network equipment (routers/switches) needs to be configured to forward network traffic to the TFTP server.
- Common network setup.
- Multiple Preboot Services Imaging Servers can be installed so that each server provides service only for certain subnets.

### Disadvantages

- DHCP server configuration required (option tag 60).
- Only one Preboot Services Imaging Server can be installed because it needs to run on the same server as the DHCP server (and there is usually only one DHCP server).
- The network equipment (routers/switches) must be configured with additional IP helpers. Some network equipment might not function properly when more than one additional IP helper is configured.
Configuring a WAN/VLAN with Preboot Services and DHCP Running on the Same Server

You can install Configuration Management (which includes Preboot Services) on the same server where DHCP is installed and running. However, you must do the following to make it work:

- Set option tag 60 on the DHCP server so that it can work with novell-proxydhcp. See the steps in the previous section ("Configuring LAN Environments for Preboot Services" on page 60).
- On the server, edit the `novell-proxydhcp.conf` file and change:

  ```
  LocalDHCPFlag = 0
  to
  LocalDHCPFlag = 1
  ```

  The file is located at:
  - **Windows**: `%ZENWORKS_HOME%\conf\preboot\`
  - **Linux**: `/etc/opt/novell/`

  Then restart the service so that the change is recognized by entering the following command on the server:
  - **Windows**: In the Services dialog box, right-click Novell Proxy DHCP Service, then select Restart.
  - **Linux**: `/etc/init.d/novell-proxydhcp restart`

**IMPORTANT:** If the switch is acting as a firewall and limiting the type of traffic on the network, understand that novell-tftp and novell-zmgprebootpolicy are not firewall or network filter friendly. You should not attempt to run these services or daemons through a firewall. If users need to pass preboot work through a firewall, then all Preboot Services work needs to be on the outside and merely reference a Web service inside the firewall.

Configuring a WAN/VLAN With Preboot Services and DHCP Running on Separate Servers

You can install Configuration Management (which includes Preboot Services) on a separate server than where DHCP is installed and running. However, you must configure the network equipment so that it correctly forwards Preboot Services network traffic.

**IMPORTANT:** If the switch is acting as a firewall and limiting the type of traffic on the network, understand that novell-tftp and novell-zmgprebootpolicy are not firewall or network filter friendly. You should not attempt to run these services or daemons through a firewall. If users need to pass preboot work through a firewall, then all Preboot Services work needs to be on the outside and merely reference a Web service inside the firewall.

An example deployment is given below of a WAN/VLAN environment with Preboot Services and DHCP running on separate servers. The following sections provide the specific steps required to configure network equipment so that it correctly forwards Preboot Services network traffic.

**Example Deployment**

In this example, three VLANs are configured on a Bay Networks Accel 1200 switch running firmware version 2.0.1. One VLAN hosts the Proxy DHCP server, the second VLAN hosts the DHCP server, and the third VLAN hosts the PXE device. The PXE device's DHCP broadcast is forwarded by the
Setting Up Preboot Services and Imaging

switch to both the Proxy DHCP server and the DHCP server. The response from both servers is then routed correctly back to the PXE device, and the PXE device starts the Preboot Services session correctly.

The three VLANs are all 24-bit networks; their subnet mask is 255.255.255.0.

The first VLAN gateway is 10.0.0.1. This VLAN hosts the PXE device that is allocated an IP in the range of 10.0.0.2 to 10.0.0.128. This VLAN is named VLAN1.

The second VLAN gateway is 10.1.1.1. This VLAN hosts the DHCP server with IP 10.1.1.2. This VLAN is named VLAN2.

The third VLAN gateway is 196.10.229.1. This VLAN hosts the server running novell-proxydhcp and novell-zmgprebootpolicy. The server’s IP is 196.10.229.2. This VLAN is named VLAN3.

Routing is enabled between all VLANs. Each VLAN must be in its own spanning tree group.

Configuring Cisco Equipment

1. Go to the Global configuration mode.
2. Type `ip forward-protocol udp 67`, then press Enter.
3. Type `ip forward-protocol udp 68`, then press Enter.
4. Go to the LAN interface that serves the PXE device.
5. Type `ip helper-address 10.1.1.2`, then press Enter.
6. Type `ip helper-address 196.10.229.2`, then press Enter.
7. Save the configuration.

Configuring Nortel Networks Equipment

1. Connect to the router with Site Manager.
2. Ensure that IP is routable.
3. Enable the Bootp check box on the PXE device subnet/VLAN.
4. Select the interface that the PXE devices are connected to.
5. Edit the circuit.
6. Click Protocols.
7. Click Add/Delete.
8. Ensure that there is a check mark in the Bootp check box.
9. Click OK.
10. Click Protocols > IP > Bootp > Relay Agent interface table. The interface where Bootp was enabled is visible in the list.
11. Click Preferred server.
12. Change the Pass through mode value to Bootp and DHCP.
13. Set up the relay agents:
   13a. Click Add.
   13b. In the Relay agent IP address box, type the local LAN IP address.
   13c. In the Target server IP address box, type the DHCP server IP address.
   13d. Click OK.
   13e. Change the Pass through mode value to Bootp and DHCP.
Perform Step 1 to Step 5 again and specify the Proxy DHCP server IP address at Step 3.

Apply the configuration.

**Configuring Bay Networks Equipment**

Perform the following steps on the switch:

1. Enable DHCP for the client VLAN using the following command lines:

   ```shell
   # config vlan1 ip
   # dhcp enable
   ```

2. Configure IP helpers to forward DHCP requests from the device subnet to the TFTP server, using the following command lines:

   ```shell
   # config ip dhcp-relay
   # create 10.0.0.1 10.1.1.2 mode dhcp state enable
   # create 10.0.0.1 196.10.229.2 mode dhcp state enable
   ```

   The `create` command has the form `create agent server mode dhcp state enable`, where `agent` is the IP address of the gateway that serves the PXE device, and `server` is the IP address of the server that the DHCP frame should be forwarded to.

3. Save the configuration.

**Configuring Filters on Switches and Routers**

Some network devices filter network traffic that passes through them. Preboot Services makes use of several different types of traffic, and all of these must be able to successfully pass through the router or switch for the Preboot Services session to be successful. The Preboot Services session uses the following destination ports:

<table>
<thead>
<tr>
<th>Component</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP and Proxy DHCP servers</td>
<td>UDP Ports 67, 68, and 4011</td>
</tr>
<tr>
<td>TFTP server</td>
<td>UDP Port 69</td>
</tr>
<tr>
<td>novell-zmgprebootpolicy</td>
<td>UDP Port 13331</td>
</tr>
</tbody>
</table>

**IMPORTANT:** If the switch is acting as a firewall and limiting the type of traffic on the network, understand that novell-tftp and novell-zmgprebootpolicy are not firewall or network filter friendly. You should not attempt to run these services or daemons through a firewall. If users need to pass preboot work through a firewall, then all Preboot Services work needs to be on the outside and merely reference a Web service inside the firewall.
Spanning Tree Protocol in Switched Environments

The spanning tree protocol (STP) is available on certain switches and is designed to detect loops in the network. When a device (typically a network hub or a device) is patched into a port on the switch, the switch indicates to the device that the link is active, but instead of forwarding frames from the port to the rest of the network, the switch checks each frame for loops and then drops it. The switch can remain in this listening state from 15 to 45 seconds.

The effect of this is to cause the DHCP requests issued by PXE to be dropped by the switch, causing the Preboot Services session to fail.

It is normally possible to see that the STP is in progress by looking at the link light on the switch. When the device is off, the link light on the switch is obviously off. When the device is turned on, the link light changes to amber, and after a period of time changes to a normal green indicator. As long as the link light is amber, STP is in progress.

This problem only affects PXE devices that are patched directly into an Ethernet switch. To correct this problem, perform one of the following:

- Turn off STP on the switch entirely.
- Set STP to Port Fast for every port on the network switch where a PXE device is attached.

After the problem is resolved, the link light on the port should change to green almost immediately after a device connected to that port is turned on.

Information about STP and its influence on DHCP can be found at Using PortFast and Other Commands to Fix End-Station Startup Connectivity Problems (http://www.cisco.com/en/US/docs/internetworking/troubleshooting/guide/tr1923.html#wp1022283).

2.4.3 Administering Preboot Services

This section includes information about administering and configuring Preboot Services:

- “Configuring Preboot Services Imaging Servers” on page 64
- “Configuring IP Port Usage” on page 66

Configuring Preboot Services Imaging Servers

In Preboot Services, the services or daemons do not use switches. Instead, to configure a service or daemon to do something that is not a default, you need to edit the configuration files.

You can edit configuration files while the service or daemon is running, because they are only read when the service or daemon starts. After editing the file you must restart the service or daemon for the changes to take effect.

For more information on the service or daemon configuration files, see Section D.10, “Imaging Server,” on page 253.

**NOTE:** To start or stop the following imaging services on SLES12 OS onwards, use the `systemctl` command.

- novell-pbserv
- novell-proxydhcp
- novell-tftp

64 Setting Up Preboot Services and Imaging
Setting Up Preboot Services and Imaging

- novell-zislnx
- novell-zmgprebootpolicy

Syntax: `systemctl reload|restart|start|status|stop|... <my_service(s)>\.service`

Example: `systemctl reload|restart|start|status|stop novell-proxydhcp.service`

The following sections explain how to configure the following ZENworks Imaging Servers:

- “Configuring the TFTP Server” on page 65
- “Configuring the Proxy DHCP Server” on page 65
- “Configuring Novell-pbserv” on page 66
- “Configuring Novell-zmgprebootpolicy” on page 66
- “Configuring the DHCP Server” on page 66

### Configuring the TFTP Server

It is seldom necessary to change the default TFTP server configuration values. If you need to change them, use the following procedure:

1. Open the following file in an editor:
   - Windows: `%ZENWORKS_HOME%\conf\preboot\novell-tftp.conf`
   - Linux: `/etc/opt/novell/novell-tftp.conf`
2. Edit the configuration settings according to the instructions within the file.
3. Save the changes.
4. On a command line, enter the following:
   - Windows: In the Services dialog box, right-click Novell TFTP Service, then select Restart.
   - Linux: `/etc/init.d/novell-tftp restart`

### Configuring the Proxy DHCP Server

The Proxy DHCP server provides PXE devices with the information that they require to be able to connect to the Preboot Services system.

Use the following steps to modify the settings of novell-proxydhcp:

1. Open the following file in an editor:
   - Windows: `%ZENWORKS_HOME%\conf\preboot\novell-proxydhcp.conf`
   - Linux: `/etc/opt/novell/novell-proxydhcp.conf`
2. Edit the configuration settings according to the instructions within the file.
3. Save the changes.
4. On a command line, enter the following:
   - Windows: In the Services dialog box, right-click Novell Proxy DHCP Service, then select Restart.
   - Linux: `/etc/init.d/novell-proxydhcp restart`

You can set any of the IP address fields to 0.0.0.0 in the configuration utility. The server replaces these entries with the IP address of the first network adapter installed in the server.
Configuring Novell-pbserv

Novell-pbserv provides imaging services to the devices.

Use the following steps to modify the settings of novell-pbserv:

1. Open the following file in an editor:
   - Windows: %ZENWORKS_HOME%\conf\preboot\novell-pbserv.conf
   - Linux: /etc/opt/novell/zenworks/preboot/novell-pbserv.conf
2. Edit the configuration settings according to the instructions within the file.
3. Save the changes.
4. On a command line, enter the following:
   - Windows: In the Services dialog box, right-click Novell ZENworks Preboot Service, then select Restart.
   - Linux: /etc/init.d/novell-pbserv restart

Configuring Novell-zmgprebootpolicy

Novell-zmgprebootpolicy is used to check if there are any imaging actions that need to be performed on the device. It forwards requests to novell-pbserv on behalf of PXE devices.

Use the following steps to modify the settings of novell-zmgprebootpolicy:

1. Open the following file in an editor:
   - Windows: %ZENWORKS_HOME%\conf\preboot\novell-zmgprebootpolicy.conf
   - Linux: /etc/opt/novell/zenworks/preboot/novell-zmgprebootpolicy.conf
2. Edit the configuration settings according to the instructions within the file.
3. Save the changes.
4. On a command line, enter the following:
   - Windows: In the Services dialog box, right-click Novell ZENworks Preboot Policy Service, then select Restart.
   - Linux: /etc/init.d/novell-zmgprebootpolicy restart

Configuring the DHCP Server

The DHCP server needs to have option 60 (decimal) added to the DHCP tags if the Proxy DHCP and DHCP servers are running on the same physical server. This option should be a string type and must contain the letters PXEClient.

For more information, see "Configuring LAN Environments for Preboot Services" on page 60.

Configuring IP Port Usage

This section describes the network ports used by Preboot Services. Using the information in this section, you can configure routers to correctly forward the network traffic generated by Preboot Services. For further information about configuring routers, see Section 2.4.2, "Deploying Preboot Services in a Network Environment," on page 56.

Preboot Services uses both well-known and proprietary IP ports.
The well-known IP ports include:

- **67 Decimal**: The Proxy DHCP server listens on this port for PXE information requests. This is the same port used by a standard DHCP server.
- **68 Decimal**: The DHCP/Proxy DHCP server responds to client requests on this port. This is the same port used by a standard DHCP server.
- **69 Decimal**: The TFTP server listens on this port for file requests from PXE devices.
- **4011 Decimal**: When running on the same server as the DHCP service or daemon, the Proxy DHCP server listens on this port for PXE information requests.

The proprietary IP ports include:

- **998 Decimal**: Novell-pbserv client connection port. It receives all connection requests from the Preboot Services devices on this port.
- **13331 Decimal**: Novell-zmgprebootpolicy client connection port. It receives all connection requests from the PXE devices on this port.

Although PXE devices make their initial requests to novell-tftp and novell-zmgprebootpolicy on the ports listed above, the remainder of the transactions can occur on any available port. For this reason, Imaging Servers cannot be separated from their clients by a firewall.

**IMPORTANT**: Novell-tftp and novell-zmgprebootpolicy are not firewall or network filter friendly. You should not attempt to run these services or daemons through a firewall. If users need to pass preboot work through a firewall, then all Preboot Services work needs to be on the outside and merely reference a Web service inside the firewall.

### 2.4.4 Editing the Novell Preboot Services Menu

Depending on the configuration settings for Preboot Services in ZENworks Control Center, PXE devices might be able to display the Novell Preboot Services Menu during the boot process. The menu has the following options:

- Start ZENworks Imaging
- Start ZENworks Imaging Maintenance
- Disable ZENworks Partition
- Enable ZENworks Partition
- Exit

For information on configuring how the menu used, see Section 2.5.1, “Configuring Novell Preboot Services Menu Options,” on page 72.

There might be circumstances when you want to modify the options on the Novell Preboot Services Menu. You can customize these options by editing a text file contained on the Imaging Server. For example, you can:

- Add, delete, and modify menu options
- Add submenu items
- Change the color scheme
- Change the menu title and screen name
The following procedures should be done on each Imaging Server where you want to customize the menu.

- “Editing the Menu” on page 68
- “Editing the Menu for UEFI” on page 70

Editing the Menu

To edit the menu perform the following:

1. In a text editor, open the following file on an Imaging Server where the ZENworks Proxy DHCP server (novell-proxydhcp) is running:

   For BIOS:
   - Windows: `%ZENWORKS_HOME%\share\tftp\pxemenu.txt`
   - Linux: `/srv/tftp/pxemenu.txt`

   For UEFI:
   - Windows: `%ZENWORKS_HOME%\srv\tftp\efi\x86_64\pxemenu.txt`
   - Linux: `/srv/tftp/efi/x86_64/pxemenu.txt`

   **IMPORTANT:** If you want to save the default options for this menu, we recommend that you make a backup copy of `pxemenu.txt`, such as `pxemenu_orig.txt`.

   For example:

   The following is the content of the default menu’s `pxemenu.txt` file:

   ```
   #This file describes a PXEMenu
   
   ScreenName = Novell Preboot Services Menu
   ScreenInfo = Version 2.0 July, 2007
   MenuTitle = ZENworks Preboot Options
   FormatVersion = 2
   
   #The screen colors determine the color of the main part of the menu screen
   ScreenColor = bright_white
   ScreenBackgroundColor = blue
   
   #The info colors determine the color of the screen information at the top
   #of the menu screen
   InfoColor = yellow
   InfoBackgroundColor = blue
   
   #The hint colors determine the color of the hint line at the bottom of the screen
   HintColor = lt_cyan
   HintBackgroundColor = blue
   
   #The menu colors determine the color of the menu box and menu title
   MenuColor = yellow
   MenuBackgroundColor = blue
   
   #The option colors determine the color of the menu option
   OptionColor = BRIGHT_WHITE
   OptionBackgroundColor = BLUE
   ```
# The chosen colors determine the color of the high-lighted option
ChosenColor = BRIGHT_WHITE
ChosenBackgroundColor = RED

# The 'forced option' is the option that will be automatically
# executed without presenting a menu to the user. It MUST be an
# option on the first ('Main' by default) menu. The following
# example will force 'Start ZENworks Imaging Maintenance'
#ForceOption=2

StartMenu = Main

# Note: The original version of the pxemenu.txt file does not
# require submenus, but example syntax is provided in
# comments for demonstration purposes.

[Main]
MenuTitle = ZENworks Preboot Options
option = execute ; "Start ZENworks Imaging" ; "ZENworks Imaging in Automated Mode" ; pxelinux.0 ; z_auto.cfg
option = execute ; "Start ZENworks Imaging Maintenance" ; "ZENworks Imaging Linux Session in Interactive Mode" ; pxelinux.0 ; z_maint.cfg
option = execute ; "Disable ZENworks Partition" ; "Disable Existing ZENworks partition" ; pxelinux.0 ; z_zpdis.cfg
option = execute ; "Enable ZENworks Partition" ; "Re-enable Existing ZENworks partition" ; pxelinux.0 ; z_zpen.cfg
#option = submenu ; "Sub Menu Options >>" ; "Submenu example with more options" ; SUBMenu
option = exit ; "Exit" ; "Boot to local hard drive"

# [SUBMenu]
#MenuTitle = Sub Menu Options
#option = execute ; "Sub Menu #1" ; "Description for sub menu #1" ;
#  pxelinux.0 ; submenu1.cfg
#option = execute ; "Sub Menu #2" ; "Description for sub menu #2" ;
#  pxelinux.0 ; submenu2.cfg
#option = return ; "Return" ; "Return to main menu"
#option = exit ; "Exit" ; "Boot to local hard drive"

2 To change the appearance of the menu, edit the first seven sections (title and colors).
To change colors, the settings you enter must be selected from the following:

<table>
<thead>
<tr>
<th>BLACK</th>
<th>RED</th>
<th>GRAY</th>
<th>LT_GREEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLUE</td>
<td>MAGENTA</td>
<td>YELLOW</td>
<td>LT_CYAN</td>
</tr>
<tr>
<td>GREEN</td>
<td>BROWN</td>
<td>BRIGHT_WHITE</td>
<td>LT_RED</td>
</tr>
<tr>
<td>CYAN</td>
<td>WHITE</td>
<td>LT_BLUE</td>
<td>LT_MAGENTA</td>
</tr>
</tbody>
</table>

3 To change the menu options, edit the sections under [Main].
The menu options, their hint descriptions, the pxelinux.0 executable, and configuration file (.cfg) are listed on the option = line.

4 When you are finished, save the pxemenu.txt file.
Editing the Menu for UEFI

To edit the menu for UEFI:

1. In a text editor, open the following file on an Imaging Server where the ZENworks Proxy DHCP server (novell-proxydhcp) is running:
   - Windows: \%ZENWORKS_HOME\%\share\tftp\efi\x86_64\pxemenu.txt
   - Linux: /srv/tftp/efi/x86_64/pxemenu.txt

   **IMPORTANT:** To save the default options for this menu, we recommend that you make a backup copy of pxemenu.txt.

The following is the content available in the pxemenu.txt file of the default menu:

```plaintext
#This file describes a PXEMenu

ScreenName  = Novell Preboot Services Menu
ScreenInfo  = Version 1.0  Dec, 2012
MenuTitle = ZENworks Preboot Options

FormatVersion = 2
MainOptionCount = 10
SubOptionCount = 5

#The screen colors determine the color of the main part of the menu screen
ScreenColor  = bright_white
ScreenBackgroundColor = blue

#The info colors determine the color of the screen information at the top of
#the menu screen
InfoColor = yellow
InfoBackgroundColor = blue

#The hint colors determine the color of the hint line at the bottom of the
screen
HintColor = lt_cyan
HintBackgroundColor = blue

#The menu colors determine the color of the menu box and menu title
MenuColor = yellow
MenuBackgroundColor = blue

#The option colors determine the color of the menu option
OptionColor = BRIGHT_WHITE
OptionBackgroundColor = BLUE

#The chosen colors determine the color of the high-lighted option
ChosenColor = BRIGHT_WHITE
ChosenBackgroundColor = RED

#The 'forced option' is the option that will be automatically executed without
#presenting
#a menu to the user. It MUST be an option on the first ('Main' by default) menu
#The following example will force 'Start ZENworks Imaging Maintenance'
#ForceOption=2

StartMenu = Main
```
# Note: The original version of the pxemenu.txt file does not require submenus, but example syntax is provided in comments for demonstration purposes.

[Main]
MenuTitle = ZENworks Preboot Options
option = "execute;Start ZENworks Imaging;ZENworks Imaging in Automated Mode;efi/x86_64/bootx64.efi;efi/x86_64/z_auto.conf"
option = "execute;Start ZENworks Imaging Maintenance;ZENworks Imaging Linux Session in Interactive Mode;efi/x86_64/bootx64.efi;efi/x86_64/z_maint.conf"
option = "execute;Disable ZENworks Partition;Disable Existing ZENworks partition;efi/x86_64/bootx64.efi;efi/x86_64/z_zpdis.conf"
option = "execute;Enable ZENworks Partition;Re-enable Existing ZENworks partition;efi/x86_64/bootx64.efi;efi/x86_64/z_zpen.conf"
#option = "submenu;Sub Menu Options >>;Submenu example with more options1;SUBMenu"
option = "exit;Exit;Boot to local hard drive"

# [SUBMenu]
#MenuTitle = Sub Menu Options
#option = "execute;Sub Menu 1;Description for sub menu 1;efi/x86_64/bootx64.efi;efi/x86_64/submenu1.conf"
#option = "execute;Sub Menu 2;Description for sub menu 2;efi/x86_64/bootx64.efi;efi/x86_64/submenu2.conf"
#option = "return;Return;Return to main menu"
#option = "exit;Exit;Boot to local hard drive"

2 To change the appearance of the menu, edit the first seven sections (title and colors).
To change colors, select the related settings from the following:

<table>
<thead>
<tr>
<th>BLACK</th>
<th>RED</th>
<th>GRAY</th>
<th>LT_GREEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLUE</td>
<td>MAGENTA</td>
<td>YELLOW</td>
<td>LT_CYAN</td>
</tr>
<tr>
<td>GREEN</td>
<td>BROWN</td>
<td>BRIGHT_WHITE</td>
<td>LT_RED</td>
</tr>
<tr>
<td>CYAN</td>
<td>WHITE</td>
<td>LT_BLUE</td>
<td>LT_MAGENTA</td>
</tr>
</tbody>
</table>

3 To change the menu options, edit the sections under [Main].
The menu options, their hint descriptions, the bootx64.efi executable, and configuration file (.conf) are listed on the option = line.

Example 2-1  Example:

option = "execute;Start ZENworks Imaging;ZENworks Imaging in Automated Mode;efi/x86_64/bootx64.efi;efi/x86_64/z_auto.conf"

In the example listed above:
- Start ZENworks Imaging is the menu entry.
- ZENworks Imaging in Automated Mode stands for description of the menu entry.
- efi/x86_64/bootx64.efi is the executable binary.
- efi/x86_64/z_auto.conf is the configuration file.
**NOTE:** The recommended maximum characters:

- Menu entry: 35
- Description of the menu entry: 77

4. When you are finished, save the `pxemenu.txt` file.

## 2.5 Configuring Preboot Services Defaults for ZENworks Imaging

You can configure Preboot Services default settings for a ZENworks Management Zone. These are settings that apply globally to all devices in the Management Zone.

Some of these settings enable you to automatically register devices with the ZENworks Server, and some can be overridden by configurations done for devices or folders containing devices. For more information, see Section 2.6, "Overriding Preboot Services Defaults," on page 88.

The following default settings can be configured in ZENworks Control Center:

- Section 2.5.1, "Configuring Novell Preboot Services Menu Options," on page 72
- Section 2.5.2, "Configuring Non-Registered Device Settings," on page 73
- Section 2.5.3, "Configuring Device Imaging Work Assignments," on page 76
- Section 2.5.4, "Configuring the Server Referral List," on page 86
- Section 2.5.5, "Configuring Intel Active Management Technology (AMT)," on page 87

### 2.5.1 Configuring Novell Preboot Services Menu Options

The Novell Preboot Services Menu provides options for how Preboot Services can be used on your devices. The following options are presented when the menu is displayed:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start ZENworks Imaging</td>
<td>Executes the assigned Preboot Services bundles.</td>
</tr>
<tr>
<td>Start ZENworks Imaging Maintenance</td>
<td>Displays the imaging maintenance mode prompt, where you can execute imaging commands.</td>
</tr>
<tr>
<td>Disable ZENworks Partition</td>
<td>Prevents an existing ZENworks partition from being used when booting to execute the assigned Preboot bundles.</td>
</tr>
<tr>
<td>Enable ZENworks Partition</td>
<td>Allows an existing ZENworks partition to be used when booting to execute the assigned Preboot bundles.</td>
</tr>
<tr>
<td>Exit</td>
<td>Resumes booting of the device without doing any Preboot bundle work.</td>
</tr>
</tbody>
</table>

Generally, if your Preboot Services work is completely automated, you should select to never display the Novell Preboot Services Menu on the device when it boots. Conversely, if you need to do manual Preboot Services functions for some or all devices, then select to always display the menu. A compromise is where you select to display the menu if Ctrl+Alt is pressed, allowing unattended Preboot Services work while allowing you the opportunity to display the menu when needed.
IMPORTANT: PXE must be enabled on the device for the menu to be displayed.

To determine whether the Novell Preboot Services Menu is displayed on your devices when they boot:

1. In ZENworks Control Center, click Configuration in the left pane to display the Configuration tab, then if it’s not expanded, click Management Zone Settings.
2. Click Device Management to expand its listing, then select Preboot Services to display the configuration sections.
3. Locate and expand the Preboot Menu Options section.
4. Select one of the following:
   - Always Show Imaging Menu
   - Never Show Imaging Menu
   - Show Imaging Menu if CTRL+ALT Pressed
5. To provide PXE boot options, specify them in the PXE Kernel Boot Parameters field. Each parameter should be separated by a space.
6. Click either Apply or OK to save the change.

This sets the default menu display mode for the Management Zone. This can be overridden at the folder or device level. For more information, see Section 2.6, “Overriding Preboot Services Defaults,” on page 88.

### 2.5.2 Configuring Non-Registered Device Settings

The following configurations can be set after a device is imaged. The settings are applied to devices that are not registered in the Management Zone and are placed in the devices’ image-safe data.

For more information, see Section 1.4.3, “Non-Registered Device Settings,” on page 23.

To configure default ID settings for non-registered devices:

1. In ZENworks Control Center, click Configuration in the left pane to display the Configuration tab, then if it’s not expanded, click Management Zone Settings.
2. Click Device Management to expand its listing, then select Preboot Services to display the configuration sections.
3. Locate and expand the Non-Registered Device Settings section:
4. Fill in the fields:
   - **DNS Suffix:** Provides a suffix for all of your device’s names. For example, if you enter "provo.novell.com" and a device’s name is "device1," that device’s full name becomes “device1.provo.novell.com.”
   - **Workgroup:** Specify the Windows workgroup that you want the device to be a member of.
   - **Name Servers:** To control what DNS servers the device uses, specify a DNS name server, then click Add to place it into the listing. So that a booting device can find a name server efficiently, specify multiple DNS name servers. For optimal availability of a DNS server for a device, you can rearrange the order using Move up and Move down, one name server entry at a time.
   - You can delete multiple name servers by selecting them and clicking Remove.
**Device Name:** You can specify the default device names for non-registered devices. The name is applied after the device is imaged.

This can be useful for when you have multiple devices to be imaged. You can automatically provide unique names for each device (from its BIOS asset tag or its BIOS serial number), as well as group devices by providing the same prefix for their names.

- **Use Prefix:** ____:
  This provides a common prefix to the device names, such as Lab1, to distinguish them from the devices in Lab2. This can be useful when doing bulk imaging of certain groups of devices. It is limited to 8 characters.

  If this option is used, the prefix you enter here is appended with a random string of letters and numbers to make the device name 15 characters long. Underscores and hyphens are valid in your prefix. The remaining random string uniquely names the device.

  For example, if you enter Lab1_, then ten other characters are randomly generated to complete the name with Lab1 separated from the random characters by the underscore for readability.

- **Use BIOS Asset Tag:** This is the asset tag stored in the device’s BIOS, which is unique for every device. This can be useful for tracking a device based on its asset tag.

- **Use BIOS Serial Number:** This is the serial number stored in the device’s BIOS, which is unique for every device. This can be useful for tracking a device based on its serial number.

**NOTE:** To know the correct hardware or the BIOS information that the Imaging Engine will use, run the `img -info` command in the Maintenance mode.

- **Do Not Automatically Assign a Name:** Select this option if you do not want to use any of the above options. This is the default option.

**IP configuration:** You can select either **Use DHCP** or **Specify Address List** to identify devices for Preboot Services work.

These are the settings that the device is told to use after it is imaged. It uses them for Preboot Services work any time it reboots.

For IP configuration, select one of the following options:

- **Use DHCP:** Allows the devices to be dynamically assigned with IP addresses.

- **Specify Address List:** Uses IP addresses to identify your devices. The addresses you add to the list are available to be used by your devices. This way, you can specify a range of IP addresses or individual IP addresses that you want your devices to use. For example, you can ensure that all of your lab devices use addresses between 10.0.0.5 and 10.0.0.25.
If you select **Specify Address List**, perform the tasks contained in the following table:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add an IP address range     | 1. In the **IP Address Configuration** panel, click **Add** to open the **Range Information** dialog box.          | After a device is imaged, IP settings are applied to the device. The IP address that gets assigned to the imaged device is no longer displayed in the available list, but is instead listed in the **Used Address Ranges** list. The **Used Address Ranges** list in the Range Information dialog box indicates those that are currently being used by devices in the zone. With CIDR (Classless Inter-Domain Routing) notation, the dotted decimal portion of the IP address is interpreted as a 32-bit binary number that has been broken into four 8-bit bytes. The number following the slash (/n) is the prefix length, which is the number of shared initial bits, counting from the left side of the address. The /n number can range from 0 to 32, with 8, 16, 24, and 32 being commonly used numbers. For example:  
  - 123.45.678.12/16 matches all IP addresses that start with 123.45  
  - 123.45.678.12/24 matches all IP addresses that start with 123.45.678  |
|                             | 2. Specify a subnet mask in the **Subnet in CIDR Notation** field.                                                      |                                                                                   |
|                             | 3. Specify the subnet's gateway in the **Default Gateway** field.                                                        |                                                                                   |
|                             | 4. To place IP addresses in the **Available Address Ranges** field, specify an address range using CIDR notation in the **Add** field, then click **Add**. |                                                                                   |
|                             | 5. To remove an IP address range from the **Available Address Ranges** list, select the entry then click **Remove**.    |                                                                                   |
|                             | You can only remove address ranges, not specific IP addresses within a range.                                              |                                                                                   |
|                             | 6. Click **OK** to place the address ranges into the **IP Address Configuration** listing in the **Non-Registered Device Settings** section. |                                                                                   |
| Remove IP addresses from the IP Address Configuration listing | 1. Select the check boxes for one or more IP address entries in the list, then click **Remove**. |                                                                                   |
| Remove displayed IP address ranges from the Range Information dialog box | 1. In the **IP Address Configuration** panel, click **Edit** to open the **Range Information** dialog box. |                                                                                   |
|                             | 2. In the **Used Address Ranges** section, select an IP address range in the listing, then click **Remove Range**.     |                                                                                   |
5 Click either Apply or OK to save the changes.

This sets the default device ID method for the Management Zone.

### 2.5.3 Configuring Device Imaging Work Assignments

You can determine what imaging work is to be performed on a device when it boots, based on a set of hardware rules. This configuration section lets you specify a particular bundle for each set of hardware rules. The Custom Hardware Types section allows you to provide specific data for a Hardware Type hardware rule option.

All rules and custom types configured here are applied globally to all managed devices in the Management Zone. However, only those devices that exactly match the rule and its custom types have the assigned bundle applied to them when they boot.

For more information, see Section 1.4.4, "Device Imaging Work Assignment," on page 24.

To configure default imaging work assignments for non-registered devices:

1. In ZENworks Control Center, click Configuration in the left pane to display the Configuration tab, then if it's not expanded, click Management Zone Settings.
2. Click Device Management to expand its listing, then select Preboot Services to display the configuration sections.
3. Locate and expand the Device Imaging Work Assignment section.
4. Configure the following:
   - “Hardware Rules” on page 77
   - “Custom Hardware Types” on page 84
   - “Allow Overwrites” on page 86
5. Click either Apply or OK to save the changes.

This sets the default imaging work assignments for devices registered in the Management Zone.
**Hardware Rules**

You can specify hardware-based rules for a Preboot bundle. This enables any device matching those rules to have the specified bundle applied to it when it boots.

For example, you can create a rule that applies a bundle to any device with at least 512 MB of RAM and 150 GB of hard drive space.

A work rule is made up of filters that are used to determine whether a device complies with the rule. The rules use logic to determine whether a device meets the requirements for applying the Preboot bundle. The AND, OR, and NOT logical operators are used for creating filtering for the rule.

When a device is seeking work to be done, it scans the rules until it finds a rule where all of the rule’s filters match the device, then executes the bundle assigned to the rule.

The following table lists the tasks you can perform to configure hardware rules:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add a hardware rule         | 1. Click **Add** next to the Hardware Rules list box, which opens the Rule Construction dialog box.  
                               2. To create the hardware rule, follow the instructions contained in “Rule Construction” on page 78.  
                               3. After exiting the Rule Construction dialog box, click **Apply** at the bottom of the configuration page to save the new rule. | The information that you configure in the Rule Construction dialog box comprises one rule. You can add multiple rules.  
                               Each time you click **Add** to use the Rule Construction dialog box, you can select the same bundle as the previous time that you used the dialog box, or you can select a different bundle for the rule.  
                               Only the first hardware rule that is matched is used when a device boots to apply the assigned bundle. |
| Edit a hardware rule        | 1. Select a hardware rule, then click **Edit**, which opens the Rule Construction dialog box in edit mode.  
                               2. To edit the hardware rule, follow the instructions contained in “Rule Construction” on page 78.  
                               3. After exiting the Rule Construction dialog box, click **Apply** at the bottom of the configuration page to save the rule’s changes. |                                                                                       |
| Disable or enable a hardware rule | 1. Select a hardware rule, then click **Edit**.  
                                            2. In the Rule Construction dialog box, select the check box for **Enabled** to enable or disable it.  
                                            3. Click **Apply** at the bottom of the configuration page to save the rule’s change. | This is the only way to change the status of a hardware rule.  
                               Whether a hardware rule is enabled or disabled is indicated in the Hardware Rules list box. For example, **Enabled** - Asset Tag Rule. |
Setting Up Preboot Services and Imaging

Hardware Rule Configuration

- “Rule Construction” on page 78
- “Rule Variables” on page 80

Rule Construction

Understanding rule logic is important in using this dialog box. For more information, see “Rule Logic” on page 82.

To configure a hardware rule:

1. If you plan to select Hardware Type when constructing a rule, you must first configure the hardware type.
   For instructions, see “Custom Hardware Types” on page 84.
2. Click Add in the Hardware Rules section to display the Rule Construction Dialog box.

   NOTE: To know the correct hardware or the BIOS information that the Imaging Engine will use, run the `img -info` command in the Maintenance mode.

3. In the Rules Construction dialog box, fill in the following fields and select or deselect the options:
   - **Rule Name**: This name is displayed in the rules listing on the Preboot Services page in the Device Imaging Work Assignment section. Make it descriptive enough that you can later remember its purpose.
   - **Bundle to Apply**: When a device is seeking work to be done, it scans the rules until it finds a rule where all of the rule’s filters match the device, then executes the bundle assigned to the rule. Each rule can be applied to only one bundle.
Because the rules, not the bundles, are listed in the Device Imaging Work Assignment section, you can apply multiple rules to a given bundle. This means that a bundle has multiple chances to be selected for device imaging work.

When multiple rules are listed, the first rule with criteria to match a device causes that rule’s assigned bundle to be applied to the device.

If no rules match a device, then none of the applicable bundles are applied to the device.

**PXE Kernel Boot Parameters:** Select one of these two options:

- **Use the Parameters Configured in Imaging Menu Options:** This causes the rule to use the default boot parameters for the Management Zone.
- **Use These Parameters:** Only the boot parameters that you specify here are used for this rule.

  Each parameter should be separated by a space.

**Enabled:** This is the only way that you can temporarily disable a hardware rule. It is enabled by default.

The rule’s status is shown by the first word in the work rules listing on the Preboot Services page. For example, Enabled - Asset Tag Rule.

**Force Download:** Forces the download of the assigned bundle, even if it matches the most recently installed bundle. By default, downloading the hardware rule is not forced.

By default, ZENworks imaging does not reimage a machine containing the same image. This option allows you to force the image to be reapplied to the device. For example, you might want to refresh all of your lab machines for the next use of the lab.

**IMPORTANT:** Use this option cautiously. It can create an endless loop, because the option remains selected after an image has been applied. If you image a device that remains non-registered after it is imaged, it is reimaged with the same image over and over each time it boots. To prevent this, edit this hardware rule and deselect this option after you have imaged the applicable devices.

**Using the Rule Logic** fields and options, create the hardware rule expression using the following options:

- **Add Filter:** Adds the new filter at the end of the list of filters.

  Because the filter is added to the end of the last filter set, you cannot use this option to select which filter set to add it to. Use the Insert Filter option to add a filter into an earlier filter set.

- **Add Filter Set:** Adds a new set of filters, beginning with one filter in the set. The filter set order cannot be rearranged.

- **Insert Filter:** Allows you to insert a new filter either above or below the selected filter. This also enables you to specify which filter set to add a filter to.

- **Delete:** Removes the selected filters from the rule.

- **Combine Filters Using:** The default is to have filters ANDed and filter sets ORed. You can use this field to reverse these Boolean functions for the filters and sets.

  Using OR for filter sets means that all filters in a set must be matched to apply the rule, but any of the sets can be matched to apply the rule.

  Using AND for the filter sets means the reverse. At least one filter in each set must be matched for the rule to be applied.

An expression consists of a criteria option, operator, and value, and in some cases, a qualifier. For example:
RAM (in MB) =< 512 MB

RAM (in MB) is the criteria option, =< is the operator, 512 is the value, and MB is the qualifier.

If necessary, you can use NOT (in the first blank field with a down-arrow) to perform a logical negation of the expression. For example:

NOT RAM (in MB) =< 512 MB

In the above example, the rule is applied only to devices with less than 512 MB of RAM.

You can use more than one expression for the rule. For example:

RAM (in MB) =< 512 MB or

Hard Drive Size (in MB) < 20 GB

Hardware Type displays in the criteria options list only if you have previously configured a custom hardware type and saved it by clicking Apply at the bottom of the Preboot Services configuration page.

**IMPORTANT:** Be aware of the possibility of creating conflicting filters or rules. For example, if you specify a RAM condition in multiple filters, make sure the effective logical operators where each is configured make sense for the megabyte values that you enter. In other words, if two filters are both required (ANDed), you would not want one filter to require exactly 512 MB of RAM and the other to specify at least 512 MB of RAM.

5 Click OK to exit the dialog box and place the new hardware rule into the Hardware Rules list box on the Preboot Services configuration page.

**Rule Variables**

The Rule Variables tab enables you to define rule variables for the following Preboot bundles:

- Imaging Script
- Third-Party Script
- AutoYaST
- Kickstart
- MDT Deployment

The defined system variables takes the following precedence order. Variable defined at bundle being the highest and zone being the lowest precedence order:

- Bundle
- Device
- Device Folder
- Rule
- Zone

The following table lists the tasks that can be performed to manage the system variables:
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add a variable      | 1. Click **Add**, provide the name and value for the variable, then click **OK**.  
                        2. Click **Apply**.                                                   | Let us consider an example of Preboot bundle with the following script:  
                                                                                                                                                                                                                                                                                    |
|                     |                                                                       | \textit{img} -rp \textit{windows7\_x64.zmg}                                                                                                                                                                                                                                                                                                        |
|                     |                                                                       | Using System Variables, you can define a generic script as shown below:                                                                                                                                                                                                                                                                               |
|                     |                                                                       | \textit{img} -rp $\textit{image\_name}$                                                                                                                                                                                                                                                                                                          |
|                     |                                                                       | Where \textit{image\_name} is a system variable which gets resolved based on the precedence order.                                                                                                                                                                                                                                             |
|                     |                                                                       | When configuring system variables for a preboot bundle, you can override the system variables value based on the precedence order by defining a new variable with the same name but a different value. For example, if a variable is define at the zone level (\textit{image\_name} = \textit{windows8\_x64.zmg}), and you have defined a variable at the rule level (\textit{image\_name} = \textit{windows7\_x64.zmg}), the system variable defined at the rule level will take precedence over the zone level. $\textit{image\_name}$ will resolve to \textit{windows7\_x64.zmg} and the following script will be executed on the device: \textit{img} -rp \textit{windows7\_x64.zmg} |
|                     |                                                                       | Variable names cannot include spaces and must be unique at the level where they are defined. Variable values cannot include the characters & and <.                                                                                                                                                                                                 |
| Remove a variable   | 1. Select the check box next to the variable (or variables).  
                        2. Click **Remove**.                                                   |                                                                                                                                                                                                                                                                                                                                                  |
|                     | 3. Click **Apply**.                                                    |                                                                                                                                                                                                                                                                                                                                                  |
| Edit a variable     | 1. Select the check box next to the variable.  
                        2. Click **Edit**.                                                    |                                                                                                                                                                                                                                                                                                                                                  |
|                     | 3. Modify the **Name** and **Value** fields as desired, then click **OK**.  
                        4. Click **Apply**.                                                   |                                                                                                                                                                                                                                                                                                                                                  |
| Use a variable      | Use the following syntax:  
                        $\texttt{\$|\textit{var\_name}|}$  
                        Replace \textit{var\_name} with the name of the variable.             |                                                                                                                                                                                                                                                                                                                                                  |
Rule Logic

A rule is made up of one or more filters that are used to determine whether a device complies with the rule. The Rule Construction dialog box begins with one empty filter. A device must match the entire filter list of a rule (as determined by the logical OR nd AND operators that are explained below) for the rule to apply to the device.

A filter is a row of fields providing a condition that must be met by a device in order for the bundle to be applied. For example, you can add a filter to specify that the device must have exactly 512 MB of RAM in order to be accepted by the rule, and you can add another filter to specify that the hard drive be at least 20 GB in size. There is no technical limit to the number of filters that you can add in the rule, but there are practical limits, such as:

- Designing a rule that is easy to understand
- Devising the rule so that you do not accidentally create conflicting filters
- Being able to view the dialog box as it grows in size because of the filters and filter sets that you add

Filters can be added individually or in sets. Each set contains logical operators within the set and logical operators determine the association between the sets.

By default, the logical operator AND is displayed for the filters within a set in the Combine Filters Using field (which you can change), and OR is displayed in the Filter Sets Will Be Combined Using field (display-only). If you change the Combine Filters Using field to OR, the Filter Sets Will Be Combined Using field then displays AND.

You can think of filters and filter sets as using algebraic notation parentheticals, where filters are contained within parentheses, and sets are separated into a series of parenthetical groups. Logical operators (AND and OR) separate the filters within the parentheses, and the operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the Rule Construction dialog box, it looks like this:

u AND
v AND
w
OR
x AND
y AND
z

Filter sets cannot be nested. You can only enter them in series, and the first filter set to match the device (the default of OR) is used to validate the rule so that the bundle can be applied to do imaging work on the device.

The order in which filters and filter sets are listed does not matter. For the OR operator, the first to be met satisfies the rule. For the AND operator, all items must be met to satisfy the rule.
TIP: You can easily run a test to see how these logical operators work. Access the Rule Construction dialog box, click both the Add Filter and Add Filter Set options a few times each to create a few filter sets, then switch between AND and OR in the Combine Filters Using field and observe how the operators change. Then, either select the filters that you added and click Delete, or click Cancel to exit the Rule Construction dialog box.

You can set up the conditions for a rule by adding all of the filters and filter sets that you need to identify the type of device you want to match. You typically do not need to set up complex rules. However, because you can apply multiple rules to a bundle, you can further complicate the use of logical operators, because each rule is considered to be an OR condition for the bundle, causing the bundle to be applied if any one of the rules matches the device.

For example, you could create several rules for the bundle with each rule being a long listing of AND conditions to be met. This means that each rule becomes a specific set of criteria for a device to meet, causing the bundle to be applied if one is met. Conversely, if you add that same amount of information into one rule (using filter sets for the AND and OR conditions), it might make the dialog box so long that it becomes unmanageable.

To determine what you need, consider the following possibilities:

- One filter set with multiple filters
- Multiple filter sets with only one or a few filters per set
- Multiple filter sets each with multiple filters
- Multiple rules per bundle

Remember that the logical operators for filters within a set are the opposite of the operators between the sets, and all rules for a bundle use the OR condition. For example, suppose you are selecting the operator in the Combine Filters Using field:

<table>
<thead>
<tr>
<th>Table 2-8 OR and AND Operator Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>OR</td>
</tr>
<tr>
<td>AND</td>
</tr>
</tbody>
</table>

Obviously, adding filter sets complicates the use of logical operators, and adding multiple rules to the bundle further complicates it. Therefore, carefully plan how to configure your information before using the Rules Configuration dialog box.
Custom Hardware Types

Custom hardware types enable you to include any devices matching your custom type to have the bundle assigned to the hardware rule applied to them when the devices boot. For example, you can create a rule that applies the bundle to any device that is a laptop by entering the applicable string as a custom hardware type, selecting Hardware Type in the Rule Construction dialog box, then selecting your custom type.

The Hardware Type option does not display in the Rule Construction dialog box until at least one custom type has been configured.

The following table lists the tasks you can perform to configure custom hardware types:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add a custom hardware type  | 1. Click Add next to the Custom Hardware Types list box, which opens the Custom Hardware Type dialog box.  
                             | 2. To create the custom hardware type, follow the instructions contained in "Custom Hardware Type Dialog Box" on page 85.  
                             | 3. After exiting the Custom Hardware Type dialog box, click Apply at the bottom of the configuration page to save the new custom type.                                      | In the Custom Hardware Type dialog box you can add multiple strings, which identify specific hardware type information in the device’s BIOS.  
                             |                                                                                                                                | The set of strings that you add in the dialog box is considered one custom hardware type that is identified by the name you also provide in the dialog box.  
                             |                                                                                                                                | The custom type won’t display in the drop-down list of hardware items on the Rule Construction dialog box until you click Apply or OK to save the configuration. |
| Edit a custom hardware type | 1. Select a custom hardware type, then click Edit, which opens the Custom Hardware Type dialog box in edit mode.  
                             | 2. To edit the custom hardware type, follow the instructions contained in "Custom Hardware Type Dialog Box" on page 85.  
                             | 3. After exiting the Custom Hardware Type dialog box, click Apply at the bottom of the configuration page to save the custom type’s changes.                                      |                                                                                                                                |
| Rearrange the order of the  | 1. Select one custom hardware type, then click either Move Up or Move Down.  
                             | You cannot move multiple types at one time.  
                             | 2. Repeat as necessary to arrange the order of the custom hardware types.  
                             | 3. Click Apply at the bottom of the configuration page to save the new custom type’s order.                                      | The custom hardware type order is important because when the device boots, the first type that is found to match the device is used to apply the assigned bundle. The other types are ignored. |
| custom hardware types       |                                                                                                                                |                                                                                                                                |
Custom Hardware Type Dialog Box

Custom hardware types enable you to include any devices matching your custom type and to have the bundle assigned to the hardware rule applied to them when the devices boot. For example, you can create a rule that applies the bundle to any device that is a laptop by entering the applicable string as a custom hardware type, then select Hardware Type in the Rule Construction dialog box and select your custom type.

The Hardware Type option does not display in the Rule Construction dialog box until at least one custom type has been configured.

Your custom hardware type definitions are applicable only to rules; they do not otherwise apply to the Management Zone.

To configure custom hardware types, perform the tasks in the following table:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Configure a custom hardware type | 1. Specify a name for the custom type in the Hardware Type Name field.  
2. Specify a string in the BIOS Strings field, then click Add to add it to the list box.  
3. Repeat Step 2 for each BIOS string to be added to this custom type.  
4. Click OK to exit the dialog box.  
5. Click Apply (located at the bottom of the Preboot Services configuration page) to save your new custom type. | The new custom type does not display in the Rule Construction dialog box until you have clicked Apply to save it.  
The strings you can enter are anything that you want to match in the device’s BIOS.  
To determine the BIOS product names of your servers or laptops, use the img -i command at the imaging maintenance mode prompt, which displays various BIOS information. The BIOS information that you need is listed in the Product Name field. For servers and laptops, you can enter partial strings to select all BIOS product names containing that string. |
## Setting Up Preboot Services and Imaging

1. In the ZENworks Control Center, click **Configuration** in the left pane to display the **Configuration** tab, then if it's not expanded, click **Management Zone Settings**.

2. Click **Device Management** to expand its listing, then select **Preboot Services** to display the configuration sections.

3. Locate and expand the **Server Referral List** section.

### Additional Details

#### Task Steps Additional Details

**Edit a custom hardware type**

1. In the Custom Hardware Type dialog box, to edit the custom hardware type’s name, edit the name in the **Hardware Type Name** field.

2. To edit a string in the list, select it, then click **Edit**.

3. In the Edit String dialog box, edit the string, then click **OK**.

4. Click **OK** to exit the dialog box.

5. Click **Apply** (located at the bottom of the **Preboot Services** configuration page) to save your custom type changes.

**Rearrange the order of the strings in the list**

1. In the Custom Hardware Type dialog box, select one string, then click either **Move Up** or **Move Down**.

2. Repeat as necessary to arrange the order of the strings.

3. Click **OK** to exit the dialog box.

4. Click **Apply** (located at the bottom of the **Preboot Services** configuration page) to save your custom type changes.

**Remove strings from the list**

1. In the Custom Hardware Type dialog box, select one or more strings, then click **Remove**.

2. Click **OK** to exit the dialog box.

3. Click **Apply** (located at the bottom of the **Preboot Services** configuration page) to save your custom type changes.

You can use the Ctrl or Shift keys to select multiple strings to remove them from the list.

**Allow Overwrites**

Select the **Allow Preboot Services to Overwrite Existing Files when Uploading** check box if you want existing .zmg files to be overwritten by a newer version when the image is taken.

### 2.5.4 Configuring the Server Referral List

Referral lists are used to make sure managed devices belonging to other Management Zones can access their home zone. For more information, see Section 1.4.5, “Server Referral List,” on page 25.

1. In ZENworks Control Center, click **Configuration** in the left pane to display the **Configuration** tab, then if it's not expanded, click **Management Zone Settings**.

2. Click **Device Management** to expand its listing, then select **Preboot Services** to display the configuration sections.

3. Locate and expand the **Server Referral List** section.
4 To configure a server referral list, complete the tasks in the following sections, as applicable:
   • "Configuring Imaging Servers in the Server Referral List" on page 87

**Configuring Imaging Servers in the Server Referral List**

To configure the List of Server IP Addresses and DNS Names list box, perform the tasks in the following table:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add a server to the server referral list  | 1. In the List of Server IP Addresses and DNS Names field, specify the DNS name or IP address of a server that can host preboot operations, then click Add to place it into the list.  
                                                                             2. Repeat as necessary to complete the list of servers in your environment capable of preboot operations. | You can add a range of IP addresses by typing the beginning IP address, type a space, a dash, another space, then type the ending IP address of the range. However, these are displayed as you typed them when you click Add; the addresses within the range do not separate into individual IP addresses in the list. |
| Edit a listed server                      | 1. Select a server in the list, then click Edit.  
                                                                             2. In the Edit String dialog box, edit the IP address or DNS name that is displayed there, then click OK to save the changes. |                                                                                     |
| Rearrange the order of the servers in the server referral list | 1. Select one server, then click either Move Up or Move Down.  
                                                                             2. Repeat as necessary to arrange the order of the servers. | You cannot move multiple servers at one time. |
| Remove servers from the server referral list | 1. Select one or more servers, then click Remove. | You can use the Ctrl or Shift keys to select multiple servers to remove them from the list. |

**2.5.5 Configuring Intel Active Management Technology (AMT)**

The Intel AMT functionality allows you to accurately identify devices, even if they have had physical drive replacements. This sets up Preboot Services with persistent device identification by providing ZENworks with nonvolatile memory for storing the unique device identity.

For more information, see Section 1.4.6, "Intel Active Management Technology (AMT)," on page 26.

To set up global Intel AMT enterprise names:

1. In ZENworks Control Center, click Configuration in the left pane to display the Configuration tab. If it’s not expanded, click Management Zone Settings.

2. Click Device Management to expand its listing, then select Preboot Services to display the configuration sections.

3. Locate the Intel Active Management Technology (AMT) panel.

4. Fill in the fields:
Name List: This list should contain at least one valid AMT enterprise name for every AMT device in the Management Zone. Click Add to place each one into the list box.

Move Up/Move Down: Arranges the order in which the AMT names are listed. You can move only one at a time.

Remove: To remove names from the list, select them, then click Remove.

Click either Apply or OK to save the changes.

2.6 Overriding Preboot Services Defaults

You can determine which Novell Preboot Services Menu displays a configuration to use and whether the menu should be displayed on a device when it boots. By default, the Management Zone configuration applies to all folders and devices. You can override this at the folder or device level.

For more information on the Novell Preboot Services Menu options, see Section 1.4.2, “Preboot Services Menu,” on page 22.

The menu can be customized by editing the pxemenu.txt file. For more information, see Section 2.4.4, “Editing the Novell Preboot Services Menu,” on page 67.

To override the default configuration at the folder or device level:

1. In ZENworks Control Center, click the Devices in the left pane to display the Devices panel in the Managed tab.

2. Select one of the following in the Name column:
   - The Details option next to the Servers or Workstations folder
   - The Servers folder, then a server contained in the folder
   - The Workstations folder, then a workstation contained in the folder

3. On the page that is displayed, click the Settings tab to display the Settings page options.

4. Click Preboot Services to display the Preboot Services configuration page.

5. To configure the settings for the folder or device, click Override.

   The following is displayed:

   Current: /Devices/Servers
   Revert to settings from: (System)

   and the Preboot Menu Options section is enabled for editing. The above text varies depending on whether you are at the folder or device level.

6. Select which option to use:
   - Always Show Imaging Menu
   - Never Show Imaging Menu
   - Show Imaging Menu if CTRL+ALT is Pressed

   PXE must be enabled on the device for the menu to be displayed.

7. Click Apply or OK.

   OK: Enables the change and exits the page.
   Apply: Enables the change and retains focus on the page, so you can click Revert to temporarily disable the configuration change.

8. To temporarily disable the change, click Revert and the Management Zone settings for the menu remain in effect.
2.7 Enabling PXE on Devices

To image a device using Preboot Services, you need to find out if the device is PXE capable, and then make sure that PXE is enabled.

PXE code is typically delivered with newer devices (PC 99 compliant or later) on the NIC.

This section includes the following information:

- Section 2.7.1, "Enabling PXE on a PXE-Capable Device," on page 89
- Section 2.7.2, "Verifying That PXE Is Enabled on a Device," on page 89

2.7.1 Enabling PXE on a PXE-Capable Device

When PXE is enabled, it can lengthen the time of the boot process slightly, so most NICs have PXE turned off by default. To enable PXE on a PXE-capable device:

1. Access the computer system BIOS and look at the Boot Sequence options.
   The PXE activation method for a device varies from one manufacturer to another, but generally one of the following methods is used:
   - Some BIOS have a separate entry in the BIOS configuration to enable or disable the PXE functionality. In this case, set either the PXE boot setting or the Network boot setting to Enabled.
   - Some BIOS extend the entry that allows you to configure boot order.
2. If PXE is not listed in the Boot Sequence options and if the NIC is embedded in the motherboard, look at the Integrated Devices section of the BIOS, which might have an option to enable PXE. PXE might be called by another name, such as MBA (Managed Boot Agent) or Pre-Boot Service.
   After enabling PXE in the Integrated Devices section, look at the Boot Sequence options and move PXE so that it is first in the boot sequence.
3. Save any changes you have made and exit the system BIOS.
4. Reboot the device.

If the device does not have the network adapter and PXE integrated into the motherboard, it uses the installed NIC management software to prompt you to start PXE configuration during the boot process.

For example, many network adapters that are PXE-aware prompt you to press Ctrl+S during the boot process to allow you to configure the PXE functionality. Other network adapters might prompt you to press Ctrl+Alt+B or another key combination to configure PXE.

If the computer system does not have an integrated NIC, you might need to use NIC management software to configure your NIC to support PXE. Refer to your NIC documentation for support of PXE.

On a UEFI machine, do not boot into BIOS PXE mode, as this corrupts the GPT header. Ensure that the mode is set to UEFI Only, or Legacy Only to prevent cross PXE boot scenario.

2.7.2 Verifying That PXE Is Enabled on a Device

After you have activated PXE, it becomes available in the Boot section of the BIOS. PXE is correctly enabled on a device when the device attempts to establish a PXE session during the boot process. You can see this happening when the device pauses during the boot process and displays the following on the screen:
The actual message displayed varies from one manufacturer to another, but you can identify it by the obvious pause in the boot process as the device searches for DHCP.

2.8 Setting Up Devices for ZENworks Imaging

The following sections cover procedures to prepare devices for imaging. The procedures that are applicable to you depend on your imaging deployment strategy. For more information, see Section 2.4.2, “Deploying Preboot Services in a Network Environment,” on page 56.

If you are using Preboot Services (PXE) as your imaging method, you need to enable PXE on the device. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.

If you are using a ZENworks partition as your imaging method, you need to create the partition on the device. For more information, see “Creating a ZENworks Partition” on page 52.

If your cloned virtual or physical machine does not boot up properly, you must disable the use of persistent device names for networks and storages for CODE 10 products.

The following sections contain additional information:

- Section 2.8.1, “Device Requirements,” on page 90
- Section 2.8.2, “Enabling a Device for Imaging Operations,” on page 91
- Section 2.8.3, “Disabling Persistent Device Names,” on page 92

2.8.1 Device Requirements

This section gives the requirements for using a network-connected device.

It is possible (but usually not as convenient) to image a device without connecting to the network. Such operations can’t be fully automated.

The following are the requirements for the device:

<table>
<thead>
<tr>
<th>Table 2-12 Device Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Must Have</strong></td>
</tr>
<tr>
<td>A supported Ethernet card</td>
</tr>
<tr>
<td>Free disk space for a ZENworks partition (optional)</td>
</tr>
<tr>
<td>Standard hardware architecture</td>
</tr>
</tbody>
</table>
2.8.2 Enabling a Device for Imaging Operations

Use one of the following methods to enable a device for auto-imaging operations:

- “Using PXE” on page 91
- “Using a ZENworks Partition” on page 91
- “Using a CD, DVD or bootable USB” on page 91
- “Using a USB” on page 91

Using PXE

You can set up a device to be automatically imaged from Preboot bundles by enabling PXE on the device.

For more information, see Section 2.7.1, “Enabling PXE on a PXE-Capable Device,” on page 89.

Using a ZENworks Partition

If you cannot enable PXE on the device, you can use a partition to perform unattended imaging operations.

For more information, see “Creating a ZENworks Partition” on page 52.

Using a CD, DVD or bootable USB

If you cannot use the PXE or ZENworks partition methods to automate imaging of your devices, you can image a device using an imaging CD, DVD or bootable USB.

For information, see Section 3.1.3, “Setting Up Disconnected Imaging Operations,” on page 113.

Using a USB

You can use a bootable USB drive to boot systems with BIOS and UEFI firmware to perform Imaging operations.

For more information, see Section 2.3.3, “Creating Bootable USB Drives for Imaging,” on page 51.
2.8.3 Disabling Persistent Device Names

The network card of every Linux device is associated with the device MAC. If you take an image of the device along with the network card - MAC association information, a new additional network card is created when you restore the image on a different Linux device resulting in two network cards for a device. Consequently, there will no network connectivity. To fix these issues, you must disable the persistent device names for network and storage before taking an image of a Linux device.

- “Disabling the Persistent Network Device Names” on page 92

Disabling the Persistent Network Device Names

Review the following sections to understand how to disable the persistent network device names for Linux devices:

- “Disabling the Persistent Network Device Names for SLES 11 or SLED 11” on page 92

Disabling the Persistent Network Device Names for SLES 11 or SLED 11

Perform the following tasks on the SLES 11 or SLED 11 device:

2. Rename the Ethernet configuration files to initialize the Ethernet devices on boot.
   2a. Go to /etc/sysconfig/network.
   2b. Find the ifcfg-eth file for each Ethernet device. In the filename, the trailing identifier for an Ethernet device represents the MAC address for the device.
       For example, in the ifcfg-eth-id-00:AA:BB:11:22:33 file, the trailing identifier, AA:BB:22:33, is the MAC address for the device.
   2c. Rename the file to ifcfg-ethX, where X represents the number of Ethernet devices on the system. For example, the name for the configuration eth0 is ifcfg-eth0.
3. Reboot the device in to PXE, then in to Imaging maintenance or auto mode.
4. Take an image of the device.
5. Restore the image on the same device.
6. Reboot the device, then log into it.
7. In the /etc/sysconfig/network/ifcfg-ethX file, change LLADDR to the MAC address of the target device. For a virtual machine, the target virtual machine MAC address is available in the .vmx file.
8. Reboot the device.
Using Imaging

This section provides instructions on how to use Preboot Services imaging operations in ZENworks:

- Section 3.1, “Imaging Devices,” on page 93
- Section 3.2, “Understanding the Sandboxing Behaviour for Preboot Bundles,” on page 118
- Section 3.3, “Multicasting Images for ZENworks Imaging,” on page 121
- Section 3.4, “Configuring Imaging Script Bundles for ZENworks Imaging,” on page 131
- Section 3.5, “Configuring the AutoYaST Bundle,” on page 132
- Section 3.6, “Configuring the Kickstart Bundle,” on page 137
- Section 3.7, “Using Dell Configuration Bundles,” on page 139
- Section 3.8, “Configuring MDT Deployment Bundles,” on page 144
- Section 3.9, “ISDTool,” on page 148
- Section 3.10, “Assigning Preboot Bundles,” on page 149
- Section 3.11, “Editing Imaging Work,” on page 151
- Section 3.12, “Managing Preboot Bundles,” on page 153
- Section 3.13, “ZENworks WinPE Imaging,” on page 157
- Section 3.14, “High Performance NTFS Driver (Tuxera),” on page 172
- Section 3.15, “Remote Imaging over SSH,” on page 176
- Section 3.16, “Converting MBR Disk to GPT Disk,” on page 177

3.1 Imaging Devices

Preboot Services provides tools for creating and compressing images of device hard disks, as well as images of specific add-on applications or sets of files. ZENworks also provides tools for customizing such images and for making images available to auto-imaging operations.

You can take images of devices, then reimage them and other devices with those images. The available devices are Windows and Linux servers and workstations.

ZENworks imaging supports devices that physically connect to the network that meet the minimum requirements for devices.

ZENworks imaging does not support:

- Imaging operations (creating or restoring images) using wireless connectivity.
- Imaging operations for the encrypted LVM partitions.
- PXE booting on Citrix XEN and SUSE Linux Enterprise Server XEN.
- Software RAID configurations (however, hardware RAID is supported).
- Devices running boot managers, such as System Commander.
Using Imaging

Boot managers create their own information in the MBR and overwrite the ZENworks boot system, which prevents the device from communicating with the Imaging Server. If you are using boot managers in your environment, you should disable or remove them before performing imaging operations.

- Imaging operations for systems having Dynamic Disks.

Prerequisites for taking an Image on Windows

1. Ensure that the file system is clean by running the `chkdsk /f` command.
2. Press `Y` when the `chkdsk` program asks for a file system check during the next boot.
3. After the disk checking is complete, ensure that there are no errors in the drive and log in to Windows.
4. Run the `chkdsk` command, (without the `/f` switch) from the command prompt and ensure that there are no errors.
5. Proceed to take the image of the device.

Prerequisites for taking an Image on a Windows 10 or later device without Sysprep

If you are taking an image on a Windows 10 device, you need to perform the following additional steps:

1. Log in as the administrator and open the command prompt.
2. Run the `Powershell` command.
3. Run the `set-executionpolicy -executionpolicy unrestricted -force` command.
4. Create the `<script_name>.ps1` file with the following script and place it anywhere in the system:
   ```powershell
   Get-AppXPackage -AllUsers | Foreach {Add-AppxPackage -DisableDevelopmentMode -Register "$_.InstallLocation\AppXManifest.xml"}
   Get-AppXPackage -AllUsers | Foreach {Add-AppxPackage -DisableDevelopmentMode -Register "$_.InstallLocation\AppXManifest.xml"}
   ``
5. Add a registry key in the `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunOnce` location with the following details:
   - **Type:** string
   - **Key:** any_name
   - **Value:** `powershell.exe -file <script_path>`, where `script_path` can be a value such as `C:\Windows\<ScriptFile.ps1`

The following sections provide more information about ZENworks Imaging procedures and features:

- Section 3.1.1, “Using ZENworks Control Center for Imaging,” on page 94
- Section 3.1.2, “Using the Command Line for ZENworks Imaging,” on page 102
- Section 3.1.3, “Setting Up Disconnected Imaging Operations,” on page 113

3.1.1 Using ZENworks Control Center for Imaging

The following imaging tasks are available in ZENworks Control Center:

- “Taking a Base Image of a Device” on page 95
- “Creating an Add-On Image for an Existing Bundle” on page 98
Taking a Base Image of a Device

A base image is an image of partitions and data on a source device’s hard disks. Normally, such an image is prepared with the intent to completely replace the contents of a target device’s hard disks.

You can take an image of an existing device and use it to image a similar device, or use it as a backup image for reimaging the original device.

If you want to copy a Virtual machine, or during the image restoration on a new device, if you want the restored managed device to generate its own GUID and register as a new object in ZENworks Control Center, before taking the image, do the following:

1. After installing ZENworks Agent on the device, ensure that the device has been rebooted at least once.
2. Run the following command on the managed device:
   
   ```bash
   zac fsg -d
   ```

   This command removes the workstation GUID in the file system in preparation for taking an image. For more information about the zac command, see `zac for Windows(1)` or `zac for Linux(1)` in the ZENworks Command Line Utilities Reference.

   **NOTE:**
   
   You must not run the `zac fsg -d` command if you want to take an image as a backup image of the managed device.

3. Run the `zac cc` command to clear the ZENworks cache data
4. (Conditional) If you want to take an image of a Windows operating system, run SysPrep on the device.
5. (Conditional) If you want to take an image of a Linux device, manually delete the `DeviceGuid.sav` and `DeviceData.sav` files, which are located in the `/etc/opt/novell/zenworks/` directory, from the device.
6. Reboot the system and proceed to the Imaging distro to take the image of the system.

To take an image of a device:

1. In ZENworks Control Center, click **Devices** in the left pane to display the Devices panel in the **Managed** tab.
2. Click **Servers** or **Workstations**, then select the check box next to a device.
   
   This selects the device for taking the image.
3. Click **Action > Take image**.

   You can also select the check box next to **Servers** or **Workstations** to start this wizard, then click **Action > Take image**. If you do so, you are asked to select a device from the group. Then the File Information page is displayed.
4. Click **Next** to display the File Information page:
5. Fill in the fields:
Take an image using:

- **ZENworks Linux Imaging**: Select this option to take a ZENworks image (.zmg) using the ZENworks Linux distro.

- **ZENworks WinPE Imaging**: Select this option to take a ZENworks image (.zmg) using the ZENworks WinPE (Windows Preinstallation Environment) distro.

**Image Format**: Select the format of the image to be taken for the device.

**Server and File Path**: Click the icon to display the Server and Path Information dialog box. Configure the following options.

- **Server Object, IP, or DNS**: Click the icon to browse for and select the object of the Primary Server or the device that is promoted to the Imaging Server role. You can also specify the IP address or the DNS name of the Primary Server or of the device that is promoted to the Imaging Server role.

  Ensure that the DNS server is up and running, and the DNS name is successfully resolved before configuring this option.

- **Directory Path on Server**: Click the icon to browse for and select the `\content-repo\images` directory.

  All ZENworks images must be stored in `%ZENWORKS_HOME%\work\content-repo\images` on the Windows Primary Server and in `/var/opt/novell/zenworks/content-repo/images` on the Linux Primary Server. If you are unable to browse to this directory, then you must manually specify the complete path of the directory. For example, `C:\Program Files\Novell\ZENworks\work\content-repo\images` on Windows and `/var/opt/novell/zenworks/content-repo/images` on Linux.

  **NOTE:** You cannot browse to the specified file system if multiple DNS search domains with DHCP are configured for Linux and if the server is on Windows.

- **File Name**: Specify a filename with the .zmg filename extension for the image. The .zmg extension indicates that the file is a valid ZENworks image file.

**Shared Network Path for Image File**: Specify the shared-network path where you want to save the .wim or .gho files. This option is displayed only for the Windows Imaging Format (.wim) and Ghost imaging format (.gho). The directory must be a Windows share or a Linux CIFS or SMB share, and you must have the Write permission to it.

If the Novell File Upload extension is not installed on the device, you must install it before you can browse to and upload the file.

**Image Filename**: Specify the filename to save the .wim or the .gho file. This option is displayed only for the Windows Imaging Format (.wim) and Ghost Imaging Format (.gho).

**Network Credential**: Click to browse for and select the network credentials to be used for accessing the device that has .wim or .gho files. This option is displayed only for the Windows Imaging Format (.wim) and Ghost Imaging format (.gho).

**Use Compression**: Compression is required. Choose one of the following:

- **Balanced**: Automatically balances compression between an average of the reimaging speed and the available disk space for the image file. This option is displayed only for the ZENworks Image format.

- **None**: This option is displayed only for the Windows Imaging format and Ghost imaging format (.gho).

- **Optimize for Speed**: Optimizes the compression to allow for the fastest reimaging time. Use this option if CPU speed is an issue.

- **Optimize for Space**: Optimizes the compression to minimize the image file's size to conserve disk space. This can cause restoring an image to take longer.
Balanced is the default option for the ZENworks Image format and Optimize for Speed is the default option for the Windows Imaging format and Ghost imaging format (.gho).

Create an Image Bundle: If you select this option, another wizard page is displayed (see Step 6) where you can configure the new bundle. Otherwise, the Summary is your next wizard page (skip to Step 10).

6 If you selected to create an image bundle, the New Image Bundle page is displayed.

7 Fill in the fields:
- **Bundle Name**: Specify a unique name for the bundle, because many other bundle names might be listed in the same folder.
  For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.
- **Folder**: Specify a folder where you want to list the new bundle. This is a location in ZENworks Control Center, not a file location on a device.
- **Description**: Enter information to help you later recognize the purpose and scope of this image bundle. For example, “Image taken after the OS was installed, but before GroupWise was installed.”

8 Click Next to display the Summary page.

9 Do the following:
- If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.
  For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.
- If you want to deploy the bundle as a sandbox version, select the Create As Sandbox check box. A Sandbox version of a bundle enables you to test it on your device before actually deploying it.

10 Review the configuration, then click one of the following:

- **Back**: Allows you to make changes after reviewing the summary.
- **Finish**: Click to take the image. If you completed Step 7, the image is assigned to the bundle when it is created.

The images are stored in %ZENWORKS_HOME%\work\content-repo\images on the Windows Primary Server and in /var/opt/novell/zenworks/content-repo/images on the Linux Primary Server, or on the device that is promoted to the Imaging Server role. However, the ZENworks images are not replicated from the Primary Server to other Primary Servers or Satellites.

If the images are taken in the Ghost format, ZENworks additionally creates an XML file with the filename as `image_name-ghost.xml` in the same location as the image file. You must not edit the xml file.

If you are taking an image of a device that has multiple disks, an image file is created for each disk and only one XML file is created per image.

If you want to move a Ghost image to a different location, you must move all the image files and the XML file specific to the image.

This base image can be used in Step 8 on page 99 under “Configuring the ZENworks Image Bundle for Automatic Imaging” on page 99.

To create an add-on image of files selected from a file system for use in Step 8 on page 99, see “Creating an Add-On Image from Files in a File System” on page 106.
NOTE

If there are OEM partitions on a GPT disk:

- **For ZENworks Imaging:** From the ZENworks FRU1 release onwards, OEM partitions with a unique GUID are ignored if the ZENworks Imaging distro is booted in the UEFI mode. If the distro is booted in the legacy BIOS mode, these partitions are included in the partition list. Hence, if an MBR base image is restored to the device, the OEM GPT partitions with unknown GUIDs will get deleted.

  In ZENworks, these partitions are ignored during the Take Image and Restore Image operations.

- **For Third-Party Imaging:** OEM partitions are not supported. Before taking the image, it is recommended that you either uncheck these partitions, or you delete these partitions from the disk using Diskpart. If the OEM partition is of the standard GUID type, such as MBD, WRE, MRP, or ESP, you have to manually remove the partition before performing the Take Image operation. The OEM partitions are deleted during image restoration.

---

Creating an Add-On Image for an Existing Bundle

For the current bundle, you can create the installed version as a ZENworks add-on image. This is not supported for Third-Party Image bundle formats.

Add-on images of bundles are useful for incorporating predelivery of bundles when you are imaging new devices, or when you are reimagining existing devices.

A newer version of the add-on image is automatically created when the bundle’s version number is incremented.

The filename for the add-on bundle is automatically created and uses the following format:

`bundle_name-bundle_UID-counter.zmg`

where `bundle_name` is the name of the current bundle for which the add-on image is being created, `bundle_UID` is a UID number generated for the image, and `counter` is a four-digit counter (beginning with 0000) that is incremented each time the image is updated (that is, when the bundle’s version number is changed). All ZENworks image files end in `.zmg`.

To create an add-on image:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. In the Name column, click a Windows bundle to display its Summary tab.
3. In the General panel, click the Create option next to the Add-on Image File field.
   
   This opens the Bundle Add-on Image Wizard.
4. In the Image Servers panel, click Add.
5. In the dialog box, browse for and select the Primary or Imaging Satellite Servers where the add-on image file needs to be created, then click OK.
6. Click Finish to create an add-on image of the installed bundle.

   You can remove an add-on image by selecting its check box and clicking Remove.

You do not have control over where add-on images are stored:

- For Windows servers, the path to the add-on image files is:

  `%ZENWORKS_HOME%\work\content-repo\images\addon-image`
The remainder of the path is fixed.

- For Linux servers, the path to the add-on image files is:

> /var/opt/novell/zenworks/content-repo/images/addon-image

The `addon-image` directory might not exist until the first add-on image has been created on the server. This directory is automatically created the first time you create an add-on image for a bundle, or you can manually create the directory for storing add-on image files that you create outside of ZENworks Control Center.

**NOTE:** You need to have an agent installed on your system for restoring add-on images that are created using bundles.

**Configuring the ZENworks Image Bundle for Automatic Imaging**

You can use ZENworks to install software bundles. Software included in a bundle that is assigned directly is considered mandatory (the bundle is directly assigned to the devices, their groups, or their folders).

To configure a ZENworks Image bundle and assign devices to the bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3. In the Create New Bundle Wizard, select Preboot Bundle, then click Next.
4. On the Select Bundle Category page, select ZENworks Image.
5. Click Next to display the Define Details page.
6. Fill in the fields:
   - **Bundle Name:** Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder where they are listed, you should develop a naming scheme that differentiates the ZENworks Image bundles that are listed together in a folder. For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.
   - **Folder:** Browse for the location where you want the ZENworks Image bundle to be displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon:** Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description:** Provide a description to help you later recognize the exact purpose of this ZENworks Image bundle.
7. Click Next to display the Select ZENworks image file page:
8. Fill in the fields:
   - **Restore the image using:**
     - **ZENworks Linux Imaging:** Select this option to restore the image (.zmg) taken using ZENworks Linux distro.
     - **ZENworks WinPE Imaging:** Select this option to restore the image (.zmg) taken using ZENworks WinPE distro.
   - **ZENworks Image File:** This is an image file existing on an Imaging Server. You must provide the full path and filename here. The image filename must end in `.zmg` (case-sensitive). For information on creating a base image, see “Taking a Base Image of a Device” on page 95.
If the directory contains add-on images that are created by using the Image Explorer utility or created through ZENworks Control Center, do not select an application add-on image because the application add-on image can be used only with linked application bundles. For information on creating an add-on image of files selected from a file system, see “Creating an Add-On Image from Files in a File System” on page 106.

Click the browse button to access the Server and Path Information dialog box:

- **Server Object, IP, or DNS:** Click the icon to browse for and select the object of the Primary Server or the device that is promoted to the Imaging Server role. You can also specify the IP address or the DNS name of the Primary Server or of the device that is promoted to the Imaging Server role.

  Ensure that the DNS server is up and running, and the DNS name is successfully resolved before configuring this option.

- **File Path on Server:** The full path to the base image file.

  **NOTE:** You cannot browse to the specified file system if multiple DNS search domains with DHCP are configured for Linux and if the server is on Windows.

**File Set:** Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.

Image Explorer is executed by running:

- **Windows:** `%ZENWORKS_HOME%\bin\preboot\zmgexp.bat`
- **Linux:** `/opt/novell/zenworks/preboot/bin/zmgexp`

9 Click **Next** to display the Summary page.

10 Do the following:

- If you want to perform other configuration tasks after the bundle has been created, select the **Define Additional Properties** check box.

  For example, you can make assignments to the bundle in the **Relationships** tab, add actions in the **Actions** tab, and so on.

- If you want to deploy the bundle as a sandbox version, select the **Create As Sandbox** check box. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

11 Review the configuration, then click one of the following:

- **Back:** Allows you to make changes after reviewing the summary.
- **Finish:** Creates the Preboot bundle as configured according to the settings listed on this Summary page.

This bundle is not assigned to any device or group after it is created until you make that assignment on a **Relationships** tab.

**IMPORTANT:** If this Preboot bundle has been created on a management device inside the firewall and you are assigning it to a device outside the firewall, port 8089 must be open both ways (PUBLIC -> PRIVATE, and PUBLIC <-> PRIVATE).

If PXE is enabled on the device, the bundle's work is performed on the device before its operating system starts when a device assigned to the ZENworks Image bundle boots.
Creating and Configuring the Third-Party Image Bundle for Automatic Imaging

You can use ZENworks to specify the third-party images that must be restored on a device. The image that is taken with a third-party Imaging tool and restored by using a third-party Preboot bundle will not have any partition information. Consequently, it creates only one single partition on the destination hard disk. To prevent this issue, you must take an image by using ZENworks Control Center or the Novell ZENworks Third Party Imaging utility in the maintenance mode.

To configure the Third-Party Imaging settings:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3. In the Create New Bundle Wizard, select Preboot Bundle, then click Next.
5. Click Next to display the Define Details page.
6. Fill in the fields:
   - **Bundle Name:** Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder where they are listed, you should develop a naming scheme that differentiates the ZENworks Image bundles that are listed together in a folder.
     For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.
   - **Folder:** Browse for the location where you want the ZENworks Image bundle to be displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon:** Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description:** Provide a description to help you later recognize the exact purpose of this ZENworks Image bundle.
7. Click Next to display the Select a Third-Party Image File page.
8. Fill in the fields:
   - **Image File:** Select the type of the image to be used in the bundle.
     For information on creating a base image, see “Taking a Base Image of a Device” on page 95.
   - **Shared Network Path for Image File:** Specify the shared-network directory containing the .wim or .gho files. The directory must be a Windows share or a Linux CIFS or SMB share, and you must have the Write permission to it. If the Novell File Upload extension is not installed on the device, you must install it before you can browse to and upload the file.
   - **Network Credential:** Click to browse for and select the network credentials to be used for accessing the device that has .wim or .gho files.
   - **Restore WIM as Add-On:** Select this option if you want to use the WIM bundle as an add-on image and configure the following options:
     - **Image Number (WIM Only):** Select the index number of the image to be restored
     - **Path to Restore the Add-on Image:** Specify the location on the device where you want to restore the add-on image.
9. Click Next to display the Summary page.
10. Do the following:
    - If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.
For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.

- If you want to deploy the bundle as a sandbox version, select the Create As Sandbox check box. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

11 Review the configuration, then click one of the following:

**Back:** Allows you to make changes after reviewing the summary.

**Finish:** Creates the Preboot bundle as configured according to the settings listed on this Summary page.

The bundle is not assigned to any device or group after it is created until you make that assignment on a Relationships tab.

---

**IMPORTANT:** If the Preboot bundle has been created on a management device inside the firewall and is assigned to a device outside the firewall, port 8089 must be open both ways (PUBLIC > PRIVATE, and PUBLIC < PRIVATE).

---

### Using a Script to Image a Device

You can perform scripted imaging using the Imaging Script bundle. Any imaging commands can be entered for the script. This is applicable only for ZENworks Imaging.

For example, if you want to mount a DVD and restore an image from it, you could enter something similar to the following in the Script Text field in the Create New Preboot Bundle Wizard when defining an Imaging Script bundle:

```
echo "Please insert the DVD containing the image into the drive and press a key."
read
mount /dev/cdrom /mnt/cdrom
img -rl /mnt/cdrom/myimagefile.zmg
umount /mnt/cdrom
eject /dev/cdrom
```

This example is a combination of automatic and manual tasks, where you define the bundle in ZENworks Control Center, assign it to the device, then when the device boots, it runs the bundle’s script, prompting you to insert the DVD containing an image into the device’s DVD drive. The script then runs the commands to restore the image on the device and ejects the DVD when finished.

For information on creating an Imaging Script bundle, see Section 3.4, “Configuring Imaging Script Bundles for ZENworks Imaging,” on page 131.

### 3.1.2 Using the Command Line for ZENworks Imaging

The following manual imaging tasks are available for ZENworks Imaging:

- “Manually Taking an Image of a Device” on page 103
- “Creating an Add-On Image from Files in a File System” on page 106
- “Using Image Explorer to Customize an Image” on page 107
- “Manually Restoring an Image on a Device” on page 108
- “Making an Image Available for Automatic Imaging” on page 111
These instructions assume that you have already prepared the Imaging Server (see Section 2.1, “Preparing a Preboot Services Imaging Server,” on page 41), prepared devices for imaging (see Section 2.8, “Setting Up Devices for ZENworks Imaging,” on page 90), and set up imaging defaults (Section 2.5, “Configuring Preboot Services Defaults for ZENworks Imaging,” on page 72).

ZENworks imaging supports devices that physically connect to the network and that meet the minimum requirements for devices. ZENworks imaging does not support imaging operations (creating or restoring images) through wireless connectivity.

**Manually Taking an Image of a Device**

This section explains how to take an image of a device by booting from an imaging method and entering a particular imaging command. The image is stored on your Imaging Server.

If you want to store an image locally rather than on an Imaging Server, see “Using a CD, DVD or bootable USB for Disconnected Imaging Operations” on page 113 and “Using a Hard Disk for Disconnected Imaging Operations” on page 115.

Ensure that your Imaging Server has enough disk space for the image. Otherwise, you encounter a “Failed to write to proxy” error.

The following sections contain additional information:

- “Using the Imaging Maintenance Mode to Manually Take an Image of a Device” on page 103
- “Using the ZENworks Imaging Engine Menu to Manually Take an Image of a Device” on page 105

**IMPORTANT:** When you take an image locally, using the Tuxera driver, use the following command to mount the partition on which the image is stored if the partition is NTFS:

```
# mount -t tntfs /dev/sdXn mount_dir
```

In this command, \textit{sdX} is the device node and \textit{n} stands for the partition number in the device.

**Using the Imaging Maintenance Mode to Manually Take an Image of a Device**

1. Boot the device using one of the following methods:
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

2. Depending on how you boot, do one of the following:
   - **CD:** Select Manual Mode from Novell Preboot Services menu.
   - **PXE:** Select Start ZENworks imaging maintenance from the Novell Preboot Services Menu.
   - **ZENworks Partition:** Select Enable ZENworks Partition from the Novell Preboot Services Menu.

3. (Optional) At the prompt, type \texttt{img -dump}, then press Enter.
   - This displays a list of the partition slots on the device. For your reference, note the number and type of partitions and which one is active.
4 Enter a command at the prompt, using one of the following formats:

- To create an image and store it on the Imaging Server, enter:

  ```
  img -makep added_path/newimg.zmg [-comp=comp_level]
  ```

  The `makep` mode command stands for "make on proxy," which creates an image and stores it on the imaging (proxy) server.

  The IP address or DNS name of your Imaging Server is not necessary because the Imaging software automatically points to the `images` directory on the Imaging Server. However, you can add structure under the `images` directory. If you do, that directory structure should be included where `added_path` exists in the command syntax above, immediately followed by `/` and the image filename (`newimg`). Also, the subdirectories in the path must exist.

  The `.zmg` filename extension is required and is case-sensitive.

  You can use the following characters in the path and filename:
  - Letters: a through z (uppercase and lowercase)
  - Numbers
  - Special characters: $ % - _ @ { } ~ #

  In the above syntax, `comp level` is the amount of compression used when creating the image. Specify any number from 0-9. 0 means no compression. 1 is the same as `Optimize for speed` and is used by default if you do not specify this parameter. 6 is the same as `Balanced`. 9 is the same as `Optimize for space`. (`Optimize for speed` takes the least amount of time but creates the largest image file. `Optimize for space` creates the smallest image file but might take a significant amount of time. `Balanced` is a compromise between compression time and image file size.)

  For example:

  ```
  img -makep subdir1/cpqnt.zmg -comp=6
  ```

- To create an image and store it locally, enter:

  ```
  img -makel filepath [-comp=comp_level]
  ```

  The `makel` mode command stands for "make locally," which creates an image and stores it on a local hard disk.

  ```
  NOTE: Unless you mount a drive before using `makel`, the image is created in RAM and is lost during a reboot of the device.
  ```

  In the above syntax, `filepath` is the image filename, including the `.zmg` extension (case-sensitive) and the complete path from the root of the partition where you want it locally stored.

  The directories in the path must exist.

  You can use the following characters in the path and filename:
  - Letters: a through z (uppercase and lowercase)
  - Numbers
  - Special characters: $ % - _ @ { } ~ #

  In the above syntax, `comp level` is the amount of compression used when creating the image. Specify any number from 0-9. 0 means no compression. 1 is the same as `Optimize for speed` and is used by default if you do not specify this parameter. 6 is the same as `Balanced`. 9 is the same as `Optimize for space`. (`Optimize for speed` takes the least amount of time but creates the largest image file. `Optimize for space` creates the smallest image file but might take a significant amount of time. `Balanced` is a compromise between compression time and image file size.)
of time but creates the largest image file. Optimize for space creates the smallest image file but might take a significant amount of time. Balanced is a compromise between compression time and image file size.)

For example:

```
img -makel myimages/myimage.zmg -comp=6
```

**IMPORTANT:** Make sure to use forward slashes in the UNC path as shown above. If you want to use backslashes, enclose the entire UNC path in quotes. The path you specify must exist on your Imaging Server.

For more information on the mode commands and parameters you can use and usage examples, see Section E.3, “Make Mode,” on page 268.

Depending on the amount of data on the hard disk, the image might take several minutes to create. If the screen goes blank, just press any key. (Linux enters a screen-saving mode after a few minutes.)

5 After the image is created and the imaging maintenance mode prompt is displayed, remove any CD, DVD or bootable USB from the drive and reboot the device.

6 (Optional) Verify that the image file was created on your Imaging Server. You might also want to check its size.

### Using the ZENworks Imaging Engine Menu to Manually Take an Image of a Device

1 Boot the device using one of the following methods:

   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

2 Depending on how you boot, do one of the following:

   - **CD:** Select Manual Mode from Novell Preboot Services menu.
   - **PXE:** Select Start ZENworks imaging maintenance from the Novell Preboot Services Menu.
   - **ZENworks Partition:** Select Enable ZENworks Partition from the Novell Preboot Services Menu.

3 Enter `img` to display the ZENworks Imaging Engine menu.

4 (Optional) Click System information > Drive information to display a list of the partition slots on the device.

   For your reference, note the number and type of partitions and which one is active.

5 Click Imaging > Make image.

6 In the Make Image Wizard window, specify the destination where the image is stored (Local or Server), then click Next.

7 Browse to and specify the path to the image archive.

   The directories in the path must exist. You can use the following characters in the path and filename:

   - Letters: a through z (uppercase and lowercase)
Select the partitions that you want to include in the image.

9 Select a compression option:
   - **None**: No compression is used.
   - **Speed**: Takes the least amount of time to compress but creates the largest compressed image file. This option is used by default when an image is created.
   - **Balanced**: Represents a compromise between compression time and image file size.
   - **Size**: Creates the smallest image file but takes longer to compress.

10 Click **Next**.

11 (Optional) Fill in the fields:
   - **Author**: The name of the person creating this image.
   - **Computer**: The name of the computer being imaged.
   - **Image Description**: A description of the image.
   - **Comments**: Any additional comments about the image.

12 Click **Next**.

Depending on the amount of data on the hard disk, the image might take several minutes to create. If the screen goes blank, just press any key. (Linux enters a screen-saving mode after a few minutes.)

13 After the image is created, exit from the ZENworks Imaging Engine menu, remove any CD, DVD or bootable USB from the drive, then reboot the device.

14 (Optional) Verify that the image file was created on your Imaging Server. You might also want to check its size.

### Creating an Add-On Image from Files in a File System

An *add-on* image is an archived collection of files to be applied to an existing installation on a target device. The existing partitions and files on the target device are left intact, except for any files that the add-on image might update.

An add-on image typically corresponds to an application or utility, or simply to a set of data files or configuration settings.

To create an add-on image:

1 Run the Image Explorer utility, which is located on the Imaging Server at:
   - **Windows**: \%ZENWORKS_HOME\%\bin\preboot\zmgexp.bat
   - **Linux**: /opt/novell/zenworks/preboot/bin/zmgexp

2 Drag files and folders from an existing device into a new image archive.

   For more information, see Section D.1, “Image Explorer (zmgexp),” on page 223.

3 Save this image with the .zmg extension (case-sensitive) in the same directory on the Imaging Server where you store base images.

   Generally, an add-on image created in this manner doesn’t require any post-processing on the target device. It is simply a set of files that are copied to the appropriate locations on the hard disk, much like what happens when you unzip an archive. For more information, see “Using Image Explorer to Customize an Image” on page 107.
This add-on image can be used in Step 8 on page 99 under “Configuring the ZENworks Image Bundle for Automatic Imaging” on page 99.

Using Image Explorer to Customize an Image

After you have created a base or add-on image as explained in the previous sections, you can customize it with the Image Explorer utility. Specifically, you can:

- **Compress the Image:** You can compress an image (including images created by previous versions of ZENworks) to 40-60% of the original file size, if you have not done so already during the imaging process. There are three compression options. **Optimize for speed** takes the least amount of time but creates the largest compressed image file. **Optimize for space** creates the smallest image file but might take a significant amount of time. **Balanced** is a compromise between compression time and image file size. This option is used by default when an image is created.

The following compression methods are provided:

- **Compress:** Use this option to compress an image file that you currently have open in Image Explorer. For more information, see “Compressing an Opened Image File” on page 228.
- **QuickCompress:** Use this option to compress an image file without waiting for the file to fully load into Image Explorer. For more information, see “Compressing an Unopened Image File” on page 229.

- **Split the Image:** You can specify a device image file that you want to split into separate files so that the entire image can be spanned across several CDs or DVDs. Splitting a device image is helpful for applying or restoring images in a disconnected environment. For more information, see “Splitting an Image” on page 229.

- **Resize a Partition in an Image:** For base images, you can edit the value in the **Original size** text box to allow you to change how big the ZENworks Imaging Engine makes the partition when the image is restored. For more information, see “Changing a Partition’s Size” on page 227.

- **Purge Deleted Files:** You can completely remove excluded or hidden files and folders from an open image. This saves space in the image if you no longer want to include the files. For more information, see “Removing Hidden Directories and Files from the Image File” on page 231.

- **Exclude Individual Files and Folders from the Image:** In doing this, you create subsets of the image by specifying which of ten possible file sets to exclude a given file or folder from. This exists merely as internal attributes of the same image archive. For more information, see “Unhiding Directories or Files in the Image” on page 230.

**IMPORTANT:** Do not exclude BIOS Parameter Block (BPB) files from a base image or the device won’t be able to boot the new operating system after receiving the image.

- **Add Files and Folders to the Image:** By default, any file or folder you add is included in all file sets. To change this, you must explicitly exclude the file or folder from one or more file sets. For more information, see “Adding Directories and Files” on page 233.

For information on starting Image Explorer, see Section D.1, “Image Explorer (zmgexp),” on page 223.
Manually Restoring an Image on a Device

The section explains how to restore an image to the device by booting from an imaging method and entering a particular imaging command. The image is retrieved from your Imaging Server.

Ensure that the device receiving a new image has enough disk space for the image. Otherwise, you receive a “Failed to write to proxy” error.

**IMPORTANT:** When you restore an image locally, using the Tuxera driver, use the following command to mount the partition on which the image is stored if the partition is NTFS:

```
# mount -t tntfs /dev/sdXn mount_dir
```

In this command, `sdX` is the device node and `n` is the partition number in the device.

The following sections contain additional information:

**Using the Imaging Maintenance Mode Prompt to Manually Restore an Image to a Device**

1. If you haven’t already done so, create the image to restore on the device, as instructed in “Manually Taking an Image of a Device” on page 103.

   Make sure that the image is of the same type of device (same hardware configuration) and is stored on your Imaging Server. You can use a previous image of the same device.

   **IMPORTANT:** If you are restoring an image on a device without a ZENworks partition, make sure the image was made on a device without a ZENworks partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the device fails to boot.

2. (Optional) Boot the device from a Windows startup disk and run `fdisk` to remove all partitions from the hard disk.

   Running `fdisk` is not required, but it is recommended for purposes of comparing workstation or server partitions before and after the imaging operation.

3. Boot the device using one of the following methods:

   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

4. Enter `manual` at the imaging maintenance mode (bash) prompt.

5. (Optional) At the imaging maintenance mode prompt, type `img -dump`, then press Enter to display a list of the partition slots on the device.

   For your reference, note the number and type of partitions and which one is active. If you removed all partitions using `fdisk`, each slot should be empty and none should be active.

6. Enter a command at the prompt, using one of the following formats:

   - To restore an image from the Imaging Server and place it on a device, enter:

     ```
     img -restorep added_path/newimg.zmg
     ```
The \texttt{-restorep} command stands for "restore from proxy." It retrieves an image from the imaging (proxy) server and restores it on the device. The IP address or DNS name should be that of your Imaging Server, and the UNC path specifies the location and filename where the image is to be retrieved from.

For example:

\begin{verbatim}
img -restorep subdir1/cpqnt.zmg
\end{verbatim}

\textbullet To retrieve an image from a local device and place it on a device:

\begin{verbatim}
img -restorep filepath
\end{verbatim}

The \texttt{-restorep} command stands for "restore from local." It retrieves an image from a local device and restores it on the device. \emph{FilePath} represents the filename of the image to retrieve, including the .\texttt{zmg} extension (case-sensitive) and the complete path from the root of the partition.

\textbf{IMPORTANT:} Make sure to use forward slashes in the UNC path as shown above. Backslashes aren't recognized by Linux. However, you can use backslashes and enclose an entire UNC path in quotes. The path you specify must exist.

If you want to manually restore an image from a folder that uses extended or double-byte characters in its name, you should perform an automatic image restoration. For more information, see Section 1.6.2, “Creating, Installing, and Restoring Standard Images,” on page 35 or Section 1.6.4, “Restoring Lab Devices to a Clean State,” on page 36.

For more information on the mode commands and parameters you can use and usage examples, see Section E.4, “Restore Mode,” on page 274.

Depending on the size of the image, it might take several minutes to restore the image. Images usually take slightly longer to apply than they do to take.

7 (Optional) After the image is applied and the prompt is displayed, type \texttt{img -dump}, then press Enter.

As before, this displays a list of the partition slots on the device. You should now see information about the new partitions that are created and activated by the image that you just applied.

8 Remove any CD, DVD or bootable USB from the drive and reboot the device.

9 Verify that the device boots to the operating system that was installed by the new image.

\section*{Using the ZENworks Imaging Engine Menu to Manually Restore an Image to a Device}

1 If you haven't already done so, create the image to restore on the device, as instructed in “Manually Taking an Image of a Device” on page 103.

Make sure that the image is of the same type of device (same hardware configuration) and is stored on your Imaging Server. You can use a previous image of the same device.

\textbf{IMPORTANT:} If you are restoring an image on a device without a ZENworks partition, make sure the image was made on a device without a ZENworks partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the device fails to boot.

2 (Optional) Boot the device from a Windows startup disk and run \texttt{fdisk} to remove all partitions from the hard disk.

Running \texttt{fdisk} is not required, but it is recommended for purposes of comparing the workstation or server partitions before and after the imaging operation.
3 Boot the device using one of the following methods:
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, "Using Preboot Services (PXE)," on page 47.
   - Boot the device using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

4 Depending on how you boot, do one of the following:
   - **CD**: Select Manual Mode from Novell Preboot Services menu.
   - **PXE**: Select Start ZENworks imaging maintenance from the Novell Preboot Services Menu.
   - **ZENworks Partition**: Select Enable ZENworks Partition from the Novell Preboot Services Menu.

5 Enter `img` to display the ZENworks Imaging Engine menu.

6 (Optional) Click System information > Drive information to display a list of the partition slots on the device.
   
   For your reference, note the number and type of partitions and which one is active. If you removed all partitions using fdisk, each slot should be empty and none should be active.

7 Click Imaging > Restore image.

8 In the Restore Image Wizard window, specify the source location of the image (Local or Server), then click Next.

9 Browse to and specify the path to the image archive.

10 (Optional) Specify a file set.
   
   Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.

11 (Optional) Specify any advanced options, such as `sfileset` or `apartition:ppartition`.
   
   For details on this and other related `img` commands, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.

12 Click Next.
   
   Depending on the size of the image, it might take several minutes to restore the image. Images usually take slightly longer to apply than they do to take.

13 (Optional) Click System information > Drive information to display a list of the partition slots on the device.
   
   As before, this displays a list of the partition slots on the device. You should now see information about the new partitions that are created and activated by the image that you just applied.

14 Exit the ZENworks Imaging Engine menu.

15 Remove any CD, DVD or bootable USB from the drive and reboot the device.

16 Verify that the device boots to the operating system that was installed by the new image.
Making an Image Available for Automatic Imaging

When you boot a device from an imaging method and allow the boot process to proceed in auto-imaging mode, the imaging operation that is performed on the device is determined by default Preboot Services settings that you define in ZENworks Control Center.

Creating a Preboot bundle also allows you to combine a base image and one or more add-on images into a single entity that can be applied on target devices. You can specify a standard image file to apply, or you can create a script to further customize your imaging operation. You can also specify that a particular file set of an image be used.

The sections that follow give instructions for performing these tasks:

- “Creating a Base Image” on page 111
- “Associating an Add-On Image with a Preboot Bundle” on page 111
- “Using a File Set of an Image” on page 112

Creating a Base Image

1 Create the base image using one of the following methods:
   - ZENworks Control Center: See “Taking a Base Image of a Device” on page 95.
   - Imaging Maintenance Mode Prompt: See “Manually Taking an Image of a Device” on page 103.

2 After the base image is created, perform one of the following procedures in ZENworks Control Center:
   - If you created the image using a Preboot bundle, assign the bundle to the devices to be imaged:
     1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel, then in the Name column, click the bundle containing the base image that you want to assign to a device to display its Summary page.
     2. Click the Relationships tab, then in the Device Assignments panel, click Add to open the Select Objects dialog box.
     3. Select the devices or groups containing devices, then click OK to display the Assign Bundle Wizard page.
     4. Click Next to display the Summary page, then click Finish to assign the devices to the bundle and exit the wizard.
   - If you created the image manually, assign the image to a Preboot Image bundle, then assign that bundle to the devices to be imaged:
     1. Follow the instructions in “Configuring the ZENworks Image Bundle for Automatic Imaging” on page 99.
     2. In Step 11 on page 100, click Next to assign the bundle to the devices.

The next time these devices boot, they are imaged from this Preboot bundle.

Associating an Add-On Image with a Preboot Bundle

1 Create the add-on image to associate with the preboot bundle. For more information, see “Creating an Add-On Image from Files in a File System” on page 106.

2 Copy the add-on image file to a Configuration Management Imaging Server that is accessible in your Management Zone.

You might want to copy your add-on images to the same location as the base image.
Using Imaging

3 In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel, then in the Name column click a Preboot bundle containing a base image that you want to associate the add-on images with. Its Summary page displays.

4 Click the Actions tab, then click Add > ZENworks Image.

5 In the Add Action - ZENworks Image dialog box, browse for and select an add-on image.
   You can associate more than one add-on image with the bundle. Repeat this step for each add-on image.

6 (Optional) In the Action Name field, change the default name to a useful name.
   This name is displayed in the Name column on the Actions tab.

7 (Optional) In the File Set field, select a file set number.
   For information on file sets, see Appendix A, “File Sets and Image Numbers,” on page 197.

8 In the Restore the image using section, select the appropriate option:
   - **ZENworks Linux Imaging:** Select this option to restore the image (.zmg) taken using ZENworks Linux distro.
   - **ZENworks WinPE Imaging:** Select this option to restore the image (.zmg) taken using ZENworks WinPE distro.

9 Click OK to exit the dialog box.

10 To arrange the order in which the images are applied, select a check box and click either Move Up or Move Down.

11 Click Apply to save the changes.
   When a device boots that is assigned to this bundle, the add-on images are applied in the order listed on this page.

Using a File Set of an Image

As explained in “Using Image Explorer to Customize an Image” on page 107, you can exclude individual files and folders from any of 10 possible file sets of an image.

Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.
### Table 3-1  Image File Set Usages

<table>
<thead>
<tr>
<th>Type of imaging operation</th>
<th>How to specify the file set to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>In the ZENworks Image Wizard in ZENworks Control Center, specify the number of the file set in the File Set field. You must create the file set using the Image Explorer utility. For more information, see Section D.1, “Image Explorer (zmgexp),” on page 223.</td>
</tr>
<tr>
<td></td>
<td>You can create multiple Preboot bundles that point to the same base image, but to different file sets of that image.</td>
</tr>
<tr>
<td>Manual</td>
<td>Use the (-s) parameter on the (-restore) mode command. For example, to specify file set number 3:</td>
</tr>
<tr>
<td></td>
<td>(\text{img} \ -\text{restore} \ \text{myimage.zmg} \ -s=3)</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>You can enter (\text{img}) at the imaging maintenance mode prompt to display a menu, select Restore an Image, then select Local Image. Specify File Set (for example, 3) in the Advanced Parameters field.</td>
</tr>
<tr>
<td></td>
<td>For details, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.</td>
</tr>
</tbody>
</table>

### 3.1.3 Setting Up Disconnected Imaging Operations

Disconnected imaging operations are inherently manual. To perform a disconnected imaging operation on a device, you must have a storage device to hold the image to be created or restored, and that storage device must be locally accessible to the ZENworks Imaging Engine (in Linux) when you boot the device from the imaging boot media. This is applicable only for ZENworks Imaging.

The following sections explain how to set up and perform disconnected operations:

- “Using a CD, DVD or bootable USB for Disconnected Imaging Operations” on page 113
- “Using a Hard Disk for Disconnected Imaging Operations” on page 115

### Using a CD, DVD or bootable USB for Disconnected Imaging Operations

You can use CDs and DVDs only as the storage medium for an image to applied, not for an image to be created.

You can apply an image from a bootable or non-bootable imaging CD, DVD or bootable USB using either the imaging maintenance mode prompt or using the ZENworks Imaging Engine menu.

The following sections contain additional information:

- “Using the Imaging Maintenance Mode Prompt to Apply an Image” on page 114
- “Using the ZENworks Imaging Engine Menu to Apply an Image” on page 114
Using the Imaging Maintenance Mode Prompt to Apply an Image

1. Use your CD- or DVD-burning software to burn the source image onto a CD, DVD or bootable USB.

2. Boot the device by using one of the following methods:
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device by using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

3. Select Manual Mode from Novell Preboot Services menu.

4. Insert the CD, DVD or bootable USB that contains the source image.

5. At the prompt, enter `cdrom.s` to mount the CD, DVD or bootable USB.
   This mounts the CD, DVD or bootable USB to `/mnt/cdrom`.

6. Enter a command by using the following format:

   ```
   img -restorel /mnt/cdrom/path/image_name.zmg
   ```

   where `path` and `image_name` are the path and filename of the image relative to the root of the CD, DVD or bootable USB.

7. When the imaging is done, remove the imaging boot media (if applicable) and reboot the device with the new image.

Using the ZENworks Imaging Engine Menu to Apply an Image

1. Use your CD- or DVD-burning software to burn the source image onto a CD, DVD or bootable USB.

2. Boot the device by using one of the following methods:
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device by using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

3. Select Manual Mode from Novell Preboot Services menu.

4. Insert the CD, DVD or bootable USB that contains the source image.

5. At the prompt, enter `cdrom.s` to mount the CD, DVD or bootable USB.
   This mounts the CD, DVD or bootable USB to `/mnt/cdrom`.

6. Enter `img` to display the ZENworks Imaging Engine menu.

7. Click Imaging, then click Restore image.

8. Click Local, then click Next.

9. Browse to and specify the path to the image archive.

10. (Optional) Specify a file set.

   Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.

11. (Optional) Specify any advanced options, such as `sfileset` or `apartition:ppartition`. 
For details on this and other related `img` commands and parameters, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.

12 Click Next.

Depending on the size of the image, it might take several minutes to restore the image. Images usually take slightly longer to apply than they do to take.

13 When the imaging is done, remove the imaging boot media (if applicable) and reboot the device with the new image.

Using a Hard Disk for Disconnected Imaging Operations

When you boot a device from a ZENworks imaging boot media, you can place an image on, or take an image from, any primary partition on an IDE or SCSI hard drive. You can also use the local ZENworks partition if one is installed. Any target partition must have sufficient space.

When you create an image, the partition where you store the image is itself excluded from the image. When you apply an image, the source partition is not altered.

You can create or apply an image on a hard disk by using either the imaging maintenance mode prompt or by using the ZENworks Imaging Engine menu.

The following sections contain the instructions:

- “Using the Imaging Maintenance Mode Prompt to Create an Image” on page 115
- “Using the ZENworks Imaging Engine Menu to Create an Image” on page 116
- “Using the Imaging Maintenance Mode Prompt to Apply an Image” on page 117
- “Using the ZENworks Imaging Engine Menu to Apply an Image” on page 117

Using the Imaging Maintenance Mode Prompt to Create an Image

1 Boot the device by using one of the following methods:

- If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
- Boot the device by using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
- Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

2 Select Manual Mode from Novell Preboot Services menu.

3 At the prompt, enter `img -dump` to view the available partitions.

   Note the number of the partition where you will store the new image.

4 Enter a command by using the following format:

   `img -makel [-part=pNumber] /added_path/image.zmg [-comp=comp_level]`

   where `pNumber` is the number of the partition to store the image in, and `comp_level` is the amount of compression used when creating the image. Specify any number from 0-9. 0 means no compression. 1 is the same as Optimize for speed, 6 is the same as Balanced and is used by default if you do not specify this parameter. 9 is the same as Optimize for space. (Optimize for speed takes the least amount of time but creates the largest image file. Optimize for space creates the smallest image file but might take a significant amount of time. Balanced is a
compromise between compression time and image file size.) *Path and image* are the path and filename of the new image relative to the partition root. If you omit the partition number, the local ZENworks partition is used.

For details on other related `img` commands and parameters, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.

### Using the ZENworks Imaging Engine Menu to Create an Image

1. **Boot the device by using one of the following methods:**
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device by using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

2. **Select Manual Mode** from Novell Preboot Services menu.

3. **Enter `img`** to display the ZENworks Imaging Engine menu.

4. **(Optional) Click System information > Drive information** to display a list of the partition slots on the device.

   For your information, note the number of the partition where you will store the new image.

5. **Click Imaging > Make image.**

6. **In the Make Image Wizard window, click Local > Next.**

7. **Browse to and specify the path to the image archive.**

8. **Select the partitions that you want to include in the image.**

9. **Select a compression option:**
   - **None:** No compression is used.
   - **Speed:** Takes the least amount of time to compress but creates the largest compressed image file. This option is used by default when an image is created.
   - **Balanced:** Represents a compromise between compression time and image file size.
   - **Size:** Creates the smallest image file but takes longer to compress.

10. **Click Next.**

11. **(Optional) Fill in the fields:**
    - **Author:** The name of the person creating this image.
    - **Computer:** The name of the computer being imaged.
    - **Image Description:** A description of the image.
    - **Comments:** Any additional comments about the image.

12. **Click Next.**

    Depending on the amount of data on the hard disk, the image might take several minutes to create.

13. **After the image is created, exit from the ZENworks Imaging Engine menu, remove any CD, DVD or bootable USB from the drive, then reboot the device.**

14. **(Optional) Verify that the image file was created. You might also want to check its size.**
Using the Imaging Maintenance Mode Prompt to Apply an Image

1 Boot the device by using one of the following methods:
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device by using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

2 Select Manual Mode from Novell Preboot Services menu.

3 (Optional) At the prompt, enter `img -dump` to view the available partitions. For your information, note the number of the partition where the source image is stored.

4 Enter a command by using the following format:

   `img -restore [-part=pNumber] added_path/image.zmg`

   where `pNumber` is the number of the partition where the source image is stored, and `path` and `image` are the image path and filename relative to the partition root. If you omit the partition number, the local ZENworks partition is used.

   For details on other related `img` commands and parameters, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.

5 When the imaging is done, remove the imaging boot media (if applicable) and reboot the device with the new image.

Using the ZENworks Imaging Engine Menu to Apply an Image

1 Boot the device by using one of the following methods:
   - If the device is PXE-enabled, boot it from the Preboot Services Imaging Server. For more information, see Section 2.3.1, “Using Preboot Services (PXE),” on page 47.
   - Boot the device by using an imaging boot CD, DVD or bootable USB. For more information, see Section 2.3.2, “Preparing Imaging Boot CDs, DVDs or bootable USB,” on page 47.
   - Boot the device from the ZENworks partition. For more information, see “Creating a ZENworks Partition” on page 52.

2 Select Manual Mode from Novell Preboot Services menu.

3 Enter `img` to display the ZENworks Imaging Engine menu.

4 (Optional) Click System information > Drive information to display a list of the partition slots on the device.

   For your reference, note the number of the partition where the source image is stored.

5 Click Imaging > Restore image.

6 Click Local > Next.

7 Browse to and specify the path to the image archive.

8 (Optional) Specify a file set.

   Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.

9 (Optional) Remove the word `sfileset` from the sentence.

   For details on this and other related `img` commands and parameters, see Appendix E, “ZENworks Imaging Engine Commands,” on page 265.
10 Click Next.

Depending on the size of the image, it might take several minutes to restore the image. Images usually take slightly longer to apply than they do to take. If the screen goes blank, just press any key. (Linux enters a screen-saving mode after a few minutes.)

11 When the imaging is done, remove the imaging boot media (if applicable) and reboot the device with the new image.

3.2 Understanding the Sandboxing Behaviour for Preboot Bundles

ZENworks introduces a new change management capability for bundles, allowing you to make changes to them with minimum disruption to IT services. You can now create a bundle as a sandbox. Also, any change made to the published version of the bundle creates a sandbox. The sandbox is available only to devices or users that have been flagged as test. This allows you to test the changes made to a bundle on a test device before rolling out the changes into the production environment. If the test results are satisfactory, you can publish the sandbox, or you can discard the changes by reverting the sandbox. The published version is available to all the assigned devices and users that have been flagged as non-test. This ensures that all the devices in the network always receive the same version of a bundle or policy.

For detailed information about how to test and use bundle change management, see the ZENworks Software Distribution Reference.

Review the following scenarios to understand the bundle change management (Sandboxing) behavior for Preboot bundles:

- Section 3.2.1, “Scenario: Taking or Restoring the ZENworks Image for Registered Devices (with or without Rule-Based Imaging),” on page 118
- Section 3.2.2, “Scenario: Restoring an Image on Unmanaged Devices By Using a Hardware Rule,” on page 119
- Section 3.2.3, “Scenario: Configuring Multicasting Device Images,” on page 119
- Section 3.2.4, “Scenario: Restoring a Bundle on a Test or Non-Test Device Booted in the Manual Mode,” on page 120
- Section 3.2.5, “Scenario: Applying the Published Version of Both the Preboot Bundle and the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device,” on page 120
- Section 3.2.6, “Scenario: Applying the Published Version of the Preboot Bundle and the Sandbox Version of the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device,” on page 120
- Section 3.2.7, “Scenario: Applying the Sandbox Version of Both the Preboot Bundle and the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device,” on page 120
- Section 3.2.8, “Scenario: Applying the Sandbox Version of the Preboot Bundle and the Published Version of the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device,” on page 121

3.2.1 Scenario: Taking or Restoring the ZENworks Image for Registered Devices (with or without Rule-Based Imaging)

- If you create a Preboot bundle with the default options to either take or restore an image, a published version of the bundle is created. By default, bundle is created as sandbox version.
- If you select the **Create as Sandbox** option (on the Summary page) while creating the Preboot bundle, the ZENworks Image bundle is created as a sandbox.
- On applying the published version of a Preboot bundle to a managed device, all the actions configured in the latest published version are applied to the device.
- On applying the sandbox version of a Preboot bundle to a managed device that is a test device, all the actions configured in the sandbox version of the bundle are applied to the device.
- On applying a Preboot bundle that has both the sandbox and published versions to a managed device:
  - If the managed device is a non-test device, all the actions configured in the latest published version of the bundle are applied to the device.
  - If the managed device is a test device, all the actions configured in the sandbox version of the bundle are applied to the device.
- On applying a Preboot bundle with only the published version to a test device, all the actions configured in the latest published version of the bundle are applied to the device.
- On applying a Preboot bundle with only the sandbox version to a non-test device, no action is performed and the device exits from PXE mode.

### 3.2.2 Scenario: Restoring an Image on Unmanaged Devices By Using a Hardware Rule

- If you create a Preboot bundle with the default options to restore an image, a published 0 version of the bundle is created. By default, bundle is created as sandbox.
- If you select the **Create as Sandbox** option (on the Summary page) while creating the bundle, the ZENworks Image bundle is created as a sandbox.
- On applying the published version of a Preboot bundle to an unmanaged device, the device loads the ZENworks distro and the image is restored.
- On applying a Preboot bundle with only the sandbox version to an unmanaged device, no action is performed and the device exits from PXE mode.
- On applying a Preboot bundle that has both the sandbox and published versions to an unmanaged device, the latest published version of the bundle is applied to the device.
- If any hardware rule is applied on a managed device, unless the Apply Rule Based Imaging Bundle is selected from the action menu for the device, no action is performed and the device exits from the PXE mode.
- If a device is registered to a different zone, it exits from the PXE mode. If you want to force the hardware rule on this device, clear the ISD data.

### 3.2.3 Scenario: Configuring Multicasting Device Images

- If you create a Multicast Image Set bundle with the default options, a published 0 version of the bundle is created. By default, bundle is created as sandbox.
- If you select the **Create as Sandbox** option (on the Summary page) while creating the bundle, the Multicast Image Set bundle is created as a sandbox.
- The normal devices load the ZENworks distro and receive the published version of the bundle.
- The test devices load the ZENworks distro and receive the sandbox version of the bundle. The multicast session on the test device is prepended with the word sandbox.
3.2.4 Scenario: Restoring a Bundle on a Test or Non-Test Device Booted in the Manual Mode

- To restore the sandbox version of the bundle on a test or non-test device booted from the imaging boot media in manual mode, execute the following command:

  ```
  img -rp -IF= <IP address of the Imaging Server> -b=<bundlename> -sandbox
  ```

- To restore the published version of the bundle on a test or non-test device booted from the imaging boot media in manual mode, execute the following command:

  ```
  img -rp -IF= <IP address of Imaging Server> -b=<bundlename>
  ```

3.2.5 Scenario: Applying the Published Version of Both the Preboot Bundle and the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device

- By default, an add-on image (`copy-guid-00X.zmg`) file is created in the `content-repo` directory of the selected Imaging server.

- If you apply the bundle to a test device, the device receives the published version of both the Preboot bundle and the Linked Application bundle.

- If you apply the bundle to a non-test device, the device receives the published version of both the Preboot bundle and the Linked Application bundle.

3.2.6 Scenario: Applying the Published Version of the Preboot Bundle and the Sandbox Version of the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device

- By default, an add-on image (`copy-guid-00X.zmg`) file is created in the `content-repo` directory of the selected Imaging server.

- If you apply the bundle to a test device, the device receives the published version of both the Preboot bundle and the Linked Application bundle.

- If you apply the bundle to a non-test device, the device receives the published version of both the Preboot bundle and the Linked Application bundle.

3.2.7 Scenario: Applying the Sandbox Version of Both the Preboot Bundle and the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device

- The test device receives the sandbox version of both the Preboot bundle and the Linked Application bundle.

- The non-test device receives the published version of both the Preboot bundle and the Linked Application bundle.
3.2.8 Scenario: Applying the Sandbox Version of the Preboot Bundle and the Published Version of the Application Bundle (Add-On Image) to a Test Device and to a Non-Test Device

- The test device receives the sandbox version of the Preboot bundle and the published version of Linked Application bundle.
- The non-test device receives the published version of both the Preboot bundle and the Linked Application bundle.

3.3 Multicasting Images for ZENworks Imaging

Multicast Image Set bundles use an image that is previously taken from a device and stored on an Imaging Server. The image is sent to multiple devices at one time to reimage them, rather than being sent one time for each device, thus saving on network bandwidth usage. For example, if you have 10 devices in the multicast session and the image is 3 GB in size, your network experiences 3 GB of network traffic to image all 10 devices. Without multicasting, the network experiences 30 GB of network traffic.

For multicasting to work properly, all routers and switches on the network must have their multicast features configured. Multicast packets should not be blocked in a switch.

A multicast session consists of all clients (devices) that are assigned to the Multicast Session Set bundle that are booting (joining), but must wait for a start trigger in order to complete booting. In other words, the boot processes for the devices can be held up until one of the triggers is encountered, even for as long as you specify in an elapsed time or number of clients entry.

After a session has started, other devices booting that are assigned to this bundle do not become part of this session, but become part of the next session when it triggers.

There are two triggers that you can use to determine when to start the multicast session. The first trigger to be encountered starts the session. These triggers are useful if you want economy of scale in multiple clients joining, but don’t want to stall the session too long.

For multicast addresses used by devices, see Session Mode commands and Parameters in Table E-12 on page 283.

You can perform multicasting of images either in ZENworks Control Center or manually:

- Section 3.3.1, “Using ZENworks Control Center to Multicast an Image,” on page 121
- Section 3.3.2, “Using the Command Line to Multicast an Image,” on page 126

3.3.1 Using ZENworks Control Center to Multicast an Image

Multicast Image Set bundles use an image that is previously taken from a device and is stored on an Imaging Server. The image is sent to multiple devices at one time to reimage them, rather than being sent one time for each device, thus saving on network bandwidth usage. For example, if you have 10
devices in the multicast session and the image is 3 GB in size, your network experiences 3 GB of network traffic to image all 10 devices. Without multicasting, the network experiences 30 GB of network traffic.

For multicasting to work properly, all routers and switches on the network must have their multicast features configured. Multicast packets should not be blocked in a switch.

- “Configuring Multicast Image Set Bundles” on page 122
- “Creating a Multicast Image Containing the Base Operating System, ZENworks Agent, and Add-on Application Image” on page 124
- “Adding Participants to a Multicast Session” on page 124
- “Enabling or Disabling a Multicast Image Set Bundle” on page 126

Configuring Multicast Image Set Bundles

With Preboot Services, multicasting is an automated procedure. You simply define a Multicast Image Set bundle and assign it to the devices. The multicast session starts when the trigger event that you configured occurs.

Using Configuration Management, you can install software by using a bundle. Software included in a bundle that is assigned directly is considered mandatory; the software is installed on all assigned devices (the bundle is directly assigned to the devices, their groups, or their folders).

To configure a Multicast Image Set bundle and assign devices to the bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3. Select Preboot Bundle, then click Next to display the Select Bundle Category page.
4. Select Multicast Image Set, then click Next to display the Define Details page.
5. Fill in the fields:
   - **Bundle Name:** (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the Multicast Image Set bundles that are listed together in a folder.
     - For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.
   - **Folder:** Browse for the location where you want the Multicast Image Set bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon:** Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description:** Provide a description to help you later recognize the exact purpose of this Multicast Image Set bundle.
     - If you are using subsets of an image, be sure to indicate which file set this bundle is configured for.
6. Click Next to display the Master Image Source page.
7. Select the multicast imaging mode.
   - Select ZENworks Linux Imaging to multicast the image using the Linux distro.
   - Select ZENworks WinPE Imaging to multicast the image using WinPE distro.
8. Fill in the fields:
**File Path:** The location on the Imaging Server where the image file to be used by the Multicast Image Set bundle is stored.

**NOTE:** If the directory contains add-on images that are created by using the Image Explorer utility or created through ZENworks Control Center, do not select an application add-on image because the application add-on images can be used only with linked application bundles.

**File Set:** Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.

Image Explorer is executed by running:

**Windows:** %ZENWORKS_HOME%\bin\preboot\zmgexp.bat

**Linux:** /opt/novell/zenworks/preboot/bin/zmgexp

9 Fill in the fields:

There are two triggers that you can use to determine when to start the ZENworks Multicast session. The first trigger is the number of clients for a session and the second trigger is the time within which the clients need to connect to the session. The first trigger to be realized starts the session.

A session consists of all clients (devices) that are assigned to the Multicast Image Set bundle that are booting (joining), but must wait for a start trigger. Therefore, the boot processes for the devices can be held up until one of the triggers is realized, even for as long as you specify in an elapsed time or number of clients entry.

After a session has started, if other devices boot that are assigned to this bundle, they do not become part of this session, but become part of the next session when it triggers.

**Start the Session As Soon As:** You have two choices:

- _____ clients have joined
  After the specified number of clients have registered for the session, the server waits for a couple of seconds and checks for any new clients. The server accommodates all the newly requested clients and then triggers the session.

- _____ minutes have elapsed since a new client has joined
  This trigger, if met first, causes the session to start, regardless of the number of clients that have joined, except that at least one client must have joined (otherwise there is no device to multicast to).
  A “new client” means that it is the first device to boot that starts this round of waiting for a trigger to be realized. The default is 5.

**NOTE:** You cannot manually specify any particular device as the master in the multicast session.

These triggers are useful if you want economy of scale in multiple clients joining, but don’t want to stall the session too long from starting.

10 Click Next to display the Summary page.

11 Do the following:

- If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.

  Because a generic non-intuitive action name is given to this bundle, you need to rename it in Step 13 after the bundle has been created.

- If you want to deploy the bundle as a sandbox version, ensure that Create As Sandbox check box is selected. A sandbox version of a bundle enables you to test it on your device before actually deploying it.
Review the configuration, then click one of the following:

**Back:** Allows you to make changes after reviewing the summary.

**Finish:** Creates the Multicast Image Set bundle as configured per the settings listed on this Summary page.

When the bundle’s Summary tab is displayed, click the Actions tab, click the bundle name in the Name column (“Multicast Image Set” defaults), edit the name in the Action Name field, then click OK.

This bundle is not assigned to any device or group after it is created until you make that assignment on a Relationships tab.

**IMPORTANT:** If this Preboot bundle has been created on a management device inside the firewall and you are assigning it to a device outside the firewall, port 8089 must be open both ways (PUBLIC -> PRIVATE, and PUBLIC <- PRIVATE).

When the Multicast Image Set bundle’s trigger event occurs (configured in Step 9), the Multicast session begins.

### Creating a Multicast Image Containing the Base Operating System, ZENworks Agent, and Add-on Application Image

1. Create the `C:\Program Files\Novell\ZENworks\work` directory structure by using an add-on image.
   
   For more information on creating an Addon image, see “Creating an Add-On Image for an Existing Bundle” on page 98.

2. Create a single Preboot bundle.

3. Create two Multicast Imaging Set actions in the bundle. Create one for the base operating system, ZENworks Agent, and the folder structure created in Step 1, and the second for the add-on application images.

   For example, create the following Multicast Imaging Set actions in the bundle:
   - Action 1: Contains the base operating system image, `addondir.zmg`, and the `PreAgent.zmg`.
   - Action 2: Contains the add-on application images.

### Adding Participants to a Multicast Session

There are two sources for Multicast session participants: registered devices and unregistered devices. Either or both can be assigned to a given Multicast Image Set bundle. The participant devices must be PXE booted from the server where the ZENworks image file is located.

- “Assigning Registered Devices” on page 124
- “Assigning Unregistered Devices” on page 125

### Assigning Registered Devices

1. In ZENworks Control Center, click Devices in the left pane to display the Devices panel in the Managed tab.

2. Click the Servers or Workstations folder, then select the check boxes for the devices to be in the multicast session.
3 Click **Action > Assign Bundle.**
   This starts the Assign Bundle Wizard.

4 In the Select Objects dialog box, select the desired Multicast Image Set bundle.

5 In the Shortcut Location section, make sure all check boxes are deselected, then click **OK.**
   Preboot bundles do not use shortcut locations.

6 Click **Next > Finish** to complete the multicast session assignment.
   When devices assigned to this Multicast Image Set bundle boot, they can become part of the multicast session and be imaged from the image contained in the bundle.

7 On the **Summary** tab for the device, click **Advanced** in the Imaging Work panel.

---

**NOTE**

- When multiple bundles are assigned, only the first bundle in the **Bundle** drop-down list is applied to the device. For more information about the **Bundle** drop-down list in the Imaging Work panel, see “**Apply Assigned Imaging Bundle:**” on page 151.
- You can change the effective bundle assignment to the device by altering the order of the bundles in the **Bundle** drop-down list.

---

8 In the **Scheduled Work** field, select **Apply Assigned Imaging Bundle**, then click **OK.**
   This sets up a device to do Multicast Image Set bundle work for its effective bundle the next time it boots.

9 (Conditional) If the multicast session needs to be enabled, continue with “**Enabling or Disabling a Multicast Image Set Bundle” on page 126.**
   By default, a Multicast Image Set bundle is enabled when you create it.

---

**Assigning Unregistered Devices**

1 In ZENworks Control Center, click **Configuration** in the left pane to display the **Configuration** tab, if it's not expanded, click **Management Zone Settings.**

2 Click **Device Management** to expand its listing, then select **Preboot Services.**

3 If necessary, expand the Device Imaging Work Assignment section, then click **Add** in the Hardware Rules section to open the Rule Construction dialog box.
   For information on the Rule Construction dialog box, see “**Rule Construction” on page 78.**

4 In the **Bundle to Apply** field, browse for and select the desired Multicast Image Set bundle.

5 Fill in remaining the fields to configure the type of device that you want to image in the multicast session.

6 Click **Apply** at the bottom of the Preboot Services section to save the non-registered device settings.
   When devices fulfilling the requirements that you defined in these steps boot, they can become part of the multicast session and be imaged from the image contained in the Multicast Image Set bundle.

7 (Conditional) If the multicast session needs to be enabled, continue with “**Enabling or Disabling a Multicast Image Set Bundle” on page 126.**
Enabling or Disabling a Multicast Image Set Bundle

By default, a Multicast Image Set bundle is enabled when you create it. However, you can disable the bundle as a means of controlling whether to have the session run, rather than visit each device to unschedule that work.

If you have disabled the session for this bundle, the multicast session cannot occur, even when devices assigned to the bundle reboot to trigger the session.

To enable or disable a Multicast Image Set bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. In the Name column, click a Multicast Image Set bundle to open its Summary tab. Multicast Image Set is displayed in the Category column for all Multicast Image Set bundles. You can use the Search panel to display only Multicast Image Set bundles. Click the down-arrow for the Category field and select Multicast Image Set.
3. Click the Actions tab, then do one of the following:
   - To enable the bundle, select the check box for the bundle, then click Enable.
   - To disable the bundle, select the check box for the bundle, then click Disable.
4. Click Apply to enable or disable multicasting for the devices that are assigned to this bundle.

If enabled, the next time a device assigned to the Multicast Image Set bundle boots, it can become part of that multicast session if its Imaging Work has been scheduled.

3.3.2 Using the Command Line to Multicast an Image

If you want to perform a multicast session from a command line, you need to start the multicast session from the ZENworks Imaging Server and physically visit each participating device. Performing a manual multicast session is particularly useful in a lab environment in which a small number of devices participate.

The following sections contain step-by-step information about performing a manual multicast session. You must perform the steps in both of the following sections; however, the order in which you perform these tasks does not matter.

- “Initiating a Multicast Session from the ZENworks Imaging Server” on page 126
- “Initiating a Multicast Session from Each Client” on page 128

Initiating a Multicast Session from the ZENworks Imaging Server

On the ZENworks Imaging Server, do the following to initiate the multicast session:

- “On Windows” on page 126
- “On Linux” on page 127

On Windows

1. In the Services window, determine whether the Novell ZENworks Preboot Service is running. If it is not running, then right-click the service and select Start.
2. On the command line, enter the following to enable a multicast session:

   `%ZENWORKS_HOME%\bin\preboot\zmgmcast.exe -mcast arguments`
where *arguments* represents the following that you can append to the command line:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>session_name</em></td>
<td>(Required) The session name is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network.</td>
</tr>
<tr>
<td>-p <em>path</em></td>
<td>(Required) The path to the image to be multicast, which is located on the Imaging Server. This must be the full path.</td>
</tr>
<tr>
<td>-i <em>IP_address</em></td>
<td>(Optional) The IP address of the Imaging Server. If not specified, the IP address of the Primary Server is considered by default.</td>
</tr>
<tr>
<td>-f <em>file_set_number</em></td>
<td>(Optional) File sets are assigned to the current ZENworks Image bundle by using this information.</td>
</tr>
</tbody>
</table>

**File Set:** Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197.

Image Explorer is executed by running:

**Windows:** `%ZENWORKS_HOME%\bin\preboot\zmgexp.bat`

**Linux:** `/opt/novell/zenworks/preboot/bin/zmgexp`

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-t <em>time_wait</em></td>
<td>(Optional) If not enough devices have booted to fulfill the Client Count requirement, the multicast session begins if a participating device boots and a certain amount of time passes without another participating device booting. Specify this amount of time. The default is 5 minutes.</td>
</tr>
<tr>
<td>-c <em>client_count</em></td>
<td>(Optional) The number of participating devices you want to have booted before the multicast session begins. If you do not specify a number, the default is 1.</td>
</tr>
</tbody>
</table>

**IMPORTANT:** The image is sent to and placed on each participating device only after you initiate the multicast session from each participating client.

3 To view the list of multicast sessions, enter:

```
%ZENWORKS_HOME%\bin\preboot\zmgmcast.exe -list -i proxy_IP_address
```

The -i argument is optional.

4 To stop a multicast session, enter:

```
%ZENWORKS_HOME%\bin\preboot\zmgmcast.exe -stop session_name -i proxy_IP_address
```

The *session_name* is required and the -i argument is optional.

5 Continue with “Initiating a Multicast Session from Each Client” on page 128.

**On Linux**

1 On the command line, enter the following to make sure the imaging software is running:

```
/etc/init.d/novell-pbserv status
```

If it is not running, then enter:

```
/etc/init.d/novell-pbserv start
```

2 On the command line, enter the following to enable a multicast session:
Using Imaging

The command line is:

```
/opt/novell/zenworks/preboot/bin/novell-zmgmcast -mcast arguments
```

where *arguments* represents the following that you can append to the command line:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>session_name</td>
<td>(Required) The session name is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network.</td>
</tr>
<tr>
<td>-p path</td>
<td>(Required) The path to the image to be multicast, which is located on the Imaging Server. This must be the full path.</td>
</tr>
<tr>
<td>-i IP_address</td>
<td>(Optional) The IP address of the Imaging Server.</td>
</tr>
<tr>
<td>-f file_set_number</td>
<td>(Optional) File sets are assigned to the current ZENworks Image bundle by using this information. File Set: Using Image Explorer, you can create file sets for selection when creating the Preboot bundle. For more information, see Appendix A, “File Sets and Image Numbers,” on page 197. Image Explorer is executed by running: Windows: <code>%ZENWORKS_HOME%\bin\preboot\zmgexp.bat</code> Linux: <code>/opt/novell/zenworks/preboot/bin/zmgexp</code></td>
</tr>
<tr>
<td>-t time_wait</td>
<td>(Optional) If not enough devices have booted to fulfill the Client Count requirement, the multicast session begins if a participating device boots and a certain amount of time passes without another participating device booting. Specify this amount of time. The default is 5 minutes.</td>
</tr>
<tr>
<td>-c client_count</td>
<td>(Optional) The number of participating devices you want to have booted before the multicast session begins. If you do not specify a number, the default is 1.</td>
</tr>
</tbody>
</table>

**IMPORTANT:** The image is sent to and placed on each participating device only after you initiate the multicast session from each participating client.

3 To view the list of multicast sessions, enter:

```
/opt/novell/zenworks/preboot/bin/novell-zmgmcast -list -i proxy_IP_address
```

The `-i` argument is optional.

4 To stop a multicast session, enter:

```
/opt/novell/zenworks/preboot/bin/novell-zmgmcast -stop session_name -i proxy_IP_address
```

The `session_name` is required and the `-i` argument is optional.

5 Continue with “Initiating a Multicast Session from Each Client” on page 128.

**Initiating a Multicast Session from Each Client**

You can use the imaging maintenance mode prompt or the ZENworks Imaging Engine menu to perform the multicast session as you physically visit each device.

The following sections contain additional information:

- “Using the Imaging Maintenance Mode Prompt to Perform the Multicast Session” on page 129
- “Using the ZENworks Imaging Engine Menu to Perform the Multicast Session” on page 129
Using the Imaging Maintenance Mode Prompt to Perform the Multicast Session

1. (Optional) Install the Novell ZENworks Configuration Management Imaging Agent, `novell-zisdservice` on a Windows device, or `novell-zislnx` on a Linux device.

   If you do not install the Imaging Agent on each participating device, the devices have duplicate network identities. For more information, see "Limitations of Multicasting Images" on page 39.

2. Create an imaging boot CD, DVD or bootable USB for each person who will assist with the multicast session, or enable PXE on the participating devices.

   If you don’t know how to do this, see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46.

3. At each device, including the master device (unless you are starting the multicast session from the Imaging Server), access the imaging maintenance mode prompt by using the imaging boot CD, DVD or bootable USB, or if it is PXE-enabled, boot it.

4. Enter `manual` at the prompt.

5. To identify each participating device in the multicast session, enter the following command at the prompt of every device:

   ```bash
   img -session session_name
   ```

   where `session_name` is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network. Use the same session name on each of the participating devices in this multicast session. You can specify any multicast session, including one that originates from the Imaging Server (as long as you specify the session name used by the Imaging Server).

   Example: `img -session mcast01`

   The `img -session` command can take other parameters that allow you to designate the master device and the imaging start time beforehand. See Appendix E, “ZENworks Imaging Engine Commands,” on page 265 for details.

6. (Conditional) If you have not already done so, start the multicast session from the master device or from the imaging server.

   **Master device:** To start the multicast session from the master device, after all of the other devices have registered as participants, click Start session.

   If you start the session from the master device, the session master must be a device. If you start the session from the imaging server, the session master must be an imaging server that uses a previously saved image file.

   The ZENworks Imaging Engine begins creating the image of the master device and the image is sent to and restored on each participating device. Any problems are reported and displayed on the master device.

   **Imaging server:** To start the multicast session from the imaging server, follow the steps under “Initiating a Multicast Session from the ZENworks Imaging Server” on page 126.

7. At each participating device, when the imaging is done, boot the device with the new operating system.

Using the ZENworks Imaging Engine Menu to Perform the Multicast Session

1. (Optional) Install the Novell ZENworks Configuration Management Imaging Agent, `novell-zisdservice` on a Windows device, or `novell-zislnx` on a Linux device.

   If you do not install the Imaging Agent on each participating device, the devices have duplicate network identities. For more information, see “Limitations of Multicasting Images” on page 39.
2 Create an imaging boot CD, DVD or bootable USB for each person who will assist with the multicast session, or enable PXE on the participating devices.

If you don’t know how to do this, see Section 2.3, “Setting Up the Preboot Services Methods for ZENworks Imaging,” on page 46.

3 At each device, including the master device (unless you are starting the multicast session from the Imaging Server), access the imaging maintenance mode prompt by using the imaging boot CD, DVD or bootable USB, or if it is PXE-enabled, boot it.

4 Enter **manual** at the prompt.

or

Select **Start ZENworks Imaging Maintenance** from the Novell Preboot Services Menu.

5 To identify each participating device in the multicast session, type `img` at the prompt to display the ZENworks Imaging Engine screen.

6 Click **Imaging**, then click **Multicast session** (or click **F7 Multicast** on the task bar) to start the Multicast Wizard.

7 Enter a session name.

The session name is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network. Use the same session name on each of the participating devices in this multicast session. You can specify any multicast session, including one that originates from the Imaging Server (as long as you specify the session name used by the Imaging Server).

8 Select a **Session role** option:

   **Master:** Select this option if this is the session master.

   **Client:** Select this option if this is a participating device.

9 (Optional) If you chose Master in Step 8, click **Specify additional options**, click **Next**, then fill in the fields:

   **Compression Level:** Specify the compression level you want to use for this multicast session:

   - **None:** No data compression is used. Data is sent immediately across the network to participating devices. You might use this option if the master device has a slow CPU; the amount of time to compress the data is eliminated and the data is immediately sent across the network. However, this option creates more network traffic than if you selected one of the other compression levels (**Speed**, **Balanced**, or **Size**).

   - **Speed:** Takes the least amount of time to compress the data before the data is sent across the network to participating devices. You might use this option if the master device has a slow CPU; the amount of time to compress the data is reduced before the data is sent across the network. With this option, however, the multicast session creates more network traffic than if you selected either the **Balanced** or **Size** compression level.

   - **Balanced:** Represents a compromise between data compression and the amount of network traffic that the multicast session creates.

   - **Size:** Takes the most amount of time to compress the data before sending it across the network to participating devices. You might use this option if the master device has a fast CPU. Using this option requires the most CPU resources to compress the data but creates less network traffic to transfer the data to the participating devices.

   **Automated Session:** Click **Enabled** to specify the number of participating devices (clients) that must register before starting the automated multicast session and to specify the amount of time, in minutes, that can expire without the number of participating devices to register before starting the automated multicast session. If you do not click the **Enabled** check box, you must manually start the multicast session.

10 Click **Next**, then click **Start session**.
You can cancel the session by clicking **Abort session > Yes > OK > Close**.

11 At each participating device, when the imaging is done, boot the device with the new operating system.

### 3.4 Configuring Imaging Script Bundles for ZENworks Imaging

[bug 484921] Imaging Script bundle can contain any ZENworks script (containing the general shell and ZENworks Imaging Engine commands) that you can run from the imaging maintenance mode prompt.

Using Configuration Management, you can install software by using a bundle. Software included in a bundle that is assigned directly is considered mandatory; the software is installed on all assigned devices (the bundle is directly assigned to the devices, their groups, or their folders).

To configure Imaging Script bundle and assign devices to the bundle:

1. In ZENworks Control Center, click **Bundles** in the left pane to display the Bundles panel.
2. Click **New > Bundle** to start the Create New Bundle Wizard.
3. Select **Preboot Bundle**, then click **Next**.
4. On the Select Bundle Category page, select **Imaging Script**, then click **Next** to display the Define Details page.
5. Fill in the fields:
   - **Bundle Name**: (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the Imaging Script bundles that are listed together in a folder.
   - **Folder**: Browse for the location where you want the Imaging Script bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon**: Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description**: Provide a description to help you later recognize the exact purpose of this Imaging Script bundle.
6. Click **Next** to display the Imaging script page.
7. Fill in the fields:
   - **Script Text**: Specify the text of the script. The script is restricted to doing preboot work prior to the device booting.
   - For information on using this bundle to perform scripted imaging, see “Using a Script to Image a Device” on page 102.
8. Click **Next** to display the Summary page.
9. Do the following:
   - If you want to perform other configuration tasks after the bundle has been created, select the **Define Additional Properties** check box.
For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.

- If you want to deploy the bundle as a sandbox version, ensure that Create As Sandbox check box is selected. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

10  Review the configuration, then click one of the following:

  **Back:** Allows you to make changes after reviewing the summary.

  **Finish:** Creates the Imaging Script bundle as configured per the settings listed on this Summary page.

This bundle is not assigned to any device or group after it is created until you make that assignment on a Relationships tab.

---

**IMPORTANT:** If this Preboot bundle has been created on a management device inside the firewall and you are assigning it to a device outside the firewall, port 8089 must be open both ways (PUBLIC -> PRIVATE, and PUBLIC <- PRIVATE).

When a device assigned to the Imaging Script bundle boots, the bundle’s work is performed on the device before its operating system starts. In the imaging maintenance mode, the script is downloaded as the zenAdvancedScript file in the /bin directory. Subsequently, you must execute the script in order to apply the bundle. You can execute the script by using the `sh /bin/zenAdvancedScript` command.

If you manually query for a task in the Maintenance mode, for a scripted bundle, after issuing a query by using the `img -a` command, then you need to convert the task script to UNIX format by running the `#dos2unix /bin/zenAdvancedScript` command. After the script is converted, you can complete the task.

This bundle is not assigned to any device or group after it is created until you make that assignment on a Relationships tab.

---

**IMPORTANT:** If this Preboot bundle has been created on a management device inside the firewall and you are assigning it to a device outside the firewall, port 8089 must be open both ways (PUBLIC -> PRIVATE, and PUBLIC <- PRIVATE).

When a device assigned to the Imaging Script bundle boots, the bundle’s work is performed on the device before its operating system starts. In the imaging maintenance mode, the script is downloaded as the zenAdvancedScript file in the /bin directory. Subsequently, you must execute the script in order to apply the bundle. You can execute the script by using the `sh /bin/zenAdvancedScript` command.

If you manually query for a task in the Maintenance mode, for a scripted bundle, after issuing a query by using the `img -a` command, then you need to convert the task script to UNIX format by running the `#dos2unix /bin/zenAdvancedScript` command. After the script is converted, you can complete the task.

### 3.5 Configuring the AutoYaST Bundle

An AutoYaST bundle contains the location and access protocol of an AutoYaST configuration file and network installation directory for SUSE Linux. This bundle allows you to launch an automated installation of SUSE Linux using Preboot Services.
To configure an AutoYaST bundle and assign devices to the bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3. Select Preboot Bundle, then click Next.
4. On the Select Bundle Category page, select AutoYaST Bundle, then click Next to display the Define Details page.
5. Fill in the fields:
   - **Bundle Name**: (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the AutoYaST bundles that are listed together in a folder.
   - For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.
   - **Folder**: Browse for the location where you want the AutoYaST bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon**: Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description**: Provide a description to help you later recognize the exact purpose of this AutoYaST bundle.
6. Click Next to display the Set AutoInstall Attributes page.
7. Configure the Preboot Environment:
   7a. Before configuring the Preboot environment, ensure that you have copied the RAM drive (initrd) and Linux kernel (linux) files from the SUSE Linux Enterprise Server (SLES) installation source to the /srv/tftp/ directory on your Imaging server. By default, the files are located in the /i386/boot/i386/loader/ directory in the SUSE Linux Enterprise Server installation source.
   7b. Configure the following Preboot Environment variables
      - **Linux Kernel Filename**: Specify the relative path of linux in the tftp directory. The path should be relative to the default directory of the TFTP daemon.
        For example, if the linux file is located in the /srv/tftp/autoyast/linux directory on your Imaging server, you must specify the path of the file as autoyast/linux.
      - **Initial RAM Drive Filename**: Specify the relative path of initrd in the tftp directory. The path should be relative to the default directory of the TFTP daemon.
        For example, if the initrd file is located in the /srv/tftp/autoyast/initrd directory on your Imaging server, you must specify the path of the file as autoyast/initrd.
      - **Additional Kernel Parameters**: Specify the additional kernel parameters that your Linux kernel might need. These are not Preboot Services or ZENworks parameters.
        You need to assign the MAXSECTOR parameter with the least starting sector number among all the available partitions.

**NOTE**: This parameter is applicable for any recent SUSE operating systems (such as SLES12 onwards). As the recent Linux installation takes first 100 or more sectors of the disk, this value needs to be set as part of the AutoYaST bundle configuration to avoid the ZISD being overwritten. Hence, after the first installation of SUSE, you need to find the MAXSECTOR value.

For example, consider the following partition details using fdisk -l:
In the above table, the least starting sector number among all the available partitions (sda1, sda2, and sda3) is 640. Hence, you need to specify MAXSECTOR=640. If this value is not specified, then the AutoYaST installation will overwrite the ZENworks Image Safe Data (ZISD) that is written in the lower sector ranges (starting from sector 5).

For more information about the kernel parameters, see your Linux documentation.

8 Configure the following settings to procure the linux installation source:

- **Protocol**: Select the protocol to be used to connect to the device that has the Linux installation source mounted. The available protocols are NFS, FTP, HTTP, or TFTP.
- **IP Address / DNS Name**: Specify the IP address or the DNS name of the device that has the Linux installation source mounted.
- **Path to Network Install Directory (Relative to Protocol)**: Specify the path of the Linux installation source. The path should be relative to the default directory of the selected protocol daemon.

For example, assume that the Linux installation source is located on a SLES 10 device in the `/sles10/SLES-10-SP3-GM/i386/boot/i386/loader/` directory. If you specify HTTP as the protocol, myserver.provo.novell.com as the DNS name, and `/sles10/sles-10-sp3-gm/i386/boot/i386/loader/` as the path, the URL to the installation directory is:

```
http://myserver.provo.novell.com/sles10/sles-10-sp3-gm/i386/boot/i386/loader/initrd
```

In this example, `/sles10/sles-10-sp3-gm/i386/boot/i386/loader/initrd` is relative to the protocol and server ID.

9 Click **Next**.

10 Configure the location of the AutoYaST script file and the settings required to access the file. You can either specify the script location or browse for and select the script. If the script file has system variables, you must choose the **Browse for Script** option to import and upload the file to the Primary Server whose ZENworks Control Center you are using so that the variables are automatically resolved while applying the bundle on the managed devices.

- **Specify Script Location**: Configure the following settings to access the script:

  - **Protocol**: Select the protocol to be used to access the AutoYaST script. The available protocols are NFS, FTP, HTTP, TFTP, or FILE.

    If you select the TFTP protocol, you must manually copy the AutoYaST XML file that you specify on this wizard page to the TFTP server.

    If you select the FILE protocol, you must manually copy the AutoYaST XML file that you specify on this wizard page in to the initial RAM drive file that you specified on the Set AutoInstall Attributes wizard page before executing the AutoYaST bundle.

    For example, if **initrd** is your initial RAM drive file and **autoyast.xml** is your AutoYaST XML file, perform the commands in the following tables:
### Table 3-2 Obtaining and Preparing the RAM Drive File

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cd /path_to_RAM_drive_file</td>
<td>Change to the directory where initrd exists.</td>
</tr>
<tr>
<td>cp initrd initrd.bak</td>
<td>Make a backup copy of your original RAM drive file (recommended).</td>
</tr>
<tr>
<td>mv initrd initrd.gz</td>
<td>Rename initrd to a temporary gzipped file.</td>
</tr>
<tr>
<td>gzip -d initrd.gz</td>
<td>Decompress the .gz file. This changes the initrd.gz filename back to initrd, but in an uncompressed mode.</td>
</tr>
<tr>
<td>mkdir temp</td>
<td>Create a temporary working directory.</td>
</tr>
<tr>
<td>file initrd</td>
<td>Determine which type of file system initrd is. If the type is cpio, perform the commands in Table 3-3, &quot;Updating a cpio File Type,&quot; on page 135; otherwise, perform the commands in Table 3-4, &quot;Updating a non-cpio File Type,&quot; on page 135.</td>
</tr>
</tbody>
</table>

**Table 3-3 Updating a cpio File Type**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cd temp</td>
<td>Move to the temporary directory.</td>
</tr>
<tr>
<td>cpio -idmuv &lt; ../initrd</td>
<td>Extracts cpio archive to the current directory.</td>
</tr>
<tr>
<td>cp /path_to_autoyast.xml_file/autoyast.xml</td>
<td>Copy your AutoYaST XML file to the temp directory.</td>
</tr>
<tr>
<td>find .</td>
<td>cpio -o -H newc &gt; ../initrd</td>
</tr>
<tr>
<td>cd ..</td>
<td>gzip -v9 initrd</td>
</tr>
<tr>
<td>mv initrd.gz initrd</td>
<td></td>
</tr>
</tbody>
</table>

**Table 3-4 Updating a non-cpio File Type**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mount -o loop initrd temp</td>
<td>Create a temp directory and mount the initial RAM drive file to temp.</td>
</tr>
<tr>
<td>cp autoyast.xml temp</td>
<td>Copy your AutoYaST XML file to the temp directory.</td>
</tr>
<tr>
<td>umount temp</td>
<td></td>
</tr>
<tr>
<td>gzip -v9 initrd</td>
<td>Return the initrd file back to its compressed state with the AutoYaST XML file in it.</td>
</tr>
<tr>
<td>mv initrd.gz initrd</td>
<td></td>
</tr>
</tbody>
</table>
After performing these commands, the initial RAM drive file (initrd) can be used with the AutoYaST XML file when this AutoYaST bundle is executed on the device.

- **IP Address / DNS Name**: Specify the IP address or DNS name of the device containing the AutoYaST script.

- **Script Name and Path (Relative to Protocol Default Directory)**: Specify the AutoYaST XML filename and its complete path. The path should be relative to the home directory of the selected protocol daemon.

  For example, if you specify HTTP as the protocol, myserver.provo.novell.com as the DNS name, and /scripts/autoyast.xml as the path and filename, the URL to the installation directory is:

  http://myserver.provo.novell.com/scripts/autoyast.xml

  In this example, /scripts/autoyast.xml is relative to the protocol and server ID.

- **Browse for Script**: Browse for the AutoYaST XML file, and upload it to the Imaging server:

  1. Click to display the Upload File dialog box.
  2. Click Browse to browse for and select the AutoYaST XML file.

     If the imported XML file has ZENworks system variables defined, the variables are resolved when the bundle is applied to the device.

  3. When you are prompted to upload the XML file to the Primary Server whose ZENworks Control Center you are using, click OK.

     The Status field displays the upload status.

  4. Click OK.

  5. (Optional) Modify the XML file content:

     a. Click Edit Script.

     The content of the XML file is displayed in the Edit AutoYaST XML File dialog box.

     b. Edit the script content.

        You can also specify ZENworks system variables in the script. For more information, see Section 3.12.2, “Managing Bundle Variables,” on page 154.

     c. Click Save.

11 Click Next to display the Summary page.

12 Do the following:

   - If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.

     For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.

   - If you want to deploy the bundle as a sandbox version, ensure that Create As Sandbox check box is selected. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

13 Review the configuration, then click one of the following:

   - **Back**: Allows you to make changes after reviewing the summary.
   - **Finish**: Creates the AutoYaST bundle as configured per the settings listed on this Summary page.
3.6 Configuring the Kickstart Bundle

A Kickstart bundle contains the location and access protocol of an KickStart configuration file for Red Hat Linux. This bundle allows you to launch an automated installation of Red Hat Linux using Preboot Services.

To configure a Kickstart bundle and assign devices to the bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3. Select Preboot Bundle, then click Next.
4. On the Select Bundle Category page, select Kickstart, then click Next to display the Define Details page.
5. Fill in the fields:
   - **Bundle Name**: (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the Kickstart bundles that are listed together in a folder. For more information, see "Naming Conventions in ZENworks Control Center" in the ZENworks Control Center Reference.
   - **Folder**: Browse for the location where you want the Kickstart bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon**: Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description**: Provide a description to help you later recognize the exact purpose of this Kickstart bundle.
6. Click Next to display the Set AutoInstall Attributes page.
7. Configure the following settings for a Kickstart script bundle to be used to automate a Red Hat installation. When the device boots, the Kickstart bundle is executed before the operating system boots. Preboot Services cannot control what might happen if the Kickstart bundle has errors in it:
   7a. Before configuring the Preboot environment, ensure that you have copied the kernel and RAM drive files from the Red Hat Enterprise Linux installation source to the /srv/tftp/kickstart/ on your Imaging server. By default, the kernel file (vmlinuz) and the RAM drive file (initrd.img) are located in the /isolinux directory in the Red Hat Enterprise Linux installation source.
   7b. Configure the following Preboot environment:
      - **Linux Kernel Filename**: Specify the relative path of vmlinuz in the tftp directory. The path should be relative to the default directory of the TFTP daemon.
        For example, if vmlinuz is located in the /srv/tftp/kickstart/ directory on your Imaging server, you must specify the path of the file as kickstart/vmlinuz.
      - **Initial RAM Drive Filename**: Specify the relative path of initrd.img in the tftp directory. The path should be relative to the default directory of the TFTP daemon.
        For example, if initrd.img is located in the /srv/tftp/kickstart/ directory on your Imaging server, you must specify the path of Linux kernel file as kickstart/initrd.img.
      - **Additional Kernel Parameters**: Specify the additional kernel parameters that your Linux kernel might need. These are not Preboot Services or ZENworks parameters. They are parameters that your Linux kernel needs.
You need to assign the MAXSECTOR parameter with the least starting sector number among all the available partitions.

**NOTE:** This parameter is applicable for any recent RHEL operating systems (such as RHEL7). As the recent Linux installation takes first 100 or more sectors of the disk, this value needs to be set as part of the Kickstart bundle configuration to avoid the ZISD being overwritten. Hence, after the first installation of RHEL, you need to find the MAXSECTOR value.

For example, consider the following partition details using `fdisk -l`:

<table>
<thead>
<tr>
<th>Device</th>
<th>Start</th>
<th>End</th>
<th>Blocks</th>
<th>Id</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>/dev/sda1</td>
<td>2048</td>
<td>4208639</td>
<td>2103296</td>
<td>82</td>
<td>Linux swap / Solaris</td>
</tr>
<tr>
<td>/dev/sda2</td>
<td>4208640</td>
<td>83886079</td>
<td>39838720</td>
<td>83</td>
<td>Linux</td>
</tr>
<tr>
<td>/dev/sda3</td>
<td>640</td>
<td>2047</td>
<td>720</td>
<td>83</td>
<td>Linux</td>
</tr>
</tbody>
</table>

In the above table, the least starting sector number among all the available partitions (sda1, sda2, and sda3) is 640. Hence, you need to specify MAXSECTOR=640. If this value is not specified, then the Kickstart installation will overwrite the ZENworks Image Safe Data (ZISD) that is written in the lower sector ranges (starting from sector 5).

For more information about the kernel parameters, see your Linux documentation.

Configure the location of the Kickstart configuration file, and the settings required to access the file. You can either specify the file location or browse for and select the file. If the configuration file has system variables, you must choose the **Browse for Script** option to import and upload the file to the Primary Server whose ZENworks Control Center you are using as the variables are automatically resolved while applying the bundle on the managed devices.

- **Specify Script Location:** Configure the following settings to access the configuration file:
  - **Protocol:** Select the protocol to be used to access the device containing the Kickstart configuration file. The available protocols are **NFS** and **HTTP**.
  - **Script Name and Path (Relative to Protocol Default Directory):** Specify the Kickstart configuration filename and its complete path. The path should be relative to the home directory of the selected protocol daemon.
    
    For example, if you specify HTTP as the protocol, `myserver.provo.novell.com` as the DNS name, and `/config/ks.cfg` as the complete path of the configuration file, the URL to the installation directory is:
    
    `http://myserver.provo.novell.com/config/ks.cfg`
    
    In this example, `/config/ks.cfg` is relative to the protocol and server ID.

- **Browse for Script:** Browse for the Kickstart configuration file, and upload it to the Imaging server.
  1. Click ![Upload File](image) to display the Upload File dialog box.
  2. Click **Browse** to browse for and select the Kickstart configuration file (.cfg).
    
    If the imported XML file has ZENworks system variables defined, the variables are resolved when the bundle is applied to the device.
  3. When you are prompted to upload the file to the Primary Server whose ZENworks Control Center you are using, click **OK**.
The Status field displays the upload status.

4. Click OK.

5. (Optional) Modify the configuration file content:
   a. Click Edit Script.
      The content of the configuration file is displayed in the Edit Kickstart File dialog box.
   b. Edit the script content, then click Save.
      You can also specify ZENworks system variables in the script. For more information, see Section 3.12.2, “Managing Bundle Variables,” on page 154.

8 Click Next to display the Summary page.

9 Do the following:
   - If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.
     For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.
   - If you want to deploy the bundle as a sandbox version, ensure that Create As Sandbox check box is selected. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

10 Review the configuration, then click one of the following:
   - Back: Allows you to make changes after reviewing the summary.
   - Finish: Creates the Kickstart bundle as configured per the settings listed on this Summary page.

### 3.7 Using Dell Configuration Bundles

When a server boots, the ZENworks Dell Configuration bundle is executed on the server before the operating system boots. The Dell Configuration bundle is used in server provisioning to do the following:

- Use scripts and files to configure the BIOS, BMC, RAID, and DRAC
- Install a Dell utility partition
- Overwrite an existing Dell utility partition
- Update the files in an existing Dell utility partition
- Execute another Preboot bundle to install an operating system after updating the Dell device

For more information on the Dell OpenManage Deployment Toolkit (DTK), see the guides (dtk20cli.pdf and dtk20ug.pdf) contained in the DTK download.

In using Dell Configuration bundles, you should first create the Dell Configuration scripts and files, if they are needed, then create the Dell Configuration bundle:

**IMPORTANT:** If a newer version of the DTK is available from Dell, and you want to use it for your Dell Configuration bundle work, see Appendix G, “Dell DTK,” on page 315 for instructions on updating the DTK.
3.7.1 Creating Dell Configuration Scripts and Files

When you create a Dell Configuration bundle you might need specialized scripts or files to already exist, depending on which settings you employ in the bundle. Novell recommends that you follow the instructions in the Dell DTK documentation to create the necessary configuration files and scripts.

To help do this, ZENworks provides the Dell DTK (Maintenance Mode) option when booting a Preboot Services Imaging CD, which provides a complete DTK environment where configuration scripts and files can be created and tested. This environment is identical to the environment provided by booting the Dell DTK CD, but includes additional configuration information needed for placing files and scripts on the ZENworks servers.

After you create them, you need to copy all of the scripts and files to be used in the Dell Configuration bundle to the ZENworks TFTP server. You will need to do this before you reboot the device that you used to create the scripts and files, because the scripts and files are created in a RAM drive, which is replaced in rebooting.

The DTK environment provides a TFTP client utility that allows you to upload your configuration files directly to your ZENworks servers, because the Dell DTK (Maintenance Mode) also provides an environment variable ($TFTPIP) that always resolves to the IP address of the TFTP service on the ZENworks server.

To create the scripts and files that you might need when creating a Dell Configuration bundle:

- “Creating a BIOS or BMC Configuration File” on page 140
- “Creating a DRAC 5 Configuration File” on page 141
- “Creating a RAID Configuration Script” on page 142

**IMPORTANT:** In the aforementioned sections you are instructed to upload files to your ZENworks TFTP server. Because this is not enabled by default, you must first configure TFTP before attempting to upload those files.

Creating a BIOS or BMC Configuration File

1. Make sure the novell-proxydhcp daemon is running on a server in your network.
   This service must be available so that the device’s PXE can access files from the ZENworks server, such as the Preboot Services Menu and Dell DTK (Maintenance Mode).
2. Boot a Dell device that is PXE-enabled and press the Ctrl-Alt keys during booting.
   Press these keys when a string starting with "Novell ..." is displayed during the boot process.

**IMPORTANT:** Choose the correct device to boot for creating the BIOS or BMC file. The devices to receive the update must be the same as the device you are using to configure the file. For example, if the boot device is a Dell 2950, then the configured file can only be used to update other Dell 2950 devices.

3. When the bash (#) prompt is displayed, auto-generate the file using the following command:

   ```
   syscfg -o BIOS-BMC_filename
   ```

   where BIOS-BMC_filename is the name of the BIOS or BMC file to be used.

**WARNING:** Do not reboot the device at this time, because the file you created is in a RAM drive. (You can safely reboot after you upload the file to the TFTP server.)
4. Upload the configuration file to a location relative to the TFTP directory on the ZENworks Imaging server by using the following command:

```
tftp -l local_BIOS_BMC_filename_and_path -r remote_BIOS_BMC_filename -p $TFTPIP
```

In this command, `local_BIOS_BMC_filename_and_path` is the complete path and filename of the BIOS or BMC configuration file that you provided when running `syscfg`, `remote_BIOS_BMC_filename` is the name with which the configuration file must be uploaded to your ZENworks Imaging server, and `$TFTPIP` is the IP address of the ZENworks Imaging Server.

The remote file is uploaded to a path that is relative to the TFTP directory of the Imaging server because the DellDTK Configuration bundle is designed to look for files relative to the TFTP directory.

5. Continue with the appropriate section:

- “Creating a DRAC 5 Configuration File” on page 141
- “Creating a RAID Configuration Script” on page 142
- “Configuring the DellDTK Configuration Bundle” on page 142

### Creating a DRAC 5 Configuration File

1. Make sure the novell-proxydhcp daemon is running on a server in your network.
   This service must be available so that the device’s PXE can access files from the ZENworks server, such as the Preboot Services Menu and Dell DTK (Maintenance Mode).

2. Boot a Dell device that is PXE-enabled and press the Ctrl-Alt keys during booting.
   Press these keys when a string starting with "Novell ..." is displayed during the boot process.

   **IMPORTANT:** Choose the correct device to boot for creating the DRAC 5 file. The devices to receive the update must be the same as the device you are using to configure the file. For example, if the boot device is a Dell 2950, then the configured file can only be used to update other Dell 2950 devices. In Dell 9G devices, DRAC 5 is included in the BIOS, rather than a separate file.

3. Run the `raccap.sh` script located at `/opt/dell/toolkit/template/scripts/`.

4. Specify a name for the configuration file.

5. Upload the configuration file to a location relative to the TFTP directory on the ZENworks Imaging server by using the following command:

```
tftp -l local_DRAC_configuration_filename_and_path -r remote_DRAC_filename -p $TFTPIP
```

In this command, `local_DRAC_configuration_filename_and_path` is the complete path and filename of the DRAC 5 configuration file that you provided when running the `raccap.sh` script, `remote_DRAC_filename` is the name with which the configuration file must be uploaded to your ZENworks Imaging server, and `$TFTPIP` is the IP address of the ZENworks Imaging Server.

The remote file is uploaded to a path that is relative to the TFTP directory of the Imaging server because the DellDTK Configuration bundle is designed to look for files relative to the TFTP directory.

6. Continue with the appropriate section:

- “Creating a RAID Configuration Script” on page 142
- “Configuring the DellDTK Configuration Bundle” on page 142
Creating a RAID Configuration Script

This bundle option only configures RAID; it cannot be used to update it.

1. Make sure the novell-proxydhcpc daemon is running on a server in your network.
   This service must be available so that the device’s PXE can access files from the ZENworks server, such as the Preboot Services Menu and Dell DTK (Maintenance Mode).

2. Boot a Dell device that is PXE-enabled and press the Ctrl-Alt keys during booting.
   Press these keys when a string starting with "Novell ..." is displayed during the boot process.

   **IMPORTANT:** Choose the correct device to boot for creating the RAID script. The devices to receive the update must be the same as the device you are using to configure the script. For example, if the boot device is a Dell 2950, then the configured script can only be used to update other Dell 2950 devices.

3. When the bash (#) prompt is displayed, to edit the following sample script file, first make a copy of it where you have editing rights:

   ```bash
   cp -a /opt/dell/toolkit/template/scripts /tmp
   ```

   then to edit the copy:

   ```bash
   vi /temp/scripts/raidcfg.sh
   ```

   Modify the file as needed, then save the changes. You can save the file using any filename; however, the filename you save it as must be provided in the Dell Configuration bundle. Therefore, if you save to a different name, make a note of it.

   **WARNING:** Do not reboot the device at this time, because the script you created is in a RAM drive. (You can safely reboot after you upload the script to the TFTP server.)

4. Upload the configuration file to a location relative to the TFTP directory on the ZENworks Imaging server by using the following command:

   ```bash
   tftp -l local_RAID_filename_and_path -r remote_RAID_filename -p $TFTPIP
   ```

   In this command, `local_RAID_filename_and_path` is the complete path and name of the edited `raidcfg.sh` file, `remote_RAID_filename` is name with which the configuration file must be uploaded to your ZENworks Imaging server, and `$TFTPIP` is the IP address of the ZENworks Imaging Server.

   The remote file is uploaded to a path that is relative to the TFTP directory of the Imaging server because the DellDTK Configuration bundle is designed to look for files relative to the TFTP directory.

5. Continue with “Configuring the DellDTK Configuration Bundle” on page 142.

### 3.7.2 Configuring the DellDTK Configuration Bundle

The DellDTK Configuration bundle contains the location of files and scripts for configuring Dell servers. This bundle allows you to use Preboot Services to configure the BIOS, BMC, RAID, and DRAC for settings and to create a new Dell Utility partition. You can also identify another Preboot bundle to be run immediately after these configurations have completed.

To configure a DellDTK Configuration bundle and assign devices to the bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3 Select Preboot Bundle, then click Next.

4 On the Select Bundle Category page, select DellDTK Configuration, then click Next to display the Define Details page.

5 Fill in the fields:
   - **Bundle Name:** (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the DellDTK Configuration bundles that are listed together in a folder. For more information, see Naming Conventions in ZENworks Control Center in the ZENworks Control Center Reference.
   - **Folder:** Browse for the location where you want the DellDTK Configuration bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.
   - **Icon:** Browse for and select an icon if you plan to use one on your desktop for this bundle.
   - **Description:** Provide a description to help you later recognize the exact purpose of this DellDTK Configuration bundle.

6 Click Next to display the Dell Config Bundle Options page.

7 Configure the following settings to create a Dell Configuration bundle:

   7a **Configure the Configuration Scripts:**
      - **BIOS/BMC/DRAC 5 Configuration File:** Specify the path and filename of the BIOS, BMC (Base Management Controller), or DRAC 5 (Dell Remote Access Controller 5) configuration file. The path must be relative to the TFTP server's home directory. Do not specify the tftp directory or any of the path that precedes it.

      **NOTE:** This bundle option configures the BIOS, BMC, or DRAC 5 only; it cannot be used to update them. This option is applicable only for the Dell devices that support the DRAC 5 card.

      - **RAID Configuration Script:** Specify the path and filename of the RAID configuration script relative to the TFTP server's home directory. Do not specify the TFTP directory or any of the path that precedes it.

      - **DRAC Configuration Script:** Specify the DRAC path and filename of the configuration file relative to the TFTP server's home directory. Do not specify the tftp directory or any of the path that precedes it. This option is applicable for the Dell devices that support DRAC card versions prior to version 5.

      For information on how to create these files, see Section 3.7.1, “Creating Dell Configuration Scripts and Files,” on page 140.

    7b (Conditional) To create a new Dell utility partition, select the Create Dell Utility Partition check box, then fill in the fields.

       **WARNING:** If you use this option, all the existing partitions on the target disk are replaced by the Dell utility partition. However, you can select the Overwrite Existing Dell Utility Partition check box to only update an existing Dell utility partition. In that case, all existing partitions are retained and the Dell server diagnostics utility files are written to the existing Dell utility partition using the entry that you provide in the File option.

       You cannot use a ZENworks partition for the same purpose as the Dell utility partition. However, both a Dell utility partition and a ZENworks partition can exist on the same server, with each partition being used for its own purposes.

       - **Partition Size:** This partition requires 32 MB for the Dell server diagnostics utilities. This option is only used when creating a new Dell utility partition.
• **Target Disk:** This is the disk's identifier, such as /dev/hda. This ID is used to determine the disk for creating the new partition, or for updating an existing partition.

• **File:** Specify the path to the Dell utility partition file. The path must be relative to the TFTP server's home directory.

  The file is written to the partition in the process of creating a new partition or when updating an existing partition.

  Dell utility partition files are available on the Dell Installation and Server management CD. For example, for a PowerEdge 1850 system, the file is at d:\server_assistant\pe1850\upimg.bin. Copy the necessary files from the CD to a path relative to the TFTP server's home directory for use in this option.

• **Overwrite Existing Dell Utility Partition:** If a Dell utility partition already exists on the selected target disk, select this check box to update the partition with the latest utility files instead of replacing the partition.

8 Click Next to display the Summary page.

9 Do the following:

  • If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.

    For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.

  • If you want to deploy the bundle as a sandbox version, select the Create As Sandbox check box. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

10 Review the configuration, then click one of the following:

  Back: Allows you to make changes after reviewing the summary.

  Finish: Creates the Dell DTK Configuration bundle as configured per the settings listed on this Summary page.

### 3.8 Configuring MDT Deployment Bundles

The MDT Deployment bundle supports the deployment of the Windows operating system using Microsoft Deployment Toolkit (MDT). The supported version is Microsoft Deployment Toolkit (MDT) 2013 Update 2. The uploaded MDT content will be replicated to the selected Primary and Imaging Satellite Servers.

To configure an MDT Deployment bundle and assign devices to the bundle:

1 In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.

2 Click New > Bundle to start the Create New Bundle Wizard.

3 Select Preboot Bundle, then click Next.

4 On the New Bundle Category page, select MDT Deployment, then click Next to display the Define Details page.

5 Fill in the fields:

  **Bundle Name:** (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the MDT Deployment bundles that are listed together in a folder.

  For more information, see "Naming Conventions in ZENworks Control Center" in the ZENworks Control Center Reference.
Folder: Browse for the location where you want the MDT Deployment bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.

Icon: Browse for and select an icon if you plan to use one on your desktop for this bundle.

Description: Provide a description to help you later recognize the exact purpose of this MDT Deployment bundle.

6 Click Next to display the MDT Deployment page.

To select the MDT WIM image that has to be used in this imaging bundle, based on whether it is a 32-bit or 64-bit file, upload the WIM image in the relevant section.

7 Fill in the fields:

- **32-bit MDT:** Upload the 32-bit WIM image, in the Upload a New MDT Image section. Click the browse icon, and select and upload the WIM image.
- **64-bit MDT:** Upload the 64-bit WIM image, in the Upload a New MDT Image section. Click the browse icon, and select and upload the WIM image.

**NOTE:** To upload the image, ensure that Microsoft Windows Assessment and Deployment Kit (WADK) is installed on the device running ZENworks Control Center. You can download WADK from the [Microsoft Download Center website](https://www.microsoft.com/en-us/download/details.aspx?id=13775).

8 Click Next to display the Summary page.

9 Do the following:

- If you want to perform other configuration tasks after the bundle has been created, select the Define Additional Properties check box.
  
  For example, you can make assignments to the bundle in the Relationships tab, add actions in the Actions tab, and so on.

- If you want to deploy the bundle as a sandbox version, ensure that Create As Sandbox check box is selected. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

10 Review the configuration, then click one of the following:

- Back: Allows you to make changes after reviewing the summary.
- Finish: Creates the MDT Deployment bundle.

The `zman betf` and `zman bc` commands are not supported for MDT Deployment bundles and for Preboot bundles containing an MDT Deployment Action.

### 3.8.1 Content Replication for MDT Deployment Action

The replication behavior for the content associated with the MDT Deployment Action is different from other bundle types in ZENworks.
### Scenario | Replication Behavior
--- | ---
Create a new MDT Deployment bundle | **Primary Servers**
The bundle inherits the content replication setting established for the Management Zone (Configuration > Management Zone Settings > Content > Primary Server Replication) or the bundle folder, if the settings have been overridden.

To include or exclude servers for replication for the current bundle:
1. Click the bundle.
2. Click **Settings** > Primary Server Replication.
3. Select the required servers and click **Include or Exclude** as needed.

**Satellite Servers**
The content is not replicated to any of the Imaging Satellite Servers in the zone. You need to explicitly include the Imaging Satellite Servers on which the current bundle content needs to be replicated.

To include Imaging Satellite Servers:
1. Click the bundle.
2. Click **Settings** > Satellite Server Replication.
3. Select the required Imaging Satellite Servers and click **Include**.

Create a new MDT Deployment bundle as a sandbox | **Primary Servers**
The content is replicated only to the Primary Server from which the bundle content was uploaded via ZENworks Control Center.

**Satellite Servers**
The content is not replicated to any of the Imaging Satellite Servers in the zone.

Edit an existing MDT Deployment Action in a Preboot bundle of any category or add an MDT Deployment action to a non-MDT Deployment Preboot bundle and create a sandbox version of the bundle | **Primary Servers**
The content is replicated only to the Primary Server from which the bundle content was uploaded using ZENworks Control Center.

**Satellite Servers**
The content is not replicated to any of the Imaging Satellite Servers in the zone.

Edit an existing MDT Deployment Action in a Preboot bundle of any category or add an MDT Deployment Action to a non-MDT Deployment Preboot bundle and publish it as new version. | **Primary Servers**
The content replication setting of the previous published version is inherited.

To include or exclude servers for replication for the new version:
1. Click the bundle.
2. Click **Settings** > Primary Server Replication.
3. Select the required servers and click **Include or Exclude** as needed.

**Satellite Servers**
The content replication setting of the previous published version is inherited.

To include or exclude servers for replication for the new version:
1. Click the bundle.
2. Click **Settings** > Satellite Server Replication.
3. Select the required Imaging Satellite Servers and click **Include or Exclude** as needed.
<table>
<thead>
<tr>
<th>Scenario</th>
<th>Replication Behavior</th>
<th>Satellite Servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit an existing MDT Deployment Action in a Preboot bundle of any</td>
<td>The new bundle inherits the content replication setting of the published version of the original bundle.</td>
<td>The new bundle inherits the content replication setting of the published version of the original bundle.</td>
</tr>
<tr>
<td>category or add an MDT Deployment action to a non-MDT Deployment</td>
<td>To include or exclude servers for replication for the new bundle:</td>
<td>To include or exclude servers for replication for the new bundle:</td>
</tr>
<tr>
<td>Preboot bundle and publish it as a new bundle (not as a sandbox)</td>
<td>1. Click the new bundle.</td>
<td>1. Click the new bundle.</td>
</tr>
<tr>
<td></td>
<td>2. Click Settings &gt; Primary Server Replication.</td>
<td>2. Click Settings &gt; Satellite Server Replication.</td>
</tr>
<tr>
<td></td>
<td>3. Select the required servers and click Include or Exclude as needed.</td>
<td>3. Select the required Imaging Satellite Servers and click Include or Exclude as needed.</td>
</tr>
<tr>
<td>Edit an existing MDT Deployment Action in a Preboot bundle of any</td>
<td>The content is replicated only to the Primary Server from which the bundle content was uploaded using ZENworks Control Center.</td>
<td>The content is not replicated to any of the Imaging Satellite servers in the zone.</td>
</tr>
<tr>
<td>category or add an MDT Deployment action to a non-MDT Deployment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preboot bundle and publish it as a new bundle with Create as Sandbox</td>
<td></td>
<td></td>
</tr>
<tr>
<td>option selected:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Content Extraction:** After the replication of the MDT content completes, it is then extracted to the `tftp\mdt` directory on the included servers. The extraction status can be viewed in the **Extracted** column on the following page:

**Primary Servers:** Bundle > Settings > Primary Server Replication

**Satellite Servers:** Bundle > Settings > Satellite Server Replication

The tick icon indicates that the content has been extracted to the specified folder. Only after the content is extracted successfully, the bundle will be available for use.

**NOTE:** The files under the `tftp\mdt` directory will not be replicated during the TFTP Directory Replication.

### 3.8.2 MDT Deployment Functionality

Currently, only PXE Auto mode is supported as the boot mechanism for MDT Deployment. On PXE boot, when the device queries for imaging work, the MDT Deployment environment is booted based on the architecture of the device:

**BIOS Devices**

- All BIOS Virtual Machines will boot only 32-bit MDT WIM.
- 32-bit BIOS hardware will boot the 32-bit MDT WIM

If the applied bundle does not have a 32-bit MDT WIM, then the **Expected 32-Bit MDT wim not uploaded** error message is displayed on the device and the **Message Log** of the corresponding bundle and device page in ZENworks Control Center.
• 64-bit BIOS hardware will boot the 64-bit MDT WIM

For a 64-bit BIOS hardware, if the applied MDT bundle contains only a 32-bit MDT WIM, it will boot the 32-bit WIM.

UEFI Devices

• 32-bit UEFI devices (hardware and virtual machines) will boot the 32-bit MDT WIM

If the applied bundle does not have a 32-bit MDT WIM, then the **Expected 32-Bit MDT wim not uploaded** error message is displayed on the device and the **Message Log** of the corresponding bundle and device page in ZENworks Control Center.

• 64-bit UEFI devices (hardware and virtual machines) will boot the 64-bit MDT WIM

If the applied bundle does not have a 64-bit MDT WIM, then the **Expected 64-Bit MDT wim not uploaded** error message is displayed on the device and the **Message Log** of the corresponding bundle and device page in ZENworks Control Center.

3.9 ISDTool

The ISDTool is a standalone tool that enables you to send success and error status messages for the tasks.

Download the ISDTool 32-bit or 64-bit from ZENworks Download page (https://zenworks_server_IP_address:port/zenworks-setup) under Imaging Tools.

The following commands are supported ISDTool commands:

• **ISDTool mdt 4 taskReturnCode [rebootoff]**: This command is used to indicate the failure of the MDT Deployment Action in the Preboot bundle.
  
  taskReturnCode - The return code for the MDT Deployment task. Specify a number.

  [rebootoff] - This is an optional parameter. When specified, the device will not reboot. If [rebootoff] is not specified, by default, after sending the status for the final task, the device will reboot.

  The following commands can be used to send status messages for the intermediate tasks in the MDT Task Sequence:

  • **ISDTool mdt e “error status message”** - Specify the error status message that you want to send to the server.

  • **ISDTool mdt s “success status message”** - Specify the success status message that you want to send to the server.

  • **d “Dumps image safe data.”**

  • **w [taskstate] [taskcode]**: Writes task state and task return code to image safe data.

  • **[cleandisk] <disk index>**: Clears the MBR table (sector 0) of the disk.

  • **[cleandisk] <disk index> [startsector] [count]**: Cleans {count} sectors in the disk starting from [startsector].

  The following commands are applicable only for MDT deployment:

  • **[mdt] [taskstate] [taskretcode] [<rebootoff>]** : Sends MDT task state and task return code to ZENworks server. Supported value for [taskstate] is 4. [<rebootoff>] flag is optional.

  • **[mdt] [e] [error message]**: Sends MDT error message to ZENworks server.

  • **[mdt] [s] [success message]**: Sends MDT success message to ZENworks server.
3.10 Assigning Preboot Bundles

IMPORTANT: If you are assigning a Preboot bundle that has been created on a management device inside the firewall to a device outside the firewall, port 8089 must be open both ways (PUBLIC -> PRIVATE, and PUBLIC <- PRIVATE).

You can assign a bundle from the Devices or Bundles tabs, assign devices to bundle groups, and assign bundles to non-registered devices:

- Section 3.10.1, “Using the Devices Tab to Assign Bundles,” on page 149
- Section 3.10.2, “Assigning Devices to Bundle Groups,” on page 149
- Section 3.10.3, “Using the Bundles Tab to Assign Bundles,” on page 150
- Section 3.10.4, “Assigning Bundles to Non-Registered Devices,” on page 151

### 3.10.1 Using the Devices Tab to Assign Bundles

1. In ZENworks Control Center, in the left panel, click Devices.
2. In the Devices panel, click Servers or Workstations, select the check boxes of one or more servers or workstations, click Action, then select Assign Bundle.
   
   This starts the Assign Bundle Wizard.
3. In the Select Objects dialog box, select the bundle to be assigned, then click OK to display the Bundles to be Assigned page.
4. Click Add as necessary to include the desired bundles.
5. In the Shortcut Location section, make sure all check boxes are deselected.
   
   Preboot bundles do not use shortcut locations.
6. Click Next to display the Summary page.
7. Review the configuration, then click one of the following:
   
   | Back: Allows you to make changes after reviewing the summary. |
   | Finish: Click to make the assignments. |
8. If you’ve assigned a ZENworks Image bundle to the device, do the following:
   
   - 8a Select the check box next to the device to which you assigned the ZENworks Image bundle.
   - 8b Click Action > Apply Assigned Imaging Bundle.

When devices assigned to this Preboot bundle boot, they are imaged from the image contained in the bundle.

### 3.10.2 Assigning Devices to Bundle Groups

1. In ZENworks Control Center, click Devices in the left pane to display the Devices panel in the Managed tab.
2. In the Name column, click Servers or Workstations, then select the check boxes next to the devices to be assigned.
3. Click Action > Add to Group to open the Add to Group Wizard:
4 Click **Next** to add to an existing group to display the Targets page:
For information on adding to a new group, see “Creating Bundles” in the *ZENworks Software Distribution Reference*.
5 Click **Add** to open the Select Groups dialog box.
6 Select the groups and click **OK**.
7 Repeat this step as necessary to include the desired groups, then click **Next** to display the Summary page.
8 Review the configuration, then click one of the following:
   - **Back**: Allows you to make changes after reviewing the summary.
   - **Finish**: Click to make the assignments.
9 If you've assigned a ZENworks Image bundle to the devices, do the following:
   9a Select the check box next to the devices to which you assigned the ZENworks Image bundle.
   9b Click **Action > Apply Assigned Imaging Bundle**.
When devices assigned to any assigned Bundle Group boot, they are imaged from the image contained in the Preboot bundle that is assigned to the group.

### 3.10.3 Using the Bundles Tab to Assign Bundles

To assign a bundle to devices or bundle groups:
1 In ZENworks Control Center, click **Bundles** in the left pane to display the Bundles panel.
2 In the **Name** column, click the bundle to be assigned to open its properties.
3 Click the **Relationships** tab.
4 To assign the bundle to devices, in the Device Assignments panel, click **Add**, then do the following:
   4a In the Select Objects dialog box, select the devices to be assigned, then click **OK** to display the Devices to be Assigned page:
   4b Click **Add** as necessary to include the desired devices.
   4c In the Shortcut Location section, make sure all check boxes are deselected.
   Preboot bundles do not use shortcut locations.
   4d Click **Next** to display the Summary page.
   4e Click **Finish** to complete the assignment.
   4f Repeat these steps until all of the desired devices have been assigned to the bundle.
5 To assign the bundle to bundle groups, in the Bundle Groups panel, click **Add**, in the Select Groups dialog box, browse for and select the groups, then click **OK**.
The Bundle Groups the Preboot bundle is assigned to are listed in this panel. Repeat clicking **Add** until the Preboot bundle has been assigned to all of the desired Bundle Groups.
When devices assigned to this Bundle Group boot, they are imaged from the image contained in the Preboot bundle that is assigned to the group.
### 3.10.4 Assigning Bundles to Non-Registered Devices

1. In ZENworks Control Center, click Configuration in the left pane to display the Configuration tab, if it’s not expanded, click Management Zone Settings.

2. Click Device Management to expand its listing, then select Preboot Services.

3. If necessary, expand the Device Imaging Work Assignment section, then click Add in the Hardware Rules section to open the Rules Construction dialog box.

4. In the Bundle to Apply field, browse for and select the desired Preboot bundle.

5. Fill in remaining the fields to configure the type of device that you want to image in the multicast session.

   For more information on the Rule Construction dialog box, see “Rule Construction” on page 78.

6. Click Apply at the bottom of the Preboot Services section to save the non-registered device settings.

   When devices fulfilling the requirements that you defined in these steps boot, they are imaged from the image contained in the selected Preboot bundle.

7. To enable the multicast session, continue with “Enabling or Disabling a Multicast Image Set Bundle” on page 126.

### 3.11 Editing Imaging Work

The Edit Imaging Work page allows you to view all images that have been recently applied to the selected device, and the image that is currently assigned (known as its “effective” image).

To edit a server’s or workstation’s Preboot Services work:

1. In ZENworks Control Center, click Devices in the left pane to display the Devices panel in the Managed tab.

2. In the Name column, click Servers or Workstations to display the devices.

3. Click a device.

   The Summary tab should display. If not, select it.

4. In the Imaging Work section, click Advanced to start the Edit Imaging Work Wizard.

5. In the Imaging Work section, select one of the following from the drop-down list for the Scheduled Work field:

   - **Do Nothing:** Review the image files:
     - The Applied Image Files section displays the image files most recently applied to the device.

   - **Apply Assigned Imaging Bundle:** Select a bundle in the Bundle field:
     - **Bundle:** Select or specify the bundle. Its bundle name, folder, and description are displayed.

     The Bundle field displays the currently effective bundle. You can select the bundle to apply from the drop-down list, which changes the effective bundle for the device, then click OK.

     If you’ve assigned a ZENworks Image bundle to a device, do the following:

     1. Click the Devices tab.

     2. Click Servers or Workstations.

     3. Select the check box next to the device to which you assigned the bundle.

     4. Click Action > Apply Assigned Imaging Bundle.
The next time the device boots, or when you manually apply a Preboot bundle (such as from a ZENworks imaging CD, DVD or bootable USB), the selected bundle is applied.

**IMPORTANT:** In order to have bundles to select, the administrator user that you are logged in as must have rights to modify devices and to apply bundles. For more information on administrator rights, see “Rights Descriptions” in the ZENworks Administrator Accounts and Rights Reference.

**NOTE**
- When multiple bundles are assigned, only the first bundle in the **Bundle** drop-down list is applied to the device.
- You can change the effective bundle assignment to the device by altering the order of the bundles in the **Bundle** drop-down list.

- **Apply Rule-Based Imaging Bundle:** This assigns the device to be imaged if it matches any Preboot bundle that is based on rules.
- **Take an Image:** Fill in the fields:
  - **Image Format:** Select the format of the image to be applied.
  - **Server and Path of New Image File:** Browse for or enter the full path to where you want the image file saved. This option is displayed only for the ZENworks Image format.
  - **Shared Network Path for Image File:** Specify the shared-network path where you want to save the .wim or .gho files. The directory must be a Windows share or a Linux CIFS or SMB share, and you must have the Write permission to it. If the Novell File Upload extension is not installed on the device, you must install it before you can browse to and upload the file. This option is displayed only for the Windows Imaging Format (.wim).
  - **Image Filename** Specify the filename to save the .wim or .gho file. This option is displayed only for the Windows Imaging Format (.wim) and Ghost Imaging Format (.gho).
  - **Network Credential:** Click to browse for and select the network credentials to be used for accessing the device that has .wim or .gho files. This option is displayed only for the Windows Imaging Format (.wim) and Ghost Imaging Format (.gho).
  - **Image Compression:** Select one:
    - **Balanced:** Automatically balances compression between an average of the reimaging speed and the available disk space for the image file. This option is displayed only for the ZENworks Image format.
    - **None:** This option is displayed only for the Windows Imaging format (.wim) and Ghost Imaging Format (.gho).
    - **Optimize for Speed:** Optimizes the compression to allow for the fastest reimaging time. Use this option if CPU speed is an issue. By default, this option is selected.
    - **Optimize for Space:** Optimizes the compression to minimize the image file’s size to conserve disk space. This can cause reimaging to take longer.
  - **Imaging Bundle:** To create a new image bundle, select the Create an Image Bundle option and configure the following options
    - **Name:** Provide a name for the bundle. The bundle name must be different than the name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name you provide displays in ZENworks Control Center and the ZENworks Agent (on managed devices).
    - **Destination Folder:** Type the name or browse to the ZENworks Control Center folder where you want the bundle to reside. The default is /bundles, but you can create additional folders to organize your bundles.
**Description:** Provide a short description of the bundle’s contents. This description displays in ZENworks Control Center and in the ZENworks Agent.

The image is taken the next time the device boots, or when you manually apply a Preboot bundle, such as from a ZENworks imaging CD, DVD or bootable USB.

6. Click OK to exit the wizard.

Your changes should be displayed in the Imaging Work panel for the device.

## 3.12 Managing Preboot Bundles

The Settings page of a bundle lets you manage bundle settings, including the ZENworks system variables that are available for use on bundles, content replication settings for ZENworks Primary Servers and Satellite devices, sandbox settings, Endpoint throttle, and Image bundle flags.

Settings can be inherited from the following locations:

- **(System):** The bundle is inheriting the setting established for the Management Zone (Configuration tab > Management Zone Settings).
- **Folder:** The bundle is inheriting the setting established for one of its parent folders.
- **Device:** The bundle is not inheriting the setting, but the setting is configured directly on the bundle.
- **---:** The bundle is not inheriting the setting and the setting is not configured directly on the bundle. In other words, the setting is not configured at the system level, the folder level, or the bundle level.

For detailed information about the settings that you can configure for a Preboot bundle, review the following sections:

- Section 3.12.1, “Configuring Settings for a Preboot Bundle,” on page 153
- Section 3.12.2, “Managing Bundle Variables,” on page 154
- Section 3.12.3, “Configuring Sandbox Settings,” on page 156
- Section 3.12.4, “Configuring Image Bundle Flag Settings,” on page 156

### 3.12.1 Configuring Settings for a Preboot Bundle

1. In ZENworks Control Center, click the **Bundles** tab.
2. Click the Preboot bundle whose settings you want to configure.
3. Click the **Settings** tab.
4. In the Bundle Management panel, click the setting you want to configure:
   - **System Variables:** Lets you manage the ZENworks system variables that are available for use on devices, including those inherited from the Management Zone and new variables that you define. For more information on system variables, see “Using System Variables” in the ZENworks Control Center Reference.
   - **Primary Server Replication:** Lets you manage content replication to Primary Servers. You can specify whether or not new Primary Servers added to the system are assigned to host the bundle. You can also specify that the bundle is included or excluded from being hosted on a specified Primary Server.
For more information on content replication, see “Content Replication” in the ZENworks Primary Server and Satellite Reference.

- **Satellite Server Replication**: Lets you manage content replication to Satellite devices. You can specify whether or not new Satellites added to the system are assigned to host the bundle. You can also specify that the bundle is included or excluded from being hosted on a specified Satellite.

  **NOTE**: ZENworks images are not replicated from one Primary Server to other Primary or Satellite Servers.

For more information on content replication, see Content Replication in “Content Replication” in the ZENworks Primary Server and Satellite Reference.

- **Sandbox Settings**: Lets you configure the settings for the sandbox.
  
  For more information on the sandbox settings, see Section 3.12.3, “Configuring Sandbox Settings,” on page 156.

- **Endpoint Throttle Settings**: Lets you configure the throttle rate settings at a bundle and bundle folder level. The throttle rate determines the bandwidth for distributing content to devices associated with a location.

- **Image Bundle Flag Settings**: Lets you configure Image bundle settings that are used when restoring an image by applying a bundle.

  For more information on Image bundle settings, see Section 3.12.4, “Configuring Image Bundle Flag Settings,” on page 156.

  5 If the setting is configured at the system or folder level, click Override settings to enable you to configure the setting at the bundle level.

  6 Fill in the fields.

  To get information about the fields, click the Help button or select the appropriate topic from the following list:

### 3.12.2 Managing Bundle Variables

The Bundles Settings page lets you manage the system variables that are available for use on the Imaging Script, AutoYaST, and Kickstart bundles.

You can define the system variables in the ZENworks script that you specify while creating the Imaging Script bundle. For more information, see Section 3.4, “Configuring Imaging Script Bundles for ZENworks Imaging,” on page 131.

You can define system variables in the AutoYaST XML script and the Kickstart configuration file that are required to create AutoYaST and Kickstart bundles respectively. While creating a bundle, you must choose to import the AutoYaST XML script or the Kickstart configuration file so that the variables can be automatically resolved when the bundle is applied on the managed devices. If you choose to create a bundle in which the AutoYaST XML script or the Kickstart configuration file that contains system variables is accessed by using a protocol, the system variables are not resolved, and consequently the bundle is not applied on the managed devices. For more information about the AutoYaST bundle, see Section 3.5, “Configuring the AutoYaST Bundle,” on page 132, and about the Kickstart bundle, see Section 3.6, “Configuring the Kickstart Bundle,” on page 137.

The Inherited panel displays all system variables that are inherited from the ZENworks Management Zone or parent folders. You cannot delete or modify inherited variables. However, if you add the same system variable, but give it a different value, the new variable value overrides the inherited variable value.
When specifying the variable in a script, use the following syntax:

Replace with the name of the ZENworks variable.

The System Variables panel lets you define that can be used to replace paths, names, and so forth as you enter information.

You can define system variables at three levels:

- **Management Zone**: The system variables are inherited by the following: device folders, devices, and bundles.
- **Device Folder**: The system variables are inherited by all devices contained within the folder or its subfolders.
- **Device or Bundle**: The system variables apply only to the device or bundle for which they are configured.

The following table lists the tasks you can perform to manage the system:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add a variable  | 1. If you are configuring system for an object (not for the entire Management Zone), click **Override settings** to activate the System Variables panel.  
2. Click Add, provide the name and value for the variable, then click OK.  
3. Click Apply. | When configuring system variable for an object, you can override an inherited variable by defining a new variable with the same name but a different value. For example, if Var1=c:\ is inherited, you can override it by defining Var1=d:\. Variable names cannot include spaces and must be unique at the level where they are defined. For example, you cannot have two variables named Var1 defined at the device level (unless one is inherited, in which case the device level variable overrides the inherited variable). Variable values cannot include the characters & and <. |
| Remove a variable | 1. Select the check box next to the variable or variables that you want to delete.  
2. Click Remove.  
3. Click Apply. | |
| Edit a variable  | 1. Select the check box next to the variable.  
2. Click Edit.  
3. Modify the **Name** and **Value** fields as desired, then click OK.  
4. Click Apply. | Variable names cannot include spaces and must be unique at the level where they are defined. For example, you cannot have two variables named Var1 defined at the device level (unless one is inherited, in which case the device level variable overrides the inherited variable). Variable values cannot include the characters & and <. |
For more information about system variables, see “Using System Variables” in the ZENworks Control Center Reference.

### 3.12.3 Configuring Sandbox Settings

1. In ZENworks Control Center, click **Bundles**.
2. Click the desired Preboot bundle for which you want to configure sandbox settings.
3. Click **Settings**.
4. Click **Sandbox Settings**.
5. Configure the desired settings:
   - **Sandbox Content Replication Status**: Select the **Sync Sandbox content to content servers** option to enable the Primary Server Replication settings and Satellite Server Replication settings of the published version of the bundle to be applied to the sandbox version of the bundle. This enables the sandbox content to also be replicated to the specified Primary and Satellite servers.
   - **Sandbox Chained Bundles Settings**: Select the **Consume Sandbox version of chained bundles** option to enable the test device to receive the sandbox version of the dependent bundles if it exists. If this option is not selected, the device receives only the published version of all the dependent bundles.
   - **Sandbox Addon Image Settings**: The **Enable creation of addon image for Sandbox** option is available only for the Windows bundles. Select this option if the published version of the Windows bundle has an add-on image and if you want a new add-on image to be created for the sandbox version of the bundle.
     
     If the **Enable creation of addon image for Sandbox** option is not selected, the add-on image is not automatically created for the sandbox version of the bundle. Also, you cannot manually create an add-on image to the bundle at a later time.
     
     Even though you can have multiple published versions for a bundle, add-on images are available only for the latest published version and the sandbox version of the bundle. The add-on image of an existing published bundle is deleted when you create a new published version.

6. Click **Apply > OK**.

### 3.12.4 Configuring Image Bundle Flag Settings

The Image Bundle Flag settings allow you to retain the IP address and other identity information of a device while restoring an image. You can choose to retain the IP address and other identity information from the existing ISD or from the restored image.

These options are only applicable when the Preboot bundle is applied to a specific device. The image used in this bundle must contain the device’s previous IP address and ZENworks Control Center object information.

1. In ZENworks Control Center, click **Bundles**.
2. Click the desired Preboot bundle for which you want to set Image Bundle Flag settings.
3. Click **Settings**.
4. Click **Image Bundle Flag Settings**.
5. Select one or both of the following options:
   - **Use the IP Address from the Bundle Image Rather Than from Image Safe Data**
Use this option if you have previously taken an image of the device and are using that image with this Preboot bundle. This option causes the imaging agent service to write the device’s IP address that is contained in this image to the Image Safe Data location on the replacement hard drive.

Do not use this option if the image being used for this bundle was not previously made from this device.

If you do not select this option, then:

- If the device that this Preboot bundle is applied to is still using its primary hard drive to boot from, the IP address in its Image Safe Data continues to be used.
- Or
- If the device that this Preboot bundle is applied to has been given a new hard drive to boot from, but you do not have a previous image of the old hard drive, then the IP address is assigned according to your ZENworks Management Zone configuration for non-registered devices.

- **Use Identity Information from the Bundled Image Rather Than from Image Safe Data**

If you are using a previous image of this device, this option writes ZENworks Control Center object identity information as contained in the image to the new hard drive’s Image Safe Data location, which allows the device to retain its ZENworks Control Center object.

However, if the image contained in this bundle was not previously made from this device, it receives the new ZENworks Control Center object that is defined in the image.

If you do not select this option and the device that this Preboot bundle is applied to has been given a new hard drive to boot from, then a new ZENworks Control Center object is created according to your ZENworks Management Zone configuration for non-registered devices.

6 Click **Apply > OK**.

### 3.13 ZENworks WinPE Imaging

- Section 3.13.1, “Limitations of Using ZENworks WinPE Imaging,” on page 158
- Section 3.13.3, “Using the WinPE Maintenance Mode Prompt to Make an Image on a Proxy,” on page 159
- Section 3.13.4, “Using the WinPE Maintenance Mode Prompt to Restore an Image Locally,” on page 161
- Section 3.13.5, “Using the WinPE Maintenance Mode Prompt to Restore an Image from a Proxy,” on page 162
- Section 3.13.6, “Using ZENworks Control Center for WinPE Auto Imaging,” on page 163
- Section 3.13.7, “Image-Safe Data Viewer and Editor (zisview and zisedit),” on page 164
- Section 3.13.8, “Prerequisites for Taking and Restoring an Image Partition-wise Using WinPE,” on page 164
- Section 3.13.9, “WinPE Add-on Imaging,” on page 166
- Section 3.13.10, “Multicast Images using ZENworks WinPE,” on page 166
- Section 3.13.11, “WinPE ISDTool,” on page 169
- Section 3.13.12, “Creating WinPE ISO,” on page 169
3.13.1 Limitations of Using ZENworks WinPE Imaging

Following are some of the limitations of using ZENworks WinPE imaging:

- ZENworks image taken using WinPE and add-ons extracted from the image cannot be restored in Linux distro and vice versa.
- Peer-to-peer multicasting cannot be performed between WinPE and Linux distro.
- By default, PowerShell packages are not added in the WinPE. For more information, see Section 3.13.13, “Adding the PowerShell Package to WinPE,” on page 170.
- Ensure that all WinPE img command arguments are prefixed with a - (hyphen).
- In the ZENworks 2017 Update 2 release, img -info, img -auto and img -dump commands are not supported.

3.13.2 Using WinPE Maintenance Mode Prompt to Make an Image Locally

Using the WinPE maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the “make locally” (-makel) mode command:

```
img -make -local drive_letter\filename.zmg [-exclude=partition_number] [-include=partition_number]
```

You can abbreviate -make -local as: -m -local, -makel, or -ml.

You can also abbreviate -exclude as -x and -include as -I.

For more information, see:
- “Command Details” on page 158
- “Examples” on page 159

Command Details

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>drive_letter\filename.zmg</td>
<td>The image file name, including the .zmg extension, and any drive letter, which has local file share or any mounted storage disk. However, the directories in the path must exist. If the file already exists, an error occurs. You must use a different file name or delete the existing image file in order to use the same filename.</td>
</tr>
</tbody>
</table>
3.13.3 Using the WinPE Maintenance Mode Prompt to Make an Image on a Proxy

Using WinPE maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the "make to proxy" (-makep) mode command:

```
img -make -proxy added_filepath\filename.zmg -ip=IP_address [-comp=comp_level] [-exclude=partition_number] [-include=partition_number]
```

You can abbreviate -make -proxy as: -m -proxy, -makep, or -mp.

You can also abbreviate -exclude as -x and -include as -I.

To set the proxy address, run the `set PROXYADDR=<SERVER_IP>` command.

For more information, see:
- "Command Details" on page 160
- "Example:" on page 160
Command Details

Table 3-7  Make Proxy Commands and Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>added_path\filename.zmg</td>
<td>The image file name, including a .zmg extension (which is case sensitive) and any added path. The Imaging engine automatically saves images to the default images directory on the Imaging Server.</td>
</tr>
<tr>
<td></td>
<td><strong>Windows:</strong> $ZENWORKS_HOME\work\content-repo\images\</td>
</tr>
<tr>
<td></td>
<td><strong>Linux:</strong> /var/opt/novell/zenworks/content-repo/images/</td>
</tr>
<tr>
<td></td>
<td>If no folders are specified in the path (added_path), the image is created in this images directory.</td>
</tr>
<tr>
<td></td>
<td>A forward slash is not needed at the beginning of any added path.</td>
</tr>
<tr>
<td></td>
<td>You can create subdirectories under images for organizing your image files. However, any such subdirectories that you specify in the path must already exist when you use this command. ZENworks does not create the directories during imaging.</td>
</tr>
<tr>
<td></td>
<td>If the image file itself already exists, the Imaging Server won’t overwrite it unless you enable this behavior in ZENworks Control Center for the Imaging Server. To enable the behavior in ZENworks Control Center, click Configuration &gt; Management Zone Settings &gt; Device Management &gt; Preboot Services &gt; Device Imaging Work Assignment, select the Allow Preboot Services to overwrite existing files when uploading option.</td>
</tr>
<tr>
<td>-ip=IP_address</td>
<td>The IP address or DNS name of an imaging server. If you do not use this parameter, the value for PROXYADDR is used.</td>
</tr>
<tr>
<td>-comp=comp_level</td>
<td>comp_level is the amount of compression used when creating the image. Specify any number from 0-9. 0 means no compression. 1 is the same as Optimize for Speed and is used by default if you do not specify this parameter. 6 is similar to Balanced. 9 is the same as Optimize for Space, which provides the slowest performance.</td>
</tr>
<tr>
<td>-exclude=partition_number or -x=partition_number and -include=partition_number or -l=partition_number</td>
<td>The partition number of a local partition to exclude from the image or include in the image. You can repeat this parameter as needed to exclude or include multiple partitions.</td>
</tr>
<tr>
<td></td>
<td>Available partitions can be displayed using img -p or img -partition.</td>
</tr>
<tr>
<td></td>
<td>If you omit either parameter, all partitions are included in the image.</td>
</tr>
</tbody>
</table>

Example:

Table 3-8  Make Proxy Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>img -makep subdir1\myimage.zmg</td>
<td>Takes an image of all partitions and saves the image to the Imaging Server.</td>
</tr>
</tbody>
</table>
### 3.13.4 Using the WinPE Maintenance Mode Prompt to Restore an Image Locally

Using the WinPE maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the “restore from local” (`-restore -local`) mode command:

```
img -restore -local drive_letter\filename.zmg [-s=file_set] [-ap=advanced_options]
```

You can abbreviate `-restore -local` as: `-r -local`, `-restorel`, or `-rl`.

For more information, see:
- “Command Details” on page 161
- “Examples” on page 162

## Command Details

### Table 3-9 Restore Local Commands and Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-restorel</code></td>
<td>The partition number (as displayed by <code>img -p</code>) of the local partition to retrieve the image from. It must be a primary partition. This partition is not changed by the imaging operation.</td>
</tr>
<tr>
<td><code>-s=fileset</code></td>
<td>The number of the image file set to be restored. Valid values are 1 through 10. For information on creating file sets of an image, see Section 1.6.2, “Creating, Installing, and Restoring Standard Images,” on page 35. If you omit this parameter, file set 1 is used.</td>
</tr>
<tr>
<td><code>-ap=partition:partition</code></td>
<td>A mapping between a partition in the image archive (<code>apartition</code>) and a target physical partition on the local machine (<code>partition</code>). Use this parameter to selectively restore a specific part of the image to a specific local partition. <strong>IMPORTANT:</strong> If you use this parameter, none of the existing local partitions are removed, and only the target local partition is updated. The update process does not remove any existing files; however, any existing files of the same names are overwritten. If you want to remove all existing files from the target partition before updating it, first use the Partition Operations Mode to delete and recreate the partition. If you choose to restore the base image, you need to delete and recreate the target partition before restoring the image because your system might be left in an inconsistent state if the Selective Partition Image restoration fails. For <code>apartition</code>, use the partition number displayed for the source partition in the Image Explorer (<code>zmgexp</code>) utility. For <code>partition</code>, use the partition number displayed by <code>img -p</code> or <code>img -partition</code> for the target partition. The target partition must be a partition of a supported file system. You can repeat this parameter as needed to request multiple selective restorations in a single operation. In doing so, you can apply multiple parts of the image to a single local partition, but you can’t apply the same part of an image to multiple local partitions in a single operation.</td>
</tr>
</tbody>
</table>

---

Using Imaging 161
3.13.5 **Using the WinPE Maintenance Mode Prompt to Restore an Image from a Proxy**

At the WinPE maintenance mode prompt, use the “restore from proxy” (-restorep) mode command to restore an image from a proxy.

- To restore an image by specifying the image file path:

  ```
  img -restore -proxy added_filepath\filename.zmg -ip=IP_address [-s=set] [-ap=advanced_options]
  ```

  You can abbreviate `-restore -proxy` as: `-r -proxy`, `-restorep`, or `-rp`.

  To set the proxy address, run the `set PROXYADDR=<SERVER_IP>` command.

  For more information, see:
  - “Command Details” on page 162
  - “Examples” on page 163

**Command Details**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>added_filepath\filename.zmg</code></td>
<td>The file name and added path of the image to retrieve, including the <code>.zmg</code> extension (case sensitive).</td>
</tr>
<tr>
<td><code>-s=fileset</code></td>
<td>The number of the image file set to be restored. Valid values are 1 through 10. For information on creating file sets of an image, see Section 1.6.2, “Creating, Installing, and Restoring Standard Images,” on page 35. If you omit this parameter, file set 1 is used.</td>
</tr>
<tr>
<td><code>-ip=IP_address</code></td>
<td>The IP address or DNS name of an imaging server. If you do not use this parameter, the value for PROXYADDR is used.</td>
</tr>
</tbody>
</table>
NOTE: In ZENworks, you only need to provide the image file name (the .zmg file) because the images are stored in a fixed location. For example, if you saved the image file in the default location, enter:

```
img -rp myimagefile.zmg
```

Because you can organize your images under the \images directory by adding subdirectories, the additional path where you created the image file should be provided. For example:

```
img -rp \windows\vista\myimagefile.zmg
```

### 3.13.6 Using ZENworks Control Center for WinPE Auto Imaging

The following imaging tasks that are available in ZENworks Control Center for WinPE imaging:

- “Auto Take Image using WinPE” on page 164
- “Auto Restore Image using WinPE” on page 164
Auto Take Image using WinPE

For more information, see “Taking a Base Image of a Device” on page 95.

Auto Restore Image using WinPE

For more information, see "Configuring the ZENworks Image Bundle for Automatic Imaging" on page 99.

3.13.7 Image-Safe Data Viewer and Editor (zisview and zisedit)

The Image-Safe Data Viewer and Editor features that are supported on the ZENworks Linux Imaging are now supported on the ZENworks WinPE Imaging as well.

For more information, see Section D.5, "Image-Safe Data Viewer and Editor (zisview and zisedit)," on page 244.

3.13.8 Prerequisites for Taking and Restoring an Image Partition-wise Using WinPE

Let us consider an example of a system with default installation having 100MB boot partition and a system partition.

1. If the system has 100MB partition (on Windows 7, or later), take an image of the 100 MB partition separately. To take an image of the 100 MB partition, run the following command:

   # img -mp <bootpartition>.zmg -I=1

   In the above command, -I =1 indicates that you include partition number 1, which is the 100 MB partition.

   You can use the following command to take image of all partitions on the system, where I indicated the partition number.

   # img -mp <windows_os_partition>.zmg -I=2

To restore the Windows images partition-wise, do the following:

1. Delete all the partitions by using the img -pd command. For example:

   img -pd 1
   img -pd 2

   1 and 2 in the above commands correspond to the hard disk partition number.

2. Create the partitions by using the img -pc command. For example:

   img -pc 1 -type=NTFS -size=100 (for the 100 MB partition for Windows 7, or later).
   img -pc 2 -type=NTFS (to restore the C:\drive)

3. Mark the partition 1 as Active by using the img -pa 1 command.

4. Restore images partition-wise.

Partition wise restore for UEFI systems
To take an image partition wise:

1. On the system with UEFI boot enabled, install the operating system and take the image partition wise using the following commands:
   1. `img -mp <WRE>.zmg -I=1`
   2. `img -mp <ESP>.zmg -I=2`
   3. `img -mp <MRP>.zmg -I=3`
   4. `img -mp <windows_os_partition>.zmg -I=4`

2. Make a note of the size of each partition on the base system. The same values can be used during the restoration of the image.

To restore the image partition wise:

1. Run the `img -pc 1 -type=NTFS -size=<xxxxMB> -guid=PartitionType` command to create a GPT partition on a device.
   
   The `PartitionType` attribute in the above command can take any of the following values:
   
   - **MBD**: Microsoft Basic Data Partition
   - **MRP**: Microsoft Reserved Partition
   - **WRE**: Windows Recovery Environment Partition
   - **ESP**: EFI System Partition

   This command will create a `xxxx MB` partition with GUID partition type, and initialize the partition with the NTFS file system.

   Ensure that the following conditions are met for a successful partition creation:
   
   - If the partition type is ESP, then the `-type` value in the command should be **FAT32**.
   - Size of MRP partitions depends on the size of the disk. For a disk size less than 16 GB, the MRP partition is 32 MB, and for a disk size more than 16 GB, the MRP partition is 128 MB.

   Example:
   ```
   img -pc 1 -type=NTFS -size=300 -guid=WRE
   img -pc 2 -type=FAT32 -size=100 -guid=ESP
   img -pc 3 -type=RAW -size=128 -guid=MRP
   img -pc 4 -type=NTFS -size=40000 -guid=MBD
   ```

2. Mark the following three partitions as active by using the `img -pa <partition number>` command:
   
   - **Recovery**: Windows Recovery Environment
   - **System**: EFI system partition
   - **Reserved**: Microsoft reserved partition
   - **Primary**: Windows partition (Microsoft basic data partition)

   For example, to make the first partition active, run the `img -pa 1` command. For information about the three partitions, refer to the following image.
3.13.9 WinPE Add-on Imaging

Following are the features supported for Add-on imaging using ZENworks WinPE:

- Add-on extracted from ZENworks images taken using WinPE
- The bundle add-on created from ZENworks Control Center
- The add-on created using the Image Explorer

For more information, see “Creating an Add-On Image for an Existing Bundle” on page 98.

3.13.10 Multicast Images using ZENworks WinPE

Following are the features supported for Multicasting images using ZENworks WinPE:

- “Auto Multicasting” on page 166
- “Manual Multicasting” on page 166
- “Peer-to-peer Manual Multicasting” on page 168

Auto Multicasting

Auto multicast can be performed by assigning multicast image set bundles to clients from ZENworks Control Center.

NOTE: While creating multicast image set bundles for WinPE, ensure that you select the ZENworks WinPE Imaging option.

For more information, see Section 3.3, “Multicasting Images for ZENworks Imaging,” on page 121.

Manual Multicasting

On the ZENworks Imaging Server, do the following to initiate a multicast session:

- “On a Windows Primary or Satellite Server” on page 166
- “On a Linux Primary or Satellite Server” on page 167
- “Initiating a Multicast Session from Each Client” on page 168

On a Windows Primary or Satellite Server

1 In the Services window, determine whether the ZENworks Preboot Service is running. If it is not running, then right-click the service and select Start.

2 On the command line, enter the following to enable a multicast session:

   %ZENWORKS_HOME%\bin\preboot\zmgmcast.exe -mcast arguments
where *arguments* represents the following that you can append to the command line:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>session_name</em></td>
<td>(Required) The session name is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network.</td>
</tr>
<tr>
<td>-p <em>path</em></td>
<td>(Required) The path to the image to be multicast, which is located on the Imaging Server. This must be the full path.</td>
</tr>
<tr>
<td>-i <em>IP_address</em></td>
<td>(Optional) The IP address of the Imaging Server. If not specified, the IP address of the Primary Server is considered by default.</td>
</tr>
<tr>
<td>-t <em>time_wait</em></td>
<td>(Optional) If not enough devices have booted to fulfill the Client Count requirement, the multicast session begins if a participating device boots and a certain amount of time passes without another participating device booting. Specify this amount of time. The default is 5 minutes.</td>
</tr>
<tr>
<td>-c <em>client_count</em></td>
<td>(Optional) The number of participating devices you want to have booted before the multicast session begins. If you do not specify a number, the default is 1.</td>
</tr>
</tbody>
</table>

**IMPORTANT:** The image is sent and placed on each participating device only after you initiate the multicast session from each participating client.

3 To view the list of multicast sessions, enter:

```
%ZENWORKS_HOME%\bin\preboot\zmgmcast.exe -list -i proxy_IP_address
```

The `-i` argument is optional.

4 To stop a multicast session, enter:

```
%ZENWORKS_HOME%\bin\preboot\zmgmcast.exe -stop session_name -i proxy_IP_address
```

The `session_name` is required and the `-i` argument is optional.

5 Continue with "Initiating a Multicast Session from Each Client" on page 168.

**On a Linux Primary or Satellite Server**

1 On the command line, enter the following to make sure the imaging software is running:

```
/etc/init.d/novell-pbserv status
```

If it is not running, then enter:

```
/etc/init.d/novell-pbserv start
```

2 On the command line, enter the following to enable a multicast session:

```
/opt/novell/zenworks/preboot/bin/novell-zmgmcast -mcast arguments
```

where *arguments* represents the following that you can append to the command line:
Using Imaging

IMPORTANT: The image is sent and placed on each participating device only after you initiate the multicast session from each participating client.

3 To view the list of multicast sessions, enter:

```
/opt/novell/zenworks/preboot/bin/novell-zmgmcast -list -i proxy_IP_address
```

The -i argument is optional.

4 To stop a multicast session, enter:

```
/opt/novell/zenworks/preboot/bin/novell-zmgmcast -stop session_name -i proxy_IP_address
```

The session_name is required and the -i argument is optional.

5 Continue with "Initiating a Multicast Session from Each Client" on page 168.

Initiating a Multicast Session from Each Client

To initiate each participating device in the multicast session, enter the following at the prompt of every device.

```
img -session session_name
```

Peer-to-peer Manual Multicasting

To perform peer-to-peer manual multicast session using ZENworks WinPE:

- “Master session” on page 168
- “Client session” on page 169

Master session

To start a peer-to-peer multicasting session using ZENworks WinPE:

Start the master session from WinPE using the following command:

```
img -session (session_name) -master [-clients=count] [-timeout=minutes]
```

Example: img -session test1 -master -clients=10 -timeout=5
In this example, test1 is the session name, 10 is the number of clients and 5 minutes is the timeout.

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(session_name)</td>
<td>(Required) The session name is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network.</td>
</tr>
<tr>
<td>[-clients=count]</td>
<td>Minimum number of clients participating in the multicast session.</td>
</tr>
<tr>
<td>[-timeout=minutes]</td>
<td>The number of minutes the master device waits (without reaching the required registered clients) after the last client has registered before starting the imaging process. This option only applies to devices designated as session masters (where the -m parameter is used). If you omit this parameter, the default timeout is 5 minutes. The imaging process does not start until the client value is reached, or the timeout value has transpired. After that, any clients attempting to register are denied.</td>
</tr>
</tbody>
</table>

**Client session**

Start client session WinPE using the following command:

```bash
img -session (session_name) -client
```

**Example:** `img -session test1 -client`

In this example, test1 is the session name.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(session_name)</td>
<td>(Required) The session name is any string that uniquely identifies this multicast session from other multicast sessions that might be in progress on the network.</td>
</tr>
<tr>
<td>-client</td>
<td>(Optional) Indicates that the device participates as a client in the multicast session.</td>
</tr>
</tbody>
</table>

### 3.13.11 WinPE ISDTool

For more information on WinPE ISDTool, see Section 3.9, “ISDTool,” on page 148.

### 3.13.12 Creating WinPE ISO

To create a WinPE ISO (BootCD or USB), perform the following:

1. Go to ZENworks setup page.
   
   `https://<server_IP>/zenworks-setup/?pageId=tools`

Where `<version_number>` is the latest version of ZCC Helper.

3. Extract or install the MSI to get the `wimprocessor.exe` file.

After installing the ZCC Helper, the `wimprocessor.exe` file can be located in the following location:

```<Drive_letter>\Users\Administrator\AppData\Roaming\Novell\ZENworks\ZCCHelper\bin```

4. In the command prompt, run the following command on a device in which WAIK or WADK is installed:

```wimprocessor.exe makeiso processor_architecture [zenworks_folder]```

Accepts the following arguments:

- **processor_architecture**: Valid values are: x86 for 32-bit and amd64 for 64-bit processor architecture.
- **zenworks_folder**: The folder which contains the ZENworks imaging files downloaded from the Primary Server location is as follows:

**On Windows server:**

- For **amd64**: `%ZENWORKS_HOME%\share\tomcat\webapps\zenworks\ext\3PIUtils\x86_64`
- For **x86**: `%ZENWORKS_HOME%\share\tomcat\webapps\zenworks\ext\3PIUtils`

**On Linux Server:**

- For **amd64**: `/opt/novell/zenworks/share/tomcat/webapps/zenworks/ext/3PIUtils/`
- For **x86**: `/opt/novell/zenworks/share/tomcat/webapps/zenworks/ext/3PIUtils`

While creating a WinPE imaging CD, if the Imaging Server is specified in the `zensettings.ini` file, then this imaging CD can be used for auto WinPE booted. If imaging server is not specified in the `zensettings.ini` file, then the CD can be used for manual imaging.

For 32-bit `zensettings.ini` image file is available in the `3PIUtils` folder and for 64-bit `zensettings.ini` image file is available in the `3PIUtils\x86_64` folder.

While copying the 32-bit image files, ignore the `x86_64` folder.

**NOTE:** The ISO file will be generated in the location where the `wimprocessor.exe` file is located.

The `winpe.wim` file available in the following location will be used to create the ISO file:

```
Windows_Drive:\Program Files (x86)\Windows Kits\<version_number>\Assessment and Deployment Kit\Windows Preinstallation Environment\<architecture>\en-us```

Use this ISO file to burn the CD or DVD or USB, and then boot into ZENworks WinPE.

### 3.13.13 Adding the PowerShell Package to WinPE

By default, PowerShell packages will not be included in WinPE. To add the PowerShell packages to `winpe.wim`, perform the following:

1. Take a backup of the `winpe.wim` file available in the following location:

   ```Drive_letter:\Program Files (x86)\Windows Kits\<version_number>\Assessment and Deployment Kit\Windows Preinstallation Environment\<architecture>\en-us```

   Where `<version_number>` can be 8, 8.1 or 10 and `<architecture>` can be x86 or amd64
2. Add following packages to winpe.wim and upload to ZCC third party settings from a WAIK or WADK device.
   - WinPE-NetFx.cab
   - WinPE-NetFx_en-us.cab
   - WinPE-PowerShell.cab
   - WinPE-PowerShell_en-us.cab
   For more information, see Section 3.13.14, “Adding Drivers and Packages to an Existing WIM File,” on page 171

3. Upload the winpe.wim file to ZCC using wimprocessor.exe.

**NOTE:** The WinPE ISO created using the above winpe.wim will include the PowerShell packages in the WinPE ISO files.

These packages are separate for 32-bit and 64-bit architectures.

The Packages are available in the following locations in devices on which WAIK or WADK is installed:

- **x86:** C:\Program Files (x86)\Windows Kits\<version>\Assessment and Deployment Kit\Windows Preinstallation Environment\x86\WinPE_OCs
- **x86 en-us cab files:** C:\Program Files (x86)\Windows Kits\<version>\Assessment and Deployment Kit\Windows Preinstallation Environment\x86\WinPE_OCs\en-us
- **x64:** C:\Program Files (x86)\Windows Kits\<version>\Assessment and Deployment Kit\Windows Preinstallation Environment\amd64\WinPE_OCs
- **x64 en-us cab files:** C:\Program Files (x86)\Windows Kits\<version>\Assessment and Deployment Kit\Windows Preinstallation Environment\amd64\WinPE_OCs\en-us

### 3.13.14 Adding Drivers and Packages to an Existing WIM File

To add drivers or packages to an existing WIM file, use addDrivers (Adding custom drivers) and addPackage (Adding custom packages) commands.

**Adding Drivers:** To add drivers to an existing WIM file, run the following command:

```
Wimprocessor.exe addDriver <wim FilePath> <Driver FilePath>
```

**Example:**
```
wimprocessor.exe adddriver "D:\winpe.wim" "D:\smsc_x86\net9500-x86-n630f.inf"
```

Where **D:\winpe.wim** is the location of the WIM file and **D:\smsc_x86\net9500-x86-n630f.inf** is the location of the driver that should be added to the WIM file.

- **<wim FilePath>):** The path of the WIM file for which drivers should be added.
- **<Driver FilePath>:** The path of the driver files that should be added into the WIM file. The driver file should be in the INF file format.

**Adding Packages:** To add packages to an existing WIM file, run the following command:

```
wimprocessor.exe addPackage <wim FilePath> <Package FilePath>
```

**Example:**
```
wimprocessor.exe addpackage "D:\winpe.wim" "D:\WinPE-NetFx.cab"
```
Where `D:\winpe.wim` is the location of the WIM file and `D:\WinPE-NetFx.cab` is the location of the package that should be added to the WIM file.

- `<wim FilePath>`: The path of the WIM file for which packages should be added.
- `<Package FilePath>`: The path of the package files that should be added into the WIM file. The package file should be in the CAB file format.

**NOTE:** If you need a WinPE ISO with custom drivers and packages, then use the `addDriver` and `addPackage` commands to add required drivers and packages, and then use `makeISO` command to create an ISO file.

### 3.14 High Performance NTFS Driver (Tuxera)

The High Performance NTFS driver (Tuxera), provides enhanced performance for imaging Windows 7 and Windows XP NTFS file systems when compared to ZENworks legacy imaging. Tuxera driver, also known as ntfs Kernel Module driver combined with the Imaging engine provides substantial performance improvements. For operations concerning base images, the Tuxera driver is used if it is uploaded and present in the zone. For add-on images, only the legacy ntfs driver is used.

**NOTE:** Before you upload the Tuxera driver onto the latest version of ZENworks, ensure that all the Primary Servers and Imaging Satellite Servers in the zone are upgraded to latest version.

### 3.14.1 Adding Tuxera Driver for ZENworks Imaging

You can download the latest Tuxera High Performance NTFS driver zip file from the hyperlink provided and save it on your local system.

1. In ZENworks Control Center, click **Configuration**.
2. In the **Management Zone Settings** panel, click **Device Management > Preboot Services > Third Party NTFS Driver Integration Settings**.
3. Click the icon to browse for and select the high performance NTFS driver zip file.
4. Click **Ok** to upload to the ZENworks Server.
5. Click **Status** to view the status of content replication across all Primary and Satellite Servers with Imaging role in the management zone. You must start the imaging operation only when the status is **Available**.

**NOTE**
- An image taken by using the legacy NTFS driver is restored by the legacy NTFS driver. For high performance, these images need to be recreated by using the High Performance NTFS (Tuxera) driver after the driver is uploaded into the ZENworks Control Center and the status is **Available**.
- After a successful upload, this NTFS driver, is integrated with the `bootcd_tntfs.iso` file in the `winutils` folder. To use the High Performance NTFS driver, use the `bootcd_tntfs.iso` file instead of the `bootcd.iso` file.
- You must upload the Tuxera driver after each ZENworks upgrade.
3.14.2 legacyntfs switch functionality

You can use the legacyntfs switch in order to use the legacy NTFS driver.

1 Boot the system into the ZENworks Maintenance mode.
2 Take an image of the device by using the img -legacyntfs command.

For example, you can run the following command:

```bash
img -mp <image_name>.zmg -legacyntfs
```

(Ensure that the -legacyntfs is at the end of the command).

**NOTE**

* If you take an image by using the legacy NTFS driver, the image is restored by the legacy NTFS driver. Also, if the tntfs.ko file is not uploaded, you need not use the legacyntfs switch. In such situations, the imaging engine uses the legacy NTFS driver. When the tntfs.ko driver is present, the imaging engine uses the Tuxera driver.

3.14.3 Prerequisites for taking and restoring an image partition-wise

Let us consider an example of a system with default installation having 100MB boot partition and a system partition. While taking an image from a device, take a backup of the MBR of the system as follows:

1 Export the MBR to a file by using the `dd if=/dev/sda of=mbr_win7.bin bs=512 count=1` command.
2 Upload the MBR file to server. If the system has 100MB partition (on Windows 7, or Windows Vista), take an image of the 100 MB partition separately by using the legacyntfs switch. To take an image of the 100 MB partition by using the legacyntfs switch, run the following command:

```bash
# img -mp <bootpartition>.zmg -I=1 -legacyntfs
```

In the above command, `-I =1` indicates that you include partition number 1, which is the 100 MB partition.

```bash
# img -mp <os_partition>.zmg -I=2 -legacyntfs
```

You can use the above command to take image of all partitions on the system, where I indicated the partition number.

To restore the Windows images partition-wise, do the following:

1 Delete all the partitions by using the img -pd command. For example:

```bash
img -pd 1
img -pd 2
```

1 and 2 in the above commands correspond to the hard disk partition number.

2 Create the partitions by using the img -pc command. For example:

```bash
img -pc 1 -type=NTFS -size=100 -legacyntfs (for the 100 MB partition for Windows 7, or Windows Vista).
```

```bash
img -pc 2 -type=NTFS (to restore the C:\drive)
```

3 Mark the partition 1 as Active by using the img -pa 1 command.

4 Restore images partition-wise. Restore the 100MB partition separately by using the legacyntfs switch.
5 Restore the MBR on the device after restoration. Download the MBR file from the server and run the `dd if=mbr_win7.bin of=/dev/sda bs=446 count=1` command.

6 Run the `sidChange -i` command. This command changes the Security Identifier (SID) of the Windows system and it sets the Boot Configuration Data (BCD) offset values of the partition in the registry. If `sysprep` runs on the base system, or if the `restoremask.xml` file is present in the system drive, then this command will not cause any changes.

**Restoring partitions from a combination of BIOS and UEFI SYSPREP images**

To selectively restore partitions from a combination of BIOS and UEFI SYSPREP images, follow the procedure in the below mentioned scenarios:

**Restoring partitions on a UEFI device:**

1. Create the required GPT partitions on a disk.
2. Restore EFI and Recovery Partitions selectively from UEFI based image.
3. Restore the C: drive from the BIOS based image.
4. Run the `sidChange -f` command and reboot the system. This command forcefully changes the Boot Configuration Data (BCD) offset values of the partitions in the registry.

**Restoring partitions on a BIOS device:**

1. Restore the 100 MB boot partition from a BIOS based image.
2. Restore the C: drive from the UEFI based image.

**NOTE:** Partition restoration to a BIOS device does not require you to run the `sidChange -f` command.

**Partition wise restore for UEFI systems**

To take an image partition wise:

1. On the system with UEFI boot enabled, install the operating system and take the image partition wise using the following commands:
   1. `img -mp <bootpartition>.zmg -I=1`
   2. `img -mp <ESP>.zmg -I=2`
   3. `img -mp <WRE>.zmg -I=3`
   4. `img -mp <system partition>.zmg -I=4`

2. Make a note of the size of each partition on the base system. The same values can be used during the restoration of the image.

To restore the image partition wise:

1. Run the `img -pc 1 -type=NTFS -size= <xxxxMB> -guid=PartitionType` command to create a GPT partition on a device.

The `PartitionType` attribute in the above command can take any of the following values:

- MBD: Microsoft Basic Data Partition
- MRP: Microsoft Reserved Partition
- WRE: Windows Recovery Environment Partition
- ESP: EFI System Partition

This command will create a 100 MB partition with GUID partition type, and initialize the partition with the NTFS file system.
Ensure that the following conditions are met for a successful partition creation:

- If the partition type is ESP, then the -type value in the command should be FAT32.
- Size of MRP partitions depends on the size of the disk. For a disk size less than 16 GB, the MRP partition is 32 MB, and for a disk size more than 16 GB, the MRP partition is 128 MB.

Example:

```
img -pc 1 -type=NTFS -size=300 -guid=WRE
img -pc 2 -type=FAT32 -size=100 -guid=ESP
img -pc 3 -type=1 -size=128 -guid=MRP
img -pc 4 -type=NTFS -size=40000 -guid=MBD
```

2 Mark the following three partitions as active by using the `img -pa <partition number>` command:

- Boot partition 300MB
- EFI system partition
- Microsoft reserved partition

For example, to make the first partition active, run the `img -pa 1` command. For information about the three partitions, refer to the following table.

<table>
<thead>
<tr>
<th>Number</th>
<th>Start</th>
<th>End</th>
<th>Size</th>
<th>File system</th>
<th>Name</th>
<th>Flags</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1049MB</td>
<td>316MB</td>
<td>315MB</td>
<td>ntfs</td>
<td>Basic data partition</td>
<td>hidden, diag</td>
</tr>
<tr>
<td>2</td>
<td>316MB</td>
<td>420MB</td>
<td>105MB</td>
<td>fat32</td>
<td>EFI system partition</td>
<td>boot</td>
</tr>
<tr>
<td>3</td>
<td>420MB</td>
<td>555MB</td>
<td>134MB</td>
<td></td>
<td>Microsoft reserved</td>
<td>msftres</td>
</tr>
<tr>
<td>4</td>
<td>555MB</td>
<td>26.8GB</td>
<td>26.8GB</td>
<td>ntfs</td>
<td>Basic data partition</td>
<td></td>
</tr>
</tbody>
</table>

3 Restore each partition using the advanced switches:

- `img -r -p <bootpartition>.zmg -ap=a1:p1`
- `img -r -p <ESP>.zmg -ap=a1:p2`
- `img -r -p <WRE>.zmg -ap=a1:p3`
- `img -r -p <system partition>.zmg -ap=a1:p4`

4 Run the `sidChange -i` command. This command changes the Security Identifier (SID) of the Windows system and it sets the Boot Configuration Data (BCD) offset values of the partition in the registry. If sysprep runs on the base system, or if the `restoremask.xml` file is present in the system drive, then this command will not cause any changes.

Restoring Linux images partition-wise:

1 Run the following GRUB install command:

```
grub-install.unsupported --recheck --root-directory=/mnt /dev/sda
```

2 Mount the boot partition to the /mnt directory.

If the `/etc/fstab` and the `grub.conf` files use UUID to map the partitions, then execute the procedure given below before running the `grub-install.unsupported --recheck --root-directory=/mnt /dev/sda` command:

1 Obtain the UUID for the partitions by running the following command:

```
# blkid -o full -s UUID
```

You can see the following message on the screen:

```
/dev/sda1: UUID="a0f83e2a-1579-423e-9a5b-70104f5ff384"
/dev/sda2: UUID="de8c2a54-ec39-45bf-8c9e-fa63b3585193"
```
Using Imaging

/dev/sda3: UUID="781f9eb0-faf4-4b39-b431-908179ad72b4"

2 Mount the boot partition and update the `fstab` and the `grub.conf` files by running the following command:

   #mount /dev/sda1 /mnt

3 Edit the `/mnt/etc/fstab` directory as shown:

   #
   UUID=a0f83e2a-1579-423e-9a5b-70104f5f384 / ext4
   defaults 1 1
   UUID=de8c2a54-ec39-45bf-8c9e-fa63b3585193 /home ext3
   defaults 1 2
   UUID=781f9eb0-faf4-4b39-b431-908179ad72b4 swap swap
   defaults 0 0

4 Edit the `/mnt/etc/grub.conf` file as shown:

   kernel /boot/vmlinuz-2.6.32-358.el6.x86_64 ro root=UUID=a0f83e2a-1579-423e-9a5b-70104f5f384 rd_NO_LUKS rd_NO_LVM LANG=en_US.UTF-8 rd_NO_MD SYSFONT=latarcyrheb-sun16 crashkernel=128M KEYBOARDTYPE=pc KEYTABLE=us rd_NO_DM rhgb quiet

3.14.4 Disabling the Tuxera Driver for ZENworks Imaging

To disable the Tuxera driver and use the legacy NTFS driver for Imaging operations:

1 On the PXE server, open the `HighPerfDriver.conf` file. The file path is as given below:
   Windows: \Program Files\Novell\ZENworks\Share\tftp
   Linux: /srv/tftp

2 Comment out the following lines for the High Performance driver as shown:
   NTFSDriver=<zenworks_version>/x86/tntfs.ko
   NTFSDriver_x64=<zenworks_version>/x86_64/tntfs.ko

3 Delete the `ntfsdriver-RANDOMNUMBER.zip` file from the `content-repo/tmp/imaging` folder.

   Path to the `content-repo` folder on the server:
   Windows: %ZENWORKS_HOME%\work\content-repo
   Linux: /var/opt/novell/zenworks/content-repo

4 Restart the imaging services on the PXE server for the changes to apply.

NOTE: To use the Tuxera driver again, you need to re-upload the `tntfs.ko` file from ZENworks Control Center.

3.15 Remote Imaging over SSH

An on-demand SSH server has been introduced for the ZENworks Imaging distro. If the server is turned on, it can be reached over the network from another device. This feature is useful in the following scenarios:

- If your device keyboard or keypad is not detected or not working in the distro environment, you can still perform imaging from another machine.
On devices that have a very high-resolution, the imaging GUI might not display correctly. You can connect to these devices from another device and perform imaging.

To troubleshoot or access the Imaging distro environment from another device.

The SSH server is turned off by default. To turn it on, use the boot parameter `SSHD=1`. In the manual mode, the IP address of the device will be displayed in the console before the distro prompt appears. You can use the IP address to connect to the device using an SSH client. If you are not able to view the machine, use the ZENworks Control Center device details or the imaging preboot logs to identify the IP address.

To perform imaging with a server, run the `export PROXYADDR=SERVER_IP` command.

To work in the UEFI mode, run the `export NOVELL_FIRMWARE_UEFI=true` command.

The SSH shell runs in a non-elevated mode. To elevate it (to use commands such as `reboot` and `halt`) you need to source `/bin/bashrc` by running the `./bin/bashrc` command or the `source /bin/bashrc` command. If any other device that is able to connect to the pxe client from another machine

### 3.16 Converting MBR Disk to GPT Disk

An MBR based disk can be converted to GPT disk without formatting the disk.

Following are the use cases:

- To convert only MBR data disk to GPT
- To convert an MBR disk with Operating system to GPT

**To convert only MBR data disk to GPT:**

- Run the `img -convert <disk_name>`.
  
  For example, `img -convert /dev/sdX`

  Where sdX is the disk name.

**Prerequisite to convert MBR disk with operating system:**

- Take an image of boot partition from the UEFI based Windows operating system. To identify EFI system partition run `img -p` and look for `<partition_type>` of type FAT32 EFI system partition.

**To convert an MBR disk with operating system to GPT:**

1. Run `img -convert <disk_name>`
   
   For example, `img -convert /dev/sdX`

   Where sdX is the disk name.

2. Delete the existing boot partition by running `img -pd <Partition_Number>`.
   
   Where `<Partition_Number>` is the number taken in the prerequisites.

3. After deleting the old boot partition, create a new boot partition in the same location by running `img -pc <partition_Number> -type=FAT32 -size=100 -guid=ESP`.

4. Make the boot partition as the active partition by running `img -pa <partition_Number>`.

5. Restore the UEFI image of the boot partition with the partition created in **Step 3**.
   
   For example, `img -rp <Image_Name> -ap=ax:py`
6 Change the security identifier by running `sidChange -i`.
7 Change the firmware to UEFI in BIOS settings.

**NOTE**

- Supports only FAT and NTFS partition types.
- Supports up to 26 partitions including extended partitions. If the partition is mounted from A to Z in the available mount point, then the partition retains the mount point.
- If any extended partition is mounted to a folder inside any pre-occupied mount point, then the folder is inaccessible after conversion. However, data will be present in the created volume and it can be accessed by mounting it on to a folder, or to a free mount point.
- If the ZEN or DELL-DTK partition exists on the MBR disk, then it cannot be converted to GPT.
- If any partition of the MBR disk is mounted in the distro, then the disk cannot be converted to GPT.
Imaging Operations in a ZENworks Asset Management Agent and ZENworks Desktop Management Agent Coexistence Environment

If the ZENworks Agent with Asset Management and the ZENworks 7.x Desktop Management (ZDM 7.x) Agent coexist in your environment, the ZENworks Configuration Management managed device is registered to the ZENworks server with the same device GUID as the ZDM 7.x Agent GUID.

For more information on deploying the ZENworks Agent to devices that have the ZDM 7.x Agent installed, see Coexisting with the ZENworks Desktop Management Agent in the ZENworks Discovery, Deployment, and Retirement Reference.

Refer to the following sections for information about the imaging operations from the ZDM 7.x server:

- Section 4.1, “Taking an Image of a Device that has the ZDM 7.x Agent and the ZENworks Agent with Asset Management Installed,” on page 179
- Section 4.2, “Restoring the Image,” on page 180

4.1 Taking an Image of a Device that has the ZDM 7.x Agent and the ZENworks Agent with Asset Management Installed

1 At the command prompt of the managed device that has the ZDM 7.x agent and the ZENworks Agent with Asset Management installed, run the following command:
   `zac fsg -d`
   This takes a backup of DeviceGUID and DeviceID files, and subsequently deletes the files. The `.sav` file is created in `zenworks_installation_directory/novell/zenworks`.

2 Launch ConsoleOne on the ZDM 7.x server, and create a task to take an image of the managed device.

3 Reboot the managed device in the PXE mode.
   An image of the device is taken and it is saved in the location that you specified while creating the task to take an image in Step 2.
4.2 Restoring the Image

The image of device that has the ZDM 7.x agent and the ZENworks Agent with Asset Management installed can be restored in the following ways:

- Section 4.2.1, “Restoring the Image on the Same Device Whose Image was Taken,” on page 180
- Section 4.2.2, “Restoring the Image to Another Device that Has Only the ZDM 7.x Agent Installed,” on page 180
- Section 4.2.3, “Restoring the Image to a Non-Registered Device,” on page 181

4.2.1 Restoring the Image on the Same Device Whose Image was Taken

If you have taken an image of a device that has the ZDM 7.x and the ZENworks Agent with Asset Management installed, perform the following tasks to restore the image on the same device:

1. Ensure that the image is taken as described in Section 4.1, “Taking an Image of a Device that has the ZDM 7.x Agent and the ZENworks Agent with Asset Management Installed,” on page 179.
2. Launch ConsoleOne on the ZDM 7.x server.
3. Create an imaging object with the path of the image of the managed device taken in Step 2 on page 179.
4. Go to the managed device’s properties page, select the Restore Image option, and assign the image object you created in Step 3.
5. Reboot the managed device in the PXE mode.

The image is restored to the device. After the image is restored, the ISD data and the GUID of the device remain unchanged, and the device can communicate to both the ZDM 7.x and ZENworks Configuration Management servers.

4.2.2 Restoring the Image to Another Device that Has Only the ZDM 7.x Agent Installed

1. Ensure that the image is taken as described in Section 4.1, “Taking an Image of a Device that has the ZDM 7.x Agent and the ZENworks Agent with Asset Management Installed,” on page 179.
2. Launch ConsoleOne on the ZDM 7.x server.
3. Create an imaging object with the path of the image of the managed device taken in Step 2 on page 179.
4. Go to the Properties page on the device that has only the ZDM 7.x Agent installed, and on which you want to restore the image.
5. Select the Restore Image option, and assign the image object you created in Step 3.
6. Reboot the managed device on which you want to restore the image in the PXE mode.
The image is successfully restored to the device. After the image is restored, the ISD data and GUID of the device remain unchanged, and the device can communicate to both the ZDM 7.x server and the ZENworks Configuration Management server.

In ZENworks Control Center, a new object is created within the Workstation folder of the Devices tab. The GUID of the object is same as that in the ISD.

### 4.2.3 Restoring the Image to a Non-Registered Device

If you have taken an image of a device that has the ZDM 7.x agent and ZENworks Agent with Asset Management installed, you can restore the image to a non-registered device that has non-registered device settings configured.

1. Ensure that the image is taken as described in Section 4.1, “Taking an Image of a Device that has the ZDM 7.x Agent and the ZENworks Agent with Asset Management Installed,” on page 179.

2. Launch ConsoleOne on the ZDM 7.x server.

3. Create an imaging object with the path of the image of the managed device taken in Step 2 on page 179.


5. Configure the non-registered device settings.

6. Create a hardware rule, and assign the image object created in Step 3.

7. Reboot the non-registered device in the PXE mode.

   The image is restored to the non-registered device.

   The device is registered to the ZDM 7.x server, and a new object is created in ConsoleOne. The device is also registered to the ZENworks Configuration Management server, and a new object is created in ZENworks Control Center (Devices tab > Workstation folder).

8. In ZENworks Control Center, click the Devices tab > the Workstation folder.

9. Delete the workstation object created in Step 7.

10. Boot the device that is imaged, and run the following command:

    `zac fsg -d`

11. Reboot the device.

   The device’s DeviceGUID is same as the GUID with which it is registered with ZDM 7.x server.
5 Preboot Actions

The Actions panel displays the action sets available for the bundle. Depending on the bundle type, the possible action sets are Install, Launch, Verify, Uninstall, Terminate, and Preboot. For example, if you select a Windows bundle, five action sets are available. If you select a Preboot bundle, Preboot is the only action set available.

You can add an action to any of the available action sets. When you do so, that action is performed whenever the action set is applicable. For example, when you add an action to the Install action set, that action is performed whenever the bundle is installed.

The following sections contain information about the actions you can configure for the Preboot action set. For more information about the actions you can configure for the Install, Launch, Verify, and Terminate action sets, see “Actions” in the ZENworks Software Distribution Reference.

- Section 5.1.1, “Adding a New Imaging Script Action,” on page 183
- Section 5.1.2, “Editing an Existing Imaging Script Action,” on page 184
- Section 5.2, “Action - Linked Application Bundle,” on page 184
- Section 5.3, “Action - MDT Deployment,” on page 184
- Section 5.4, “Action - Multicast Image Set,” on page 185
- Section 5.5, “Action - ZENworks Image,” on page 187
- Section 5.6, “Action - Third Party Image,” on page 187
- Section 5.7, “Action - Third-Party Script,” on page 188
- Section 5.8, “Action - AutoYaST Bundle,” on page 189
- Section 5.9, “Action - DellDTK Configuration,” on page 192
- Section 5.10, “Action - Kickstart,” on page 193

5.1 Action - Imaging Script

Depending on which dialog box you accessed, you can either add a new Imaging Script action to the current bundle’s Preboot actions, or edit an existing Imaging Script.

Imaging Script bundle can contain any ZENworks script (containing the general shell and ZENworks Imaging Engine commands) that you can run from the imaging maintenance mode prompt.

- Section 5.1.1.1, “Adding a New Imaging Script Action,” on page 183
- Section 5.1.2, “Editing an Existing Imaging Script Action,” on page 184

5.1.1 Adding a New Imaging Script Action

1. Specify a script name in the Action Name field.
2. Specify the text of the script in the Script Text field.
   The script is restricted to doing imaging work prior to the device’s operating system startup.
3. Click OK to create the new script action.
5.1.2 Editing an Existing Imaging Script Action

1. In the **Action Name** field, edit the existing name as needed.
2. In the **Script Text** field, edit the existing script as needed.
3. Click **OK** to save the changes.

5.2 Action - Linked Application Bundle

The Action - Linked Application Bundle dialog box allows you to link an Application bundle to the selected Preboot bundle. The content of the linked application bundle is deployed from the device local add-on imaging path (`%ZENWORKS_HOME%\work\addons\` on Windows) based upon the deployment schedule of the user or device assignment, which is added to the application bundle.

The add-on image is dynamically created from the linked application bundle when the Preboot bundle is applied. However, you must create the add-on image in the application bundle in order for this to work.

To link to the application bundle and create the add-on image in that bundle:

1. On the **Actions** tab of the Preboot bundle, then click **Add** in the Preboot section.
2. Specify a link name in the **Action Name** field.
3. In the **Select an Application Bundle to Link to** field, browse for and select the bundle.
4. Click **OK** to make the link.
5. If the add-on image has not yet been created in the linked application bundle, do the following:
   5a. Click **Bundles** in the left pane, click the desired Windows application bundle, then in the **Add-on Image File** field on the **Summary** tab, click **Create**.
   5b. In the Bundle Add-on Image Wizard, click **Add**.
   5c. Browse for and select an Imaging Server, then click **Finish**.

   The image of the application bundle is created and used when the Preboot bundle is applied to the devices.

   Ensure that the bundle you select in the **Select an Application Bundle to Link to** field is assigned to the device along with the Preboot bundle.

5.3 Action - MDT Deployment

The MDT Deployment bundle supports the deployment of the Windows operating system using Microsoft Deployment Toolkit (MDT). The supported version is Microsoft Deployment Toolkit (MDT) 2013 Update 1. The uploaded MDT content will be replicated to the selected Primary and Imaging Satellite Servers. Using this page you can upload 32-bit and 64-bit WIM images.

To select the MDT WIM image that has to be used in this imaging bundle, based on whether it is a 32-bit or 64-bit file, upload the WIM image in the relevant section of this page:

- To upload the new image, in the **Upload a New MDT Image section**, click the browse icon, and select and upload the new WIM image.

**NOTE:** To upload the image, ensure that Microsoft Windows Assessment and Deployment Kit (WADK) is installed on the device running ZENworks Control Center. You can download WADK from the [Microsoft Download Center Web site](https://www.microsoft.com).
Depending on which dialog box you accessed, you can either add a new MDT Deployment action to the current bundle’s Preboot actions, or edit an existing MDT Deployment.

The Action - MDT Deployment dialog box provides the ability for the Windows operating system deployment using Microsoft Deployment Toolkit (MDT). The content will be replicated to the selected Primary and Imaging Satellite Servers.

The `zman betf` and `zman bc` commands are not supported for MDT Deployment bundles and for Preboot bundles containing an MDT Deployment Action.

**IMPORTANT:** If you have created an MDT deployment bundle in 2017 Update 2 or an earlier version, and if you upload the MDT settings in 2017 Update 3 or a later version, then you need to re-upload the MDT image files for the configuration settings to take effect during MDT deployment.

### 5.3.1 Adding an MDT Deployment Action

1. Specify the name of the action in the **Action Name** field.
2. Based on whether you want to upload a 32-bit or 64-bit file, upload the MDT WIM image from the relevant section of the page:
   - To upload a new image, in the **Upload a New MDT Image** section, click the browse icon, and select and upload the new WIM image.
   
   **NOTE:** To upload the image, ensure that Microsoft Windows Assessment and Deployment Kit (WADK) is installed on the device running ZENworks Control Center. You can download WADK from the [Microsoft Download Center Web site](https://www.microsoft.com/download).

3. Click **OK** to create the new MDT Deployment action.

   Preboot bundle can contain only one MDT Deployment action.

### 5.3.2 Editing an MDT Deployment Action

1. In the **Action Name** field, edit the existing name as needed.
2. To upload a new image, in the **Upload a New MDT Image** section, click the browse icon, and select and upload the new WIM image.

3. Click **OK** to save the changes.

For information on the replication behavior for the MDT Deployment Action, see Section 3.8.1, “Content Replication for MDT Deployment Action,” on page 145.

### 5.4 Action - Multicast Image Set

Depending on which dialog box you accessed, you can either add a new Multicast Image Set action to the current bundle’s Preboot actions, or edit an existing Multicast Image Set.

Multicast Image Set bundles use an image that was previously taken from a device and stored on an Imaging Server. The image is sent to multiple devices at one time to reimage them, rather than being sent one time for each device, thus saving on network bandwidth usage. For example, if you have 10 devices in the multicast session and the image is 3 GB in size, your network experiences 3 GB of network traffic to image all 10 devices. Without multicasting, the network experiences 30 GB of network traffic.
For multicasting to work properly, all routers and switches on the network must have their multicast features configured. Otherwise, multicast packets might not be routed properly.

A multicast session consists of all clients (devices) that are assigned to the Multicast Session Set bundle that are booting (joining), but must wait for a start trigger in order to complete booting. In other words, the boot processes for the devices can be held up until one of the triggers is encountered. You specify an elapsed time or number of clients entry as the trigger.

After a session has started, other devices that boot and that are assigned to this bundle do not become part of this session, but become part of the next session when it triggers.

There are two triggers (elapsed time or number of clients joining) that you can use to determine when to start the multicast session. The first trigger to be encountered starts the session. These triggers are useful if you want economy of scale in having multiple clients join, but you don’t want to stall the session too long.

- Section 5.4.1, “Adding a Multicast Image Set Action,” on page 186
- Section 5.4.2, “Editing a Multicast Image Set Action,” on page 186

### 5.4.1 Adding a Multicast Image Set Action

1. Specify a multicast name in the **Action Name** field.
2. Specify the minimum number of clients needed in order to start the multicast session.
3. Specify the time to wait before starting a multicast session if not enough clients have connected. The time out period is reset after each client joins the session. For example, if you have set 5 minutes as the time out period, and if client 2 joins the session at third minute, then the time out is calculated afresh from the time the client 2 joins the session.
4. Select the appropriate option for multicast imaging. Following are the options for multicast imaging:
   - Select ZENworks Linux Imaging to multicast the image using the Linux distro.
   - Select ZENworks WinPE Imaging to multicast the image using WinPE distro.
5. In the **Items to be Included in the Multicast Session** field, do the following as applicable:
   - To add an image, click **Add Image**, then browse for and select the image file.
   - To add an application, click **Add Application**, then browse for and select the application file.
   - To edit an existing entry, select the entry, then click **Edit**.
   - Use the **Move Up** and **Move Down** buttons to change the order of execution for the listed items.
   - To remove an entry, select it, then click **Remove**. You can select and remove multiple items at a time.
6. Click **OK** to create the new multicast action.

### 5.4.2 Editing a Multicast Image Set Action

1. In the **Action Name** field, edit the existing name as needed.
2. If necessary, change the number of clients needed in order to start the multicast session.
3. If necessary, change the time to wait before starting a multicast session if not enough clients have connected.
4. (Optional) If required, you can change the multicasting imaging mode.
5. As necessary, edit the **Items to be Included in the Multicast Session** field.
You can add or remove items, edit existing items, or change their order of execution.

6 Click OK to save the changes.

5.5 Action - ZENworks Image

Depending on which dialog box you accessed, you can either add a new ZENworks Image action to the current bundle’s Preboot actions, or edit an existing ZENworks image.

- Section 5.5.1, “Adding a ZENworks Image Action,” on page 187
- Section 5.5.2, “Editing a ZENworks Image Action,” on page 187

5.5.1 Adding a ZENworks Image Action

1 Specify an image name in the Action Name field.

2 In the ZENworks Image File field, browse for and select the image file.
   This image file must have the .zmg filename extension, meaning it is a valid ZENworks image file.

3 Select a number in the File Set field.
   For information on file sets, see Appendix A, “File Sets and Image Numbers,” on page 197.

4 Restore the image using:
   - ZENworks Linux Imaging: Select this option to restore the image (.zmg) taken using ZENworks Linux distro.
   - ZENworks WinPE Imaging: Select this option to restore the image (.zmg) taken using ZENworks WinPE distro.

5 Click OK to create the new ZENworks Image action.

5.5.2 Editing a ZENworks Image Action

1 In the Action Name field, edit the existing name as needed.

2 In the ZENworks Image File field, browse for and select a different valid image file.

3 To change the file set, select a different number in the File Set field.
   For information on file sets, see Appendix A, “File Sets and Image Numbers,” on page 197.

4 (Optional) If required, change the restore mode setting.

5 Click OK to save the changes.

5.6 Action - Third Party Image

Depending on which dialog box you accessed, you can either add a new Third-Party Image action to the current bundle’s Preboot actions, or edit an existing Third-Party image.

- Section 5.6.1, “Adding a Third-Party Image Action,” on page 188
- Section 5.6.2, “Editing a Third-Party Image Action,” on page 188
5.6.1 Adding a Third-Party Image Action

1. Specify an image name in the Action Name field.
2. In the Image Type drop-down list, select the type of the image to be used in the bundle. The available options are Windows Image Format (.WIM) and Ghost Image Format (.GHO).
3. In the Shared Network Path for Image File field, specify the shared-network path where you want to save the .wim or .gho files. The directory must be a Windows share or a Linux Samba/CIFS share.
   
   If the Novell File Upload extension is not installed on the device, you must install it before you can browse to and upload the file.
4. In the Network Credential field, click to browse for and select the network credentials to be used for accessing the device that has .wim or .gho files.
5. If you want to use the WIM bundle as an add-on image, select the Restore WIM as Add-On option and configure the following options:
   - Image Number (WIM Only): Select the index number of the image to be restored
   - Path to Restore the Add-on Image: Specify the location on the device where you want to restore the add-on image.
6. Click OK to create the new third-party Image action.

5.6.2 Editing a Third-Party Image Action

1. In the Action Name field, edit the existing name as needed.
2. In the Image Type drop-down list, select the type of the image to be used in the bundle.
3. In the Shared Network Path for Image File field, specify the shared-network path where you want to save the .wim or .gho files. The directory must be a Windows share or a Linux Samba/CIFS share.
4. In the Network Credential field, click to browse for and select the network credentials to be used for accessing the device that has .wim or .gho files.
5. If you want to use a WIM bundle as an add-on image, select the Restore WIM as Add-On option and configure the following options:
   - Image Number (WIM Only): Select the index number of the image to be restored
   - Path to Restore the Add-on Image: Specify the location on the device where you want to restore the add-on image.
6. Click OK to save the changes.

5.7 Action - Third-Party Script

Depending on which dialog box you accessed, you can either add a new Third-Party Script action to the current bundle’s Preboot actions, or edit an existing Third-Party Script.
5.8 **Action - AutoYaST Bundle**

Depending on which dialog box you accessed, you can either add a new AutoYaST bundle action to the current bundle's Preboot actions, or edit an existing AutoYaST image. You can configure the specific requirements that a device must meet for the action to be executed on the device.

- Section 5.8.1, “Adding a New AutoYaST Bundle Action,” on page 189
- Section 5.8.2, “Editing an Existing AutoYaST Bundle Action,” on page 191

### 5.8.1 Adding a New AutoYaST Bundle Action

1. Specify a name in the **Action Name** field.
2. In the **Preboot/Installation Source** tab, configure the following settings required to access the Linux boot files from the Preboot TFTP Server:
   - **Preboot Environment Variables**: Configure the following settings:
     Before configuring the Preboot environment variables, ensure that you have copied the RAM drive (**initrd**) and Linux kernel (**linux**) files from the SUSE Linux Enterprise Server (SLES) installation source to the `/srv/tftp/` directory on your Imaging server. By default, the files for 32-bit platforms are located in the `SLES-11-SP3-DVD-i586-GM-DVD1/boot/i386/loader/` directory and for 64-bit platforms in the `SLES-11-SP3-DVD-x86_64-GM-DVD1/boot/x86_64/loader/` directory, in the SUSE Linux Enterprise Server installation source.
     - **Linux Kernel Filename**: Specify the relative path of **linux** in the **tftp** directory. The path should be relative to the default directory of the TFTP daemon.
       For example, if the **linux** file is located in the `/srv/tftp/autoyast/linux` directory on your Imaging server, you must specify the path of the file as `autoyast/linux`.
     - **Initial RAM Drive Filename**: Specify the relative path of **initrd** in the **tftp** directory.
       The path should be relative to the default directory of the TFTP daemon.
       For example, if the **initrd** file is located in the `/srv/tftp/autoyast/initrd` directory on your Imaging server, you must specify the path of the file as `autoyast/initrd`.
     - **Additional Kernel Parameters**: Specify the additional kernel parameters that your Linux kernel might need. These are not Preboot Services or ZENworks parameters. For more information about the kernel parameters, see your Linux documentation.
**Linux Installation Source:** Configure the following settings to obtain the Linux installation source:

- **Protocol:** Select the protocol to be used to connect to the device that has the Linux installation source mounted. The available protocols are **NFS**, **FTP**, **HTTP**, or **TFTP**.

- **IP Address / DNS Name:** Specify the IP address or the DNS name of the device that has the Linux installation source mounted.

- **Path to Network Install Directory (Relative to Protocol):** Specify the path of the Linux installation source. The path should be relative to the default directory of the selected protocol daemon.

  For example, assume that the Linux installation source is located on a SLES 10 device in the `/sles10/SLES-10-SP3-GM/i386/boot/i386/loader/` directory. If you specify HTTP as the protocol, `myserver.provo.novell.com` as the DNS name, and `/sles10/sles-10-sp3-gm/i386/boot/i386/loader/` as the path, the URL to the installation directory is:

  `http://myserver.provo.novell.com/sles10/sles-10-sp3-gm/i386/boot/i386/loader/initrd`

  In this example, `/sles10/sles-10-sp3-gm/i386/boot/i386/loader/initrd` is relative to the protocol and server ID.

3. In the **Script Source** tab, configure the location of the AutoYaST script file, and the settings required to access the file. You can either specify the script location or browse for and select the script. If the script file has system variables, you must choose the **Browse for Script** option to import and upload the file to the Primary Server whose ZENworks Control Center you are using so that the variables are automatically resolved while applying the bundle on the managed devices.

   - **Specify Script Location:** Configure the following settings required to access the script:

     - **Protocol:** Select the protocol to be used to access the AutoYaST script. The available protocols are **NFS**, **FTP**, **HTTP**, **TFTP**, or **FILE**.

       If you select the TFTP protocol, you must copy the AutoYaST XML file that you specify on this wizard page to the TFTP server.

       If you select the FILE protocol, you must copy the AutoYaST XML file that you specify on this wizard page in to the initial RAM drive file that you specified on the Set AutoInstall Attributes wizard page before executing the AutoYaST bundle.

     - **IP Address / DNS Name:** Specify the IP address or DNS name of the device containing the AutoYaST script.

     - **Script Name and Path (Relative to Protocol Default Directory):** Specify the AutoYaST XML filename and its complete path. The path should be relative to the home directory of the selected protocol daemon.

       For example, if you specify HTTP as the protocol, `myserver.provo.novell.com` as the DNS name, and `/scripts/autoyast.xml` as the path and filename, the URL to the installation directory is:

       `http://myserver.provo.novell.com/scripts/autoyast.xml`

       In this example, `/scripts/autoyast.xml` is relative to the protocol and server ID.

   - **Browse for Script:** To browse for the AutoYaST XML file, and upload it to the Imaging server:

     1. Click to display the Upload File dialog box.

     2. Click Browse to browse for and select the AutoYaST XML file.

---

190  Preboot Actions
If the imported XML file has ZENworks variables defined, the variables are resolved when the bundle is applied to the device.

3. When you are prompted to upload the XML file to the Primary Server whose ZENworks Control Center you are using, click OK. The Status field displays the upload status.

4. Click OK.

5. (Optional) Modify the XML file content.
   a. Click Edit Script
      The content of the XML file is displayed in the Edit AutoYaST XML File dialog box.
   b. Edit the script content, then click Save.
      You can also specify ZENworks system variables in the script. For more information, see Section 3.12.2, “Managing Bundle Variables,” on page 154.

6. (Optional) If you want to reuse the XML file to create another Auto YaST bundle:
   a. Click Export XML.
      The Export XML dialog box is displayed.
   b. If the script contains any ZENworks system variables, choose how you want the variables to be resolved while exporting the script to an XML file.
      The following options are available:
         • Do not resolve the variables.
         • Resolve the variables at the Bundle and Zone level: Resolves the system variables that are defined at the bundle and zone level.
         • Resolve variables with respect to bundle and device: Resolve the system variables that are defined at the bundle and device level.
   c. (Conditional) If you choose to resolve the variables at the bundle and device level, click to browse for and select the device on which the variables have been defined.
   d. Click OK.
   e. Save or view the XML file.

4 Click OK to create the new AutoYaST bundle action.

5.8.2 Editing an Existing AutoYaST Bundle Action

1. In the Action Name field, edit the existing name as needed.

2. In the Preboot/Installation Source tab, edit the necessary settings required to access the Linux boot files from the Preboot TFTP Server.
   For detailed information on how to change the settings, see Help.

3. In the Script Source tab, edit the location of the AutoYaST script file, and the settings required to access the file.
   For detailed information on how to change the settings, see Help.

4. Click OK to save the changes.
5.9 Action - DellDTK Configuration

Depending on which dialog box you accessed, you can either add a new DellDTK Configuration bundle action to the current bundle’s Preboot actions or edit an existing DellDTK Configuration image. You can configure the specific requirements that a device must meet for the action to be executed on the device.

- Section 5.9.1, “Adding a New DellDTK Configuration Bundle Action,” on page 192
- Section 5.9.2, “Editing an Existing DellDTK Configuration Bundle Action,” on page 193

5.9.1 Adding a New DellDTK Configuration Bundle Action

1 Specify a name in the Action Name field.

2 Configure the configuration scripts:
   - **BIOS/BMC/DRAC 5 Configuration File**: Specify the path and filename of the BIOS, BMC (Base Management Controller), or DRAC 5 (Dell Remote Access Controller 5) configuration file. The path must be relative to the TFTP server's home directory. Do not specify the tftp directory or any of the path that precedes it.

   **NOTE**: This bundle option configures the BIOS, BMC, or DRAC 5 only; it cannot be used to update them. This option is applicable only for the Dell devices that support the DRAC 5 card.

   - **RAID Configuration Script**: Specify the path and filename of the RAID configuration script relative to the TFTP server's home directory. Do not specify the TFTP directory or any of the path that precedes it.

   - **DRAC Configuration Script**: Specify the DRAC path and filename of the configuration file relative to the TFTP server's home directory. Do not specify the tftp directory or any of the path that precedes it. This option is applicable for the Dell devices that support DRAC card versions prior to version 5.

   For information on how to create these files, see Section 3.7.1, “Creating Dell Configuration Scripts and Files,” on page 140.

3 Configure Dell utility partition.

   To create a new Dell utility partition, select the **Create Dell Utility Partition** check box, then fill in the fields.

   **WARNING**: If you use this option, all the existing partitions on the target disk are replaced by the Dell utility partition. However, you can select the **Overwrite Existing Dell Utility Partition** check box to only update an existing Dell utility partition. In that case, all existing partitions are retained and the Dell server diagnostics utility files are written to the existing Dell utility partition using the entry that you provide in the **File** option.

   You cannot use a ZENworks partition for the same purpose as the Dell utility partition. However, both a Dell utility partition and a ZENworks partition can exist on the same server, with each partition being used for its own purposes.

   - **Partition Size**: This partition requires 32 MB for the Dell server diagnostics utilities. This option is only used when creating a new Dell utility partition.

   - **Target Disk**: This is the disk's identifier, such as /dev/hda. This ID is used to determine the disk for creating the new partition, or for updating an existing partition.

   - **File**: Specify the path to the Dell utility partition file. The path must be relative to the TFTP server's home directory.
The file is written to the partition in the process of creating a new partition or when updating an existing partition.

Dell utility partition files are available on the Dell Installation and Server management CD. For example, for a PowerEdge 1850 system, the file is at `d:\server_assistant\pe1850\upimg.bin`. Copy the necessary files from the CD to a path relative to the TFTP server's home directory for use in this option.

- **Overwrite Existing Dell Utility Partition**: If a Dell utility partition already exists on the selected target disk, select this check box to update the partition with the latest utility files instead of replacing the partition.

4. Click OK to create the new DellDTK Configuration bundle action.

### 5.9.2 Editing an Existing DellDTK Configuration Bundle Action

1. In the **Action Name** field, edit the existing name as needed.
2. In the **Configuration Scripts** panel, edit the necessary settings.
   - For detailed information on how to change the settings, see Help.
3. In the **Configure Dell Utility Partition** panel, edit the necessary settings.
   - For detailed information on how to change the settings, see Help.
4. Click OK to save the changes.

### 5.10 Action - Kickstart

Depending on which dialog box you accessed, you can either add a new Kickstart bundle action to the current bundle's Preboot actions, or edit an existing Kickstart image. You can configure the specific requirements that a device must meet for the action to be executed on the device.

- **Section 5.10.1, “Adding a New Kickstart Bundle Action,” on page 193**
- **Section 5.10.2, “Editing an Existing Kickstart Bundle Action,” on page 194**

#### 5.10.1 Adding a New Kickstart Bundle Action

1. Specify a name in the **Action Name** field.
2. Configure the Preboot environment variables
   - Before configuring the Preboot environment variables, ensure that you have copied the kernel and RAM drive files from the Red Hat Enterprise Linux installation source to the `/srv/tftp/kickstart/` on your Imaging server. By default, the kernel file (`vmlinuz`) and the RAM drive file (`initrd.img`) are located in the `/isolinux` directory in the Red Hat Enterprise Linux installation source.
   - **Linux Kernel Filename**: Specify the relative path of `vmlinuz` in the `tftp` directory. The path should be relative to the default directory of the TFTP daemon.
     - For example, if `vmlinuz` is located in the `/srv/tftp/kickstart/` directory on your Imaging server, you must specify the path of the file as `kickstart/vmlinuz`.
   - **Initial RAM Drive Filename**: Specify the relative path of `initrd.img` in the `tftp` directory. The path should be relative to the default directory of the TFTP daemon.
     - For example, if `initrd.img` is located in the `/srv/tftp/kickstart/` directory on your Imaging server, you must specify the path of Linux kernel file as `kickstart/initrd.img`.
• **Additional Kernel Parameters:** Specify the additional kernel parameters that your Linux kernel might need. These are not Preboot Services or ZENworks parameters. They are parameters that your Linux kernel needs. For more information about the kernel parameters, see your Linux documentation.

3 Configure the location of the Kickstart configuration file, and the settings required to access the file. You can either specify the file location or browse for and select the file. If the configuration file has system variables, you must choose the **Browse for Script** option to import and upload the file to the Primary Server whose ZENworks Control Center you are using so that the variables are automatically resolved while applying the bundle on the managed devices.

• **Specify Script Location:** Configure the following settings to access the configuration file:
  
  • **Protocol:** Select the protocol to be used to access the device containing the Kickstart configuration file. The available protocols are NFS and HTTP.

  • **Script Name and Path (Relative to Protocol Default Directory):** Specify the Kickstart configuration filename and its complete path. The path should be relative to the home directory of the selected protocol daemon.

    For example, if you specify HTTP as the protocol, myserver.provo.novell.com as the DNS name, and /config/ks.cfg as the complete path of the configuration file, the URL to the installation directory is:

    http://myserver.provo.novell.com/config/ks.cfg

    In this example, /config/ks.cfg is relative to the protocol and server ID.

  • **Browse for Script:** Browse for the Kickstart configuration file, and upload it to the Imaging server.

    1. Click to display the Upload File dialog box.
    2. Click Browse to browse for and select the Kickstart configuration file (.cfg).

    If the imported XML file has ZENworks variables defined, the variables are resolved when the bundle is applied to the device.

    3. When you are prompted to upload the file to the Primary Server whose ZENworks Control Center you are using, click OK.

    The Status field displays the upload status.

    4. Click OK.

    5. (Optional) Modify the configuration file content:

      a. Click Edit Script.

        The content of the configuration file is displayed in the Edit Kickstart File dialog box.

      b. Edit the script content, then click Save.

        You can also specify ZENworks system variables in the script. For more information, see Section 3.12.2, “Managing Bundle Variables,” on page 154.

4 Click OK to create the new Kickstart bundle action.

### 5.10.2 Editing an Existing Kickstart Bundle Action

1 In the Action Name field, edit the existing name as needed.

2 In the Preboot Environment Variables panel, edit the necessary settings.

    For detailed information on how to change the settings, see Help.

3 In the Kickstart Configuration Source panel, edit the necessary settings.
For detailed information on how to change the settings, see Help.
4 Click OK to save the changes.
A.1 File Sets

File sets allow you to create subsets of an image for applying to different devices. This is done by using a file set number that represents a version of the image where certain content is excluded.

When you create an Image bundle in ZENworks Control Center, you must select a file set number. By default, file set 1 is selected. In Image Explorer you can exclude content from file sets. For example, if you create a bundle that includes file set 1, any content in Image Explorer that has file set 1 in the Sets Excluded From column is excluded from the bundle.

A separate image file is not created for a file set; instead, a file set contains internal attributes representing the excluded information. Even though a file set does not exist as a separate, physical image file, it is accessed as though it is, placing the image on the receiving device, minus the excluded files. The advantage this provides is that it allows you to create an image and modify it slightly for various devices, instead of creating separate images for each device.

An image has 10 possible file sets, labeled Set 1, Set 2, and so on. Each of the 10 file set numbers initially represents the original image. When you assign any file or directory in the image to a file set number (using Image Explorer), that file set number then represents a subset of the image, which you can select when creating an Image bundle.

Because there are only 10 file set numbers available, after you have assigned all 10 file set numbers to various files or directories in the image, you no longer have a file set that represents the full image. Therefore, reserve file set 1 as the image file set where no files or directories are excluded.

You can represent a file set in long or short forms. For example, file set 1 can be represented as follows:

- Long form: `-set=1`
- Short form: `-s:1`

IMPORTANT: Because file sets only concern excluded files, any files added to the image through Image Explorer are added to all existing file sets. If you do not want new files included in a particular file set, you must use Image Explorer to exclude these new files from that file set.
A.2 Image Numbers

Image Numbers are specific to WIM imaging. You can store more than one image in a WIM file. Each image is identified by an image index, which is represented as the WIM Image Number.

The WIM image number can be used in incremental back up in which you can maintain different Images corresponding to different states of the device and can restore to any particular state by selecting the Image Number to restore to.

For a base Image, if the device had more than one partition, then each partition image has a unique image number. By using image numbers, you can restore a particular partition.

While restoring an Add On Image, you must specify the image number corresponding to the image to be restored.
Replicating the TFTP Directory

ZENworks allows you to replicate the changes made to the `tftp` directory on other Imaging servers (Primary Servers or Satellites with the Imaging role). In the `tftp` directory, if you add or modify files, then that content will be replicated but deletion of files are not supported.

The `tftp` directory contains files such as configuration files and binaries used by ZENworks to perform imaging tasks. The directory is located on the Imaging server in `/srv/` on Linux and in `%ZENWORKS_HOME%\share\` on Windows.

**NOTE:** The files under the `tftp\mdt` directory will not be replicated during the TFTP Directory Replication.

You can configure the replication settings at three levels:

- **Management Zone:** The settings are inherited by all device folders and devices, except where device folder or device-specific settings are configured.
- **Device Folder:** The settings are inherited by all devices contained within the folder or its subfolders.
- **Device:** The settings apply only to the device for which they are configured.

Review the following sections to configure the replication settings:

- **Section B.1, “Configuring the TFTP Directory Replication Settings at the Management Zone Level,”** on page 199
- **Section B.2, “Configuring the TFTP Directory Replication Settings at the Folder Level,”** on page 201
- **Section B.3, “Configuring the TFTP Directory Replication Settings at the Device Level,”** on page 203
- **Section B.4, “Understanding the TFTP Replication Schedule Types,”** on page 204
- **Section B.5, “Resolving Circular Dependency on the Master Primary Server,”** on page 205

### B.1 Configuring the TFTP Directory Replication Settings at the Management Zone Level

To replicate the changes made to the `tftp` directory on all the Imaging servers (Primary Servers or Satellites with the Imaging role) in the Management Zone:

1. In ZENworks Control Center, click the **Configuration** tab.
2. In the Management Zone Settings panel, click **Device Management > Preboot Services > TFTP Replication Settings.**
3. In the **Master Primary Server to Start the TFTP Replication** field, specify or click to browse for and select the Primary Imaging server whose `tftp` directory changes you want to replicate on all other servers in the zone.
Ensure that there is no circular dependency on the selected Primary Server. For more information on how to resolve a circular dependency, see Section B.5, “Resolving Circular Dependency on the Master Primary Server,” on page 205.

**NOTE:** If you choose a Linux Imaging server as the master Primary Server, ensure that all the files that are added to the /srv/tftp/ directory on the master Primary Server have the zenworks ownership. To change the ownership of a file to zenworks, use the `chown zenworks:zenworks filename` command.

4. (Conditional) If you do not want to replicate the tftp directory changes on a specific server in the zone, click Add in the Excluded Servers pane, and select the server to be excluded. The server is added to the Excluded Servers list.

5. Configure the schedule when you want the tftp directory changes to be replicated on the servers. You can set up a schedule and as well as immediately start the replication.

   - To immediately start the tftp directory replication, click **Start Now** in the TFTP Folder Replication field.
   - To set up a schedule:
     1. In the Schedule Type field, select one of the following schedules:
        - Date Specific
        - Recurring
     2. Fill in the fields.
        For details about the fields, click the appropriate schedule listed above.

6. Click **OK**.

   The tftp directory changes are replicated on all the servers in the zone except for the servers that are in the Excluded Servers list.

7. (Optional) To view the replication status, click **Show Status** in the TFTP Replication Status field. The status is displayed in the Replication Status dialog box.

   The Replication Status dialog box displays the status of the tftp directory replication on the Imaging servers.

   The following information is displayed for each server:
   - Hostname of the Imaging server on which the tftp directory is replicated.
   - Hostname of the master Imaging server from where the changes are to be replicated.
   - Status of the replication.
Replicating the TFTP Directory

Status | Details
--- | ---
Pending | Replication of the tftp directory changes has been initiated on the master Primary Server, and the server is awaiting a response from the target Imaging servers.
Success | The tftp directory changes have been successfully replicated from the master Primary Server to the Imaging servers.
In Sync | There are no changes to be replicated because the tftp directory on the Imaging servers is in sync with the tftp directory on the master Primary Server.
Failure | The tftp directory replication failed. For details, see zmd-messages.log on the Imaging server and loader-messages.log on the master Primary Server.

- Date or time when the replication completed.

The completion date is displayed for all the replications completed prior to the current date, and the completion time is displayed for all the replications completed on the current date. If you want to view the date, time, and the time zone, move the mouse cursor over the displayed time or date.

To view the replication status of a specific Imaging server, specify the Imaging server hostname in the Name Filter field, then click .

In the list, you can sort the imaging servers by the time when the replication was completed.

The status entries for an Imaging server are deleted from the Replication Status dialog box in the following scenarios:

- The Imaging role is removed from the Satellite.
- The Imaging Server is deleted. (ZENworks is uninstalled either from the Primary Server or the Secondary Server).

If two tftp replication tasks are consecutively performed on a device and if the second task is triggered prior to the completion of the first task, only the changes in the last triggered replication (which is cumulative of the first and the second tasks) are applied on the device.

### B.2 Configuring the TFTP Directory Replication Settings at the Folder Level

To replicate the changes made to the tftp directory on all the Imaging servers (Primary Server or Satellite with the Imaging role) located within the Servers or Workstations folder:

1. In ZENworks Control Center, click the Devices tab.

   The Managed tab is displayed by default.
2 Click the Details link next to the Workstations or Servers folder containing the Imaging Servers to which you want to replicate the tftp directory changes.

3 Click the Settings tab.

4 Click Device Management > Preboot Services.

5 In the Preboot Services panel, click Override settings to enable you to configure the setting at the folder level.

6 Configure the TFTP Replication settings:

6a In the Master Primary Server to Start the TFTP Replication field, specify or click to browse for and select the Primary Imaging server whose tftp directory changes you want to replicate.

Ensure that there is no circular dependency on the selected Primary Server. For more information on how to resolve a circular dependency, see Section B.5, “Resolving Circular Dependency on the Master Primary Server,” on page 205.

**NOTE:** If you choose a Linux Imaging server as the master Primary Server, ensure that all the files that are added to the /srv/tftp/ directory on the master Primary Server have the zenworks ownership. To change the ownership of a file to zenworks, use the chown zenworks:zenworks filename command.

6b (Conditional) If you do not want to replicate the tftp directory changes on a specific server within the Servers or Workstations folder, click Add in the Excluded Servers pane, then select the server to be excluded.

The server is added to the Excluded Servers list.

6c Configure the schedule when you want the tftp directory changes to be replicated on the server. You can set up a schedule and as well as immediately start the replication.

- To immediately start the tftp directory replication, click Start Now in the TFTP Folder Replication field.

- To set up a schedule:
  1. In the Schedule Type field, select one of the following schedules:
     - Date Specific
     - Recurring
  2. Fill in the fields.
     For details about the fields, click the appropriate schedule listed above.

7 Click OK.

The tftp directory changes are replicated on all the servers in the Servers or Workstations folder except for the servers that are in the Excluded Servers list.

8 (Optional) To view the replication status, see the message log of each server or see the Replication Status dialog box at the Management Zone level (Configuration > Management Zone Settings > Device Management > Preboot Services > TFTP Replication Settings).

If two tftp replication tasks are consecutively performed on a device and if the second task is triggered prior to the completion of the first task, only the changes in the last triggered replication (which is a cumulative of the first and the second tasks) are applied on the device.
B.3 Configuring the TFTP Directory Replication Settings at the Device Level

To replicate the changes made to the `tftp` directory on the Imaging server (Primary Server or Satellite with the Imaging role):

1. In ZENworks Control Center, click the Devices tab. The Managed tab is displayed by default.
2. Click the Workstations or Servers folder containing the Imaging Server to which you want to replicate the `tftp` directory changes.
3. Click the Imaging server.
4. Click the Settings tab.
5. Click Device Management > Preboot Services.
6. In the Preboot Services panel, click Override settings to enable you to configure the setting at the device level.
7. Configure the TFTP Replication Settings:

   7a. In the Master Primary Server to Start the TFTP Replication field, specify or click to browse for and select the Primary Imaging server whose `tftp` directory changes you want to replicate.

   Ensure that there is no circular dependency on the selected Primary Server. For more information on how to resolve a circular dependency, see Section B.5, “Resolving Circular Dependency on the Master Primary Server,” on page 205.

   **NOTE:** If you choose a Linux Imaging server as the master Primary Server, ensure that all the files that are added to the `/srv/tftp/` directory on the master Primary Server have the `zenworks` ownership. To change the ownership of a file to `zenworks`, use the `chown zenworks:zenworks filename` command.

   7b. Configure the schedule when you want the `tftp` directory changes to be replicated on the server. You can set up a schedule and as well as immediately start the replication.

      - To immediately start the `tftp` directory replication, click Start Now in the TFTP Folder Replication field.
      - To set up a schedule:
         1. In the Schedule Type field, select one of the following schedules:
            - Date Specific
            - Recurring
         2. Fill in the fields.

         For details about the fields, click the appropriate schedule listed above.

7. Click OK.

   The `tftp` directory changes are replicated on the Imaging server.

8. (Optional) To view the replication status, see the message log of the device.

If two `tftp` replication tasks are consecutively performed on a device and if the second task is triggered prior to the completion of the first task, only the changes in the last triggered replication (which is a cumulative of the first and the second tasks) are applied on the device.
B.4 Understanding the TFTP Replication Schedule Types

The following schedules are available:

- **Section B.4.1, “Date Specific,” on page 204**
- **Section B.4.2, “Recurring,” on page 204**

B.4.1 Date Specific

The Date Specific scheduling option lets you specify a date on which to run the event.

**Start Dates:** Click to display a calendar you can use to select a date for the event.

**Start Time:** Starts the event at the time you specify in the **Start Time** field.

B.4.2 Recurring

The Recurring scheduling option lets you repeat the event at a specified interval.

- **“Days of the Week” on page 204**
- **“Monthly” on page 205**

Days of the Week

This schedule lets you specify the days during the week that you want the event to run. The event is run on these same days each week.

Select **Days of the Week**, then fill in the following fields:

- **Sun ... Sat:** Specifies the days of the week you want to run the event.
- **Start Time:** Specifies the time you want to run the event.
- **Process Immediately if Device Unable to Execute on Schedule:** The event is run immediately if, for some reason, the schedule you configured results in the event not being able to run.
- **Use Coordinated Universal Time:** The Start Time is converted to Universal Coordinated Time (UTC). Select this option to indicate that the Start Time you entered is already in Coordinated Universal Time and should not be converted. For example, suppose you are in the Eastern time zone. If you enter 10:00 a.m. and select this option, the Start Time is scheduled for 10:00 UTC. If you don’t select this option, the Start Time is scheduled for 14:00 UTC because Eastern time is UTC - 4 hours.
- **Start at a Random Time between Start Time and End Time:** Starts the event at a randomly selected time between the time you specify in the **Start Time** and **End Time** fields. You can use this option to avoid possible network overload from concurrently scheduled events.
- **Restrict Schedule Execution to the Following Date Range:** Limits running the event to the time period specified by the starting and ending dates.
Monthly

This schedule lets you specify one or more days during the month to run the event.

Select Monthly, then fill in the following fields:

- **Day of the Month**: Specifies the day of the month to run the event. Valid entries are 1 through 31. If you specify 29, 30, or 31 and a month does not have those days, the event is not run that month.
- **Last Day of the Month**: Runs the event on the last day of the month, regardless of its date (28, 29 (for leap years), 30, or 31).
- **First Sunday**: Specifies a specific day of a week. For example, the first Monday or the third Tuesday. Click  to add multiple days.
- **Start Time**: Specifies the time you want to run the event.
- **Process Immediately if Device Unable to Execute on Schedule**: The event is run immediately if, for some reason, the schedule you configured results in the event not being able to run.
- **Use Coordinated Universal Time**: The Start Time is converted to Universal Coordinated Time (UTC). Select this option to indicate that the Start Time you entered is already in Coordinated Universal Time and should not be converted. For example, suppose you are in the Eastern time zone. If you enter 10:00 a.m. and select this option, the Start Time is scheduled for 10:00 UTC. If you don’t select this option, the Start Time is scheduled for 14:00 UTC because Eastern time is UTC - 4 hours.
- **Start at a Random Time between Start Time and End Time**: Starts the event at a randomly selected time between the time you specify in the Start Time and End Time boxes. You can use this option to avoid possible network overload from concurrently scheduled events.
- **Restrict Schedule Execution to the Following Date Range**: Limits running of the event to the time period specified by the starting and ending dates.

B.5 Resolving Circular Dependency on the Master Primary Server

Circular dependency occurs when there are at least two servers, and the servers are master Primary Server of each other.

For example, assume that there are two servers, Server A and Server B, in the Management Zone. In ZENworks Control Center, you configure Server A to be the master Primary Server for Server B at the Management Zone level. Later on, if you try to configure Server B to be the master Primary Server for Server A at the device or folder level, you encounter the following circular dependency error message:

Unable to apply the TFTP Replication settings. Remove the circular dependency for the Master Primary Server. For more information, see the Help.

To successfully configure the TFTP replication settings, ensure that there is no circular dependency on the master Primary Server that you select during the configuration of the TFTP replication settings.
To understand how circular dependency can occur at different levels in ZENworks Control Center and how to resolve it, review the followings sections:

- Section B.5.1, “Resolving Circular Dependency at the Management Zone Level,” on page 206
- Section B.5.2, “Resolving Circular Dependency at the Folder Level,” on page 206
- Section B.5.3, “Resolving Circular Dependency at the Device Level,” on page 206

### B.5.1 Resolving Circular Dependency at the Management Zone Level

Assume there are three servers, A, B, and C, in the Management Zone. During the configuration of the TFTP replication settings at the Management Zone level, you select Server A to be the master Primary Server for the other two servers. Additionally, you configure the TFTP replication settings for Server A at the device level by selecting Server B as the master Primary Server. You encounter the following circular dependency error message:

Unable to apply the TFTP Replication settings. Remove the circular dependency for the Master Primary Server. For more information, see the Help.

To resolve the circular dependency issue, include Server B in the Excluded Servers list of the TFTP replication settings at the Management Zone level. The `tftp` directory changes for Server A are not replicated on Server B, but the `tftp` directory changes for Server B are replicated on Server A.

### B.5.2 Resolving Circular Dependency at the Folder Level

Assume there are three servers, A, B, and C, in folder X. During the configuration of the TFTP replication settings at the folder level, you select Server A to be the master Primary Server for the other two servers. Additionally, you configure the TFTP replication settings for Server A at the device level by selecting Server C as the master Primary Server. You encounter the following circular dependency error message:

Unable to apply the TFTP Replication settings. Remove the circular dependency for the Master Primary Server. For more information, see the Help.

To resolve the circular dependency issue, include Server C in the Excluded Servers list of the TFTP replication settings at the Management Zone level. The `tftp` directory changes for Server A are not replicated on Server B, but the `tftp` directory changes for Server C are replicated on Server A.

### B.5.3 Resolving Circular Dependency at the Device Level

Assume there are three servers, A, B, and C, in the Management Zone. During the configuration of the TFTP replication settings at the device level for Server A, you select Server B to be its master Primary Server. During the configuration of the TFTP replication settings at the device level for Server B, you select Server A to be its master Primary Server. You encounter the following circular dependency error message:

Unable to apply the TFTP Replication settings. Remove the circular dependency for the Master Primary Server. For more information, see the Help.

To resolve the circular dependency issue on the Server B TFTP replication settings, do not select Server A to be the master Primary Server.
Third-Party Imaging

ZENworks supports Microsoft’s ImageX and Symantec Ghost 11.5 third-party imaging tools. ImageX takes the image in the WIM file format and Ghost takes the image in the GHO file format.

C.1 Third-Party Imaging Highlights in ZENworks

- WAIK will work for Windows 7 or earlier, WADK will work for Windows 8 or later versions. WAIK is based on the same kernel as in Windows 7 and WADK is based on the same kernel as in Windows 8.
- The winpe.wim file from WADK is necessary for Third-Party Imaging in Windows 8 or later versions.
- WADK is backward compatible with Windows platforms. WADK is also backward compatible with most hardware platforms with a few exceptions. For details see “ZENworks WADK Imaging works only on Windows 8 or later supported hardware” on page 211.
- In ZENworks 11 SP3 and higher versions, Third-Party Imaging loads the environment based on the hardware architecture. You need 32-bit WAIK or WADK, and 64-bit WADK to image all devices irrespective of the architecture. 64-bit WAIK is not supported. For more information, see “Third-Party Imaging Based On Device Architecture” on page 211.

NOTE

- Before you upload Windows Automated Installation Kit (WAIK) or Windows Assessment and Deployment Kit (WADK) onto the latest version of ZENworks, ensure that all the Primary Servers and Imaging Satellite Servers in the zone are upgraded to the latest ZENworks version.
- After you perform a ZENworks upgrade, for Third-Party Imaging to work properly, re-upload the winpe.wim, imagex.exe, and ghost.exe files from the Third Party Imaging Settings page in the ZENworks Control Center.
- For Full Disk Encrypted systems, images cannot be taken and restored by using the ImageX and Ghost third-party tools.

Currently, only PXE is supported as the boot mechanism for Third-Party Imaging.

Third-Party Imaging requires 32-bit WinPE distro from WAIK/WADK to boot a 32-bit device, and 64-bit WinPE distro from WADK to boot a 64-bit device.

WinPE distro boot depends on the architecture of the machine:

- 64-bit hardware will boot WADK 64-bit environment
- 32-bit hardware will boot WAIK/WADK 32-bit environment

This may not be applicable in some scenarios. For example, this is not applicable on Intel Xeon processors with 2 modes for 64-bit in BIOS. For more information, see “ZENworks WADK Imaging works only on Windows 8 or later supported hardware” on page 211.

NOTE: A 64-bit hardware can have a 32-bit OS installed.
C.2 Things to Know Before Working on ZENworks Third-Party Imaging

Before you begin to work on the ZENworks Third-Party Imaging, you need to know the following:

- Ensure that you upload both 32-bit and 64-bit Third-Party tools when you upgrade to a newer version of ZENworks, even if they were uploaded previously.
- The ZENworks Third-Party Imaging solution does not work on VMware for operating systems other than Windows Vista because of a network card driver problem in WinPE on VMware. Workaround: Do the following:
  1. Close VMware.
  2. Add the following line to the .vmx file:

     ```
     ethernet0.virtualDev = "e1000"
     ```
  3. Restart VMware.
- Before taking an image of the Windows Vista, Windows Server 2008, Windows Server 2008 R2, or Windows 7 device, run SysPrep on the device. Later, you must run Sysprep again on all the devices where the image is restored. This is essential because the SIDchanger is not used for ZENworks Third-Party Imaging.
- ZENworks supports only the default operations that are supported by the third-party Imaging tools. To perform advanced imaging operations that are not directly supported by ZENworks, you can use the third-party Imaging tools later. For more information on the third-party Imaging tools, see Section D.11, “TFTP Client for WinPE,” on page 264.
- If you want third-party Imaging tools to be replicated on a Satellite, the Satellite must have the same version of ZENworks installed as that of the Primary Server.
- Partitions are not supported. Before taking the image, it is recommended that you either uncheck these partitions, or you delete these partitions from the disk by using Diskpart. If the partition is of a standard GUID type, such as MBD, WRE, MRP, or ESP, the administrator has to remove the partition before performing the Take Image operation. The partitions are deleted during image restoration.

C.3 Performing ZENworks Third-Party Imaging by Using ZENworks Control Center

For detailed information, see Section 3.1.1, “Using ZENworks Control Center for Imaging,” on page 94.

C.4 Setting Up Preboot Services for ZENworks Third-Party Imaging

Preboot Services uses PXE to find out if there is imaging work specified for a device and to provide the device with the files necessary to boot to the third-party imaging environment.

Before you can use Preboot Services with automated Preboot bundles, you need to do the following:

1. Install ZENworks Configuration Management on your Imaging Server.
For more information on how to install ZENworks, see “Installing a ZENworks Primary Server on Windows” in the ZENworks Server Installation Guide.

2 Configure the third-party Imaging settings in ZENworks Control Center:

2a Ensure that Microsoft Windows Automated Installation Kit (WAIK) or Windows Assessment and Deployment Kit (WADK) is installed on the device running ZENworks Control Center. Also, ensure that you upload the winpe.wim file from the default installed location.

Add the location of the DISM folder in the WAIK/WADK installation to the Path Windows system environment variable.

You can download WAIK or WADK from the Microsoft Download Center Web site.

2b (Conditional) If you want to run ZENworks Control Center on a 64-bit device, append the WAIK_installation_path\Windows AIK\Tools\x86 to the Path Windows system environment variable.

2c In ZENworks Control Center, click Configuration tab.

2d In the Management Zone Settings panel, click Device Management > Preboot Services > the Third Party Imaging Settings panel.

Prerequisites to upload a 32-bit or a 64-bit winpe.wim, imagex and ghost files:

<table>
<thead>
<tr>
<th>Supported Operating System</th>
<th>WAIK installed Windows 7 (for x86 imaging only), and WADK installed Windows 8 x64, Windows 8.1 x64, and Windows 10 x64 devices.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported browsers</td>
<td>Internet Explorer 10 and above, latest version of Firefox and Google Chrome. Microsoft Edge is not supported. NOTE: Open the browser in the administrator mode or use it from the built-in administrator account.</td>
</tr>
</tbody>
</table>

2e For 32 Bit Upload Settings:

**NOTE:** 32-bit UEFI devices need the 32-bit winpe.wim file from WADK to boot.

Ensure that you install ZCC Helper before uploading the imaging file.

**IMPORTANT:** When you are installing ZCC Helper for the first time on a Windows 8 or later device, while detecting ZCC Helper a browser-related pop-up is displayed, ignore the pop-up.

Upload WinPE Base Distribution (Requires Windows AIK / Windows ADK): Click and allow the browser to launch ZCC Helper to initiate WIM Imaging.

In the Upload WIM Imaging Files dialog box:

1. Upload a 32-bit winpe.wim file:
   - **From WAIK:** Browse to the Windows AIK\Tools\PETools\x86 folder under the installed directory, then select the winpe.wim file.
   - **From WADK:** Browse to the Program Files\Windows Kits\<version>\Assessment and Deployment Kit\Windows Preinstallation Environment\x86\en-us folder under the installed directory, then select the winpe.wim file.

   Where <version> is a Windows Operating System version.
NOTE: Re-uploading the winpe.wim file overwrites the previous instance of this file from the server.

2. Click **OK**.
   
   This downloads the imaging files from the server to the device where you access ZENworks Control Center and rebuilds winpe.wim with imaging files and then uploads files from the device to the server. The availability of the uploaded files is displayed in the **Status** field.

**Upload ImageX Files to Support WIM Imaging (ImageX.exe):**

1. Click the 📦 icon to browse for and select the Microsoft Imaging engine (imagex.exe) on the device.
2. After configuring the third-party imaging settings, click **Apply**.

Click **Status** to view the content replication status across all Primary Server and Satellite Servers with the Imaging role in the zone.

**NOTE:** If you are uploading both 32-bit and 64-bit ImageX files, ensure that you do so in different instances.

**Upload Ghost 11.5 or Higher Files to Support Ghost Imaging (Ghost32.exe):**

1. Click the 📦 icon to browse for and select the Symantec GHOST engine (ghost32.exe) on the device.
2. After configuring the third-party imaging settings, click **Apply**.

Click **Status** to view the content replication status across all Primary Servers and Satellites Servers with the Imaging role in the zone.

**IMPORTANT:** Ensure that you start the Imaging operation only when the status is **Available**.

**For 64 Bit Upload Settings:**

Ensure that you install ZCC Helper before uploading the imaging file.

**Upload WinPE Base Distribution (Windows ADK):** Click 📦 and allow the browser to launch ZCC Helper to initiate WIM imaging.

In the Upload WIM Imaging Files dialog box:

1. To upload a 64-bit winpe.wim file from WADK, browse to Program Files (x86)\Windows Kits\<version>\Assessment and Deployment Kit\Windows Preinstallation Environment\amd64\en-us folder under the installed directory, then select the winpe.wim. file.

Where <version> is a Windows Operating System version.

2. Click **OK**.

   This downloads the imaging files from the server to the device where you access ZENworks Control Center and rebuilds winpe.wim with imaging files and then uploads files from the device to the server. The availability of the uploaded files is displayed in the **Status** field.

**Upload ImageX Files to Support WIM Imaging (ImageX.exe):**

1. Click 📦 to browse for and select the Microsoft Imaging engine (imagex.exe) on the device.
2. After configuring the third-party imaging settings, click **Apply**.
Click **Status** to view the content replication status across all Primary Servers and Satellites Servers with the Imaging role in the zone.

**NOTE:** If you are uploading both 32-bit and 64-bit ImageX files, ensure that you do so in different instances.

**Upload Ghost 11.5 or Higher Files to Support Ghost Imaging (Ghost64.exe):**

1. Click the icon to browse for and select the Symantec GHOST engine (ghost64.exe) on the device.
2. After configuring the third-party imaging settings, click **Apply**.

Click **Status** to view content replication status across all Primary Servers and Satellites Servers with the Imaging role in the zone.

**IMPORTANT:** Ensure that you start the Imaging operation only when the status is Available.

3. Enable PXE on the device.
4. Ensure that you have a standard DHCP server, either on your Imaging Server or on another network server.

**ZENworks WADK Imaging works only on Windows 8 or later supported hardware**

WADK has WINPE 4.0 which is based on Windows 8 kernel. So, you need to validate if your system hardware meets the ZENworks WADK Imaging requirements to perform Imaging operations.

To be able to perform Imaging operations, validate your system as follows:

1. Download the coreinfo.exe file from Windows Sysinternals (Download and Usage information).
2. Run the tool to determine if the system has support for NX, PAE, and SSE2.
3. If your system is reported to support NX, PAE, and SSE2, you can use WADK to image the device. Else, use the compatible WIM mode based on WINPE 3.x.

   Booting a 32-bit device that does not have Windows 8 support does not work because the winpe.wim file from WADK fails to boot. In such a scenario, re-upload the winpe.wim file from WAIK for Third-Party Imaging to work.

**Third-Party Imaging Based On Device Architecture**

In some 64-bit processors like Intel Xeon, there are two boot modes - Enabled and Capable. In both modes SMBIOS indicates that the processor is a 64-bit processor. However, if the mode is set to Capable, the system works as a 32-bit processor, and the 64-bit WADK does not boot. To use ZENworks Imaging on these 64-bit processors, the 64-bit mode should be set to Enabled in BIOS for 64-bit WADK to boot correctly. For more information, see Section 7.5.9 Processor Characteristics in System Management BIOS (SMBIOS) Reference.

**NOTE:** For VMware Virtual Machines, only 32-bit WAIK or 32-bit WADK boot is applicable.

For more information, see TID 7013318.
C.5 Performing ZENworks Third-Party Imaging in the Maintenance Mode

The Novell ZENworks Third Party Imaging utility that is available on the managed devices allows you to take an image and restore it either on the local device or the server. The utility uses the Windows Imaging Format (WIM) or Ghost Imaging Format. The utility also allows you to add and modify the disk partitions of the device.

The image that is taken with ImageX and restored by using the WIM bundle does not have any partition information. Consequently, it creates only one single partition on the destination hard disk. To prevent this issue, you must take an image by using ZENworks Control Center or the ZENworks Third Party Imaging utility in the maintenance mode.

Review the following sections for detailed information about the operations that can be performed by using the Novell ZENworks Third Party Imaging utility:

C.5.1 Launching the ZENworks Third Party Imaging Utility

1. Reboot the managed device to the PXE mode.
2. From the PXE menu, select the WinPE Maintenance mode.
   The WinPE distro loads and the Novell ZENworks Third Party Imaging utility is launched.

C.5.2 Taking an Image of a Device and Storing it Locally

The ZENworks Third Party Imaging utility allows you to take an image of an existing device and store it locally. The image can be used to image a similar device or reimage the same device.

To take an image of an existing device and store it locally:

1. Click the Imaging menu > Take Image > Local.
   The Take Image window is displayed.

2. In the Image File Path field, specify or click Browse to browse for and select the path where you want to store the Windows Imaging Format (.wim) or the Ghost imaging format (.gho) files.
3. In the Include Partitions field, select the partition of the disk whose image you want to take. Do not select the drive where you want to save the .wim or .gho file.
By default, the **Include Partitions** field displays all the partitions of the device on which the Novell ZENworks Third-Party Imaging utility is launched. The drives are displayed for Windows partitions.

**NOTE:** The drives displayed might not correlate with the original drives of the device. You must ensure that the correct drive is selected.

4. Select one of the following compression options:
   - **None:** No compression is applied.
   - **Speed:** Optimizes the compression to allow for the fastest imaging time. Use this option if CPU speed is an issue. By default, this option is selected.
   - **Size:** Optimizes the compression to minimize the image file size to conserve disk space. This might cause Imaging to take considerable amount of time.

5. Click **OK**.

If the images are taken in the Ghost format, ZENworks additionally creates an XML file with the filename as `image_name-ghost.xml` in the same location as the image file. You must not edit the xml file. If you are taking an image of a device that has multiple disks, an image file is created for each disk and only one XML file is created per image.

If you want to move a Ghost image to a different location, you must move all the image files and the XML file specific to the image.

### C.5.3 Taking an Image of a Device and Storing it in a Remote Repository

The Novell ZENworks Third Party Imaging utility allows you to take an image of an existing device and store it in a remote image repository on a shared-network path. The image can be used to image a similar device or reimage the same device.

To take an image of an existing device and store it in a remote image repository on a shared-network path:

1. Click the **Imaging** menu > **Take Image** > **Server**.
   
The Take Image window is displayed.
2 In the **Image File Path** field, specify the complete path of the shared-network location where you want to store the Windows Imaging Format (.wim) or the Ghost imaging format (.gho) files. The directory must be a Windows share or a Linux CIFS or SMB share, and you must have the Write permission to it.

**NOTE:** You cannot use the **Browse** button to select the shared-network path because it is not supported in the WinPE environment. You must specify the complete path of the network shared location.

3 In the **Server Credentials** field, click **Credential** to specify the user name and password of the remote share on the server used for storing the .wim or .gho files.

**NOTE:** If the remote share is a OES2 Linux CIFS share, provide the user name as domain\userid.

4 In the **Include Partitions** field, select the partition of the disk whose image you want to take. By default, the **Include Partitions** field displays all the partitions of the device on which the Novell ZENworks Third-Party Imaging utility is launched.

**NOTE:** The drives displayed might not correlate with the original drives of the device. You must ensure that the correct drive is selected.

5 Select one of the following compression options:
   - **None:** No compression is applied.
   - **Speed:** Optimizes the compression to allow for the fastest imaging time. Use this option if CPU speed is an issue. By default, this option is selected.
   - **Size:** Optimizes the compression to minimize the image file’s size to conserve disk space. This might cause Imaging to take considerable amount of time.

6 Click **OK**.

If the images are taken in the Ghost format, ZENworks additionally creates an XML file with the filename as `image_name-ghost.xml` in the same location as the image file. You must not edit the xml file. If you are taking an image of a device that has multiple disks, an image file is created for each disk and only one XML file is created per image.

If you want to move a Ghost image to a different location, you must move all the image files and the XML file specific to the image.

### C.5.4 Restoring a Locally Stored Image

The Novell ZENworks Third Party Imaging utility allows you to restore a locally stored image on the device.

1 (Optional) If you want to change the destination disk structure before restoring a WIM image, perform the tasks explained in Section C.7, "Configuring the Destination Disk Structure Before Restoring a WIM Image," on page 221.

2 Click the **Imaging** menu > **Restore Image** > **Local**.
   The Restore Image window is displayed.
3 In the **Image File Path** field, specify or click **Browse** to browse for and select the directory containing the Windows Imaging Format (\*.wim) or the Ghost imaging format (\*.gho) file to be restored.

4 **(Conditional)** If you want to restore the \*.wim file as an add-on image:

   4a Select the **Restore as Add-On** option.

   4b Configure the following settings:
   - **Image Number**: Select the index number of the image to be restored.
   - **Path to Restore the Add-on Image**: Specify or click **Browse** to browse for and select the location on the device where you want to restore the add-on image.

   4c Click **OK**.

5 **(Conditional)** If you want to perform any of the following operations, select **Advanced Options** and click **Next** to display the Select Partition window.

   - Restore an image that is stored on a local disk, and not on a removable or CD-ROM drive.
   - Restore a base image taken by using ImageX or Ghost.
   - Selective partition imaging.
   - View the image information and modify the disk partitions accordingly.

**NOTE:** The **Advanced Options** is available only if you are restoring a Ghost image taken by using ZENworks (through ZENworks Control Center or the Novell ZENworks Third-Party Imaging utility).

The **Advanced Options** is not available for the WIM Imaging format if you select the **Restore as Add-On** option.

6 **(Conditional)** If you select **Advanced Options** in **Step 5**, configure the Select Partition window.

   The Select Partition window allows you to select the image partition to be restored and the destination drive. You can restore the image of a disk partition on any other disk partition.

   If the image to be restored was taken by using ImageX, then all the images stored in the \*.wim file are displayed, along with their data size.

   If the image was taken by using ZENworks Configuration Management, then only the information for all the partitions within the \*.wim file is displayed.

   In the **Image Partitions** panel, select the check box for the image partition to be restored. The image is restored on the corresponding drive in the **Disk Partitions** panel. If you want to restore the image of a partition to a different drive, drag and drop the desired partition in the **Disk Partitions** panel so that it is corresponding to the selected image partition. You can also use the Up and Down arrow keys to reorganize the partitions in the panel.
NOTE: The drives displayed in the Disk Partitions panel might not correlate with the original drives of the device. You must ensure that the correct drive is selected.

7 Click OK.

C.5.5 Restoring an Image to a Device on a Shared Network Location

The Novell ZENworks Third Party Imaging utility allows you to restore an image to the device on a shared-network path.

1 (Optional) If you want to change the destination disk structure before restoring a WIM image, perform the tasks explained in Section C.7, “Configuring the Destination Disk Structure Before Restoring a WIM Image,” on page 221.

2 Click the Imaging menu > Restore Image > Server.

The Restore Image window is displayed.

3 In the Image File Path field, specify the complete path of the shared-network location containing the Windows Imaging Format (.wim) or the Ghost imaging format (.gho) file to be restored. The directory must be a Windows share or a Linux CIFS or SMB share.

NOTE: You cannot use the Browse button to select the shared-network path because it is not supported in the WinPE environment. You must specify the complete path of the network shared location.

4 In the field, click Credential to specify the user name and password of the remote share on the server having the .wim or .gho file.

NOTE: If the remote share is a OES2 Linux CIFS share, provide the user name as domain\userid.

5 (Conditional) If you want to restore the .wim file as an add-on image:

5a Select the Restore as Add-On option.

5b Configure the following settings:

   • Image Number: Select the index number of the image to be restored.
   • Path to Restore the Add-on Image: Specify or click Browse to browse for and select the location on the device where you want to restore the add-on image.

5c Click OK.
6 (Conditional) If you want to perform any of the following operations, select Advanced Options and click Next to display the Select Partition window.
- Restore a base image taken by using ImageX or the Ghost imaging format (.gho).
- Selective partition imaging.
- View the image information and modify the disk partitions accordingly.

**NOTE:** The Advanced Options is available only if you are restoring a Ghost image taken by using ZENworks (through ZENworks Control Center or the Novell ZENworks Third-Party Imaging utility).

The Advanced Options is not available for the WIM Imaging format if you select the Restore as Add-On option.

7 (Conditional) If you select Advanced Options, configure the Select Partition window.

The Select Partition window allows you to select the image partition to be restored and the destination drive. You can restore the image of a disk partition on any other disk partition.

If the image to be restored was taken by using ImageX, then all the images stored in the .wim file are displayed, along with their data size.

If the image was taken by using ZENworks Configuration Management, then only the information for all the partitions within the .wim file is displayed.

In the Image Partitions panel, select the check box for the image partition to be restored. The image is restored on the corresponding drive in the Disk Partitions panel. If you want to restore the image of a partition to a different drive, drag and drop the desired partition in the Disk Partitions panel so that it is corresponding to the selected image partition. You can also use the Up and Down arrow keys to reorganize the partitions in the panel.

**NOTE:** The drives displayed in the Disk Partitions panel might not correlate with the original drives of the device. You must ensure that the correct drive is selected.

8 Click OK.

### C.5.6 Adding, Deleting, or Activating Disk Partitions

The Novell ZENworks Third Party Imaging utility allows you to create, delete, and activate disk partitions.

#### Creating a Partition

1 Click the Partitioning menu > Modify Partition.

A list of partitions available on the device, total disk space, and the free disk space on the device is displayed. Select the disk whose partition you want to modify.
Note: The drives displayed might not correlate with the original drives of the device. You must ensure that the correct drive is selected.

2 To create a Primary or Extended partition, click Add. To create a Logical partition, select an Extended partition, then click Add.

The Add Partition window is displayed.

3 Configure the following settings:
   • **File System Type**: (Not applicable for the Extended partition) Select the file system type for the device.
   • **Partition Type**: Select the partition type to be created.
   • **Size**: Specify the size of the partition. By default, it is the free space available on the disk beyond the specified offset value for the Primary or Extended partition, and the free space available beyond the specified offset value within the Extended partition for the Logical partition.
   • **Drive Letter**: (Not applicable for the Extended partition) Select the letter to represent the partition.
   • **Offset**: Specify the offset of the disk to determine the starting position of the partition. By default, it is the offset of the first available free space on the disk for the Primary or Extended partition, and it is the offset of the first available free space within the extended partition for the Logical partition.

4 Click OK.

The Modify Partitions window is displayed.

5 Click Apply.
Deleting a Partition

1. Click the Partitioning menu > Modify Partition.
   
   A list of partitions available on the device, total disk space, and the free disk space on the device is displayed.

2. Select the partition to be deleted, then click Remove.
3. Click Apply.

Making a Partition Active

1. Click the Partitioning menu > Modify Partition.
   
   A list of partitions available on the device, total disk space, and the free disk space on the device is displayed.

2. Select the primary partition to be made active, then click Active.
3. Click Apply.

C.5.7 Querying for the Third-Party Imaging Work

In the Novell ZENworks Third Party Imaging utility, click the Imaging menu > Query for Work to query for any third-party imaging task assigned to the device.

The device is not rebooted after this operation.

C.6 Configuring Third-Party Script Bundles

Third-Party Scripts are used for scripting actions in WinPE environment on workstations or servers.

To configure Third-Party Script bundle and assign devices to the bundle:

1. In ZENworks Control Center, click Bundles in the left pane to display the Bundles panel.
2. Click New > Bundle to start the Create New Bundle Wizard.
3. Select Preboot Bundle, then click Next.
4. On the Select Bundle Category page, select Third-Party Script, then click Next to display the Define Details page.
5 Fill in the fields:

**Bundle Name:** (Required) Although bundles can be identified in ZENworks Control Center by their type of icon, as well as the folder they are listed under, you should develop a naming scheme that differentiates the Third-Party Script bundles that are listed together in a folder.

For more information, see "Naming Conventions in ZENworks Control Center" in the *ZENworks Control Center Reference*.

**Folder:** Browse for the location where you want the Third-Party Script bundle displayed in ZENworks Control Center. The folder must exist. You cannot specify a non-existent folder, because ZENworks does not create them from this wizard.

**Icon:** Browse for and select an icon if you plan to use one on your desktop for this bundle.

**Description:** Provide a description to help you later recognize the exact purpose of this Third-Party Script bundle.

6 Click **Next** to display the Third-Party Script page.

7 Fill in the fields:

**Script Type:** The following five types of scripts are supported:

- Batch script
- JScript
- VB script
- Windows script file
- HTML application
- PowerShell Script

**Script Text:** Specify the text of the script. The script is restricted to doing preboot work prior to the device booting. The script must contain only un-formatted text. Maximum length of the script text is 32000 characters.

8 Click **Next** to display the Summary page.

9 Do the following:

- If you want to perform other configuration tasks after the bundle has been created, select the **Define Additional Properties** check box.
  
  For example, you can make assignments to the bundle in the **Relationships** tab, add actions in the **Actions** tab, and so on.

- If you want to deploy the bundle as a sandbox version, select the **Create As Sandbox** check box. A sandbox version of a bundle enables you to test it on your device before actually deploying it.

10 Review the configuration, then click one of the following:

**Back:** Allows you to make changes after reviewing the summary.

**Finish:** Creates the Third-Party Script bundle as configured per the settings listed on this Summary page.

**In WinPE Maintenance mode:** On querying for work from the Novell ZENworks Third-Party Imaging utility, the script is downloaded with the `WinScript<file number>.<ext>` file name, where `ext` is the type of the script. You need to execute this script in the command prompt.

**In WinPE Auto mode:** The script is downloaded and executed.

The ISD tool enables you to view the Image Safe Data of the device in the WinPE distro. In the WinPE command prompt, execute the following command:

```
ISDTool.exe d
```
C.7 Configuring the Destination Disk Structure Before Restoring a WIM Image

ZENworks allows you to configure the disk structure of the destination device on which you want to restore a WIM image. During the restoration of the WIM, the disk of the destination device is automatically partitioned according to the newly configured structure and the image is restored on the new partitions.

You can configure the destination disk structure only if the image is restored in one of the following modes:

- Automatic Imaging mode
  For more information on the Automatic Imaging mode, see Section 3.1.1, “Using ZENworks Control Center for Imaging,” on page 94.

- Maintenance Imaging mode without configuring the Advanced options.
  For more information on how to locally restore an image in the Maintenance Imaging mode, see Section C.5.4, “Restoring a Locally Stored Image,” on page 214, and how to restore an image to a remote device, see Section C.5.5, “Restoring an Image to a Device on a Shared Network Location,” on page 216.

To configure the disk structure of the destination device, do the following before restoring a WIM image:

1. create an XML file with the filename as `WIM_image_name-wim.xml` with the following content:

   ```xml
   <ZENWORKS>
   <Disk Number="1">
     <Partition Number="1" Type="1" Size="14998" Offset="1" Active="1" FSType="NTFS" Drive="C:"></Partition>
     <Partition Number="0" Type="2" Size="99378" Offset="14999" Active="0" FSType="NA" Drive=""></Partition>
     <Partition Number="2" Type="4" Size="24999" Offset="15000" Active="0" FSType="NTFS" Drive="D:"></Partition>
   </Disk>
   <Disk Number="2">
     <Partition Number="1" Type="1" Size="14998" Offset="1" Active="1" FSType="NTFS" Drive="C:"></Partition>
     <Partition Number="0" Type="2" Size="99378" Offset="14999" Active="0" FSType="NA" Drive=""></Partition>
     <Partition Number="2" Type="4" Size="24999" Offset="15000" Active="0" FSType="NTFS" Drive="D:"></Partition>
   </Disk>
   ...
   </ZENWORKS>
   ```

2. Save the `WIM_image_name-wim.xml` created in Step 1 in the same location as the WIM image file.

Ensure to follow these guidelines as you work with the XML file:

- You can specify only the following disk settings:
  - Partition Number - The number of partitions that you can create per hard disk is depended upon number of partitions supported by Windows
Type - Valid values are 1, 2, 4, and 8. Use 1 for Primary partition, 2 for Extended partition, 4 for Logical partition, and 8 for Linux Swap partition.
Size - Size of the partition. The value must be specified in MB.
Offset - The starting position of the partition
Active - Valid values are 1 and 0 (zero). 1 indicates that the partition is active and 0 indicates that the partition is not an active partition. A disk can have only one active partition.
FSType - File system type. Valid values are NTFS, FAT12, FAT16, and FAT32.
Drive - Letter to represent the partition.

- You must specify the disk settings in the following order:
  Partition Number, Type, Size, Offset, Active, FSType, Drive
D Imaging Utilities and Components

The following sections provide reference information on Novell ZENworks imaging utilities, commands, and configuration settings.

- Section D.1, “Image Explorer (zmgexp),” on page 223
- Section D.2, “Novell ZENworks Configuration Management Imaging Agent (novell-ziswin),” on page 236
- Section D.3, “Novell ZENworks ISD Service (novell-zisdservice),” on page 238
- Section D.4, “Novell ZENworks Linux Management Imaging Agent (novell-zislnx),” on page 243
- Section D.5, “Image-Safe Data Viewer and Editor (zisview and zisedit),” on page 244
- Section D.6, “ZENworks Imaging Media Creator (zmediacreator),” on page 249
- Section D.7, “Imaging Configuration Parameters (settings.txt),” on page 249
- Section D.8, “Logging configuration parameter (novell-prebootlookup.conf),” on page 252
- Section D.9, “Imaging Boot Parameter for PCMCIA Cards,” on page 253
- Section D.10, “Imaging Server,” on page 253
- Section D.11, “TFTP Client for WinPE,” on page 264

D.1 Image Explorer (zmgexp)

Use the Novell ZENworks Image Explorer utility to view or modify device images, create add-on images, compress image files, and split images.

- Section D.1.1, “Starting Image Explorer on ZENworks Server,” on page 223
- Section D.1.2, “Installing and Starting the Image Explorer on a Standalone Device,” on page 224
- Section D.1.3, “Determining the Image Explorer Version,” on page 225
- Section D.1.4, “Image Explorer versus Windows Explorer,” on page 225
- Section D.1.5, “Opening an Image,” on page 225
- Section D.1.6, “Saving Image Changes and Exiting the Utility,” on page 226
- Section D.1.7, “Managing Image Properties,” on page 226
- Section D.1.8, “Image File Operations,” on page 228
- Section D.1.9, “Modifying Image Content,” on page 233
- Section D.1.10, “Creating a New Image File,” on page 235

D.1.1 Starting Image Explorer on ZENworks Server

There are no command line parameters for the Image Explorer utility.

1 To start Image Explorer, run the following file:

Windows: C:\Novell\ZENworks\bin\preboot\zmgexp.bat
Linux: /opt/novell/zenworks/preboot/bin/zmgexp
D.1.2 Installing and Starting the Image Explorer on a Standalone Device

You can run ZENworks Configuration Management Image Explorer as a standalone application on any device that has Java installed. The standalone device need not have ZENworks Configuration Management installed.

To install and start the Image Explorer on a standalone device:

1 Install Java JRE 1.5 or later by using one of the following ways:
   - **ZENworks Installation DVD:** Do the following:
     - **On a 32-bit Windows device:** Copy `novell-zenworks-jre-x.x.x.msi` from the `\common\msi\` directory on the ZENworks installation DVD to the system drive, and subsequently run it.
       Ensure that Java is configured in the system path variable.
     - **On a 64-bit Windows device:** Copy `novell-zenworks-jdk-x.x.x86_64.msi` from the `\common\msi\` directory on the ZENworks installation DVD to the system drive, and subsequently run it.
       Ensure that Java is configured in the system path variable.
     - **On a 32-bit Linux device:** Install the following RPM located in the `\common\rpm\` directory on the ZENworks installation DVD:
       `novell-zenworks-jre-x.x.x.rpm`
     - **On a 64-bit Linux device:** Install the following RPMs located in the `\common\rpm\` directory on the ZENworks installation DVD:
       `novell-zenworks-jre-x.x.x.rpm`
       In the above lines, x.x stands for java version.
   - **Java Web site:** Download and install Java JRE 1.5 or later from the Developer Resources for Java Technology Web site (http://java.sun.com/).

2 Install the Image Explorer utility.
   - **On Windows:** Do one of the following:
     - Open a Web browser to the `http://primary_server_IP_address_or_DNS_name/zenworks-setup address`, click the Imaging Tools tab, download `novell-zenworks-zmgexplorer-xxxxx.msi` to the system drive.
       If you double-click the msi file, it gets installed in the Source Directory location.
     - Insert the appropriate ZENworks installation DVD, browse to the `\common\msi\` directory, copy `novell-zenworks-zmgexplorer-xxxxx.msi` to the system drive, then double-click the installer.
   - **On Linux:** Insert the appropriate ZENworks installation DVD, browse to the `\common\rpm\` directory, then double-click `novell-zenworks-zmgexplorer-xxxxx.1586.rpm`.

3 Start the Image Explorer utility.

   **Windows:** Do the following if ZENworks agent is not installed:
   - Add an environment variable `%ZENWORKS_HOME%` pointing to C:\Novell\ZENworks.
   - Run the `C:\Novell\ZENworks\bin\preboot\zmgexp.bat` file.

   Run the following if ZENworks agent is installed:
   - **For 32 bit:** `C:\Program Files\Novell\ZENworks\bin\preboot\zmgexp.bat` file.
For 64 bit: C:\Program Files(x86)\Novell\ZENworks\bin\preboot\zmgexp.bat file.

Linux: Do the following:

- If Java is installed from the ZENworks installation DVD, run the following command:
  /opt/novell/zenworks/preboot/bin/zmgexp

- If Java is installed from the Java Web site, go to /opt/novell/zenworks/preboot/java/lib and run the following command:
  java -Djava.library.path=/opt/novell/zenworks/preboot/lib -Xmx256m -jar ./zmgexp.jar

  If the Java is not set in the System path, then you must enter the following command:
  /usr/java/jdk-1_5_0_11/bin/java -Djava.library.path=/opt/novell/zenworks/preboot/lib -Xmx256m -jar ./zmgexp.jar

D.1.3 Determining the Image Explorer Version

To determine which version of Image Explorer you are using:

1. Click Help > About.

D.1.4 Image Explorer versus Windows Explorer

Although ZENworks Imaging Explorer looks and functions like Microsoft Windows Explorer in most situations, some functionality differences exist between the two programs. The following describes the key differences between ZENworks Image Explorer and Microsoft Windows Explorer:

- **Replacing Files in an Image**: During the life cycle of an image, files might be deleted or updated through Image Explorer. When you replace an existing file in an image by using Image Explorer, the original file is not deleted from the image. Image Explorer purges only deleted files; it does not purge files that have been updated.

  When files are added to an image where the file already exists, Image Explorer appends the entry to the end of the image. When images are restored, all files that have been previously updated are sequentially restored.

  To avoid performance problems, you should delete and purge each instance of a duplicate file in order to have the duplicates purged from the image. In Windows Explorer, replaced files are automatically deleted.

- **Dragging Files from Image Explorer**: You cannot drag files from Image Explorer in order to extract them, which you can do in Windows Explorer. However, you can drag and drop files and folders into an image by using Image Explorer.

D.1.5 Opening an Image


2. Click on the toolbar, browse for and select the image (.zmg) file, then click Open.

   For Windows, the default image location should open (\content-repo\images).

   For Linux, the file browser opens to the .content-repo directory; you need to click the /images directory to access the image file.

3. Browse for and select the image file.

   Large image files might take a few moments to open.
D.1.6 Saving Image Changes and Exiting the Utility

To save your changes when exiting the utility:

1. Click **File > Save** or **Save As**.
   - For Windows, the default image location should open (\content-repo\images).
   - For Linux, the file browser opens to the \content-repo directory; you need to click the /images directory for saving the file.
   - If you have a subdirectory structure under images, browse for the location to save the image file.

2. Click **File > Exit** to close the utility.

If you create a new image file in Image Explorer, then select a .lnk file for the image, instead of including the shortcut file, the file it points to is saved in the image.

For example, you open Image Explorer, click **File > New**, select a partition, click **Image > Add Files**, select a shortcut file that points to services.msc, then save the new image file. Instead of including the .lnk file that points to services.msc, services.msc itself is contained in the image.

D.1.7 Managing Image Properties

You can view the properties of an image file or any item in its content, including modifying some of the properties:

- “Viewing and Modifying the Properties of the Image File” on page 226
- “Viewing the Properties of an Image File Item” on page 227
- “Changing a Partition’s Size” on page 227

Viewing and Modifying the Properties of the Image File

1. Click **File > Open**.
   - For Windows, the default image location should open (\content-repo\images).
   - For Linux, the file browser opens to the \content-repo directory; you need to click the /images directory to access the image file.

2. Browse for and select the image file.
   - Large image files might take a few moments to open.

3. Select the top line of the opened image file.
   - This is the line that displays the path to the .zmg file.

4. Click **File > Properties**.
   - You can also right-click the top line, then select Properties.

5. (Optional) Fill in the fields:
   - **Description**: Specify useful information, such as its purpose or its important content.
   - **Author**: Specify the author of this version of the image.
   - **Comments**: Specify any information that is helpful.

6. Save the image file to save your properties changes.

7. To close the properties dialog box, click **OK**.
Viewing the Properties of an Image File Item

1. Click File > Open.
   For Windows, the default image location should open (\content-repo\images).
   For Linux, the file browser opens to the /content-repo directory; you need to click the /images directory to access the image file.
2. Browse for and select the image file.
   Large image files might take a few moments to open.
3. Select a partition, directory, or file in the image.
   For other information on a partition’s properties, see “Changing a Partition’s Size” on page 227.
4. Click File > Properties.
   You can also right-click the item, then select Properties.
5. To close the properties dialog box, click OK.

Changing a Partition’s Size

You can change a partition’s size for the next time the image is applied to a device. You can edit this value for base images only; you cannot edit this value for add-on images.

If the number that you specify in the Original Size text box exceeds the size of the target hard drive, ZENworks automatically uses the entire disk. Therefore, you can specify a value larger than exists on the target device.

However, if you specify a smaller disk space size than is on the target device, only that amount of disk space is used, so the remaining disk space is unused. For example, if you create a base image of a device with a 20 GB hard drive and you want to then place that image on a new device with a 60 GB hard drive, 40 GB of that drive is unused.

You cannot decrease the number in the Original Size text box to a smaller value that what is shown in the Minimum Size text box.

To modify the partition’s size:

1. Click File > Open.
   For Windows, the default image location should open (\content-repo\images).
   For Linux, the file browser opens to the /content-repo directory; you need to click the /images directory to access the image file.
2. Browse for and select the image file.
   Large image files might take a few moments to open.
3. Select a partition.
4. Click File > Properties.
   You can also right-click the partition, then select Properties.
5. In the Original Size field, specify the new partition size.
6. Click OK to save the change.
   This only saves the partition size change. You must save the image file for it to be in effect the next time the image is applied.
D.1.8 Image File Operations

You can do the following with an image file:

- "Compressing an Image File" on page 228
- "Splitting an Image" on page 229
- "Hiding and Removing Content in the Image File" on page 230
- "Configuring File Sets" on page 231
- "Extracting Content as Files" on page 232
- "Extracting Content as an Add-on Image" on page 232
- "Creating an Add-on Image" on page 233

Compressing an Image File

You can compress an uncompressed image (including images created by previous versions of ZENworks) by 40 to 60 percent of the original file size.

You can compress an image in two ways:

- "Compressing an Opened Image File" on page 228
- "Compressing an Unopened Image File" on page 229

Compressing an Opened Image File

Use this dialog box to set compression options so that it takes less time to restore the image file or less space to store the file on your Imaging server.

**IMPORTANT:** If you have used **Delete** to hide files in the image, they are removed from the image during compression.

To compress the image file:

1. Click **File > Open**.
   - For Windows, the default image location should open (**\content-repo\images**).
   - For Linux, the file browser opens to the **../content-repo/images** directory; you need to click the **images** directory to access the image file.
2. Browse for and select the image file.
   - Large image files might take a few moments to open.
3. Click **File > Compress Image**.
4. Fill in the fields:
   - **Image File to Compress**: Specifies the name of the existing imaging file to compress.
   - **Save Compressed Image As**: Click the browse button next to this field to specify the location and filename under which to save the image.
   - **Compression Level**: Specify an image-compression level:
     - **Compress for Speed**: Takes the least amount of time to compress but creates the largest compressed image file.
     - **Balanced Compression**: Represents a compromise between compression time and image file size. This option is used by default when an image is created.
Compressing an Unopened Image File

Use this dialog box to set compression options to quickly compress an image file without waiting for the file to fully load into Image Explorer.

To quickly compress an image file:

1. Click **Tools > QuickCompress**.
2. Fill in the fields:
   - **Image File to Compress**: Specify or browse to an existing imaging file to compress.
   - **Save Compressed Image As**: Specify the location and filename under which to save the image, or click the browse button next to this field to locate and select it.
   - **Compression Level**: Specify an image-compression level:
     - **Compress for Speed**: Takes the least amount of time to compress but creates the largest compressed image file.
     - **Balanced Compression**: Represents a compromise between compression time and image file size. This option is used by default when an image is created.
     - **Compress for Size**: Creates the smallest image file but takes longer to compress.
3. Click **Compress** to compress the image file using the settings you specified.

Splitting an Image

You can split an image file into separate files so that you can span the entire image across several CDs or DVDs.

When you split a device image and span it across several CDs or DVDs, you are essentially creating a base image on the first CD, DVD or bootable USB. The remaining CDs or DVDs are add-on images.

Because images are split by placing individual files into different images, an image cannot be split if it contains any single file that is larger than the specified maximum file size.

To restore a device image that has been spanned across several CDs or DVDs you should restore the first CD, DVD or bootable USB before restoring the remaining CDs or DVDs containing the add-on images. For more information, see "Manually Restoring an Image on a Device" on page 108.

Restoring split Images is done using bundles, such as restoring a base plus add-ons. For more information, see "Creating an Add-On Image from Files in a File System" on page 106.

To split an image:

1. Click **Tools > Split Image**.
2. Fill in the fields:
   - **Image File to Split**: Enter or browse to an existing base image file to split.
   - **Directory to Store Split Images**: Specify the location and filename under which to save the split-image files, or click the browse button next to this field to locate and select it.
The split-image files are named automatically. For example, if you enter `image.zmg` in the **Image File to Split** field, the first split-image file is named `image_base.zmg`, the second file is named `image_a1.zmg`, the third file is named `image_a2.zmg`, and so forth. The `image_base.zmg` file contains files that allow the device to boot to the operating system. The add-on images (`image_a1.zmg, image_a2.zmg, etc.`) contain additional files.

**Maximum Split File Size _ MB:** Specify the maximum size of each split-image file. Depending on the size of the original image and the number you enter in this field, ZENworks creates as many files as necessary to split the entire image into separate split-image files.

3 To split the image file into as many files as necessary, using the settings you specified, click **Split**.

### Hiding and Removing Content in the Image File

You can hide a directory or file from being used when the image is applied to a device. You can also permanently remove hidden or excluded directories and files from an image file.

- “Hiding Directories or Files in the Image” on page 230
- “Unhiding Directories or Files in the Image” on page 230
- “Removing Hidden Directories and Files from the Image File” on page 231

#### Hiding Directories or Files in the Image

You can hide directories or files so that they are not used when the image is applied to a device. This enables you save their existence so that you can later unhide them to be applied to the imaged device.

1 Click **File > Open**.
   - For Windows, the default image location should open (`...\content-repo\images`).
   - For Linux, the file browser opens to the `.../content-repo` directory; you need to click the `/images` directory to access the image file.

2 Browse for and select the image file.

3 Large image files might take a few moments to open.

3 Select the directories and files to be hidden.

**IMPORTANT:** When editing a base image, do not hide BPB files or the device won’t be able to boot the new operating system after receiving the image.

4 Click **Image > Delete**.

You can also right-click the selected directories and files, then select **Delete**.

Deleting a file in the Image Explorer merely marks it for deletion; it can still be retrieved. A file marked as deleted is not removed from the image until the image is purged; files and folders marked as deleted are not restored during imaging.

#### Unhiding Directories or Files in the Image

You can unhide directories or files so that they are available when the image is applied to a device.

1 Click **File > Open**.

   - For Windows, the default image location should open (`...\content-repo\images`).
   - For Linux, the file browser opens to the `.../content-repo` directory; you need to click the `/images` directory to access the image file.
2 Browse for and select the image file.
   Large image files might take a few moments to open.
3 Select the directories and files that were previously hidden that you want to unhide.
4 Click **Image > Undelete**.
   You can also right-click the selected directories and files, then select **Undelete**.
   This makes them available in the image when it is applied to a device.

### Removing Hidden Directories and Files from the Image File

To permanently remove hidden directories and files from the open image in order to create a different version of the image file:

1 Click **File > Open**.
   For Windows, the default image location should open (``\content-repo\images``).
   For Linux, the file browser opens to the ``/../content-repo`` directory; you need to click the `/images` directory to access the image file.
2 Browse for and select the image file.
   Large image files might take a few moments to open.
3 Click **File > Purge Files**.
4 Browse to the image filename or specify a new image filename, then click **OK**.
   You can save over the original image file to make this modification, or create another version of the image with the hidden directories and files removed.
   For Windows, the default image location should open (``\content-repo\images``).
   For Linux, the file browser opens to the ``/../content-repo`` directory; you need to click the `/images` directory for saving the file.
   If you have a subdirectory structure under `images`, browse for the location to save the new image file.

### Configuring File Sets

For information on file sets, see Appendix A, “File Sets and Image Numbers,” on page 197.

To configure a file set:

1 Click **File > Open**.
   For Windows, the default image location should open (``\content-repo\images``).
   For Linux, the file browser opens to the ``/../content-repo`` directory; you need to click the `/images` directory to access the image file.
2 Browse for and select the image file.
   Large image files might take a few moments to open.
3 Select the directories and files in the image that you want excluded from the image.
   Ways that you can select content:
   - Click a single file in the right pane.
   - Use the Shift and Ctrl keys to select multiple files in the right pane.
• Individually select partitions and directories in the left pane. Any partition or directory that you select includes everything under it.
• Select a partition or directory in the left pane, then click Edit > Select All to select all files listed in the right pane. Subdirectories are not included.

4 Do one of the following to exclude the selected files and directories from the image:
• Click Edit > File Sets, then select one of the options from Exclude from Set 1 through Exclude from Set 10.
  You can also right-click your selection to access the File Sets menu options.
• Click Edit > File Sets > Edit to open the File Sets dialog box, do the following as applicable, then click OK to exit the dialog box:
  • **Exclude Specific Items:** To exclude the selected directories and files from specific file set numbers, click the check box for each set number.
    This causes all selected directories and files to be excluded from the image for any Image bundle assigned to the specified file set numbers.
  • **Exclude All Items:** To exclude the selected directories and files from all file sets of this image, click Exclude All.
    This causes all selected directories and files to be excluded from the image for any Image bundle assigned to any file set number.
  • **Include All Items:** To clear all of the check boxes, click Exclude None.
    This allows all selected directories and files to be included in the image.
  
You can also right-click your selection to access the File Sets menu options.

**Extracting Content as Files**

To extract a file or directory from the open image and copy it to a directory:

1 Click File > Open.
   • For Windows, the default image location should open (...\content-repo\images).
   • For Linux, the file browser opens to the ../../../content-repo/images directory; you need to click the images directory to access the image file.

2 Browse for and select the image file.

Large image files might take a few moments to open.

3 Click File > Save.
   • If any changes have been made, this must be done before you can extract the information.

4 Click File > Extract > As Files.

5 Browse to and select a directory for the files, then click OK.

**Extracting Content as an Add-on Image**

To extract a file or directory from the open image as an add-on image:

1 Click File > Open.
   • For Windows, the default image location should open (...\content-repo\images).
   • For Linux, the file browser opens to the ../../../content-repo/images directory; you need to click the images directory to access the image file.

2 Browse for and select the image file.
Large image files might take a few moments to open.

3 Click File > Save.

If any changes have been made, this must be done before you can extract the information.

4 Click File > Extract > As Add-on Image.

5 Specify the name and location of the new add-on image, then click OK.

Creating an Add-on Image

You can create an add-on image from existing directories and files on your system and add partitions to the new add-on image.

1 Click File > New.

2 To add a partition, click the root of the image, click Image, then click Create Partition.

You cannot add a partition to an existing image.

3 Do any of the following to add content:
   - Browse to the directories and files you want the add-on image to contain, then drag or copy the directories and files into the right pane from your file browser.
   - Click Image > Add Files and select the files to be added.
   - Click Image > Add Directory and select the directories to be added.
   - Click the Add Directory icon and select the directories to be added.
   - Click the Add File icon and select the files to be added.

4 Click File > Save As, then specify the filename of the add-on image, including the .zmg filename extension.

For Windows, the default image location should open (\content-repo\images).

For Linux, the file browser opens to the /content-repo directory; you need to click the /images directory for saving the file.

If you have a subdirectory structure under images, browse for where to save the new image file.

D.1.9 Modifying Image Content

You can modify the content of an image file in the following ways:

- “Adding Directories and Files” on page 233
- “Creating a New Directory” on page 234
- “Creating a New Partition” on page 234
- “Resizing a Partition” on page 234
- “Adding a Windows Registry File” on page 234

Adding Directories and Files

To add directories and files to the open image:

1 Click File > Open.

For Windows, the default image location should open (\content-repo\images).

For Linux, the file browser opens to the .content-repo directory; you need to click the /images directory to access the image file.
2 Browse for and select the image file.
Large image files might take a few moments to open.

3 Do any of the following to add content:
   - Browse to the directories and files you want the add-on image to contain, then drag or copy
     the directories and files into the right pane from your file browser.
   - Click Image > Add Files and select the files to be added.
   - Click Image > Add Directory and select the directories to be added.
   - Click the Add Directory icon and select the directories to be added.
   - Click the Add File icon and select the files to be added.

4 Browse to and select the files or directory, then click Add or OK.
   You can select multiple files using the Shift and Ctrl keys.

5 Repeat these steps as necessary.

Creating a New Directory

To create a directory in the open image:

1 Click File > Open.
   For Windows, the default image location should open (. . . /content-repo/images).
   For Linux, the file browser opens to the . . . /content-repo directory; you need to click the /images directory to access the image file.

2 Browse for and select the image file.
Large image files might take a few moments to open.

3 Browse to the partition or directory in the left pane where you want to create the directory, then
   click Image > Create Directory.
   You can also click the New Directory icon.

4 Specify the name of the directory, then click OK.

Creating a New Partition

New partitions cannot be created in an existing base or add-on image that you opened for editing.
You can only create a new partition in a new image file. For more information, see “Adding Partitions” on page 235.

Resizing a Partition

You can resize the partitions in a base image, but not an add-on image. For more information, see
“Changing a Partition’s Size” on page 227.

Adding a Windows Registry File

(Windows only) To add specific Windows registry settings that are to be applied after the open image
is laid down:

1 Click File > Open.
   The default image location (. . . /content-repo/images) should open.

2 Browse for and select the image file.
Large image files might take a few moments to open.

3 Select a partition.

4 Click Image > Add Registry File.

5 Select the registry (\reg) file that contains the settings, then click Add.

The registry file is added to a fixed, known area of the partition and is applied by the ZENworks Imaging Windows Agent (ziswin) when the device reboots after receiving the image.

D.1.10 Creating a New Image File

Do the following to create a new image file:

- “Creating, Configuring, and Saving the New Image File” on page 235
- “Selecting New Image File Options” on page 235

Creating, Configuring, and Saving the New Image File

1 Click File > New.

2 Configure the new image file using the instructions in “Selecting New Image File Options” on page 235, then return to Step 3.

3 To save the new image file, click Save As.

   For Windows, the default image location should open (\content-repo\images).

   For Linux, the file browser opens to the .../content-repo directory; you need to click the /images directory for saving the file.

   If you have a subdirectory structure under images, browse for where to save the new image file.

4 Specify an image filename, including the .zmg filename extension, then click Save.

Selecting New Image File Options

You can do the following in this new image file:

- “Adding Partitions” on page 235
- “Adding Content” on page 236
- “Configuring File Sets” on page 236

Adding Partitions

1 Select the top line of the new image file.

   This is the line that will display the path to the new .zmg file when you save it.

2 Click Image > Create Partition.

3 Repeat Step 1 through Step 2 as necessary.

4 To add content to the partitions, continue with “Adding Content” on page 236.

NOTE: While installing Windows 7 or Windows Server 2008 R2, a hidden system partition with 100 MB disk space is created by default as the first disk partition. If you want to restore an add-on image on a Windows 7 or Windows Server 2008 R2 device that has a hidden partition, ensure to create adequate partitions from the Image Explorer and copy the image files to the appropriate partition.
where you want to restore the files. Lets assume that you want to restore the add-on images on a
Windows 7 device that has two partitions, a hidden system partition and a disk partition (C:). You must
create two partitions in the Image Explorer, and copy the add-on files to the second partition.

Adding Content

1 See Section D.1.9, "Modifying Image Content," on page 233 for instructions on adding new
content.

2 Continue with "Configuring File Sets" on page 236, or return to Step 3 in "Creating, Configuring,
and Saving the New Image File" on page 235.

Configuring File Sets

1 See “Configuring File Sets” on page 231 for instructions on configuring file sets.

2 Return to Step 3 in "Creating, Configuring, and Saving the New Image File” on page 235.

D.2 Novell ZENworks Configuration Management Imaging Agent (novell-ziswin)

The Novell ZENworks client (which includes novell-ziswin) should be installed on devices where you
want to apply images. For information on installing the client on your devices, see the Installing the
ZENworks Agent in the ZENworks Server Installation Guide.

Installing the Configuration Management client automatically installs the Novell ZENworks
Configuration Management Imaging Agent (novell-ziswin). Therefore, every Primary Server is an
imaging server.

After the ZENworks Agent is installed, the ZENworks Imaging Windows Agent window indicating that
the configuration files are being processed by the Imaging Agent is displayed during the device boot-
up. During this process, the ZENworks Imaging Windows Agent restores the data from ISD so that
the device can communicate by using its previous identity. Later on, the Imaging Agent automatically
reboots the device.

The Imaging Agent’s purpose is to save certain device-unique data (such as IP addresses and
hostnames) to an area on the hard disk that is safe from imaging. The Imaging Agent records this
information when you install it on the device. Then the agent restores this information from the image-
safe area after the device has been imaged. This allows the device to use the same network identity
as before. This functionality is handled by the novell-zisdserver on Windows 7 or later.

If a device is new and does not contain a unique network identity, the default settings that you have
configured for the Management Zone are applied when you image the device by using a Preboot
bundle.

The data that the Imaging Agent saves to (or restores from) the image-safe area includes the
following:

- Whether a static IP address or DHCP is used
- If a static IP address is used:
  - IP address
  - Subnet mask
  - Default gateway (router)
- DNS settings
  - DNS suffix
  - DNS hostname
  - DNS servers

From Windows 7, or later versions novell-zisdservice runs automatically when the device boots up.

The following table lists the task that you can perform using the novell-ziswin command line options on a Windows device:

Table D-1  novell-ziswin Command Line Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete the data from ISD</td>
<td>`ziswin [/c</td>
</tr>
<tr>
<td></td>
<td>You can also delete the data from ISD using the ZENworks Imaging Windows Agent utility:</td>
</tr>
<tr>
<td></td>
<td>1. Launch the ZENworks Imaging Windows Agent utility by double-click %ZENworks_Home%\bin\preboot\ziswin.exe.</td>
</tr>
<tr>
<td></td>
<td>2. Click Edit &gt; Clear Image-safe Data</td>
</tr>
<tr>
<td>Export the ISD to a file</td>
<td><code>ziswin -export complete_path_of_the_file.zis</code></td>
</tr>
<tr>
<td></td>
<td>For example, if you want to export the ISD to c:\isd_export.zis, use the following command:</td>
</tr>
<tr>
<td></td>
<td><code>ziswin -export c:\isd_export.zis</code></td>
</tr>
<tr>
<td>Import the ISD from a file</td>
<td><code>ziswin -import complete_path_of_the_file.zis</code></td>
</tr>
<tr>
<td></td>
<td>For example, if you want to import the ISD from c:\isd_export.zis, use the following command:</td>
</tr>
<tr>
<td></td>
<td><code>ziswin -import c:\isd_export.zis</code></td>
</tr>
<tr>
<td>Delete the ISD</td>
<td>`ziswin.exe [/w</td>
</tr>
</tbody>
</table>

The image based on the hardware rule is restored only when you delete both the ISD of a registered device and the device object associated with the registered device in ZENworks Control Center. If you want to perform the imaging operations on the device after you delete its ISD only, you must assign the work for the device by using the device object or Rule-Based Imaging.

If a registered device has a device object based on MAC address or Serial number in the database, the device continues to be a registered device when you reboot it after you delete its ISD, Device GUID, and Device data files. The device still gets the imaging work assigned to the device object.
D.3 Novell ZENworks ISD Service (novell-zisdservice)

The Novell ZENworks SID Service (novell-zisdservice) saves certain device-unique data (such as IP addresses and hostnames) to an area on the hard disk that is safe from imaging. The Imaging Agent records this information when you install it on the device. Then the novell-zisdservice restores this information, except for the SID, from the image-safe area after the device has been imaged. This allows the device to use the same network identity as before. The SID is restored by the SIDchanger.

The novell-zisdservice is available only on Windows 7 or later.

NOTE: After installing the ZENworks Agent on a Windows 7 or later and subsequently rebooting the devices, updates the device GUID and device ID. However, this does not have any impact on the functionality of ZENworks Configuration Management. Other device data are retrieved on the subsequent reboot (manual or automatic) of the device.

If a device is new and does not contain a unique network identity, the default settings that you have configured for the Management Zone are applied when you image the device by using a Preboot bundle.

The data that the Imaging Agent saves to (or restores from) the image-safe area includes the following:

- Whether a static IP address or DHCP is used
- If a static IP address is used:
  - IP address
  - Subnet mask
  - Default gateway (router)
- DNS settings
  - DNS suffix
  - DNS hostname
  - DNS servers

novell-ziswin or novell-zisdservice usually runs automatically.

The ZENworks SIDchanger runs automatically after the image restoration on the Windows 7 or later managed devices. It runs within the ZENworks imaging distro, which is a Linux environment. Consequently, the SIDchanger changes the Windows SID within the Linux environment.

Review the following sections for detailed information:

- Section D.3.1, "Understanding the SID," on page 239
- Section D.3.2, "Understanding the ZENworks SIDchanger," on page 239
- Section D.3.3, "Disabling the SIDchanger," on page 240
D.3.1 Understanding the SID

The Security Identifier (SID) is generated by a security authority, which is Windows on a local computer and the Domain Controller on a domain or Active Directory network.

Windows grants or denies access and privileges to resources based on ACLs that use SIDs to uniquely identify users and their group memberships. When a user requests access to a resource, the user’s SID is checked by the ACL to determine if the user is allowed to perform the action or if the user is part of a group that is allowed to perform that action.

The SID of a machine is a unique 96-bit number. The machine SID prefixes the SIDs of user accounts and group accounts that are created on the computer. The machine SID is concatenated with the relative ID (RID) of the account to create the account’s unique identifier.

SID has the following format: S-1-5-12-7623811015-3361044348-030300820-1013.

S indicates that the string is a SID.
1 is the revision level.
5 is the identifier authority value.
12-7623811015-3361044348-030300820 is the domain or local computer identifier.
1013 is a relative ID (rid).

A SID should be unique across different machines because duplicate SIDs can lead to problems if the machine or user must be uniquely identified. In a domain environment, if a system with a duplicate SID tries to join the domain, it results in errors.

For example, in a Workgroup environment, security is based on local account SIDs. Consequently, if two computers have users with the same SID, the Workgroup cannot distinguish between the users. All resources, including files and registry keys, can therefore be accessed by both users.

D.3.2 Understanding the ZENworks SIDchanger

The ZENworks SIDchanger runs only if the following conditions are met:

- The JustImaged flag is set.
  
  In the image-safe data, the JustImaged flag is set whenever an image is restored.

- Windows boot or system partition exist in Windows 7 or later versions.

You must change the SID of the Windows system after an image restoration because a SID must be unique. When the image is restored on the newly imaged device, the device contains the SID in the image which might result in duplication of SID. However, this is handled by ziswin for all versions of Windows prior to Windows Vista. ziswin changes the windows SID on the first reboot after the image is restored.

The ZENworks SIDchanger obtains the SID from the registry and changes the SID in the following scenarios:

- If the ISD (image-safe data) does not contain a SID.
- If the ISD SID does not match the computer SID.

NOTE: The ZENworks imaging engine cannot image partitions encrypted by using the BitLocker technology. BitLocker Drive Encryption is a full-disk encryption feature included with Microsoft's Windows 7 or later operating systems. It is designed to protect data by providing encryption for entire volumes. Any image of a full-disk encrypted device can be restored only on that device.
After the SID is changed, the files encrypted by using the Windows file encryption cannot be accessed because Windows file encryption uses the SID. If you want to access the encrypted files, you must back up the file encryption key before taking the image, and import the key after the SID is changed.

D.3.3 Disabling the SIDchanger

You must disable the ZENworks SIDchanger by using either ziswin or Image Explorer if you want to use a third-party tool such as SYSPREP to change the SID.

- "Using Ziswin to Disable the SIDchanger" on page 240
- "Using Image Explorer to Disable the SIDchanger" on page 240
- "Registry Keys for novell-ziswin and novell-zisdservice" on page 240

Using Ziswin to Disable the SIDchanger

You can use ziswin to disable the SIDchanger only for managed devices. Do the following before taking the image:

1. In ziswin, click Edit > Options > Restore Mask.
2. Select Windows SID.
   
   This creates a hidden restoremask.xml system file in the system drive, with the following contents:

   <ISDConf>
   <DoNotRestoreMask>
   <SID>true</SID>
   </DoNotRestoreMask>
   </ISDConf>

   To disable the SIDchanger, ensure that the value of <SID> is set to true. If you want to enable the SIDchanger, set the value to false.

Using Image Explorer to Disable the SIDchanger

1. Create the restoremask.xml file, with the following contents:

   <ISDConf>
   <DoNotRestoreMask>
   <SID>true</SID>
   </DoNotRestoreMask>
   </ISDConf>

   2. Open the image to be restored in the Image Explorer, then add the restoremask.xml file to the system drive of the image.
   3. Save the image.

Registry Keys for novell-ziswin and novell-zisdservice

The following table lists the Registry Keys that are used to customize the ZENworks Configuration Management Imaging Agent (novell-ziswin) and Novell ZENworks ISD service (novell-zisdservice):
<table>
<thead>
<tr>
<th>Registry Key Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ZISWIN Clear              | **Registry Key Type:** String  
                            | **Registry Key Value:** 1  
                            | When this string value is set to 1, ZISWIN clears all the Image Safe data and exits without doing any other task. |
| ZISWIN Disabled           | **Registry Key Type:** String  
                            | **Registry Key Value:** 1  
                            | When this string value is set to 1, ZISWIN exits without doing any other task. |
| ZISWIN Reset Flag         | **Registry Key Type:** String  
                            | **Registry Key Value:** 1  
                            | When this string value is set to 1, ZISWIN sets the Just Imaged flag to FALSE and exits without doing any other task. |
| ZISWIN Do Not Restore Mask| **Registry Key Type:** DWORD  
                            | **Registry Key Value:** Desired value of the Image Safe data component.  
                            | You can use this DWORD value to specify the Image Safe data component that you do not want ZISWIN to restore to the Windows registry, after a successful completion of an image. The value is interpreted as a mask, with each of the component receiving one bit in the mask. To stop the restoration of any component, specify the corresponding mask as the value in the registry key. For more information on values for different components, see "Component Masks" on page 242. |
### Component Masks

The following is a list of commonly used component masks:

**Workstation Distinguished Name** - 0x00000001  
**Workstation Tree** - 0x00000002  
**NetBios Name** - 0x00000004  
**Workgroup** - 0x00000008

---

<table>
<thead>
<tr>
<th>Registry Key Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ZISWIN SYSPrep Restore Mask</strong></td>
<td><strong>Registry Key Type:</strong> DWORD</td>
</tr>
<tr>
<td></td>
<td><strong>Registry Key Value:</strong> Desired value of Image Safe data component.</td>
</tr>
<tr>
<td></td>
<td>You can use this DWORD value to specify the Image Safe data component that</td>
</tr>
<tr>
<td></td>
<td>you do not want ZISWIN to restore to the Windows registry, after a success-</td>
</tr>
<tr>
<td></td>
<td>ful completion of an image. The value is interpreted as a mask, with each</td>
</tr>
<tr>
<td></td>
<td>of the component receiving one bit in the mask. To stop the restoration of</td>
</tr>
<tr>
<td></td>
<td>any component, specify the corresponding mask as the value in the registry</td>
</tr>
<tr>
<td></td>
<td>key.</td>
</tr>
<tr>
<td></td>
<td>If you are using the SYSprep process to mask the Image Safe data components,</td>
</tr>
<tr>
<td></td>
<td>then use the ZISWIN SYSPrep Restore Mask registry key, instead of ZISWIN</td>
</tr>
<tr>
<td></td>
<td>Do Not Restore Mask registry key. This is because ZISWIN or ZISDservice</td>
</tr>
<tr>
<td></td>
<td>check for values under the ZISWIN SYSPrep Restore Mask registry key and not</td>
</tr>
<tr>
<td></td>
<td>under ZISWIN Do Not Restore Mask registry key, on the first run after the</td>
</tr>
<tr>
<td></td>
<td>completion of the SYSPrep process.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> ZISWIN SYSPrep Restore Mask is not set by the ZISWIN GUI. You need</td>
</tr>
<tr>
<td></td>
<td>to enter the registry key directly with regedit.</td>
</tr>
<tr>
<td></td>
<td>For more information on values for different components, see “Component</td>
</tr>
<tr>
<td></td>
<td>Masks” on page 242.</td>
</tr>
<tr>
<td><strong>ZISWIN Do Not Collect Mask</strong></td>
<td><strong>Registry Key Type:</strong> DWORD</td>
</tr>
<tr>
<td></td>
<td><strong>Registry Key Value:</strong> Desired value of the Image Safe data component.</td>
</tr>
<tr>
<td></td>
<td>You can use this DWORD to specify the components you do not want ZISWIN to</td>
</tr>
<tr>
<td></td>
<td>collect in the Image Safe data. For more information on component mask, see</td>
</tr>
<tr>
<td></td>
<td>“Component Masks” on page 242.</td>
</tr>
<tr>
<td><strong>ZISWIN Clear Mask</strong></td>
<td><strong>Registry Key Type:</strong> DWORD</td>
</tr>
<tr>
<td></td>
<td><strong>Registry Key Value:</strong> Desired value of the Image Safe data component.</td>
</tr>
<tr>
<td></td>
<td>You can use this DWORD to specify the components that you want ZISWIN to</td>
</tr>
<tr>
<td></td>
<td>clear from the Image Safe data. For more information on component mask, see</td>
</tr>
<tr>
<td></td>
<td>“Component Masks” on page 242.</td>
</tr>
</tbody>
</table>
IP address - 0x00000010
SID - 0x000000020
DNS - 0x000000100
Workstation ID - 0x00000200

Some examples of using the novell-ziswin registry keys are as follows:

**Windows Domain Environment:** To add a workstation to the domain, you can use ZISWIN SYSPrep Restore Mask registry key. You can use ZISWIN Do Not Restore Mask registry key to restore everything except the Workgroup. Hence the value of the registry key is 0x00000008.

**DHCP Environment:** Administrators who add IP and DNS configuration of their systems through DHCP do not need ZISWIN to restore information from Image Safe data. You can use ZISWIN Do Not Restore Mask registry key with 0x0000000100 value.

**SYSPREP naming convention:** If ZISWIN is preparing to rename a workstation after the name is determined by the SYSPREP routine, in order for ZISWIN to not restore the NetBios name of a workstation, you can use ZISWIN Do Not Restore Mask registry key with 0x0000000004 value.

If your environment has all the above mentioned configurations, then you need to add the 4 components mask together and the registry value is 0x0000011C.

If your environment needs only the Workstation Object, ID, and Tree to be restored after imaging, you need add up all the other components mask, and the resulting registry value is 0x0000013C.

If your environment does not need anything restored by ZISWIN, the value can be set to 0x0000033F.

---

**D.4 Novell ZENworks Linux Management Imaging Agent (novell-zislnx)**

The Novell ZENworks Linux Management client (which includes novell-zislnx) should be installed on devices where you want to apply images. For information on installing the client on your devices, see the *Installing the ZENworks Agent* in the *ZENworks Server Installation Guide*.

Installing the Linux Management client automatically installs the Novell ZENworks Linux Management Imaging Agent (novell-zislnx). The Imaging Agent’s purpose is to save certain device-unique data (such as IP addresses and host names) to an area on the hard disk that is safe from imaging. The Imaging Agent records this information when you install it on the device. Then the agent restores this information from the *image-safe area* after the device has been imaged. This allows the device to use the same network identity as before.

**IMPORTANT:** To read or write the image-safe data from or to the hard disk, you must set the `MODE` to `ENABLE` in the `/etc/opt/novell/zenworks/preboot/novell-zislnx.conf` file.

The Imaging Agent is installed on your imaging server by default when you install ZENworks Linux Management.

If a device is new and does not contain a unique network identity, the default settings that you have configured for the ZENworks Management Zone are applied when you image the device using a Preboot Services Imaging bundle.

The data that the Imaging Agent saves to (or restores from) the image-safe area includes the following:

- Whether a static IP address or DHCP is used
If a static IP address is used:
- IP address
- Subnet mask
- Default gateway (router)

DNS settings
- DNS suffix
- DNS hostname
- DNS servers

The novell-zislnx daemon is generally run automatically. However, if you want to run it, for the command line arguments that can be used with the Imaging Agent, see “Understanding the Arguments” on page 262.

The following table lists the task that you can perform using the novell-zislnx command line options on a Linux device:

<table>
<thead>
<tr>
<th>Task</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete the data from ISD</td>
<td>/etc/init.d/novell-zislnx start clearISD</td>
</tr>
<tr>
<td>Set the Just Image flag</td>
<td>/etc/init.d/novell-zislnx start setJustImagedFlag</td>
</tr>
<tr>
<td>Reset the Just image flag</td>
<td>/etc/init.d/novell-zislnx start resetJustImagedFlag</td>
</tr>
<tr>
<td>Dump the ISD data on the terminal</td>
<td>/etc/init.d/novell-zislnx dump</td>
</tr>
<tr>
<td>Update the ISD, if there are any</td>
<td>/etc/init.d/novell-zislnx start/restart</td>
</tr>
<tr>
<td>changes to it</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: On a SUSE Linux Enterprise Server (SLES), if you switch the network setup method from ifup to Network Manager and modify the DNS settings, the changed settings will be listed in the resolv.conf.netconfig file. As a result, the DNS name resolution will fail. To reconnect to the network, manually delete the resolv.conf file and restart the network service.

D.5 Image-Safe Data Viewer and Editor (zisview and zisedit)

After booting a device from an imaging boot media (PXE, CD, DVD, or ZENworks partition), you can enter zisedit and zisview at the imaging maintenance mode prompt to edit and view the image-safe data for that device.

The following sections contain additional information:
- Section D.5.1, “Information Displayed by the Image-Safe Data Viewer,” on page 245
- Section D.5.2, “Using the Image-Safe Data Viewer,” on page 246
- Section D.5.3, “Using the Image-Safe Data Editor,” on page 247
D.5.1 Information Displayed by the Image-Safe Data Viewer

After booting a device from an imaging boot media, enter `zisview` at the imaging maintenance mode prompt to view the image-safe data for that device.

The image-safe data viewer (`zisview`) displays the following information about the device:

<table>
<thead>
<tr>
<th>Category</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image-safe Data</td>
<td>✷ <strong>Version</strong>: The version number of the Novell ZENworks Configuration Management Imaging Agent (<a href="#">novell-ziswin</a>).</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Just Imaged Flag</strong>: If this is set to False, the Imaging Agent reads data from the OS and writes it to the image-safe data store. If this is set to True, the Imaging Agent reads data from the image-safe data store and writes it to the OS.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Scripted Image Flag</strong>: If this is set to True, the last imaging operation was a scripted image. If this is set to False, the last imaging operation was not a scripted image.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Last Base Image</strong>: The last base image that was restored to the device.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Last Base Image Time</strong>: The time stamp of the last base image that was restored to the device.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Last Base Image Size</strong>: The size of the last base image that was restored to the device.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Last Base Image Address</strong>: The IP address of the last base image that was restored to the device.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>Script Checksum</strong>: Displays the checksum value representing the last script run. The ZENworks Imaging Engine uses the checksum to prevent the same script from re-running on the device unless you specify in ZENworks Control Center that you want to rerun the same script.</td>
</tr>
<tr>
<td></td>
<td>✷ <strong>LastBaseImageAddr6</strong>: Stores the IPV6 address of the server where the last base image was restored.</td>
</tr>
</tbody>
</table>
### Imaging Utilities and Components

#### D.5.2 Using the Image-Safe Data Viewer

To use `zisview`, enter any of the following commands at the imaging maintenance mode prompt:

<table>
<thead>
<tr>
<th>Category</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workstation Identity Information</td>
<td>If the device is a member of a Management Zone or there is image-safe data present:</td>
</tr>
<tr>
<td></td>
<td>- Zone GUID: The Management Zone that contains the device, if it has been imported.</td>
</tr>
<tr>
<td></td>
<td>- Device GUID: The Globally Unique Identifier of this computer’s device.</td>
</tr>
<tr>
<td></td>
<td>If the device is not a member of a Management Zone and image-safe data is not present:</td>
</tr>
<tr>
<td></td>
<td>- Workstation Tree: The tree that contains the device, if it has been created in a tree.</td>
</tr>
<tr>
<td></td>
<td>- Workstation DN: The device’s DN, if known.</td>
</tr>
<tr>
<td></td>
<td>- Workstation ID: The device identification number, if known.</td>
</tr>
<tr>
<td></td>
<td>For all devices:</td>
</tr>
<tr>
<td></td>
<td>- Win 9x Computer Name: The computer name for the device.</td>
</tr>
<tr>
<td></td>
<td>- Windows Workgroup: The Microsoft network workgroup of the device.</td>
</tr>
<tr>
<td></td>
<td>- Windows SID: The Windows Security ID of the device, which is a unique number that identifies this device in Windows.</td>
</tr>
<tr>
<td>Network Information</td>
<td>- DHCP: Displays whether this device uses DHCP to obtain its IP address.</td>
</tr>
<tr>
<td></td>
<td>- IP Address: The static IP address that this device uses.</td>
</tr>
<tr>
<td></td>
<td>- Gateway: The gateway that this device uses.</td>
</tr>
<tr>
<td></td>
<td>- Subnet Mask: The subnet mask that this device uses.</td>
</tr>
<tr>
<td></td>
<td>- DHCP6 Displays whether this device uses DHCP to obtain its IPv6 addresses.</td>
</tr>
<tr>
<td></td>
<td>- IP6 Address: The Static IP address that this device uses for IPv6.</td>
</tr>
<tr>
<td></td>
<td>- Gateway6: The gateway that this device uses for IPv6 addresses.</td>
</tr>
<tr>
<td></td>
<td>- prefix6: The prefix that this device uses for IPv6 address.</td>
</tr>
<tr>
<td>Production DNS Information</td>
<td>- DNS Servers: The number of DNS nameservers used for DNS name resolution.</td>
</tr>
<tr>
<td></td>
<td>- DNS Suffix: The DNS context of the device.</td>
</tr>
<tr>
<td></td>
<td>- DNS Hostname: The DNS local hostname of the device. Use this field to change the computer name of the device.</td>
</tr>
<tr>
<td></td>
<td>- DNS6 Servers: The DNS name server used for DNS name resolution of IPv6 address.</td>
</tr>
<tr>
<td>Intel iAMT Information</td>
<td>- iAMT Enterprise Name.</td>
</tr>
</tbody>
</table>

**D.5.2 Using the Image-Safe Data Viewer**

To use `zisview`, enter any of the following commands at the imaging maintenance mode prompt:
Table D-5  Data Viewer Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>zisview</td>
<td>Displays all image-safe data.</td>
</tr>
<tr>
<td>zisview -z field</td>
<td>Displays information about a specific field or fields. field is one or more</td>
</tr>
<tr>
<td></td>
<td>field names separated by a space. field is not case sensitive.</td>
</tr>
<tr>
<td></td>
<td>All of the following are valid field names (the corresponding minimum</td>
</tr>
<tr>
<td></td>
<td>names that can also be entered on the command line follow each field</td>
</tr>
<tr>
<td></td>
<td>name in parenthesis):</td>
</tr>
<tr>
<td></td>
<td>JustImaged (J)</td>
</tr>
<tr>
<td></td>
<td>ScriptedImage (SC)</td>
</tr>
<tr>
<td></td>
<td>LastBaseImage (L)</td>
</tr>
<tr>
<td></td>
<td>ZoneGUID (ZoneGuid)</td>
</tr>
<tr>
<td></td>
<td>DeviceGUID (DeviceGuid)</td>
</tr>
<tr>
<td></td>
<td>WindowsWorkGroup (WorkG)</td>
</tr>
<tr>
<td></td>
<td>WindowsSID (SI)</td>
</tr>
<tr>
<td></td>
<td>WorkstationID (ID)</td>
</tr>
<tr>
<td></td>
<td>DHCP (DH)</td>
</tr>
<tr>
<td></td>
<td>IP (IP)</td>
</tr>
<tr>
<td></td>
<td>Gateway (Gateway)</td>
</tr>
<tr>
<td></td>
<td>Mask (Mask)</td>
</tr>
<tr>
<td></td>
<td>DNSServerCount (DNSServerC)</td>
</tr>
<tr>
<td></td>
<td>DNSServer (DNSServer)</td>
</tr>
<tr>
<td></td>
<td>DNSSuffix (DNSSu)</td>
</tr>
<tr>
<td></td>
<td>DNSHostName (DNSH)</td>
</tr>
<tr>
<td></td>
<td>DHCP6 (DH6)</td>
</tr>
<tr>
<td></td>
<td>IP6 (IP6)</td>
</tr>
<tr>
<td></td>
<td>Gateway6 (Gateway6)</td>
</tr>
<tr>
<td></td>
<td>prefix6 (prefix6)</td>
</tr>
<tr>
<td></td>
<td>DNS6Server (DNS6Server)</td>
</tr>
<tr>
<td>zisview -s</td>
<td>Creates a script that can be used to generate environment variables that</td>
</tr>
<tr>
<td></td>
<td>contain all of the image-safe data fields.</td>
</tr>
<tr>
<td>zisview -h</td>
<td>Displays help for zisview.</td>
</tr>
</tbody>
</table>

D.5.3  Using the Image-Safe Data Editor

After booting a device from an imaging boot media, you can enter zisedit at the imaging maintenance mode prompt to change, clear, or remove information the image-safe data for that device.

To use zisedit, enter any of the following commands at the prompt:

Table D-6  zisedit Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>zisedit</td>
<td>Displays a screen showing all of the image-safe data fields. You can add or</td>
</tr>
<tr>
<td></td>
<td>change any of the information in the fields.</td>
</tr>
<tr>
<td>Command</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>zisedit field=new_information</td>
<td>You can change the information for one field using this syntax, where field is any valid field name and new_information is the information you want this field to contain. field is not case sensitive. For example, enter zisedit Mask=255.255.252.0 to enter this information in the subnet mask field. All of the following are valid field names (the corresponding minimum names that can also be entered on the command line are shown in parenthesis after each field name): JustImaged (J) ScriptedImage (SC) LastBaselineImage (L) ZoneGuid (ZoneGuid) DeviceGuid (DeviceGuid) WindowsWorkGroup (WorkG) WindowsSID (SI) WorkstationID (ID) DHCP (DH) IP (IP) Gateway (Gateway) Mask (M) DNSServerCount (DNSServerC) DNServer1 (DNSServer1) DNSPrefix (DNSSu) DNSHostName (DNSH) DHCP6 (DH6) IP6 (IP6) Gateway6 (Gateway6) prefix6 (prefix6) DNS6Server (DNS6Server)</td>
</tr>
<tr>
<td>zisedit -c</td>
<td>Clears all image-safe data fields.</td>
</tr>
<tr>
<td>zisedit -r</td>
<td>Removes the image-safe data store. The image based on the hardware rule is restored only when you delete both the ISD of a registered device and the device object associated with the registered device in ZENworks Control Center. If you want to perform the imaging operations on the device after you delete its ISD only, you must assign the work for the device by using the device object or Rule-Based Imaging. If a registered device has a device object based on MAC address or Serial number in the database, the device continues to be a registered device when you reboot it after you delete its ISD, Device GUID, and Device data files. The device still gets the imaging work assigned to the device object.</td>
</tr>
<tr>
<td>zisedit -h</td>
<td>Displays help for zisedit.</td>
</tr>
</tbody>
</table>

**NOTE:** To delete a particular dns6server, use the command `zisedit dns6serverx=`, where x value ranges from 1 to 1350

Example: `zisedit dns6server1=`
D.6 ZENworks Imaging Media Creator (zmediacreator)

You can use this utility to do the following:

- Create a floppy boot diskette to help devices that cannot boot from their CD, DVD or bootable USB to do so
- Manage the settings.txt file
- Create a Preboot Bootable Image (PBI)

The ZENworks Imaging Media Creator utility must run on a Windows device. Its executable is located on your Windows ZENworks Imaging Server at:

`%ZENWORKS_HOME%\bin\preboot\zmediacreator.exe`

The Zmediacreator imaging utility is available at the following locations:

https://primary_server_IP_address:port/zenworks-downloads/msi/novell-zenworks-zmediacreator-11.0.0.xxxxx.msi

https://primary_server_IP_address:port/zenworks-downloads/rpm/novell-zenworks-zmediacreator-11.0.0-xxxxx.i586.rpm

D.7 Imaging Configuration Parameters (settings.txt)

The settings.txt file contains parameters that control how the imaging boot process occurs. You should maintain the working copy of settings.txt at the root of the imaging boot device (CD, DVD or bootable USB, or ZENworks partition):

Windows: `%ZENWORKS_HOME%\bin\preboot\`

Linux: `/opt/novell/zenworks/preboot/bin/winutils/`

The Imaging distro is based on SLES 11. This requires you to additionally maintain a working copy of settings.txt in the `/tftp/boot/` directory of the Imaging Server.

Settings.txt is a plain text file that contains various parameters, each on a separate line. Each parameter has the general format of `PARAMETER=value`. Lines that begin with a pound sign (#) signify comments and are ignored during the imaging boot process.

You can edit this file in a text editor, or by making configuration changes in the `zmediacreator.exe` utility (see Section D.6, "ZENworks Imaging Media Creator (zmediacreator)," on page 249).

**IMPORTANT:** If you edit the settings.txt file to provide any paths to executables, make sure that you provide the full path, or the executable might not run. Also, make sure not to change the order of the settings in the file.

The format and function of each parameter in the settings.txt file are described in Table D-7:
### Table D-7  Settings.txt File Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PROMPT</strong></td>
<td>Specifies whether to prompt for each configuration setting when you boot a device from the imaging boot media.</td>
</tr>
<tr>
<td></td>
<td>If you leave this parameter commented out or set it to No, the device boots using the configuration settings specified in <code>settings.txt</code> and you can't override the settings when booting, unless you type <code>config</code> at the boot prompt before the operating system begins to load.</td>
</tr>
<tr>
<td></td>
<td>If you set this parameter to Yes, you are automatically prompted for each configuration setting when booting.</td>
</tr>
<tr>
<td><strong>MANUALREBOOT</strong></td>
<td>Specifies whether you must reboot a device after it was booted from the imaging boot media in automatic mode. If the device was booted from the imaging boot media in manual mode, you must always reboot the device.</td>
</tr>
<tr>
<td></td>
<td>If you boot a device from the imaging boot media and you let the boot process proceed in automatic mode, the ZENworks Imaging Engine starts and checks the Imaging Server to see if an imaging operation should be performed on the device. If so, it performs the imaging operation and quits. If not, it quits without doing anything.</td>
</tr>
<tr>
<td></td>
<td>What happens next depends on how you set this parameter:</td>
</tr>
<tr>
<td></td>
<td>• If you leave it commented out or set it to No, you are prompted to remove the imaging boot media (if necessary) and press any key to reboot the device to the native operating system.</td>
</tr>
<tr>
<td></td>
<td>• If you set this parameter to Yes, the device doesn’t reboot automatically, but instead displays the imaging maintenance mode prompt, allowing you to perform additional imaging-related tasks using the Linux menu or at the command line. This is helpful if you want to do things such as check the current partition information or the image-safe data before booting to the native operating system.</td>
</tr>
<tr>
<td></td>
<td>Example: MANUALREBOOT=YES</td>
</tr>
<tr>
<td><strong>PARTITIONSIZE</strong></td>
<td>Specifies the number of megabytes to allocate to the ZENworks partition if you choose to create one locally on a device when you boot the device from the imaging boot media.</td>
</tr>
<tr>
<td></td>
<td>The default size is 150 MB. The minimum partition size is 50 MB. The maximum size allowed is 2048 MB (2 GB).</td>
</tr>
<tr>
<td></td>
<td>If you plan to store an image in the ZENworks partition, such as to enable the device to be restored to a certain state without connecting to the network, you might want to specify a larger size for this parameter.</td>
</tr>
<tr>
<td></td>
<td>Example: PARTITIONSIZE=500</td>
</tr>
<tr>
<td><strong>NOABORTBUTTON</strong></td>
<td>To cancel any Imaging operation in progress, you need the ABORT button on the Imaging interface. If you do not need this functionality, you can hide this button by setting the NOABORTBUTTON variable appropriately.</td>
</tr>
<tr>
<td></td>
<td>Example: export NOABORTBUTTON=a</td>
</tr>
<tr>
<td>Parameter</td>
<td>Specifies</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
</tr>
<tr>
<td>netsetup</td>
<td>If you are using DHCP, keep this option enabled. By default, the value is “dhcp,now”. If you are using a specific IP address, replace “dhcp,now” with “-dhcp,now” and uncomment and configure the other three IP address lines (HostIP, netmask, and gateway). Example: netsetup=-dhcp,now</td>
</tr>
<tr>
<td>HostIP</td>
<td>The IP address used by a device to communicate on the network when you boot the device from the imaging boot media, if a static IP address is needed. Example: HostIP=123.45.67.89 If you want DHCP to be used, leave this and the next two parameters commented out.</td>
</tr>
<tr>
<td>netmask</td>
<td>Specifies the subnet mask to be used by the device, if the device is using a static IP address. Example: netmask=255.255.252.0 If DHCP is being used, leave this parameter commented out.</td>
</tr>
<tr>
<td>gateway</td>
<td>Specifies the IP address of the gateway (router) to be used by the device, if the device is using a static IP address. Example: gateway=123.45.67.254 If DHCP is being used, leave this parameter commented out.</td>
</tr>
<tr>
<td>nameserver</td>
<td>Specifies the list of DNS name servers, by IP address, to use for resolving DNS domain names used on this device. Use a space to separate entries. Example: nameserver=123.45.6.7 123.45.6.9 If DHCP is being used, leave this parameter commented out.</td>
</tr>
<tr>
<td>domain</td>
<td>Specifies the list of DNS domain suffixes to be used to identify connections used by this device. Use a space to separate entries. For example: domain=example.novell.com example.xyz.org If DHCP is being used, leave this parameter commented out.</td>
</tr>
</tbody>
</table>
D.8 Logging configuration parameter (novell-prebootlookup.conf)

The novell-prebootlookup file enables you to configure the prebootlookup.log file setting.

**Windows:** `%ZENWORKS_HOME%\conf\preboot\novell-prebootlookup.conf`

**Linux:** `/etc/opt/novell/zenworks/preboot/novell-prebootlookup.conf`

The novell-prebootlookup file includes following parameters:

- **LogLevel:** Specifies the debug log level.

Following are the defined log levels:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROXYADDR</td>
<td>Specifies the IP address or full DNS name of the imaging (proxy) server to connect to when you boot a device from the imaging boot media in auto-imaging mode.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>PROXYADDR=123.45.67.89</td>
</tr>
<tr>
<td></td>
<td>PROXYADDR=imaging.xyz.com</td>
</tr>
<tr>
<td></td>
<td>This parameter is used to set the PROXYADDR environment variable</td>
</tr>
<tr>
<td></td>
<td>when the device is booted from an imaging boot media (other than PXE). The ZENworks Imaging Engine then reads this variable to determine which server to contact if it is running in automatic mode. Whether it is running in automatic or manual mode, the ZENworks Imaging Engine attempts to log the imaging results to the server specified in this variable.</td>
</tr>
<tr>
<td></td>
<td>IMPORTANT: This parameter is set automatically when booting PXE</td>
</tr>
<tr>
<td></td>
<td>and normally should not be modified in the copy of settings.txt that is</td>
</tr>
<tr>
<td></td>
<td>used by PXE:</td>
</tr>
<tr>
<td></td>
<td>Windows:</td>
</tr>
<tr>
<td></td>
<td>%ZENWORKS_HOME%\share\tftp\boot\</td>
</tr>
<tr>
<td></td>
<td>Linux:</td>
</tr>
<tr>
<td></td>
<td>/srv/tftp/boot/</td>
</tr>
<tr>
<td>export IMGCMD</td>
<td>Alters the behavior of automated imaging. If this variable is defined as a script (or a series of commands), then that script (or those commands) are executed instead of the usual <code>img -auto</code> command (see <code>/bin/imaging.s</code>).</td>
</tr>
<tr>
<td>netdevice=eth0</td>
<td>Selects a specific network adapter. If necessary, replace <code>eth0</code> with the correct interface.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>VALUE</td>
<td>Log level  Description</td>
</tr>
<tr>
<td>0</td>
<td>None  No information is logged in the file.</td>
</tr>
</tbody>
</table>
Imaging Utilities and Components

D.9 Imaging Boot Parameter for PCMCIA Cards

When performing imaging work using CDs or DVDs, some computers (particularly laptops) with PCMCIA cards can hang during the boot process. By default, Configuration Management allows the loading of a PCMCIA driver when a device boots for imaging work. Although loading this driver does not normally cause problems, you can use a command line parameter to prevent it from loading.

To prevent the PCMCIA card manager from starting, enter the following at the imaging maintenance mode prompt when booting from a CD, DVD or bootable USB:

```
manual NoPCMCIA=1
```

D.10 Imaging Server

The Imaging Server is a software component of the Configuration Management server. It enables imaging clients to connect with the network to receive imaging services, including:

- Storage or retrieval of an image on a server
- Automatic imaging based on settings created in ZENworks Control Center
D.10.1 Initiating the Imaging Processes

An Imaging Server service or daemon is initiated by running its executable at a command line, which in turn calls the program executable and uses the configuration set in the corresponding .conf file. You use these .conf files to set parameters, because scripts usually accept only arguments instead of parameters.

The following ZENworks services or daemons run the Imaging Server processes:

- “Novell-pbserv” on page 254
- “Novell-proxydhcp” on page 256
- “Novell-tftp” on page 258
- “Novell-zmgprebootpolicy” on page 260
- “Understanding the Arguments” on page 262

Novell-pbserv

Novell-pbserv provides imaging services to devices.

Novell-pbserv is started automatically when installing Configuration Management, or when rebooting the server.

- “Understanding the Novell-pbserv Components” on page 254
- “Configuring Novell-pbserv” on page 255

Understanding the Novell-pbserv Components

To initiate novell-pbserv, enter the following command:

Windows: %ZENWORKS_HOME%\bin\preboot\novell-pbserv.exe

Linux: /etc/init.d/novell-pbserv

Table D-9 lists the arguments for this command, the executable it starts, and the configuration file it uses:
Table D-9 Novell-pbserv Command Details

<table>
<thead>
<tr>
<th>Script Arguments:</th>
<th>start, stop, restart, force-reload, status, showpid (for descriptions of these arguments, see &quot;Understanding the Arguments&quot; on page 262)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux Executable:</td>
<td>/opt/novell/zenworks/preboot/bin/novell-pbservd</td>
</tr>
<tr>
<td>Linux Configuration File:</td>
<td>/etc/opt/novell/zenworks/preboot/novell-pbserv.conf</td>
</tr>
<tr>
<td>Windows Configuration File:</td>
<td>%ZENWORKS_HOME%\conf\preboot\novell-pbserv.conf</td>
</tr>
</tbody>
</table>

**Configuring Novell-pbserv**

The novell-pbserv configuration file (novell-pbserv.conf), contains the following parameters:

Table D-10 Novell-pbserv Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableLogging=YES</td>
<td>If YES, a log file is created for debug messages. This is the default. If NO, no log file is created for debug messages. The novell-pbserv.log file is created in: Windows: %ZENWORKS_HOME%\logs\preboot Linux: /var/opt/novell/log/zenworks/preboot</td>
</tr>
<tr>
<td>IPAddress=</td>
<td>The IP address to be used by imaging for all communications. If nothing is entered, novell-pbserv attempts to detect an IP address. Can be used in a clustering environment to specify the IP address of the virtual server. Can also be used in a multiple-NIC environment to bind the Imaging Server to a specific IP address. By default, this is commented out.</td>
</tr>
<tr>
<td>LIBRARY_NAME=</td>
<td>For Linux, full path of the library to be loaded by the ZENWorks Imaging Service. If the library name is not specified, then by default libzenimgweb.so is loaded from the /opt/novell/zenworks/preboot/lib directory. For Windows, provide the full path of zenimgweb.dll. By default, this is commented out.</td>
</tr>
<tr>
<td>PrebootServiceLogFile Size</td>
<td>For Linux, the log file path is /var/opt/novell/log/zenworks/preboot/novell -pbserv.log. The size of the log file is controlled by the value of the PrebootServiceLogFileSize. When the log file exceeds this value, it is deleted and restarted. The PrebootServiceLogFileSize is in Mega Bytes.</td>
</tr>
</tbody>
</table>
**Novell-proxydhcp**

Novell-proxydhcp provides PXE devices with the information that they require to be able to connect to the ZENworks Preboot Services system.

Novell-proxydhcp is not started automatically when installing Configuration Management.

- “Understanding the Novell-proxydhcp Components” on page 256
- “Configuring novell-proxydhcp” on page 256

**Understanding the Novell-proxydhcp Components**

To initiate novell-proxydhcp, enter the following command:

**Windows:** `%ZENWORKS_HOME%\bin\preboot\novell-proxydhcp.exe`  
**Linux:** `/etc/init.d/novell-proxydhcp`

Table D-11 lists the arguments for this command, the executable it starts, and the configuration file it uses:

*Table D-11 Novell-proxydhcp Command Details*

<table>
<thead>
<tr>
<th>Script Arguments</th>
<th>start, stop, restart, force-reload, status, showpid, install (for descriptions of these arguments, see “Understanding the Arguments” on page 262)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executable</td>
<td><code>/opt/novell/bin/novell-proxydhcpd</code></td>
</tr>
<tr>
<td>Linux Configuration File</td>
<td><code>/etc/opt/novell/novell-proxydhcp.conf</code></td>
</tr>
<tr>
<td>Windows Configuration File</td>
<td><code>installation_path\novell\zenworks\conf\preboot\novell-proxydhcpd.conf</code></td>
</tr>
</tbody>
</table>

**Configuring novell-proxydhcp**

The **novell-proxydhcp configuration file** (`novell-proxydhcp.conf`), *contains the following parameters.*

Parameters that are not commented out, but contain no values, are given a default value.

*Table D-12 Novell-proxydhcp Parameters*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| `LocalDHCPFlag = 0`| Indicates whether the DHCP server for this subnet resides on the same server as novell-proxydhcp.  
0 (the default) means novell-proxydhcp is not running on the same server as the DHCP service. 1 means they are running on the same server.  
The Proxy DHCP server needs to behave slightly differently if it is loaded on the same server as the DHCP service. |
| `LocalInterface = 10.0.0.1` | Indicates the IP address to be used by the Proxy DHCP server. This setting is intended only for use on servers with multiple LAN interfaces. The IP address must be valid on the server.  
By default, this parameter is commented out. |
Novell-proxydhcp is compliant with the following RFCs:

- RFC 2131 - Dynamic Host Configuration Protocol
- RFC 2132 - DHCP Options and BOOTP Vendor Extensions

Novell-proxydhcp is compliant with the Preboot Execution Environment (PXE) Specification v2.1 industry specification, published by Intel.

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NovellPolicyEngine = 10.0.0.1</td>
<td>The IP address of the server where a Novell Preboot policy engine is running. Most often, this is a ZENworks imaging service or daemon. If no value is specified, the Proxy DHCP assumes that the service or daemon is running on the same server. By default, this parameter is commented out.</td>
</tr>
<tr>
<td>NBPx86 = nvlbp.sys</td>
<td>The name of the boot file this service will suggest for all x86 computers, such as nvlbp.sys.</td>
</tr>
<tr>
<td>MenuTimeout = 2</td>
<td>The number of seconds the F8 menu is displayed before automatically choosing the first option, which is always this server and its default network bootstrap program (NBP). The default is 2 seconds.</td>
</tr>
<tr>
<td>ProxyLogLevel = 2</td>
<td>The value assigned here determines which events are entered in novell-proxydhcp.log. Specifying a high level in an active system can quickly fill the log. Valid values are: 0, 1, 2, 3, and 4. The default is 2. Each message from the Proxy DHCP server is assigned a priority level. If ProxyLogLevel is set to a value equal to or greater than a message’s priority level, that message is entered in novell-proxydhcp.log. All other messages are ignored. Priority meaning: 0: Critical information. Service start, stop, and critical events are logged. 1: Warning information. Additionally, warning information is logged. 2: Transaction information. All completed client transactions are logged. 3: Request information. All client requests and Proxy DHCP requests received are logged, including ignored requests. If a request is ignored, the reason for ignoring it is also logged. 4: Debugging information. All DHCP packets received and accepted are decoded and logged.</td>
</tr>
</tbody>
</table>
| ProxyLogFile = path
novellproxydhcp.log | The file where all log file entries are placed. The novell-proxydhcp.log file is created in:  
Windows: %ZENWORKS_HOME%\logs\preboot  
Linux: /var/opt/novell/log/zenworks/preboot  
By default, this parameter is commented out. |
| ProxyLogFileSize = 15       | The size of the ProxyLogFile file is controlled by the value of ProxyLogFileSize, where 15 is the default (in MB). When the log file exceeds the ProxyLogFileSize value, it is deleted and restarted.                                  |
Novell-tftp

Novell-tftp provides TFTP services to imaging clients.

Novell-tftp is started automatically when installing Configuration Management, or when rebooting the server.

- “Understanding the Novell-tftp Components” on page 258
- “Configuring Novell-tftp” on page 258

Understanding the Novell-tftp Components

To initiate novell-tftp, enter the following command:

**Windows:** %ZENWORKS_HOME%\bin\preboot\novell-tftp.exe

**Linux:** /etc/init.d/novell-tftp

Table D-13 lists the arguments for this command, the executable it starts, and the configuration file it uses:

<table>
<thead>
<tr>
<th>Table D-13</th>
<th>Novell-tftp Command Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Arguments:</td>
<td>start, stop, restart, force-reload, status, showpid (for descriptions of these arguments, see “Understanding the Arguments” on page 262)</td>
</tr>
<tr>
<td>Executable:</td>
<td>/opt/novell/bin/novell-tftpd</td>
</tr>
<tr>
<td>Linux Configuration File:</td>
<td>/etc/opt/novell/novell-tftp.conf</td>
</tr>
<tr>
<td>Windows Configuration File:</td>
<td>%ZENWORKS_HOME%\conf\preboot\novell-tftp.conf</td>
</tr>
</tbody>
</table>

Configuring Novell-tftp

The novell-tftp configuration file (novell-tftp.conf), contains the following parameters for the Novell TFTP server.

Parameters that are not commented out, but contain no values, are given a default value.

<table>
<thead>
<tr>
<th>Table D-14</th>
<th>Novell-tftp Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>TFTPInterface = 10.0.0.1</td>
<td>The IP address that is used for all TFTP communications. If a value is not given here, the service tries to detect one. This value is most useful for multihomed servers. By default, this parameter is commented out.</td>
</tr>
</tbody>
</table>
TransferBlockSize = 1428

This value determines the size of the data block used by the TFTP server to transmit and receive data to and from a client. Valid values are between 512 and 4428.

For Ethernet networks, this value should be 1428.

For token ring networks, this value can be 4428, but only if you are sure there are no Ethernet segments; otherwise, use 1428.

Older TFTP clients might be restricted to 512 bytes, which was the original transfer block size before the adoption of RFC 2348. The Novell TFTP server is compatible with these clients.

By default, this parameter is commented out.

TimeoutInterval = 1

This is the amount of time (in seconds) that the TFTP server waits for a client to acknowledge before resending a packet. However, because the TFTP server uses an adaptive algorithm to calculate the actual timeout interval, this value is only used as an initial value. It can increase or decrease, depending on the performance of the network.

This value is only a default. It can be changed at the request of a client. See RFC 2349.

Valid values are 1 through 60.

By default, this parameter is commented out.

Linux -- TFTPDirectory = /srv/tftp

TFTPDirectory is the directory where the TFTP server can store and retrieve files. All paths submitted to the TFTP server by clients are assumed to be relative to this directory.

Because TFTP has no security, you should not place files with sensitive information in this directory, and that you should place a space quota on it.

The TFTP server does not load if this directory does not exist.

By default, this parameter is commented out.

TFTPAllowWrites = 0

This tells the TFTP server whether to allow users to place new files on the server. Setting this variable to 0 (the default) makes the TFTP server more secure by not allowing users to place new files on the server. The other option is 1, which allows users to place new files on the server.

TFTPAllowWrites must be set to 1 in order for the AllowOverwrites parameter to be recognized.
Novell-tftp is compliant with the following RFCs:

- RFC 1350 -- THE TFTP PROTOCOL (REVISION2)
- RFC 2347 - TFTP Option Extension
- RFC 2348 - TFTP Blocksize Option
- RFC 2349 - TFTP Timeout Interval and Transfer Size Options

**Novell-zmgprebootpolicy**

Novell-zmgprebootpolicy allows PXE devices to query the Configuration Management system for work to do and for Preboot Menu policies.

Novell-zmgprebootpolicy is started automatically when installing Configuration Management, or when rebooting the server.

- “Understanding the Novell-zmgprebootpolicy Components” on page 261
- “Configuring Novell-zmgprebootpolicy” on page 261
Understanding the Novell-zmgprebootpolicy Components

To initiate novell-zmgprebootpolicy, enter the following command:

**Windows:** `%ZENWORKS_HOME%\bin\preboot\novell-zmgprebootpolicy.exe`

**Linux:** `/etc/init.d/novell-zmgprebootpolicy`

Table D-15 lists the arguments for this command, the executable it starts, and the configuration file it uses:

<table>
<thead>
<tr>
<th>Script Arguments:</th>
<th>start, stop, restart, force-reload, status, showpid (for descriptions of these arguments, see “Understanding the Arguments” on page 262)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executable:</td>
<td><code>/opt/novell/zenworks/preboot/bin/novell-zmgprebootpolicyd</code></td>
</tr>
<tr>
<td>Linux Configuration File:</td>
<td><code>/etc/opt/novell/zenworks/preboot/novell-zmgprebootpolicy.conf</code></td>
</tr>
<tr>
<td>Windows Configuration File:</td>
<td><code>%ZENWORKS_HOME%\conf\preboot\novell-zmgprebootpolicy.conf</code></td>
</tr>
</tbody>
</table>

Configuring Novell-zmgprebootpolicy

The novell-zmgprebootpolicy configuration file (`novell-zmgprebootpolicy.conf`), contains the following parameters.

Parameters that are not commented out, but contain no values, are given a default value.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| `LocalInterface = 10.0.0.1` | The IP address that is used by the Policy server.  
This setting is intended only for use on servers with multiple LAN interfaces.  
The address must be valid on the server.  
By default, this parameter is commented out. |
Understanding the Arguments

The following arguments are available for each of the Preboot Services daemons described above for Linux servers. Windows equivalents are noted.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PolicyLogLevel = 1</td>
<td>The value assigned here determines which events are entered in <code>novell-zmgprebootpolicy.log</code>. Specifying a high level in an active system can quickly fill the log. Valid values are: 0, 1, 2, 3, and 4. The default is 2. Each message from the novell-zmgprebootpolicy server is assigned a priority level. If <code>PolicyLogLevel</code> is set to a value equal to or greater than a message’s priority level, that message is entered in <code>novell-zmgprebootpolicy.log</code>. All other messages are ignored. Priority meaning: 1: Critical. Service start, stop, and error events are entered. 2: Normal. All critical information and notifications of successfully completed client requests are entered. 3: Debug. Includes all information from level 1 and 2, and information useful in troubleshooting problems. 4: Complete. Not intended for use during normal operations. Can quickly fill the log and may impact system performance.</td>
</tr>
<tr>
<td>PolicyLogFile = <code>path\novell-zmgprebootpolicy.log</code></td>
<td>The file where all log file entries are placed. The <code>novell-zmgprebootpolicy.log</code> file is created in: Windows: <code>%ZENWORKS_HOME%\logs\preboot</code> Linux: <code>/var/opt/novell/log/zenworks/preboot</code> By default, this parameter is commented out.</td>
</tr>
<tr>
<td>PolicyLogFileSize = 15</td>
<td>The size of the log file is controlled by the value of <code>PolicyLogFileSize</code>, where 15 is the default (in MB). When the log file exceeds the <code>PolicyLogFileSize</code> value, it is deleted and restarted.</td>
</tr>
<tr>
<td>PrebootServer = 10.0.0.5</td>
<td>This field contains the address of the Imaging Server that should be used to resolve policies. By default, this parameter is commented out.</td>
</tr>
<tr>
<td>EnableAMTSupport = Yes</td>
<td>This feature is not currently supported in Novell ZENworks Configuration Management. This field enables or disables support for Intel’s AMT technology. By default, this support is disabled by commenting out the parameter.</td>
</tr>
</tbody>
</table>

Parameter Description
D.10.2  Viewing Information About Imaging Requests

After the Imaging Server has started, you can view information about the status and results of the imaging requests that it has received from imaging clients. A statistical summary of these requests is shown on the server’s command line. The statistics shown on this screen are explained below. All statistics are reset to zero if you restart the Imaging Server.

To view the multicast imaging information, at the server’s command line enter:

Windows: `%ZENWORKS_HOME%\bin\preboot\zmgcast.exe -status`

Linux: `/opt/novell/zenworks/preboot/bin/novell-zmgmcast -status`

The information in Table D-18 explains what is displayed:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>start</td>
<td>For Linux, starts the daemon.</td>
</tr>
<tr>
<td></td>
<td>Because novell-proxydhcp is optional, use this argument to start this service or daemon. However, this daemon does not automatically start when the server reboots. (See install below.)</td>
</tr>
<tr>
<td></td>
<td>For Windows, open the Services dialog box, right-click the Novell service, then select Start.</td>
</tr>
<tr>
<td>start setjustimagedflag</td>
<td>(Linux only) For novell-zislnx only, sets the Just Imaged flag so that a device can be imaged by using its existing image-safe data.</td>
</tr>
<tr>
<td>stop</td>
<td>For Linux, stops the daemon.</td>
</tr>
<tr>
<td></td>
<td>For Windows, open the Services dialog box, right-click the Novell service, then select Stop.</td>
</tr>
<tr>
<td>restart</td>
<td>Stops and restarts the service or daemon if it is already running.</td>
</tr>
<tr>
<td></td>
<td>For Windows, open the Services dialog box, right-click the Novell service, then select Restart.</td>
</tr>
<tr>
<td>force-reload</td>
<td>(Linux only) Causes the daemon’s configuration file to be reloaded.</td>
</tr>
<tr>
<td>status</td>
<td>For Linux, displays the current status of the service or daemon.</td>
</tr>
<tr>
<td></td>
<td>For example, if you enter /etc/init.d/novell-pserv status, information similar to the following is returned:</td>
</tr>
<tr>
<td></td>
<td>Novell ZENworks Imaging Service running</td>
</tr>
<tr>
<td></td>
<td>On Windows, open the Services dialog box and review the Status column.</td>
</tr>
<tr>
<td>showpid</td>
<td>(Linux only) Displays the daemon’s process ID.</td>
</tr>
<tr>
<td></td>
<td>For example, if you enter /etc/init.d/novell-pserv showpid, information similar to the following is returned:</td>
</tr>
<tr>
<td></td>
<td>Novell ZENworks Imaging Service running</td>
</tr>
<tr>
<td>install</td>
<td>(Linux only) For novell-proxydhcp only, causes the daemon to be automatically loaded when the server boots.</td>
</tr>
</tbody>
</table>
Table D-18 Imaging Request Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>PXE Requests</td>
<td>The number of imaging requests of any kind that have been received by the Imaging Server since it was last started. This includes requests that failed, were denied, or were referred to other Imaging Servers. Information about each of these requests, such as the source, type, date/time, and results, is logged on the Imaging Server.</td>
</tr>
<tr>
<td>Images Sent</td>
<td>The number of images that the Imaging Server has sent to imaging clients since the Imaging Server was last started. This includes only images that were retrieved from this Imaging Server.</td>
</tr>
<tr>
<td>Images Received</td>
<td>The number of new images that have been received and stored on the Imaging Server since it was last started. This includes images that were received through client referrals.</td>
</tr>
</tbody>
</table>

D.10.3 Starting a Manual Multicast Session

At the imaging maintenance mode prompt, you can start a manual multicast session, see any sessions in progress, and delete sessions. For more information, see “Initiating a Multicast Session from Each Client” on page 128.

D.11 TFTP Client for WinPE

The TFTP client for WinPE can be used to download files from the TFTP directory on the ZENworks Server. The client can be used to download the Microsoft ImageX third-party imaging engine from the ZENworks Server. ImageX can later be used to perform advanced imaging operations that are not directly supported by ZENworks.

To install and use the TFTP client for WinPE:

1. Boot to WinPE maintenance mode.
2. Install the TFTP client for WinPE by running
   \windows\system32\tftpclientapplication.exe.
3. To download the files from the TFTP directory on the ZENworks Server, use the following command:
   TFTPClientApplication GET IP_address_of_the_TFTP_server source_filename [-n destination_filename]

**NOTE:** If the destination filename is not specified, the file is created with the source filename.
After booting a device from an imaging boot media, you can use the `img` command at the imaging maintenance mode prompt or use the Novell ZENworks Imaging Engine menu to do any of the following:

- Take an image of the device's hard disks
- Restore an image on the device's hard disks
- View or manipulate the device’s hard disk partitions
- View the device’s hardware configuration or image-safe data
- Display a menu from which you can also perform all of these tasks

Because the ZENworks Imaging Engine is a Linux application, the command syntax is case sensitive. The overall syntax is:

```
img mode
```

where `mode` is any of the mode commands described in the following sections:

- Section E.1, “Help Mode,” on page 266
- Section E.2, “Automatic (Query for Work) Mode,” on page 267
- Section E.3, “Make Mode,” on page 268
- Section E.4, “Restore Mode,” on page 274
- Section E.5, “Session Mode (Multicast Image Set),” on page 282
- Section E.6, “Partition Operations Mode,” on page 285
- Section E.7, “ZENworks Partition Management Mode,” on page 290
- Section E.8, “Dump Mode,” on page 291
- Section E.9, “Information Mode,” on page 292
- Section E.10, “Return Codes Generated by ZENworks Imaging Engine (img),” on page 294

Each mode command can be abbreviated to the first letter of its name. For example, `img -dump` can be abbreviated as `img -d`.

To access the ZENworks Imaging Engine menu and perform all of these tasks, enter `img` by itself. The ZENworks Imaging Engine menu is a character-based display where you can access the menu items by using the mouse or by using the Alt key with the highlighted menu option letters.

Exiting the ZENworks Imaging Engine menu returns you to the imaging maintenance mode prompt.
E.1 Help Mode

Use the -help mode command to get information about the img command if you don’t have this documentation available.

In the ZENworks Imaging Engine menu, you can access help for legacy img commands by clicking Help > Legacy Command-line Options. The legacy commands still work, but the newer ZENworks Configuration Management commands introduce added functionality.

To use the Help mode:

- Section E.1.1, "Using the ZENworks Imaging Engine Menu for Help," on page 266
- Section E.1.2, "Using the Imaging Maintenance Mode Prompt for Help," on page 266

E.1.1 Using the ZENworks Imaging Engine Menu for Help

1. To display the ZENworks Imaging Engine menu, enter:
   
   `img`

2. Click Help to display the drop-down menu of help items.

3. Select a mode name to display the help for that mode command.

   The help includes the possible syntaxes for the command under SYNOPSIS and explanations for each command and parameter under OPTIONS.

E.1.2 Using the Imaging Maintenance Mode Prompt for Help

To display the help, enter:

`img -help mode`

where `mode` is the mode whose mode command you want help with.

Examples:

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -help</code></td>
<td>Displays a short description of all modes.</td>
</tr>
<tr>
<td><code>img -help -m</code></td>
<td>Displays information on how to use the Make mode.</td>
</tr>
<tr>
<td><code>img -help -p</code></td>
<td>Displays information on how to use the Partition mode.</td>
</tr>
</tbody>
</table>
E.2 Automatic (Query for Work) Mode

Use the `-auto` mode command to image the device automatically, based on any applicable Preboot Services default settings. The ZENworks Imaging Engine runs in this mode if you let the imaging boot process proceed without interruption, or if you type the command at the imaging maintenance mode prompt.

In this mode, the ZENworks Imaging Engine queries the Imaging Server specified in the PROXYADDR environment variable for any work to do. The Imaging Server checks the relevant Preboot Services default settings to determine what imaging tasks should be performed (if any), such as taking or restoring an image. It then instructs the ZENworks Imaging Engine to perform those tasks.

If any tasks involve storing or retrieving images with other Imaging Servers, the Imaging Server refers the ZENworks Imaging Engine to those servers to complete the tasks.

After the ZENworks Imaging Engine has completed its work, it communicates the results to the original Imaging Server, and the results are logged on it.

PROXYADDR is set in the `settings.txt` file on the CD or the ZENworks partition. It can be edited by using the `config` option when booting from the imaging CD. PROXYADDR can be the IP address, DNS name, or the name from the local `hosts` file.

If the `-auto` command is used when booted to the Manual Imaging mode, manual intervention might be required to complete some tasks, such as tasks contained in imaging scripts.

For information on configuring the settings that control what happens in this mode, see Section 2.5, “Configuring Preboot Services Defaults for ZENworks Imaging,” on page 72.

To use the Automatic mode:

- Section E.2.1, “Using the ZENworks Imaging Engine Menu to Query for Work,” on page 267
- Section E.2.2, “Using the Imaging Maintenance Mode Prompt to Query for Work,” on page 267

E.2.1 Using the ZENworks Imaging Engine Menu to Query for Work

1 To display the ZENworks Imaging Engine menu, enter:

   `img`

2 Do any of the following:
   - On the menu bar, click Imaging, then click Query for Work.
   - Click F9 Query for Work on the task bar.
   - Press F9.

3 (Conditional) For a ZENworks Imaging Script bundle, execute the script by using the `sh /bin/zenAdvancedScript` command.

E.2.2 Using the Imaging Maintenance Mode Prompt to Query for Work

To use the automatic mode, enter:

`img -auto`
or

```
img -a
```

## E.3 Make Mode

Use the `make` mode command to take an image of the device and store it in a specified location. Normally, all partitions on the local hard disks are included in the image, but there are some exceptions noted in Table E-2 on page 270.

You can take an image of a device by using either the imaging maintenance mode prompt or by using the ZENworks Imaging Engine menu. For step-by-step instructions, see “Manually Taking an Image of a Device” on page 103. You can also use the Make Locally mode command to take an image of the device and store it in a partition on the local hard disk. For step-by-step instructions, see Section 3.1.3, “Setting Up Disconnected Imaging Operations,” on page 113.

The image size corresponds to about half the size of the data in all of the device’s partitions, except that the ZENworks partition and Compaq or Dell configuration partitions are always excluded. Devices with logical volumes (LVMs) are not supported for imaging.

The syntax of this mode depends on whether you store the image locally or on an Imaging Server (proxy).

The following sections contain additional information:

- Section E.3.1, “Make Locally,” on page 268
- Section E.3.2, “Make to Proxy,” on page 271

### E.3.1 Make Locally

To use the Make Locally mode:

- “Using the ZENworks Imaging Engine Menu to Make an Image Locally” on page 268
- “Using the Imaging Maintenance Mode Prompt to Make an Image Locally” on page 269
- “Using WINPE Maintenance Mode Prompt to Make an Image Locally” on page 270

**IMPORTANT:** When you make an image locally, using the Tuxera driver, use the following command to mount the partition on which the image is stored if the partition is NTFS:

```
# mount -t tntfs /dev/sdXn mount_dir
```

In this command, `sdX` is the device node and `n` stands for the partition number in the device.

### Using the ZENworks Imaging Engine Menu to Make an Image Locally

1. To display the ZENworks Imaging Engine menu, enter:

   ```
   img
   ```

2. Click Imaging > Make Image.
   This displays the Make Image Wizard.

3. In the wizard, select Local, then click Next.
   The Make Local Image Wizard is displayed.
4 Fill in the fields:

**Path to Image Archive:** Click **Browse** to select the location for the image file, or specify an existing path.

**Include Partitions:** Click the check box for any partitions that you do not want to include in the image. By default, all partitions are selected.

**Compression:** Specify any number from 0 to 9 where 0 means no compression, 1 means the least compression, and 9 means the most compression.

5 Click **Next** to continue.

The next Make Image Wizard dialog box is displayed.

6 (Optional) Fill in the fields:

**Author:** Specify who created the image file.

**Computer:** Identify the computer where this image is being made.

**Image Description:** Describe the image file's content or purpose.

**Comments:** Specify anything that might be helpful concerning this image.

7 Click **Next** to make the image.

The ZENworks Imaging Engine Menu displays a progress bar while making image.

8 If the imaging process was successful, click **OK** in the Information dialog box, then click **Close** to return to a blank ZENworks Imaging Engine Menu display.

If the imaging process was unsuccessful, determine and resolve the issue, then repeat these steps.

**Using the Imaging Maintenance Mode Prompt to Make an Image Locally**

Using the imaging maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the "make locally" (-makel) mode command:

```
img -make -local local_filepath/filename.zmg [-part=partition_number] [-comp=comp_level] [-exclude=partition_number] [-include=partition_number]
```

where the [...] brackets indicate optional commands.

You can abbreviate **-make -local as:** -m -local, -makel, or -ml.

You can also abbreviate **-exclude as** -x and **-include as** -I.

For more information, see:

- “Command Details” on page 270
- “Examples” on page 270
**Command Details**

*Table E-2  Make Local Commands and Parameters*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>local_filepath/filename.zmg</td>
<td>The image file name, including the .zmg extension (which is case sensitive), and any local path. However, the directories in the path must exist. If the file already exists, an error is given. You must use a different file name or delete the existing image file in order to use that file name.</td>
</tr>
</tbody>
</table>

- **-part=partition_number** or -P=partition_number | The partition number of the local partition for where to store the image. It must be a primary partition. This partition is excluded from the image that is created. Be sure to specify an existing partition that has enough space to store the image file. Available partitions can be displayed using `img -dump`. If you omit the partition number from this parameter, or do not use this parameter, the image is stored in volatile RAM. |

- **-comp=comp_level** | `comp_level` is the amount of compression used when creating the image. Specify any number from 0-9. 0 means no compression. 1 is the same as Optimize for Speed and is used by default if you do not specify this parameter. 6 is similar to Balanced. 9 is the same as Optimize for Space, which provides the slowest performance. |

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -makel /myimages/myimage.zmg</code></td>
<td>Takes an image of all partitions and saves it to <code>myimages/myimage.zmg</code> in RAM.</td>
</tr>
<tr>
<td><code>img -makel /myimages/myimage.zmg -x=2 -x=3</code></td>
<td>Takes an image of all partitions except those in slots 2 and 3 and saves the image to <code>myimages/myimage.zmg</code> in RAM.</td>
</tr>
</tbody>
</table>

**Using WINPE Maintenance Mode Prompt to Make an Image Locally**

For more information, see the “ZENworks WinPE Imaging” on page 157 section.
E.3.2 Make to Proxy

To use the Make Proxy mode:

- “Using the ZENworks Imaging Engine Menu to Make an Image on a Proxy” on page 271
- “Using the Imaging Maintenance Mode Prompt to Make an Image on a Proxy” on page 272
- “Using the WINPE Maintenance Mode Prompt to Make an Image on a Proxy” on page 273
- “Using the WinPE Maintenance Mode Prompt to Make an Image on a Proxy” on page 274

Using the ZENworks Imaging Engine Menu to Make an Image on a Proxy

1. To display the ZENworks Imaging Engine menu, enter:

   img

2. Click Imaging > Make Image.

   This displays the Make Image Wizard.

3. In the wizard, select Server, then click Next.

   The Make Server Image Wizard is displayed.

4. Fill in the fields:

   **Server IP Address:** Specify the IP address or DNS name of an Imaging Server. If you specified an Imaging Server in the settings.txt file when booting from the imaging CD, that Imaging Server’s IP address is the default; otherwise, the IP address for the Imaging Server specified in the settings.txt file for the PROXYADDR variable is displayed.

   **Path to Image Archive:** Edit the default image filename (archive.zmg) as needed, replacing /path with any additional subdirectories that you have previously created under the content-repo/images directory.

   **Include Partitions:** Click the check box for any partitions that you do not want to include in the image. By default, all partitions are selected.

   **Compression:** Specify any number from 0 to 9 where 0 means no compression, 1 means the least compression, and 9 means the most compression.

5. Click Next to continue.

   The next Make Image Wizard dialog box is displayed.

6. (Optional) Fill in the fields:

   **Author:** Specify who created the image file.

   **Computer:** Identify the computer where this image is being made.

   **Image Description:** Describe the image file’s content or purpose.

   **Comments:** Specify anything that might be helpful concerning this image.

7. Click Next to make the image.

   The ZENworks Imaging Engine Menu displays a progress bar while making image.

8. If the imaging process was successful, click OK in the Information dialog box, then click Close to return to a blank ZENworks Imaging Engine Menu display.

   If the imaging process was unsuccessful, determine and resolve the issue, then repeat these steps.
Using the Imaging Maintenance Mode Prompt to Make an Image on a Proxy

Using the imaging maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the “make to proxy” (-makep) mode command:

```
img -make -proxy added_filepath/filename.zmg -ip=IP_address [-comp=comp_level] [-exclude=partition_number] [-include=partition_number]
```

where the [...] brackets indicate optional commands.

You can abbreviate -make -proxy as: -m -proxy, -makep, or -mp.

If you specified an Imaging Server in the settings.txt file when booting from the imaging CD, that Imaging Server’s IP address defaults; otherwise, the IP address for the Imaging Server specified in the settings.txt file for the PROXYADDR variable is displayed.

For more information, see:
- “Command Details” on page 272
- “Examples” on page 273

Command Details

**Table E-4  Make Proxy Commands and Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>added_path/filename.zmg</code></td>
<td>The image file name, including a .zmg extension (which is case sensitive) and any added path. The Imaging engine automatically saves images to the default images directory on the Imaging Server:</td>
</tr>
<tr>
<td></td>
<td><strong>Windows:</strong> <code>%ZENWORKS_HOME%\work\content-repo\images\</code></td>
</tr>
<tr>
<td></td>
<td><strong>Linux:</strong> <code>/var/opt/novell/zenworks/content-repo/images/</code></td>
</tr>
<tr>
<td></td>
<td>If no folders are specified in the path (added_path), the image is created in this images directory.</td>
</tr>
<tr>
<td></td>
<td>A forward slash is not needed at the beginning of any added path.</td>
</tr>
<tr>
<td></td>
<td>You can create subdirectories under images for organizing your image files. However, any such subdirectories that you specify in the path must already exist when you use this command. ZENworks does not create the directories during imaging.</td>
</tr>
<tr>
<td></td>
<td>If the image file itself already exists, the Imaging Server won’t overwrite it unless you enable this behavior in ZENworks Control Center for the Imaging Server. To enable the behavior in ZENworks Control Center, click Configuration &gt; Management Zone Settings &gt; Device Management &gt; Preboot Services &gt; Device Imaging Work Assignment, select the Allow Preboot Services to overwrite existing files when uploading option.</td>
</tr>
<tr>
<td><code>-ip=IP_address</code></td>
<td>The IP address or DNS name of an imaging server. If you do not use this parameter, the value for PROXYADDR is used.</td>
</tr>
</tbody>
</table>
Using the WINPE Maintenance Mode Prompt to Make an Image on a Proxy

- "Command Details:" on page 274
- "Examples:" on page 274

Using the WINPE maintenance mode prompt, the following explains the syntax and available parameters that you can use with the Make to Proxy mode command:

```bash
img -make -proxy filename.zmg [-comp=comp_level]
```

You can abbreviate -make -proxy as: -m -proxy, -makep, or -mp.

You can change the proxy address by using below command:

```bash
set PROXYADDR={ServerAddress}
```
Command Details:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>filename.zmg</td>
<td>The image file name accepts with a .zmg extension.</td>
</tr>
<tr>
<td></td>
<td>The image file will be saved in the default directory.</td>
</tr>
<tr>
<td></td>
<td>On Windows servers, the image will be stored in \zenworks_home\work\content-repo\images folder.</td>
</tr>
<tr>
<td></td>
<td>On Linux servers, the image will be stored in /var/opt/novell/zenworks/content-repo/images folder.</td>
</tr>
<tr>
<td>comp_level</td>
<td>You can specify the compression level ranging from 0 to 9.</td>
</tr>
<tr>
<td></td>
<td>0 as lowest and 9 as highest compression level.</td>
</tr>
</tbody>
</table>

Examples:

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>img -mp test.zmg -comp=6</td>
<td>Takes an image of the test file and compresses to level 6.</td>
</tr>
</tbody>
</table>

Using the WinPE Maintenance Mode Prompt to Make an Image on a Proxy

For more information, see the “ZENworks WinPE Imaging” on page 157 section.

E.4 Restore Mode

Use the -restore mode command to retrieve an image from a specified location and restore it to a device.

You can restore an image of a device by using either the imaging maintenance mode prompt or by using the ZENworks Imaging Engine menu. For step-by-step instructions, see “Manually Taking an Image of a Device” on page 103. You can also use the Restore mode command to restore an image from a partition on a local hard disk. For step-by-step instructions, see Section 3.1.3, “Setting Up Disconnected Imaging Operations,” on page 113.

Normally, if the image to be restored is a base image (one created previously by the ZENworks Imaging Engine), all existing partitions except the ZENworks partition and Dell or Compaq configuration partitions are removed from all local hard disks before the new image is restored. When the image is restored, the sizes of the original partitions from which the image was taken are preserved, if possible. If there is insufficient space, the last partition is shrunk to fit, unless this would result in data loss, in which case the ZENworks Imaging Engine denies the requested operation. If there is extra space left after all partitions in the image have been restored to their original sizes, that space is left unpartitioned.
If the image to be restored is an add-on image, or if it’s a base image and you specify the aparticle:partition parameter, none of the existing physical partitions are removed. Instead, the appropriate partitions are merely updated with the files from the image, overwriting any existing file of the same name and location.

The syntax of this mode depends on whether you will retrieve the image from a local device or from an imaging (proxy) server, as explained in the subsections below:

- Section E.4.1, “Restore from Local,” on page 275
- Section E.4.2, “Restore from Proxy,” on page 278

**NOTE:** When you perform a partition-based restore with Windows 7 or a later version, you need to restore the Windows system partition as well. For an example on how the restore is performed with the Tuxera NTFS driver, see Section 3.14.3, “Prerequisites for taking and restoring an image partition-wise,” on page 173.

### E.4.1 Restore from Local

Use the `-restore -local` mode command to retrieve an image from a local device and restore it to the device. For more information, see Section 3.1.3, “Setting Up Disconnected Imaging Operations,” on page 113.

To use the Help mode:

- “Using the ZENworks Imaging Engine Menu to Restore an Image Locally” on page 275
- “Using the Imaging Maintenance Mode Prompt to Restore an Image Locally” on page 276
- “Using the WinPE Mode Prompt to Restore an Image Locally” on page 277
- “Using the WinPE Maintenance Mode Prompt to Restore an Image Locally” on page 278

**IMPORTANT:** When you restore an image locally, using the Tuxera driver, use the following command to mount the partition on which the image is stored if the partition is NTFS:

```
# mount -t tntfs /dev/sdXn mount_dir
```

In this command, `sdX` is the device node and `n` stands for the partition number in the device.

#### Using the ZENworks Imaging Engine Menu to Restore an Image Locally

1. To display the ZENworks Imaging Engine menu, enter:
   ```
   img
   ```
2. Click Imaging > Restore Image.
   This displays the Restore Image Wizard.
3. In the wizard, select Local, then click Next.
   The Restore Local Image Wizard is displayed.
4. Fill in the fields:
   - **Path to Image Archive:** Click Browse to select the image file, or specify its full path and filename, including the `.zmg` filename extension.
**File Set:** The number of the image file set to be restored. Valid values are 1 through 10. File set 1 defaults. For information on file sets, see Appendix A, “File Sets and Image Numbers,” on page 197.

**Options:** Specify any advanced options. For more information, see Table E-6 on page 276.

5 Click **Next** to restore the image.

The ZENworks Imaging Engine Menu displays a progress bar while restoring image.

6 If the imaging process was successful, click **OK** in the Information dialog box, then click **Close** to return to a blank ZENworks Imaging Engine Menu display.

If the imaging process was unsuccessful, determine and resolve the issue, then repeat these steps.

**Using the Imaging Maintenance Mode Prompt to Restore an Image Locally**

Using the imaging maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the “restore from local” (-restorel) mode command:

```
img -restore -local local_filepath/filename.zmg [-part=partition_number] [-s=file_set] [-ap=advanced_options]
```

where the [...] brackets indicate optional commands.

You can abbreviate `restore -local` as: `-r -local`, `-restorel`, or `-rl`.

For more information, see:

- “Command Details” on page 276
- “Examples” on page 277

**Command Details**

**Table E-6  Restore Local Commands and Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-restorel</code></td>
<td>The partition number (as displayed by <code>img dump</code>) of the local partition to retrieve the image from. It must be a primary partition. This partition is not changed by the imaging operation.</td>
</tr>
<tr>
<td><code>-part=partition_number</code></td>
<td>The filename of the image to retrieve, including the <code>.zmg</code> extension (case-sensitive) and the complete path from the root of the local partition.</td>
</tr>
<tr>
<td><code>-s=fileset</code></td>
<td>The number of the image file set to be restored. Valid values are 1 through 10. For information on creating file sets of an image, see Section 1.6.2, “Creating, Installing, and Restoring Standard Images,” on page 35.</td>
</tr>
</tbody>
</table>

If you omit this parameter, file set 1 is used.
Using the WinPE Mode Prompt to Restore an Image Locally

Using the WinPE mode prompt, the following example explains the syntax and available parameters that you can use with the “restore from local” (-restorel) mode command:

```
img -restore -local local_filepath/filename.zmg
```
You can abbreviate `-restore -local` as: `-r -local, -restorel, or -rl."

For more information, see:

- "Command Details" on page 278
- "Examples" on page 278

**Command Details**

**Table E-8  Restore Local Commands and Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>local_filepat/</td>
<td>The filename of the image to retrieve, including the .zmg extension</td>
</tr>
<tr>
<td>filename.zmg</td>
<td>(casesensitive) and the complete path from the root of the local partition.</td>
</tr>
</tbody>
</table>

**Examples**

**Table E-9  Restore Local Examples**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -restorel Q:/myimage.zmg</code></td>
<td>Removes all existing local partitions, retrieves the image from Q:(Drive mounted to share the folder path where the image is stored)/myimage.zmg, and restores the partitions and contents of that image on the available local writable devices (assuming there is sufficient local space).</td>
</tr>
</tbody>
</table>

**NOTE:** You can restore .zmg images that were taken using WinPE.

**Using the WinPE Maintenance Mode Prompt to Restore an Image Locally**

For more information, see the "ZENworks WinPE Imaging" on page 157 section.

**E.4.2 Restore from Proxy**

Use the `-restore -proxy` mode command to retrieve an image from an imaging (proxy) server and restore it to the device. For more information, see "Manually Restoring an Image on a Device" on page 108.

To use the Help mode:

- "Using the ZENworks Imaging Engine Menu to Restore an Image from a Proxy" on page 279
- "Using the Imaging Maintenance Mode Prompt to Restore an Image from a Proxy" on page 279
- "Using the WinPE Maintenance Mode Prompt to Restore an Image from a Proxy" on page 281
- "Using the WINPE Maintenance Mode Prompt to Restore an Image from a Proxy" on page 281
Using the ZENworks Imaging Engine Menu to Restore an Image from a Proxy

1. To display the ZENworks Imaging Engine menu, enter:
   ```
   img
   ```

2. Click Imaging > Restore Image.
   This displays the Restore Image Wizard.

3. In the wizard, select Server, then click Next.
   The Restore Server Image Wizard is displayed.

4. Fill in the fields:
   - **Server IP Address**: Specify the IP address or DNS name of an Imaging Server where the image you need is stored. If you specified an Imaging Server in the settings.txt file when booting from the imaging CD, that Imaging Server’s IP address is the default; otherwise, the IP address for the Imaging Server specified in the settings.txt file for the PROXYADDR variable is displayed.
   - **Path to Image Archive**: Specify the filename of the Image file to be restored, in the path to the image archive.
   - **File Set**: The number of the image file set to be restored. Valid values are 1 through 10. File set 1 is the default. For information on file sets, see Appendix A, “File Sets and Image Numbers,” on page 197.
   - **Options**: Specify any advanced options. For more information, see Table E-10 on page 280.

5. Click Next to restore the image.
   The ZENworks Imaging Engine Menu displays a progress bar while restoring image.

6. If the imaging process was successful, click OK in the Information dialog box, then click Close to return to a blank ZENworks Imaging Engine Menu display.
   If the imaging process was unsuccessful, determine and resolve the issue, then repeat these steps.

Using the Imaging Maintenance Mode Prompt to Restore an Image from a Proxy

At the imaging maintenance mode prompt, use the “restore from proxy” (-restorep) mode command to restore an image from a proxy.

- To restore an image by specifying the image file path:
  ```
  img -restore -proxy added_filepath/filename.zmg -ip=IP_address [-s=set] [-ap=advanced_options]
  ```
  where the [...] brackets indicate optional commands.

- To restore a Preboot bundle:
  1. `img -restore -proxy bundle_name -ip=IP_address`
     You can abbreviate `-restore -proxy` as: -r -proxy, -restorep, or -rp.

For more information, see:

- “Command Details” on page 280
- “Examples” on page 281
## Command Details

**Table E-10  Restore Proxy Mode Commands and Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>added_filepath/filename.zmg</strong></td>
<td>The filename and added path of the image to retrieve, including the .zmg extension (case sensitive).</td>
</tr>
<tr>
<td><strong>-s=fileset</strong></td>
<td>The number of the image file set to be restored. Valid values are 1 through 10. For information on creating file sets of an image, see Section 1.6.2, “Creating, Installing, and Restoring Standard Images,” on page 35. If you omit this parameter, file set 1 is used.</td>
</tr>
<tr>
<td><strong>bundle_name</strong></td>
<td>The name of the bundle to be applied.</td>
</tr>
<tr>
<td><strong>-ap=partition:partition</strong></td>
<td>A mapping between a partition in the image archive (apartition) and a target physical partition on the local machine (ppartition). Use this parameter to selectively restore a specific part of the image to a specific local partition. <strong>IMPORTANT:</strong> If you use this parameter, none of the existing local partitions are removed, and only the target local partition is updated. The update process does not remove any existing files or overwrite any existing files of the same names if they are newer. If you want to remove all existing files from the target partition before updating it, first use the Partition Operations Mode to delete and re-create the partition. If you choose to restore the base image, you need to delete and recreate the target partition before restoring the image because your system might be left in an inconsistent state if the Selective Partition Image restoration fails. For apartition, use the partition number displayed for the source partition in the Image Explorer (zmgeexp) utility. For ppartition, use the partition number displayed by img dump for the target partition. The target partition must be a partition of a supported file system. You can repeat this parameter as needed to request multiple selective restorations in a single operation. In doing so, you can apply multiple parts of the image to a single local partition, but you can’t apply the same part of an image to multiple local partitions in a single operation.</td>
</tr>
</tbody>
</table>
Examples

**Table E-11  Restore Proxy Mode Examples**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -restorep subdir1/myimage.zmg</code></td>
<td>Removes all existing local partitions, retrieves the image from <code>subdir1/myimage.zmg</code> on the Imaging Server, and restores the partitions and contents of that image on the available local writable devices (assuming there is sufficient local space).</td>
</tr>
<tr>
<td><code>img -restorep subdir1/myimage.zmg -s=2</code></td>
<td>Removes all existing local partitions, retrieves the image from <code>subdir1/myimage.zmg</code> on the Imaging Server, and restores the partitions and contents of file set 2 of that image on the available local writable devices (assuming there is sufficient local space).</td>
</tr>
<tr>
<td><code>img -restorep subdir1/myimage.zmg -ap=a2:p1</code></td>
<td>Retrieves the image from <code>subdir1/myimage.zmg</code> on the Imaging Server, updates local partition 1 with the data from partition 2 of that image, and leaves the other local partitions unchanged (assuming there is sufficient space in local partition 1).</td>
</tr>
<tr>
<td><code>img -rp image.zmg -ap=a3:p1 a4:p2</code></td>
<td>Retrieves <code>image.zmg</code> from server and updates local partition 1 with data from partition 3 and updates local partition 2 with data from partition 4 in the image.</td>
</tr>
</tbody>
</table>

**NOTE:** In ZENworks, you only need to provide the image filename (the .zmg file) because the images are stored in a fixed location. For example, if you saved the image file in the default location, enter:

```
img -rp myimagefile.zmg
```

Because you can organize your images under the \images directory by adding subdirectories, the additional path where you created the image file should be provided. For example:

```
img -rp /windows/vista/myimagefile.zmg
```

**Using the WinPE Maintenance Mode Prompt to Restore an Image from a Proxy**

For more information, see the "ZENworks WinPE Imaging" on page 157 section.

**Using the WINPE Maintenance Mode Prompt to Restore an Image from a Proxy**

At the WINPE maintenance mode prompt, use the “restore from proxy” (-restore) mode command to restore an image from a proxy.

- “Command Details:” on page 282
- “Example:” on page 282

```
img -restore -proxy filename.zmg
```

You can abbreviate -restore -proxy as: -r -proxy, -restorep, or –rp

You can change the proxy address by using below command:

```
set PROXYADDR={ServerAddress}
```
Command Details:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -rp filename.zmg</code></td>
<td>The image file name with .zmg extension should be used to restore the image to target machine.</td>
</tr>
</tbody>
</table>

**NOTE:** You can restore .zmg images that were taken using WinPE.

**Example:**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -rp test.zmg</code></td>
<td>Restores the test.zmg image file to the target machine.</td>
</tr>
</tbody>
</table>

**E.5 Session Mode (Multicast Image Set)**

Use the `-session` (Multicast Image Set) mode command to take an image of one device and restore it to multiple other devices simultaneously over the network in a single operation.

**IMPORTANT:** For multicasting to work properly, the routers and switches on the network must have multicast features configured. Otherwise, multicast packets might not be routed properly.

For multicasting to work, each participating device must boot from an imaging boot media and run the ZENworks Imaging Engine in this mode, as explained below. The device from which the image is taken is called the *master*, and the devices that receive the image are called *clients*.

You can start the multicast session from the Imaging Server (see “Initiating a Multicast Session from the ZENworks Imaging Server” on page 126). If you start the session this way, you specify an image file for multicasting rather than a device as the session master. Otherwise, if you start the session from a client device, you can specify one of the session clients as the session master. In that case, an image of the session master’s hard drive is sent to the session clients. For more information, see “Initiating a Multicast Session from Each Client” on page 128.

To use the Help mode:

- Section E.5.1, “Multicasting Using the ZENworks Imaging Engine Menu,” on page 282
- Section E.5.2, “Multicasting Using the Imaging Maintenance Mode Prompt,” on page 283

**E.5.1 Multicasting Using the ZENworks Imaging Engine Menu**

1. To display the ZENworks Imaging Engine menu, enter:

   `img`

2. Click Imaging > Multicast Session.

   This displays the Multicast Wizard.

3. Fill in the fields:

   **Session Name:** Specify a unique name for the session.
**Session Role:** Select whether this participant is the master or a client.

One of the participants must be the master. It is the master who starts the session.

**For Session Master Only:** To specify additional options, click the check box for the **Specify Additional Options** field to display the Multicast Wizard dialog box containing the options, then fill in the fields:

- **Compression Level:** Select one. **Speed** provides the fastest, but least compression and **Size** provides the most compression, but more slowly.

- **Automated Session:** To enable the session, click the check box for the **Enabled** field. Specify the minimum number of clients to join (the default is 5) or the minimum number of minutes to transpire (the default is 5), or both, to provide the triggers for starting the session.

4 Click **Next** to continue.

The ZENworks Imaging Engine Menu is displayed with the **Abort Session** option. If you select this option to abort the multicast session, none of the clients queued for the session can be multicast-imaged because a master is required for a session to run.

If you enabled the session in **Step 3**, then when the number of clients or the timeout value is reached, the session begins.

5 If you did not enable the session in **Step 3**, you can click **Start Session** to enable it.

### E.5.2 Multicasting Using the Imaging Maintenance Mode Prompt

Using the imaging maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the `-session` mode command:

```
img -session name -master [-clients=count] [-timeout=minutes] [-throttle=time] [-comp=comp_level][-retry=seconds]
```

or

```
img -session name -client
```

where the [...] brackets indicate optional commands.

You can abbreviate `-session` as `-s` and `-master` as `-m`.

For more information, see:

- “Command Details” on page 283
- “Examples” on page 285

### Command Details

**Table E-12  Session Mode Commands and Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>name</strong></td>
<td>The name of the multicast session. Each device joining the session uses the same value for this parameter.</td>
</tr>
</tbody>
</table>

**IMPORTANT:** The name must be unique among concurrent multicast sessions. It is hashed by the ZENworks Imaging Engine to produce a Class D IP address for the multicast session. To facilitate troubleshooting (wire sniffring), all ZENworks imaging multicast addresses start with 231. For example, the session name `mcast01` can produce the multicast address 231.139.79.72.
### Parameter Specifiers

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>-master or -client</td>
<td>Specifies that this device is the session master or a client. There can only be one master designated for the session. If you omit these parameters, the ZENworks Imaging Engine waits for a user at one of the devices to press m to designate that device as the master. You must then press s at the master device to start the session.</td>
</tr>
<tr>
<td>-clients=count</td>
<td>The minimum number of participating devices that must register in addition to the master before imaging begins. This option only applies to the device designated as the session master (where the -m parameter is used). The imaging session begins when: a) the minimum number of clients have registered, b) you press s at the master device without waiting for all devices to register, or c) five minutes has passed since the last client has registered. If you omit this parameter, the ZENworks Imaging Engine waits for you to press s at the master device, which starts the imaging session. Thereafter, any devices attempting to register in the session are denied and queued for the next multicast session.</td>
</tr>
<tr>
<td>-timeout=minutes</td>
<td>The number of minutes the master device waits (without reaching the required registered clients) after the last client has registered before starting the imaging process. This option only applies to devices designated as session masters (where the -m parameter is used). If you omit this parameter, the default timeout is 5 minutes. The imaging process does not start until: a) the client value is reached, b) the timeout value has transpired, or c) you press s at the master device. After that, any clients attempting to register are denied and queued for the next multicast session.</td>
</tr>
<tr>
<td>-throttle=time</td>
<td>The number of micro-seconds to wait between master send packets. This is useful for throttling network traffic.</td>
</tr>
<tr>
<td>-comp=comp_level</td>
<td>The amount of compression used when creating the image. Specify any number from 0-9. 0 means no compression. 1 is the same as Optimize for Speed and is used by default if you do not specify this parameter; 6 is similar to Balanced; and, 9 is the same as Optimize for Space, which provides the slowest performance.</td>
</tr>
<tr>
<td>-retry=seconds</td>
<td>While resending the multicast packet, the number of seconds the master device waits before considering the client as disconnected (timed out). Configuring this parameter is useful when multicasting from a workstation that contains large directories. If you omit this parameter, the default timeout is 60 seconds.</td>
</tr>
</tbody>
</table>
E.6 Partition Operations Mode

Use the partition mode command to activate (make bootable), add, or delete a partition on the device.

You can activate, add, or delete a partition by using either ZENworks Imaging Engine menu or the imaging maintenance mode prompt.

For more information, review the following sections:

- Section E.6.1, “Using the ZENworks Imaging Engine Menu to Partition,” on page 285
- Section E.6.2, “Using the Imaging Maintenance Mode Prompt to Partition,” on page 286
- Section E.6.3, “Using the WinPE Maintenance Mode Prompt to Partition,” on page 288

E.6.1 Using the ZENworks Imaging Engine Menu to Partition

1. Enter `img` to display the ZENworks Imaging Engine menu, then click Partitioning.
2. Click Modify partitions to open the Partition Wizard.
3. Select a partition.
4. Select an option:

---

**Examples**

*Table E-13  Session Mode Examples*

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -session mcast01</code></td>
<td>Starts a multicast session named <code>mcast01</code>. Each successive device that issues this same command before imaging begins joins the session. Imaging doesn’t start until you press <code>m</code> on one of the devices to designate itself as the master, then press <code>s</code> to start the imaging.</td>
</tr>
<tr>
<td><code>img -session mcast01 -m</code></td>
<td>Starts a multicast session named <code>mcast01</code> and designates this device as the master. Each successive device that issues <code>img -session mcast01</code> before the imaging begins joins the <code>mcast01</code> session as a client. Imaging doesn’t start until you press <code>s</code> on the master device.</td>
</tr>
<tr>
<td><code>img -session mcast01 -master -clients=5</code></td>
<td>Starts a multicast session named <code>mcast01</code>. Each successive device that issues <code>img -session mcast01</code> before imaging begins joins the <code>mcast01</code> session as a client. Minimum five other devices must register as clients before the session can begin, or five minutes must have elapsed since the last client registered. However, you can start the session from the master device without waiting for all devices to register by pressing <code>s</code>.</td>
</tr>
<tr>
<td><code>img -session mcast01 -master -clients=5 -timeout=20</code></td>
<td>Starts a multicast session named <code>mcast01</code>. Each successive device that issues <code>img -session mcast01</code> before the imaging begins joins the session. The session begins when either minimum five other devices have registered as clients, or more than 20 minutes has elapsed since the last client registered. You can also press <code>s</code> to start the session at any time.</td>
</tr>
</tbody>
</table>
Active: Select a partition that you want to activate (make bootable), then click **Active**.

Add: Opens the Create New Partition window. Click a partition type, partition size, and cluster size, then click **OK**.

Delete: Select a partition, then click **Delete**.

5 When finished, click **Done**.

For more information, see the table in Section E.6.2, “Using the Imaging Maintenance Mode Prompt to Partition,” on page 286.

### E.6.2 Using the Imaging Maintenance Mode Prompt to Partition

You can use the following partition mode commands at the imaging maintenance mode prompt:

- `img -pa partition_number`
- `img -pc partition_number -type=type [-size=size] [-cluster=cluster_size]`
- `img -pd partition_number`
- `img -pd -all`

For more information, see:

- “Command Details” on page 286
- “Examples” on page 288

#### Command Details

The following table lists the details of the commands used for creating and deleting an image partition:
**Operation** | **Action**
---|---
-pc partition_number type [size] [cluster=clusterSize][-A] [-guid] | Creates a new partition, where:

- **partition_number** is the number of the partition slot (as displayed by `img dump`) in which to create the partition.

- **type** is a keyword, a partition name or a numerical value for the partition type.

The valid keywords for the partition name are `fat12`, `fat16`, `fat32`, `fat32x`, `ntfs`, `ext2`, `reiser`, `linuxswap`, and `extended`. Ensure to specify the keywords in lowercase.

The numeric value for the partition type can be 0x0C (hexadecimal) or 11 (decimal).

If you are creating an extended partition, you can create a logical drive inside of the extended partition. (See the next table for an example.)

- **size** is a valid size for the partition type.

You must specify the size in MB or as a percentage of the total capacity of the drive. If you give a percentage, include the % symbol; otherwise, the value is considered the size in MB.

If you omit this parameter, the largest valid size for the partition type is used, given the available unpartitioned space on the drive.

- **clusterSize** is a size appropriate to the partition type and partition size.

You must specify the size in MB or as a percentage of the total capacity of the drive. If you give a percentage, include the % symbol; otherwise, the value is considered the size in MB.

If you omit this parameter, the imaging engine uses a reasonable cluster size for the specified partition type and size.

**NOTE:** When you create a partition using command line to restore an image partition-wise, you need to get the cluster size from the image first and then pass it as a parameter. If the cluster size is not specified, the default cluster size would be considered, which might not be compatible with the image restored on the partition.

- **-A** is a switch used to create an aligned partition with a start sector that is a multiple of 2048.

- **-guid** is used while creating GPT type of partitions.

You can run the `img -pc 1 -type=NTFS -size=100 -guid=PartitionType` command to create a GPT partition. The partition type attribute in this command can take values like MBD (Microsoft Disk Partition), MRP (Microsoft Reserved Partition), WRE (Windows Recovery Environment Partition), ESP (EFI System Partition). The above command will create a 100 MB partition with GUID partition type and initialize the partition with NTFS file system.

Ensure that the following conditions are met for a successful partition creation:

- If the partition type is ESP, then the -type command should be FAT32.

- Size of MRP partitions depends on the size of the disk. For disk size less than 16 GB, the MRP partition is 32 MB, and for disk size more than 16 GB, the MRP partition is 128 MB.

- If -guid is specified, either the Protective MBR should be present, or the MBR partition table should be empty.
E.6.3 Using the WinPE Maintenance Mode Prompt to Partition

You can use the following partition commands at the WinPE maintenance mode prompt:

- `img -pc partition_number -type=type [-size=size] [-cluster=cluster_size]`
- `img -pc partition_number -type=type [-size=size] [-cluster=cluster_size]-guid=guid`
- `img -pa partition_number`
- `img -pd partition_number`
- `img -pd -all`

The new partition is recognizable by other operating systems, but must be formatted or have a base image restored to it before you can store files in it.

If you use the legacy NTFS driver to create a partition on a device and no base image is restored in the partition, run the `# mkntfs -fc 4096/dev/sdXn` command to make the partition usable. In this command, `sdX` is the device node and `n` stands for the partition number in the device.

### Examples

#### Table E-14  Partition Mode Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -pc 1 -type=ext2</code> or <code>img -pc 1 -type=ext2</code></td>
<td>Creates the ext2 partition in slot 1 using all of the available unpartitioned space on the drive.</td>
</tr>
<tr>
<td><code>img -pc 1 -type=ext2 -size=1000</code> or <code>img -pc 1 -type=ext2 -size=1000</code></td>
<td>Creates a Reiser partition in slot 5 using 5,671 MB on the drive.</td>
</tr>
<tr>
<td><code>img -pd 3</code> or <code>img -pd 3</code></td>
<td>Deletes the partition from slot 3.</td>
</tr>
<tr>
<td><code>img -pa 1</code> or <code>img -pa 1</code></td>
<td>Creates an active partition in slot 1.</td>
</tr>
<tr>
<td><code>img -pd 2 -type=extended -size=2500</code> or <code>img -pd 2 -type=reiser -size=500</code></td>
<td>Creates an extended partition with a 2500 ext2 logical drive and a 500 MB Reiser logical drive.</td>
</tr>
</tbody>
</table>

NOTE: If you are deleting an Extended partition, ensure that you delete it sequentially from the first partition.

- `pd` `partition_number` Deletes the partition from slot number `partition_number`. Use `img dump` to get the slot number.

- `pd -all` Deletes all non-protected partitions.

- `pa` `partition_number` On a MBR disk: Activates (make bootable) the partition in slot number `partition_number`.

Use the `img dump` command to get the slot number.
For more information, see:

- “Command Details” on page 289
- “Examples” on page 290

## Command Details

<table>
<thead>
<tr>
<th>Operation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>-pc partition_number type [-size] [-cluster=clusterSize] [-guid]</td>
<td>Creates a new partition, where:</td>
</tr>
<tr>
<td></td>
<td>• partition_number is the number of the partition slot (as displayed by <code>img -p</code>) in which the partition is created.</td>
</tr>
<tr>
<td></td>
<td>• type is a keyword, a partition name or a numerical value for the partition type.</td>
</tr>
<tr>
<td></td>
<td>The valid keywords for the partition name are FAT32, NTFS, and extended. Ensure that you specify the keywords in lowercase.</td>
</tr>
<tr>
<td></td>
<td>If you are creating an extended partition, you can create a logical drive inside of the extended partition. (See the below table for an example.)</td>
</tr>
<tr>
<td></td>
<td>• size is a valid size for the partition type.</td>
</tr>
<tr>
<td></td>
<td>You can specify the size in MB, or as a percentage of the total capacity of the drive. If you are specifying the size in percentage, then include the percent (%) symbol, else the size value is considered in MB.</td>
</tr>
<tr>
<td></td>
<td>If you omit this parameter, the largest valid size for the partition type is used, given the available unpartitioned space on the drive.</td>
</tr>
<tr>
<td></td>
<td>• clusterSize is a size appropriate to the partition type and partition size.</td>
</tr>
<tr>
<td></td>
<td>If you omit this parameter, the largest valid size for the partition type is used, given the available unpartitioned type and size on the drive.</td>
</tr>
<tr>
<td></td>
<td>• guid (Global Unique Identifier): guid is a unique identifier assigned to every GPT partition, it can be MBD (Microsoft Basic Data Partition), MRP (Microsoft Reserved Partition), WRE (Windows Recovery Environment Partition), and ESP (EFI System Partition).</td>
</tr>
<tr>
<td>-pd partition_number</td>
<td>Deletes the partition from slot number partition_number. Use <code>img -p</code> to get the slot number.</td>
</tr>
<tr>
<td>-pd -all</td>
<td>Deletes all non-protected partitions.</td>
</tr>
<tr>
<td>-pa partition_number</td>
<td>Activates (make bootable) the partition in the slot. Use <code>img -p</code> to get the slot number.</td>
</tr>
</tbody>
</table>
Examples

Table E-15  Partition Mode Examples

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>img -pc 1 -type=fat32 -size=1024</code></td>
<td>Creates the FAT32 partition in slot 1 of size 1024 MB on the MBR disk.</td>
</tr>
<tr>
<td><code>img -pc 1 -type=ntfs -size=1024 -guid=MBD</code></td>
<td>Creates the NTFS partition in slot 1 of size 1024 MB on the GPT disk.</td>
</tr>
<tr>
<td><code>img -pc 2 -type=ntfs</code></td>
<td>Creates a NTFS partition in slot 2 using all the available unpartitioned space on the drive.</td>
</tr>
<tr>
<td><code>img -pd 3</code> or <code>img -pd3</code></td>
<td>Deletes the partition from slot 3.</td>
</tr>
<tr>
<td><code>img -pc 2 -type=extended -size=2500</code> or <code>img -pc 2 -type=ext -size=2500</code></td>
<td>Creates an extended partition of size 2500 MB, and a 500 MB NTFS logical drive within the extended partition.</td>
</tr>
<tr>
<td><code>img -pc 2 -type=ntfs -size=500</code></td>
<td></td>
</tr>
<tr>
<td><code>img -pa 1</code></td>
<td>Activates the partition in slot 1.</td>
</tr>
</tbody>
</table>

E.7  ZENworks Partition Management Mode

Use the `-zenpart` mode command to enable, disable, or remove the installed ZENworks partition.

To use the Help mode:
- Section E.7.1, “Using the ZENworks Imaging Engine Menu to Manage a Partition,” on page 290
- Section E.7.2, “Using the Imaging Maintenance Mode Prompt to Manage a Partition,” on page 291

E.7.1  Using the ZENworks Imaging Engine Menu to Manage a Partition

1  To display the ZENworks Imaging Engine menu, enter:

   `img`

2  Click Partitioning, then click one of the following:

   - **Disable ZEN Partition**: Disables the ZENworks partition.
   - **Enable ZEN Partition**: Enables the ZENworks partition.
   - **Remove ZEN Partition**: Removes the ZENworks partition.

   **IMPORTANT**: If you remove an installed ZENworks partition, you must immediately restore a base image with a valid non-grub MBR (Master Boot Record). If you do not, the device cannot boot properly.

3  Click Imaging > Exit to display the imaging maintenance mode prompt.

4  At the prompt, enter `grub.s` to make this change effective.
E.7.2 Using the Imaging Maintenance Mode Prompt to Manage a Partition

Using the imaging maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the various ZENworks partition management mode commands:

```
img -zenpart operation
```

where `operation` is to disable, enable, or remove a ZENworks partition.

To manage a ZENworks partition:

1. From the imaging maintenance mode prompt, enter one of the following:
   - `img -zenpart -disable`
   - `img -zenpart -enable`
   - `img -zenpart -remove`

   **IMPORTANT:** If you remove an installed ZENworks partition, you must immediately restore a base image with a valid non-grub MBR (Master Boot Record). If you do not, the device cannot boot properly.

2. Enter `grub.s` to make this change effective.

---

E.8 Dump Mode

The `-dump` mode command provides information about the device’s hard drives and partitions.

To use the Dump mode:

- Section E.8.1, "Using the ZENworks Imaging Engine Menu to View Partition Information," on page 291
- Section E.8.2, "Using the Imaging Maintenance Mode Prompt to View Partition Information," on page 292

---

E.8.1 Using the ZENworks Imaging Engine Menu to View Partition Information

1. To display the ZENworks Imaging Engine menu, enter:
   ```
   img
   ```

2. Click **System information**, then click **Drive information**.
   
   Information concerning the hard drives and partitions is displayed.
E.8.2 Using the Imaging Maintenance Mode Prompt to View Partition Information

Using the imaging maintenance mode prompt, the following example explains the syntax and available parameters that you can use with the Dump (-dump) mode command:

```
img -dump [-geo]
```

where the -geo parameter is optional.

You can abbreviate -dump -geo as -dg.

For more information, see:
- “Command Details” on page 292
- “Examples” on page 292

Command Details

**Table E-16 Dump Mode Commands and Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>-dump</td>
<td>Lists the existing partitions on all local hard drives. For each partition, the type, size, and slot number of the partition are given. The ZENworks partition and Dell or Compaq configuration partitions are not listed.</td>
</tr>
<tr>
<td>-geo</td>
<td>Displays additional information about the geometry (cylinders, heads, and sectors) and capacity of each hard drive.</td>
</tr>
</tbody>
</table>

Examples

**Table E-17 Dump Mode Examples**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>img -dump</td>
<td>Lists the current partitions on all local writable devices.</td>
</tr>
<tr>
<td>img -dump -geo</td>
<td>Lists all hard drives, their geometry and capacity, and the current partitions on the writable devices.</td>
</tr>
</tbody>
</table>

E.9 Information Mode

Use the -info mode command to view the following:

- The data currently stored in the image-safe area on the device
This data is saved by the Novell ZENworks Configuration Management Imaging Agent (\texttt{novell-
\texttt{zisdservice}}) during each device's session to ensure that it can be restored after the device is
reimaged. If the device is new and doesn't have an operating system yet, an initial set of data is
supplied from the default configuration for the ZENworks Management Zone, such as IP
addresses.

- Information about the hardware devices on the device
  This information is detected during the imaging boot process. If the ZENworks Imaging Engine
  runs in auto-imaging mode, this information is sent to the Imaging Server to help determine
  which image to restore to the device, if necessary.

- Name of the base image that was last restored on the device

To use the Information mode:

- \textit{Section E.9.1, "Using the ZENworks Imaging Engine Menu to View Device Information," on
  page 293}

- \textit{Section E.9.2, "Using the Imaging Maintenance Mode Prompt to View Device Information," on
  page 293}

\textbf{E.9.1 Using the ZENworks Imaging Engine Menu to View Device Information}

1. To display the ZENworks Imaging Engine menu, enter:

\texttt{img}

2. Click \texttt{System information}, then click \texttt{Detected Hardware} or \texttt{Image-Safe Data}.

   See \textit{Table E-18} for details.

\textbf{E.9.2 Using the Imaging Maintenance Mode Prompt to View Device Information}

1. Enter one of the following from the imaging maintenance mode prompt:

\texttt{img \text{-info \text{-hardware}}}

\texttt{img \text{-info \text{-zisd}}}

   You can abbreviate \texttt{-info} as \texttt{-i}.

For more information, see:

- "Command Details" on page 294
- "Examples" on page 294
Command Details

**Table E-18  Information Mode Commands and Parameters**

<table>
<thead>
<tr>
<th>Menu item or parameter</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Information &gt; Detected Hardware</td>
<td>Lists the detected hardware devices on the device, including:</td>
</tr>
<tr>
<td>or img -info (from the imaging maintenance</td>
<td>- CPU chipset</td>
</tr>
<tr>
<td>mode prompt)</td>
<td>- System manufacturer</td>
</tr>
<tr>
<td></td>
<td>- Computer product name</td>
</tr>
<tr>
<td></td>
<td>- BIOS version</td>
</tr>
<tr>
<td></td>
<td>- BIOS asset tag</td>
</tr>
<tr>
<td></td>
<td>- BIOS serial number</td>
</tr>
<tr>
<td></td>
<td>- Video adapter</td>
</tr>
<tr>
<td></td>
<td>- Network adapter</td>
</tr>
<tr>
<td></td>
<td>- MAC address</td>
</tr>
<tr>
<td></td>
<td>- Sound card</td>
</tr>
<tr>
<td></td>
<td>- Hard drive controller</td>
</tr>
<tr>
<td></td>
<td>- Hard disk capacity</td>
</tr>
<tr>
<td></td>
<td>- Detected RAM</td>
</tr>
<tr>
<td></td>
<td>- Boot media</td>
</tr>
</tbody>
</table>

| System Information > Image Safe Data         | Lists the data currently stored in the image-safe area on the device.  |
| or img -info -zisd (from the imaging         | The items that comprise this data are listed in Section D.5, "Image-Safe  |
| maintenance mode prompt)                    |   Data Viewer and Editor (zisview and zisedit),” on page 244.          |
|                                              | In addition to the image-safe data, the last base image that was       |
|                                              |   restored on the device is also listed.                               |

**Examples**

**Table E-19  Information Mode Examples**

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>img -info -hardware</td>
<td>Lists the detected hardware devices on the device.</td>
</tr>
<tr>
<td>img -info -zisd</td>
<td>Lists the Configuration Management image-safe data currently stored on</td>
</tr>
<tr>
<td></td>
<td>the device and the last base image that was restored.</td>
</tr>
</tbody>
</table>

### E.10 Return Codes Generated by ZENworks Imaging Engine (img)

- Section E.10.1, “Connection or Socket Error Codes,” on page 295
- Section E.10.2, “File Error Codes,” on page 295
### E.10.1 Connection or Socket Error Codes

-1200 IMGERR_CONN_TIMEOUT
-1201 IMGERR_SOCKET_READ_FAILURE
-1202 IMGERR_SOCKET_SEND_FAILURE
-1203 IMGERR_CONNECT_FAILURE
-1204 IMGERR_SOCKET_FAILURE
-1205 IMGERR_DATA_OUTOF_SYNC

### E.10.2 File Error Codes

-1220 IMGERR_FILE_WRITE_FAILURE
-1221 IMGERR_IMAGE_FILE_INACCESSIBLE
-1222 IMGERR_IMAGE_FILE_INVALID
-1223 IMGERR_FILE_INACCESSIBLE
-1224 IMGERR_LOCAL_FILE_OVERWRITE
-1225 IMGERR_IMAGE_FILE_NO_WRITE_PERMISSION
-1226 IMGERR_FILE_WRITE_NO_SPACE

### E.10.3 Error Codes Exchanged Between Client and Server

-1240 IMGERR_UNLOAD_MODULE
-1241 IMGERR_WRONG_CLIENT_VERSION
-1242 IMGERR_UNKNOWN_PACKET
-1243 IMGERR_GET_SAFEDATA_FAILURE
-1244 IMGERR_UNDEFIINED_WORK
-1245 IMGERR_PREVIOUS_JOB_FAILURE
-1246 IMGERR_BASE_IMAGE_EXISTS
-1247 IMGERR_VALIDATE_PATH_FAILED
-1248 IMGERR_INVALID_PATH
-1249 IMGERR_IMAGE_FILE_OVERWRITE_DISABLED
-1250 IMGERR_UNSUPPORTED_COMPRESSION
-1251 IMGERR_UNKNOWN_COMPRESSION_CODE
-1252 IMGERR_COMPRESSION_FIXUP
-1253 IMGERR_ADVANCED_SCRIPT_EXISTS
-1254 IMGERR_RECV_BUFFER_TOO_SMALL
E.10.4 General Error Codes

-1300 IMGERR_INIT_FAIL
-1301 IMGERR_MEMALLOC_FAIL

E.10.5 Error Codes Used by the DS Library

-1400 IMGERR_NO_IMAGE_DOWNLOAD
-1401 IMGERR_POLICYAUTH_FAIL
-1402 IMGERR_CLEARFLAG_FAIL
-1403 IMGERR_NO_WS
-1405 IMGERR_SERVER_IPADDRESS_FAILURE
-1406 IMGERR_NO_IMAGE_UPLOAD
-1407 IMGERR_NO_POLICY
-1408 IMGERR_NO_IMAGE_FLAG
-1409 IMGERR_WS_IPADDRESS_FAILURE
-1410 IMGERR_TREE_INVALID
-1411 IMGERR_IMAGE_OBJECT_INVALID
-1412 IMGERR_COMM_FAILURE

E.10.6 Error Codes Used Locally Between Functions

-1500 IMGERR_NO_MORE_JOB
-1501 IMGERR_WRONG_PARAM
-1502 IMGERR_JOBTABLE_FULL
-1600 IMGERR_MCAST_THREAD_FAILURE
-1601 IMGERR_MCAST_FILE_OPEN_FAILURE
-1602 IMGERR_MCAST_ABORTED_AT_CONSOLE
-1603 IMGERR_MCAST_UDP_PORT_FAILURE
-1604 IMGERR_MCAST_SESSION_EXISTED
-1605 IMGERR_MCAST_UNKNOWN_ERR
-1700 IMGERR_ASSIGNED_JOB_WAS_PREBOOT
-1701 IMGERR_LAST_PXE_JOB_MATCH

E.10.7 Error Codes for Command Line Arguments

-1800 IMGERR_NO_SESSIONS
-1801 IMGERR_NO_MEM
-1802 IMGERR_SESSION_FILE_NO_DATA

E.10.8 Error Referral List

-1900 IMGERR_NO_REFERRAL_LIST
-1901 IMGERR_REFERRAL_NOT_SUPPORTED
-2000 IMGERR_NO_MENU_STATE
-2500 IMGERR_NO_PBI_NAME
-10000 PXEERR_TASK_NOT_FOUND
Updating ZENworks Imaging Resource Files

In Novell ZENworks, you can update ZENworks imaging resource files.

The following sections provide concepts on how the boot process works with ZENworks imaging, and instructions for updating imaging resource files:

- Section F.1, “The Linux Distribution for Imaging,” on page 299
- Section F.2, “Understanding Device Boot Processes in a ZENworks Imaging Environment,” on page 299
- Section F.3, “Understanding ZENworks Partitions and Command Line Parameters,” on page 302
- Section F.4, “Modifying ZENworks Imaging Resource Files,” on page 303
- Section F.5, “Adding or Updating LAN Drivers,” on page 308
- Section F.6, “Variables and Parameters,” on page 310
- Section F.7, “Troubleshooting Linux Driver Problems,” on page 312

F.1 The Linux Distribution for Imaging

ZENworks Imaging uses a small Linux distribution on the client device to perform imaging operations. The distribution shipping with ZENworks is based on the SUSE installation system, where SUSE Linux Enterprise Server (SLES) boots to a small distribution to perform a YaST installation. ZENworks Imaging uses the same installation system found in SLES, but instead of starting a YaST installation, it starts a ZENworks Imaging session.

The PXE (Preboot Execution Environment) environment is an internally-developed PXE solution from Novell.

Using a stable Linux distribution based on SLES gives customers a distribution with the broadest range of stable drivers available. The hardware industry is continually introducing new and updated network and disk drivers, so it’s not always possible to provide the latest drivers in its software releases.

This section covers how to update Linux drivers using the new distribution. It deals with the imaging resource files that are based on the SLES distribution and ZENworks Preboot Services processing.

F.2 Understanding Device Boot Processes in a ZENworks Imaging Environment

The following provides a high-level overview of a Linux boot process and how ZENworks imaging affects it:

1. A boot loader program loads the Linux kernel and initrd (initial RAM drive) into memory.
The SLES-based imaging distribution uses *isolinux* as the boot loader for imaging CDs or DVDs, a modified *pxelinux* for booting using PXE. If you have a ZENworks partition installed, it uses the grub program to boot alternately between the ZENworks partition and the installed operating system.

Following are the filenames and paths for Windows 32-bit:

<table>
<thead>
<tr>
<th>Files</th>
<th>When booting from a CD</th>
<th>When booting from PXE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preboot Loader</td>
<td><em>isolinux</em></td>
<td><em>pxelinux</em></td>
</tr>
<tr>
<td>Linux Kernel Name</td>
<td>\boot\i386\loader\linux</td>
<td>&quot;$ZENWORKS_HOME%\share\tftp\boot\linux&quot;</td>
</tr>
<tr>
<td>Initrd Filename</td>
<td>\boot\i386\loader\initrd</td>
<td>&quot;$ZENWORKS_HOME%\share\tftp\boot\initrd&quot;</td>
</tr>
</tbody>
</table>

Following are the filenames and paths for 32-bit distro:

<table>
<thead>
<tr>
<th>Files</th>
<th>When booting from a CD</th>
<th>When booting from PXE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preboot Loader</td>
<td><em>isolinux</em></td>
<td><em>pxelinux</em></td>
</tr>
<tr>
<td>Linux Kernel Name</td>
<td>\boot\i386\loader\linux</td>
<td>&quot;$TFTP_HOME\boot\initrd&quot;</td>
</tr>
<tr>
<td>Initrd Filename</td>
<td>\boot\i386\loader\initrd</td>
<td>&quot;$tftp_home$\boot\linux\boot\initrd&quot;</td>
</tr>
</tbody>
</table>

Following are the filenames and paths for 64-bit distro:

<table>
<thead>
<tr>
<th>Files</th>
<th>When booting from a CD</th>
<th>When booting from PXE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preboot Loader</td>
<td><em>isolinux</em></td>
<td><em>pxelinux</em></td>
</tr>
<tr>
<td>Linux Kernel Name</td>
<td>\boot\x86_64\loader\linux</td>
<td>&quot;$TFTP_HOME\efi\x86_64\linux&quot;</td>
</tr>
<tr>
<td>Initrd Filename</td>
<td>\boot\x86_64\loader\initrd</td>
<td>&quot;$TFTP_HOME\efi\x86_64\initrd&quot;</td>
</tr>
</tbody>
</table>

Following are the filenames and paths for 64-bit UEFI distro:

<table>
<thead>
<tr>
<th>Files</th>
<th>When booting from a CD</th>
<th>When booting from PXE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preboot Loader</td>
<td><em>isolinux</em></td>
<td><em>pxelinux</em></td>
</tr>
<tr>
<td>Linux Kernel Name</td>
<td>\images\linux</td>
<td>&quot;$TFTP_HOME\efi\x86_64\linux&quot;</td>
</tr>
<tr>
<td>Initrd Filename</td>
<td>\images\initrd</td>
<td>&quot;$TFTP_HOME\efi\x86_64\initrd&quot;</td>
</tr>
</tbody>
</table>

2. The Linux kernel starts running, does some device driver setup, then mounts the *initrd* file system.

Regardless of which boot loader method is used, the main purpose is to set up the *initrd* file as a RAM drive, load the Linux kernel into memory, then turn control over to it with an indication to the Linux kernel of where to find *initrd*.

3. The Linux kernel turns control over to *linuxrc*, for performing initial hardware detection. When finished, control is returned to the Linux kernel.
4. The Linux kernel starts a background process (/sbin/init).

After control is passed to the linuxrc program, control is never returned to the Linux kernel or passed on to the init process.

For more information on linuxrc and zenworks.s, review the following sections:

- Section F.2.1, “linuxrc,” on page 301
- Section F.2.2, “zenworks,” on page 301

### F.2.1 linuxrc

When control is turned over to linuxrc (the filename in the initrd file is init), there are several processes it performs to get the system ready for the imaging process. Linuxrc is initially configured from the linuxrc.config file, which is located in the initrd file system. Additional configuration information for linuxrc can be placed in the /info file, but ZENworks does not normally use this file.

Linuxrc also loads a root file system, which is combined with the initrd file system that is set up by the boot loader. The root file system is located on an imaging CD as the file /boot/i386/root or /boot/x86_64/loader/root. For PXE booting, the root file system is stored on the ZENworks Imaging server as:

- **Windows**:
  - 32-bit: %ZENWORKS_HOME%\share\tftp\boot\root
  - 64-bit: %ZENWORKS_HOME%\share\tftp\efi\x86_64\root

- **Linux**:
  - 32-bit: srv/tftp/boot/root
  - 64-bit: srv/tftp/efi/x86_64/root

Linuxrc attempts to locate and load the settings.txt file, either on the root of the imaging CD, or on the ZENworks Imaging server in the TFTP directory. From settings.txt, linuxrc reads and processes any parameters that pertain to itself, then copies settings.txt to the root (/) of the file system.

Linuxrc then also attempts to locate and load a file named driverupdate. It is usually located in the same directory as root. This file is used to update drivers and other files in the imaging distribution.

The driverupdate file is based on standard SUSE technology during a PXE boot. Because the network must be operating normally in order to obtain driverupdate, this file cannot update drivers for the active network device. However, other files and drivers can be updated by using the driverupdate file. For more information, see Section F.4.3, “Using the Driverupdate File Method,” on page 306.

### F.2.2 zenworks

A normal SUSE installation for SUSE Linux or SLES boots to a small distribution to perform a YaST installation. ZENworks Imaging boots with the same installation system, but instead of starting a YaST installation, it starts the ZENworks Imaging process. Control is turned over to the ZENworks script /bin/zenworks.s, which is the main script file for ZENworks imaging processing. The script
performs a certain number of setup tasks, then gives control to the appropriate script for the selected imaging process. For more information on the imaging process, see Section 1.5, “The Preboot Services Processes,” on page 27.

One of the setup tasks is to apply any update files. When booting from a CD, zenworks.s copies the /addfiles directory structure to the Linux file system. For more information, see Section F.4.1, “Adding Files to an Imaging Boot CD,” on page 304.

F.3 Understanding ZENworks Partitions and Command Line Parameters

The following sections provide an understanding of the ZENworks partition and imaging commands that are used when updating Linux drivers:

- Section F.3.1, “The ZENworks Partition,” on page 302
- Section F.3.2, “Command Line Parameters and Variables,” on page 302

F.3.1 The ZENworks Partition

The ZENworks partition is used to store the files required to load Linux into RAM, making the result similar to using a CD or PXE boot method. The ZENworks partition has a similar boot media layout as an imaging CD. It has a minimum size of 150 MB.

The files stored on the ZENworks partition are linux, initrd, and root, which are the same as the directories as on the imaging CD (see the tables in Section F.2, “Understanding Device Boot Processes in a ZENworks Imaging Environment,” on page 299). In ZENworks, the boot loader is grub for BIOS and elilo for UEFI, which loads Linux as described under Section F.2, “Understanding Device Boot Processes in a ZENworks Imaging Environment,” on page 299. The driverupdate and settings.txt files are searched for and loaded from the ZENworks partition.

If you need to modify the Linux files, you must modify the initrd or root file sets the same way as you would for other boot methods. For information, see Section F.4.2, “Adding Files to the Initrd or Root File Systems,” on page 304.

F.3.2 Command Line Parameters and Variables

There are four types of command line parameters that can be used with the ZENworks imaging process. They are entered on the command line when booting from a CD or they can be placed in the isolinux.cfg file located in the /boot/i386/loader or /boot/x86_64/loader directory. The commands are also located in the *.cfg files for PXE and are located in the %ZENWORKS_HOME%\share\tftp directory on the Windows Imaging Server and the /srv/tftp directory on the Linux Imaging Server.

- **Kernel Parameters:** The valid parameters for the Linux kernel are found in the /Documentation/kernel-parameters.txt file that is installed with the kernel source.

  Some devices have a faulty BIOS, where you must turn off ACPI processing for the kernel to load properly. To do this, use the kernel parameter acpi=off. For more information, see Novell Support (http://www.novell.com/support/).

- **Linuxrc Parameters:** These parameters affect the way linuxrc detects hardware or sets hardware settings. They are described briefly in the /usr/share/doc/packages/linuxrc/linuxrc.html file in a Linux system.
Linuxrc parameters can be found in the /linuxrc.config or /info files that reside in the initrd file system. Some parameters can be placed in the settings.txt file that is located on the root of the imaging CD or ZENworks partition, or in the /srv/tftp/boot file for PXE booting.

Parameters that can be placed in the settings.txt file (the easiest file to edit) are limited. During PXE booting, parameters that affect the network are not processed from settings.txt, because by the time linuxrc loads the settings.txt file, the network is already set up. Network settings can be placed in the settings.txt file when booting from an imaging CD, because it is loaded early enough in the process to take effect.

- **ZENworks Variables:** Some environment variables affect the way imaging performs. They can be configured in any file, but should normally be configured in the settings.txt file.

  If you add variables to the settings.txt file that were not originally defined there, you must export the variable. For example, in the settings.txt file, enter:

  ```
  export IMGCMD="myscript"
  ```

  A list of all image engine or script variables is listed under Section F.6, "Variables and Parameters," on page 310.

- **Other Variables:** Environment variables that you might want in your script can be added in the same manner as described for the ZENworks variables.

## F.4 Modifying ZENworks Imaging Resource Files

From time to time you might want to modify an imaging distribution by adding your own files. These can be additional programs, scripts, data files, or updated Linux drivers.

You can use the following methods to update imaging resource files:

- The easiest method is to edit the settings.txt file, which is located on the root of the imaging CD or in /srv/tftp/boot for BIOS or /srv/tftp/efi for UEFI on the ZENworks Imaging Server for PXE booting.

- Where you are using a ZENworks partition, you can boot to the manual or maintenance mode, mount the ZENworks partition, then copy the modified settings.txt and the files in initrd or root to the mounted ZENworks partition.

- Another easy method is to edit the .cfg files located in /srv/tftp on the ZENworks Imaging Server for PXE booting. This method is only available for Linux Imaging Servers, because the configuration files are provided by Novell’s version of PXE.

- You can modify files in the initrd or root file systems, but you need a Linux environment for performing the modification process. Files required during the initial setup (during linuxrc processing time), such as LAN drivers, must be placed in the initrd file system. Other files that are not needed until the zenworks.s script file takes control can be placed in the root file system (for example, imaging script), or you can use the driverupdate file.

  This method is discussed in this section.

The following sections provide various methods for modifying imaging resource files:

- Section F.4.1, "Adding Files to an Imaging Boot CD," on page 304
- Section F.4.2, "Adding Files to the Initrd or Root File Systems," on page 304
- Section F.4.3, "Using the Driverupdate File Method," on page 306
F.4.1 Adding Files to an Imaging Boot CD

If you have files to add to an imaging boot CD so they can be available for use when you get to the actual imaging process (such as scripts, but normally not driver modules), you can copy the files to the /addfiles directory on the imaging CD. This is an easy way to insert your script or other files into the distribution without modifying the initrd or root file systems. However, these files are not available during the boot and module loading phases.

The imaging boot CD has a directory named /addfiles where you can add files. They should be placed below this directory in their proper directory names. They are then available in this directory structure during the imaging process.

An example of how you can add files:

1. If you want to execute your own script instead of the normal imaging process, create a script file named myscript.s and place it on the boot CD. For example, /addfiles/bin/myscript.s.

   **IMPORTANT:** The script file must have proper LF line terminators that Linux requires, not the DOS CR and LF end-of-line characters. In other words, you cannot use Notepad.exe to create the script; you must use a text editor compatible with Linux, such as TextPad.

2. To place the following line in the settings.txt file, enter:

   ```
   export IMGCMD="/bin/myscript.s"
   ```

   When imaging is run, it runs /bin/myscript.s instead of using the normal `img -auto` command.

F.4.2 Adding Files to the Initrd or Root File Systems

This is the preferred method for updating imaging resource files, and must be performed in a Linux environment.

Before performing the procedures given below, make sure you have created backup copies of any files you plan to change, specifically the /srv/tftp/boot/initrd file. If you want to change the files on an imaging CD, you need an ISO editor or some other process for extracting and replacing the file in the `bootcd.iso` image file.

**IMPORTANT:** When updating or adding files and Linux drivers in the initrd or root file systems, document the changes you make. When you receive updated resource files from ZENworks, they do not contain your customized changes. If the kernel version has changed with the newer resource files from ZENworks, previously added drivers must be updated either by obtaining a new version from the manufacturer or recompiling the driver using the correct Linux kernel version source.

- “Adding to Initrd” on page 305
- “Adding to Root” on page 306

To add files to the root file system, you can also use the `driverupdate` file method described in Section F.4.3, “Using the Driverupdate File Method,” on page 306.
Adding to initrd

To modify the initrd file system:

1. Using a Linux device, create a working directory and change to that directory.
2. To copy initrd from the PXE server or the boot CD to the new working directory:
   - For PXE, copy /tftpboot/initrd to the Linux workstation’s working directory.
   - For the CD, extract initrd from the /boot/i386/loader directory on the boot CD, then copy the extracted initrd to the Linux workstation’s working directory.
3. To rename initrd to initrd.gz, enter:
   ```
   mv initrd initrd.gz
   ```
4. To unzip the initrd.gz file, enter:
   ```
   gzip initrd.gz
   ```
5. To create another working directory for use as a mount point in the subsequent steps, enter:
   ```
   mkdir work
   cd work
   ```
6. To extract initrd into the /work directory, enter:
   ```
   cpio -Idmuv <../initrd >/dev/null 2>&1
   ```
7. To copy your files or updated driver to the extracted initrd file system, enter:
   ```
   cp /your_path/module.ko lib/modules/<kernal_version>-override-default/initrd
   ```
   where your_path is the path to the module.ko file and module is the name of the module. Other files to be included in the initrd file system should be copied to the appropriate directory.
8. To re-package the initrd file system, enter:
   ```
   find . | cpio --quiet -o -H newc > ../initrd
   cd ..
   ```
9. To zip the new initrd file, enter:
   ```
   gzip -v9c initrd > initrd.gz
   ```
10. To rename initrd.gz back to initrd, enter:
    ```
    mv initrd.gz initrd
    ```
11. To copy the file back:
    - For PXE, copy the updated initrd file to the /tftpboot directory on the PXE server.
    - For the CD, copy the updated initrd file to the /boot/i386/loader directory on the boot CD.
Adding to Root

To modify the root file system:

1. Using a Linux device, create a working directory and change to that directory.
2. To copy root from the PXE server or the boot CD to the new working directory:
   - For PXE, copy `/tftp/boot/root` to the Linux workstation's working directory.
   - For the CD, extract `root` from the `/boot/i386/` directory on the boot CD, then copy the extracted `root` to the Linux workstation's working directory.
3. To rename `root` to `root.gz`, enter:
   ```
   mv root root.gz
   ```
4. To unzip the `root.gz` file, enter:
   ```
   gunzip root.gz
   ```
5. To create another working directory for use as a mount point in the subsequent steps, enter:
   ```
   mkdir work
   ```
6. To mount the root file system to the `/work` directory, enter:
   ```
   mount -o loop root work
   ```
7. Make the desired changes to the `/work` directory.
8. To unmount the root file system, enter:
   ```
   umount work
   ```
9. To zip the new root file, enter:
   ```
   gzip -v9c root > root.gz
   ```
10. To rename `root.gz` back to `root`, enter:
    ```
    mv root.gz root
    ```
11. To copy the file back:
    - For PXE, copy the updated `root` file to the `/tftp/boot` directory on the PXE server.
    - For the CD, copy the updated `root` file to the `/boot/i386/` directory on the boot CD.

F.4.3 Using the Driverupdate File Method

Another way to customize the Novell imaging distribution is to utilize the driver update mechanism that is built into all SUSE distributions. This entails modifying a file named `driverupdate` that is located in the `/srv/tftp/boot` directory on your Imaging Server or on the root (`/`) of an imaging boot CD.

This method is a little less intrusive than modifying the `initrd` or `root` file systems. You simply create an additional file that is incorporated into the imaging operating system during boot time.

There are three types of driver update operations that can be performed:

- Install the kernel modules or hardware drivers
- Install files and execute a script
- Simply place files into the operating system
This section describes how to install files and execute a script. For information on the other two methods, see “Tech Talk #3 - Spittin’ Image” in the Novell Connection Magazine. Specifically, see the “SUSE Linux Driver Updates” and “Adding files to the distro "root" file” sections in the article.

The example in this section takes the program “tree” that is not currently available in the imaging distribution and installs it at boot time.

The driver update mechanism seeks the driverupdate file, which contains a directory structure that mimics the directory structure in the operating system after a device has booted with the ZENworks distribution. If it is present, linuxrc downloads it during booting and incorporates it into the operating system dynamically.

The driverupdate file is a file system file that can be of any file system type, such as EXT3 or REISER. For simplicity, we’ll use the CRAMFS file system in our example.

To place the tree program into the driverupdate file:

1. Create a working directory on your Imaging Server, such as /work.

2. If you are using the driverupdate file, download the driverupdate.tgz file into the /work directory, then untar it by entering:

   ```
   mkdir work
   cd work
   tar -xzvf driverupdate.tgz
   ```

   The driverupdate.tgz file contains the same directory structure as is created in Step 3.

3. If you are creating the directories, create the following structure under the /work directory:

   ```
   |-- linux
   |   |-- suse
   |       |-- i386-sles10
   |       |   |-- dud.config
   |       |   |-- inst-sys
   |       |       |-- lib
   |       |       |   |-- adddir.s
   |       |   |   |-- bin
   ```

   The contents of the dud.config file should contain lines similar to those listed below. You should maintain the keywords by supplying your own data. However, you can use the listed values:

   ```
   UpdateName:   ZENworks 11 Patch 1
   UpdateID:     a37f925564e99e
   UpdatePriority: 100
   ```

   The adddir.s file should be an executable script that contains the following lines:

   ```
   echo "Processing: adddir.s" > /dev/tty3 2>&1
   # driver update: add files to inst-sys
   for i in /update/[0-9]*/inst-sys ; do
       [ -d "$i" ] && adddir "$i" /
   done
   # driver update: run update.pre scripts
   for i in /update/[0?9]*/install/update.pre ; do
       echo "Processing: $i" > /dev/tty3 2>&1
       [ -x "$i" ] && "$i"
   done
   ```

4. To copy the tree program into the /bin directory, enter:
cp /usr/bin/tree dirstruct/linux/suse/i386-9.2/inst-sys/bin/

5 To create the CRAMFS file, enter:

   mkfs.cramfs work/ driverupdate

   The CRAMFS file is required by the SUSE distribution.

6 To copy the driverupdate file into /srv/tftp/boot, enter:

   cp driverupdate /srv/tftp/boot

7 Add the following lines to the end of the /srv/tftp/boot/settings.txt file:

   # SUSE driver update
   for i in /update/[0?9]*/install/adddir.s ; do
      if [ -x "$i" ] && "$i"
         rm $i
   done

   This causes the adddir.s script to run, which creates soft links to all of the new files being
   copied.

   These lines might already be present in the settings.txt file.

8 Reboot the PXE-enabled device.

9 Execute the tree program.

All of the files you place into the driverupdate file are now located under the /update directory in
the operating system after booting. Then, the adddir.s script (or the code that you added to the
settings.txt file in Step 7) creates soft links under the root file system that point to the
 corresponding files under the /update directory structure. You can verify this by running:

   /# which tree
   /bin/tree
   /# ll /bin/tree
   lrwxrwxrwx  1 root root 29 Aug 31 21:45 /bin/tree -> /update/000/inst-sys/bin/tree

   If you want to simply include a new hardware driver or kernel module in the imaging operating
   system, an easier process might be to copy the .ko file into the /dirstruct/linux/suse/i386-
   9.2/modules/ directory. Then, the imaging operating system automatically loads any .ko files that
   are in this directory.

F.5 Adding or Updating LAN Drivers

As LAN card manufacturers develop and release new LAN adapters, they usually release new or
updated drivers as well. Sometimes the new LAN card functions properly with an earlier driver, and
sometimes the earlier driver does not recognize the new LAN card and refuses to load. Occasionally,
the older driver does load, but the LAN card exhibits serious performance problems. To obtain the full
performance capabilities of a new LAN card, you should use the new driver.

The following sections explain how to obtain or compile drivers:

- Section F.5.1, “Obtaining Drivers,” on page 309
- Section F.5.2, “Building Drivers,” on page 309

If you need to load your drivers with specific parameters, see Section F.5.3, “Loading Drivers with
Parameters,” on page 310.
F.5.1 Obtaining Drivers

New LAN drivers should be obtained from the manufacturer. Most LAN card are free to download from the manufacturers web site. Download the appropriate LAN drivers based on the machine’s NIC (Network Interface Card) specifications.

If a manufacturer has a binary driver compiled specifically for the kernel version used by ZENworks, you can obtain the driver and use one of the update methods to add the driver. For more information, see Section F.5.2, “Building Drivers,” on page 309.

F.5.2 Building Drivers

Nearly all Linux drivers are distributed in source code form and need to be compiled before they can be used. Follow the manufacturer’s instructions included with the new driver to build the driver module. Many drivers can be built in such a way that they are built into the kernel itself; however, we recommend that LAN drivers be built as external kernel modules.

When building your LAN drivers, make sure that your build machine uses the same kernel as the imaging environment. If you have a LAN driver that doesn’t load in your imaging environment, it usually means that you have a mismatch between your build environment and the imaging environment.

You can find the current kernel version of your Linux environment by using the following command:

```
uname -r
```

To build your drivers:

- “Obtaining the Linux Source Code Tree” on page 309
- “Compiling the Module” on page 310

Obtaining the Linux Source Code Tree

To compile a module, you need the Linux source code tree that contains the configuration matching the ZENworks kernel.

To use the Linux source code tree:

1. Obtain the current kernel version of the Imaging distro:
   1a. Boot any device in the Management Zone into the ZENworks Imaging Maintenance mode.
   1b. Run the `uname -r` command.
      
      This displays the kernel version of the Imaging distro.

2. From the Novell Downloads Web site (http://download.novell.com/patch/finder/), download the kernel source RPM for the kernel version obtained in Step 1b.

   The kernel source RPM filename is in the following format:
   `kernel-source-kernel_version.i586.rpm`

   For example, `kernel-source-2.6.27.29-0.1.i586.rpm` is the source code for the kernel version 2.6.27.29-0.1-default.

3. Install the downloaded kernel source RPM.

   The RPM is installed to the `/usr/src` directory, and the following subdirectories are created:

   - `/usr/src/linux-Kernel_source_version`
   - `/usr/src/linux-Kernel_source_version-obj`
For example, the following directories are created when you install `kernel-source-2.6.27.29-0.1.i586.rpm`:

- `/usr/src/linux-2.6.27.29-0.1`
- `/usr/src/linux-2.6.27.29-0.1-obj`

To create a link to the source tree:

4a To change to the `/usr/src` directory, enter:

```
   cd /usr/src
```

4b If there is a Linux soft link in the directory, delete it.

4c Create the new Linux soft link, such as:

```
   ln -s linux-2.6.27.29-0.1 linux
```

After you have the Linux kernel source tree and soft link ready for compiling the module, continue with “Compiling the Module” on page 310.

**Compiling the Module**

To compile the module:

1. Install the source.
   Follow the manufacturer’s instructions to install the source.
   Normally, the module source is in a directory under `/usr/src`. Module source files usually come in the form of a gzipped tar file (`.tar.gz` or `.tgz`). The file might also be a bzipped file (`.bz2`).

2. Change directories to the source and compile the source according to the compilation instructions provided in the module’s Readme.

3. When you have your module compiled for ZENworks, take the generated `.ko` module file (make sure you select the proper module name and not a work `.ko` file) and install it by using the driver update method or placing it in the initrd file system.

**F.5.3 Loading Drivers with Parameters**

If there is a module that you want to load during the linuxrc processing time, and if linuxrc does not recognize that it needs to be loaded or you want to specify the load parameters, you can enter a line in the `linuxrc.config` or `/info` file. This file then needs to be updated in the initrd file system.

You might need to load a LAN driver module with specific parameters. You can do this with a line like:

```
   insmod="moduleName parm=xxx"
```

This type of line is most commonly used to load a LAN driver with specific parameters, such as full duplex or specific speed.

**F.6 Variables and Parameters**

The following sections describe the variables and parameters used in updating resource files:

- Section F.6.1, “Imaging Script Variables,” on page 311
- Section F.6.3, “Image Engine Variables,” on page 312
F.6.1 Imaging Script Variables

The following environment variables are used in the imaging scripts and must not be modified:

Table F-1 Imaging Script Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTIVEPARTITION</td>
<td>Device of the active OS partition.</td>
</tr>
<tr>
<td>CDBOOT</td>
<td>YES = Booted from a CD.</td>
</tr>
<tr>
<td>DISABLEZEN</td>
<td>1 = Disable the ZENworks partition.</td>
</tr>
<tr>
<td>ENABLEZEN</td>
<td>1 = Re-enable the ZENworks partition.</td>
</tr>
<tr>
<td>ZENDEVICE</td>
<td>Device name of the ZENworks partition.</td>
</tr>
<tr>
<td>ZENPARTBOOT</td>
<td>YES = Booted from ZENworks partition.</td>
</tr>
</tbody>
</table>

The following environment variables can be modified or set in the settings.txt file:

Table F-2 Environment Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDPARM</td>
<td>NO = Do not set hdparm parameters.</td>
</tr>
<tr>
<td>IMGCMD</td>
<td>Imaging command to run instead of the img -a command.</td>
</tr>
<tr>
<td>MANUALREBOOT</td>
<td>YES = Do not automatically reboot.</td>
</tr>
<tr>
<td>PARTITIONSIZE</td>
<td>Size in MB to create the ZENworks partition.</td>
</tr>
<tr>
<td>PROXYADDR</td>
<td>IP/DNS address of the Imaging server.</td>
</tr>
<tr>
<td>PROMPT</td>
<td>Go to the imaging maintenance mode prompt after imaging is complete.</td>
</tr>
</tbody>
</table>

F.6.2 Linuxrc Parameters Specified in Settings.txt

Table F-3 Linuxrc Parameters

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
</table>
| netsetup | dhcp = Use DHCP.  
           | 1 = Static IP. |
| HostIP   | Static IP address to use.                           |
| NetMask  | Network mask.                                       |
| Gateway  | Network gateway.                                    |
| HostName | Hostname to assign.                                 |
| Nameserver | DNS name server.                           |
| Domain   | Domain suffix.                                      |
F.7.1 Troubleshooting During the Boot Process

While booting ZENworks imaging, there are several things that you can do to help troubleshoot if there is a problem:

- Press Esc to see the kernel messages. Usually, messages are shown for failures.
- Screen 3 (press Alt+F3) is used to show the progress of the linuxrc process. It lists progress results, what linuxrc is doing, which modules are loaded, and so on.
- Screen 4 (press Alt+F4) is used to show output from the modules during the linuxrc process.
- Screens 1 (press Alt+F1), 3, and 4 can be used to help determine which part of the process is failing or causing a problem.
- Screens 3 and 4 indicate which drivers are loaded.
- If a drive is loaded properly but fails in some way, view screen 4 to see if there is an outdated driver.

If the boot process fails, the first command line parameter to use is acpi=off.

F.7.2 Troubleshooting at the Imaging Maintenance Mode Prompt

When the prompt is displayed, there are a few tools that you can use to gather information about the hardware:

- `hwinfo`: This utility is used by linuxrc to load hardware. You can use `hwinfo -pci` to determine exactly what hardware was recognized.

  Pipe to “less,” because `hwinfo` can create a lot of output. For example, `hwinfo -pci | less.`
If you need to contact Novell Support for help, you should capture the output from `hwinfo -pci` to a file for their use. You can gather the most information with this command:

```
hwinfo -pci -log /logfile
```

where `logfile` is the name of the file that you should send.

You can then mount a device, such as a thumb drive or other USB device, and save the output file for later use. You might also be able to use FTP to save the file where it can be available.

- `ethtool`: This is a valuable tool (contained in a ZENworks distribution) that can be used to change the configuration on most Ethernet network devices. See the online help for information on using the `ethtool` utility.
Dell DTK

This section contains the following information:

- Section G.1, "Upgrading the Dell DTK," on page 315
- Section G.2, "Troubleshooting Dell Configuration Bundle," on page 316

G.1 Upgrading the Dell DTK

Novell ZENworks ships with the latest available version of the Dell OpenManage Deployment Toolkit (DTK). The DTK is integrated with ZENworks. However, when new versions of the DTK become available, you can upgrade to a newer version.

To obtain the current Dell DTK build from Dell:

1. Make sure the novell-proxydhcp daemon is running on a server in your network.
   This service must be available so that the device's PXE can access files from the ZENworks server, such as the Preboot Services Menu file and the Dell DTK (Maintenance Mode) files.
2. Boot a Dell device that is PXE-enabled and press the Ctrl-Alt keys during booting.
   This boots the device into the Preboot Services Menu. These keys must be pressed by the time a string starting with "Novell .." is displayed during the boot process.
3. Select the Dell DTK (Maintenance Mode) option.
4. When the bash (#) prompt is displayed, view the content of the /BUILD file.
   This shows the version of the Dell DTK currently used by ZENworks.
5. Make a note of the build version of your current DTK.
   This is normally available as an ISO file.
7. Create a CD using the downloaded ISO file.
8. Insert the newly created CD into the drive of any Linux workstation or server.
9. To update the Linux resource files:
   9a. Using a file manager or a terminal on the server or workstation, copy the SA.1 and SA.2 files from the /isolinux directory on the CD to the /srv/tftp/dell-dtk directory on your ZENworks server.
      This replaces files of the same name.
      You might need drives mapped to your servers from the device where you inserted the CD. Otherwise, you need to place the CD into the drive of each device in order to copy the files locally to replace them.
   9b. Repeat Step 9a for each ZENworks server to replace these files on them.
10. If necessary, to modify the configuration files:
    10a. Mount the Dell DTK CD's ISO file, then open /isolinux/isolinux.cfg using any editor, text-viewing command, or utility.
    10b. Look for the ramdisk_size parameter and note its assigned value.
This parameter occurs many times in the file, but each instance is generally set to the same value. If different values are assigned in different instances of the parameter, use the value displayed in the default configuration section. For example, the file might contain default 1 on a line, indicating the default section’s name is “1,” which is displayed immediately after “label” on a line, such as label 1 under which the ramdisk_size parameter is listed.

10c On the ZENworks server, open the /srv/tftp/dell-dtk.cfg and /srv/tftp/dell-dtk_maint.cfg files and modify all ramdisk_size parameter values to be the same as what you obtained in step Step 10b.

11 To ensure that the Dell DTK has been properly updated on the ZENworks server, reboot the device into PXE and select the Dell DTK (Maintenance Mode) option.

12 To verify that the build number has increased from the number you noted in Step 5, when the bash (#) prompt is displayed, view the content of the /BUILD file:

If the build number has not incremented, either it really is not an update, or the copy operations failed.

G.2 Troubleshooting Dell Configuration Bundle

The following procedure provides a scenario for troubleshooting a Dell Configuration Preboot bundle:

1 Create or modify a Dell Configuration bundle.
For steps to do this, see Section 3.7.1, “Creating Dell Configuration Scripts and Files,” on page 140.

2 Do one of the following:
   • Assign the bundle to a managed device (see Section 3.7.1, “Creating Dell Configuration Scripts and Files,” on page 140).
   • Create a Preboot Work Assignment rule for an unmanaged device (see Section 3.7.1, “Creating Dell Configuration Scripts and Files,” on page 140).

3 In the TFTP directory, locate the .../dell-dtk/dell-dtk.s file and open it in an editor.

4 Modify this file by adding a # character at the beginning of each of the last two lines to comment them out:
   ./novell-dtask
   reboot

5 Save the edited file.

6 Allow the device to boot through PXE.
The device should be assigned work and boot into the DTK environment, but the assigned work will not be executed, because the ./dtask and reboot lines in the dell-dtk.s file were disabled.

7 After the device has booted to the Dell DTK in maintenance mode, press Alt-F2 to obtain a usable console.

8 Check the following items to determine if the Dell Configuration bundle worked correctly:
   • A directory named /tmp/dell-dtk should have been created.
     A script named dell-dtk-maint.s that is downloaded from /srv/tftp/dell-dtk creates the /tmp/dell-dtk directory.
   • A utility named novell-dtktask should have been placed in the /tmp/dell-dtk directory.
To determine whether various environment variables have been set appropriately, enter the following commands to see if the TFTPIP and PROXYADDR variables display the IP address of your ZENworks Imaging server:

```bash
  echo $TFTPIP
  echo $PROXYADDR
```

9. If all of these items show no problems, change to the `/tmp/dell-dtk` directory.

10. Run the novell-dtktask utility:

    ```bash
    ./novell-dtktask -v
    ```

    The verbose option (`-v`) is optional. It causes the information being sent to the `novell-dtktask.log` file to be displayed on screen.

11. To further determine any problems, examine the following log file:

    ```bash
    /var/log/novell-dtktask.log
    ```

    If the log file doesn’t resolve the problem, determine what action to take from the information in the log file.

    To troubleshoot, you could download the files, run the utilities, and look for error messages on screen.

12. After each trial run, reboot the device or reassign the Preboot work so that your troubleshooting starts at a known state, then repeat these steps to troubleshoot a different Dell Configuration bundle.
Supported Ethernet Cards

ZENworks provides the Ethernet card drivers contained in the Linux kernel that ships with ZENworks.

To determine which Linux kernel you are using, enter `uname -r` at the bash prompt.

If your device or laptop computer uses a different card that is not supported, you must supply your own Ethernet driver. For detailed information about the supported drivers for SLES, see the SLES Release Notes.
Accessing IP Addresses for Devices Running Dual NICs

To automatically obtain an IP address for a device running dual NICs, you can modify the following files (one or both):

- **Windows:**
  
  %ZENWORKS_HOME%\share\tftp\z_auto.cfg
  or
  %ZENWORKS_HOME%\share\tftp\z_maint.cfg

- **Linux:**
  
  /srv/tftp/z_auto.cfg
  or
  /srv/tftp/z_maint.cfg

In these files, add the following line at the end of the `append` command:

```
netdevice=eth0
```

This eliminates the need to select a NIC’s IP address.
J Troubleshooting Preboot Services and Imaging

The following sections provide solutions to the problems you might encounter while working with Preboot Services and Imaging in ZENworks:

- Section J.1, “Preboot Services and Imaging Error Messages,” on page 323
- Section J.2, “Troubleshooting Preboot Services and Imaging Services,” on page 325

J.1 Preboot Services and Imaging Error Messages

This section contains detailed explanations of the error messages you might encounter when using Preboot Services and Imaging in ZENworks.

- “The Imaging agent is currently not installed to run during the boot process of this computer” on page 323
- “No boot file found in the partition” on page 323
- “Windows Automatic Installation Kit is not found on this system” on page 324
- “Ghost reported back an error” on page 324
- “Unable to connect to Preboot Server. The Product license might have expired” on page 324

The Imaging agent is currently not installed to run during the boot process of this computer

Source: ZENworks; Preboot Services and Imaging.

Explanation: On Windows 7 or later, the zisdservice runs during the device boot instead of ziswin. Consequently, the following message is displayed in the ziswin window:

The Imaging agent is currently not installed to run during boot process of this computer.

However, you can still successfully take and restore images through ZENworks Control Center.

Action: Ignore the message.

No boot file found in the partition

Source: ZENworks; Preboot Services and Imaging.

Explanation: The error message is displayed while restoring a WIM image that was taken by using ImageX without specifying any /BOOT option.

Possible Cause: The WIM bundle does not contain the boot partition information.

Action: In the error message dialog box, click Yes to restore the image.
Windows Automatic Installation Kit is not found on this system

Source: ZENworks; Preboot Services and Imaging
Explanation: This error message is displayed when you click the for uploading WinPE Base Distribution in ZENworks Control Center (Configuration tab > Management Zone Settings > Device Management > Preboot Services > Third Party Imaging Settings).
Possible Cause: Microsoft Windows Automated Installation Kit 1.0/1.1/3.0 (WAIK) is not installed on the device running the ZENworks Control Center.
Action: Install WAIK 1.0/1.1/3.0 on the device running the ZENworks Control Center.
You can download WAIK from the Microsoft Download Center Web site (http://www.microsoft.com/downloads/).
Possible Cause: The error message is incorrectly displayed if ZENworks Control Center is launched on a 64-bit device that has WAIK 1.0/1.1/3.0 installed.
Action: Do the following:
1. Append the \WAIK_installation_path\Windows AIK\Tools\x86 to the Path Windows system environment variable.
2. Restart the Web browser to launch ZENworks Control Center.

Ghost reported back an error

Source: ZENworks; Preboot Services and Imaging; ZENworks Third-Party Imaging.
Explanation: An error message is displayed if Ghost imaging fails when it is performed through the ZENworks Third-Party Imaging utility.
Action: For detail information about the issue, refer to \windows\system32\ghosterr.txt and take the appropriate action.

Unable to connect to Preboot Server. The Product license might have expired

Source: ZENworks; Preboot Services and Imaging.
Explanation: The error message is displayed while using PXE boot to perform imaging operations.
Possible Cause: The bootp parameters, which are not compatible with ZENworks imaging, are used to provide the boot filename and the TFTP server’s IP address.
Action: While using PXE boot to perform imaging operations, use the novell-proxydhcp service.
J.2 Troubleshooting Preboot Services and Imaging Services

This section provides solutions to problems you might encounter when using Preboot Services and Imaging in ZENworks.

- "Applying the MDT Deployment bundle to re-install the operating system on a device that already has an operating system results in an infinite loop" on page 326
- "An error message is displayed when Windows Managed devices, or Windows Servers reboot after you restore an image with size greater than 2 TB" on page 327
- "The ZENworks Server continues to write to the image file even if the Imaging operation to take an image of the device fails" on page 328
- "The Imaging tools downloaded from the ZENworks Download page are not installed to the specified drive" on page 328
- "Unable to browse for the image files on the Satellite while taking an image or applying a Preboot bundle to a managed device" on page 328
- "The ZENworks Images stored in the images directory on the Primary Server are not replicated on the Secondary Server or Satellite" on page 329
- "How do I generate a developer log for ZENworks Imaging?" on page 329
- "How do I exclude a particular partition from ZENworks Imaging?" on page 329
- "How do I prevent ZENworks Third-Party Imaging from restarting in the Auto mode?" on page 330
- "Image Explorer help opens only in Firefox on Linux devices" on page 330
- "The ZENworks icon properties page of a managed device that is in private network displays that the server IP address is not available" on page 330
- "The third-party Imaging distro and tools are not immediately replicated on the Satellite" on page 330
- "Unable to take an image of the managed device" on page 330
- "The device might not pick up the assigned imaging task when booted to the Imaging Automatic mode" on page 331
- "How to enable debug logs?" on page 331
- "The Novell Proxy DHCP service is automatically stopped on the Imaging Satellite" on page 332
- "A new workstation ID is created after restoring image on a non-registered device" on page 332
- "novell-pbserv crashes during multicast imaging to 120 or more devices" on page 333
- "You might encounter an error message prompting you to restart Windows installation when the device boots up after the restoration of the ZENworks or WIM image on a Windows 7 or later" on page 333
- "If you restore an image of Windows on a bare machine that has a ZENworks partition, the machine fails to boot the second time after the image restoration" on page 333
- "Mounting an NFS partition from the Imaging kernel fails on a device that is booted in the ZENworks Imaging Maintenance mode" on page 334
- "The SLES or SLED device with SATA drive fails to boot after the restoration of an image" on page 334
- "Unable to take an image of a device if the Imaging Satellite is outside the L4 switch and the Primary Server is behind the L4 switch" on page 334
Applying the MDT Deployment bundle to re-install the operating system on a device that already has an operating system results in an infinite loop

Explanation: When you apply the MDT Deployment bundle to re-install the operating system on a device that already has an operating system, it results in an infinite loop. On PXE boot, the device picks up the same MDT bundle every time. This issue occurs because the Microsoft Deployment Toolkit (MDT) wipes out the ZENworks Image Safe Data (ZISD) when preparing the disk to re-install the operating system on the device. Hence, the Imaging Server does not know the status of the imaging work assigned to the device and it is never cleared.

Action: Workaround: Perform either of the following methods:
Method 1

1. Customize the corresponding MDT Deployment Share which the MDT WIM uploaded in the bundle contacts on booting. Use the ISDTool.exe to clear the MBR:

   1a. Download the 32-bit ISDTool.exe from the ZENworks Download page (https://zenworks_server_IP_address:port/zenworks-setup) under Imaging Tools. Place it in the MDT Deployment Share under the /Tools/x86 folder.

   1b. Download the 64-bit ISDTool.exe from the ZENworks Download page (https://zenworks_server_IP_address:port/zenworks-setup) under Imaging Tools. Place it in the MDT Deployment Share under the /Tools/x64 folder.

   1c. Open the ZTIDiskpart.wsf script file present in the MDT Deployment Share under the Scripts folder and insert the following lines just above the Open an instance for diskpart.exe, and dynamically pipe the commands to the program line:

   Dim sampCmd
   Dim aScriptDir
   Dim aArchitecture
   aScriptDir = oFSO.GetParentFolderName(WScript.ScriptFullName)
   aArchitecture = oEnvironment.Item("Architecture")
   sampCmd = aScriptDir & "\..	ools\" & aArchitecture & "\ISDTool.exe cleandisk " & iDiskIndex
   oShell.Exec(sampCmd)

   When the device boots the MDT WIM and contacts the above customized MDT Deployment Share, the script prevents MDT from wiping out the ZISD data.

Method 2

1. Clear the MBR using Third-Party Script Preboot bundle before applying the MDT Deployment bundle on the device:

   1a. Create Third-Party Script Preboot bundle in ZENworks. Add the following command as the Script Text:

   isdtool cleandisk disk_index

   For more information, see Section 3.9, “ISDTool,” on page 148.

   1b. Apply the Third-Party Script Preboot bundle on the device.

   1c. Apply the required MDT Deployment bundle on the device.

   **IMPORTANT:** Exercise extreme caution when using this option. The above dd command clears the MBR. After running this command, the operating system will not boot. Hence, the command should be run only before re-installing the operating system on the device.

An error message is displayed when Windows Managed devices, or Windows Servers reboot after you restore an image with size greater than 2 TB

Source: ZENworks; Preboot Services and Imaging.
Action: Do the following:

1. After the image is restored, insert the appropriate Windows installation CD.
2. Choose the option to repair Windows, and follow the instructions.

The ZENworks Server continues to write to the image file even if the Imaging operation to take an image of the device fails

Source: ZENworks; Preboot Services and Imaging.

Explanation: The ZENworks Server continues to write to the image file even if the ZENworks Imaging operation to take an image fails on the managed device with the following error message:

bad cluster chain, run chkdsk.exe

Consequently, the image file size grows.

Action: On the managed device, run `chkdsk.exe` before taking an image again.

The Imaging tools downloaded from the ZENworks Download page are not installed to the specified drive

Source: ZENworks; Preboot Services and Imaging.

Possible Cause: The Imaging tools that are downloaded from the ZENworks Download page (https://zenworks_server_IP_address:port/zenworks-setup) are installed by default on the drive that has the maximum disk space.

Action: To download and install the Imaging tools to a specific drive on the device, enter the following command at the command prompt:

```msiexec -i novell-zenworks-zmgexplorer-11.0.xxxx.msi TARGETDIR="complete_path_of_the_target_directory"
```

For example, if you want to download and install the Imaging tools to `c:\program files`, use the following command:

`msiexec -i novell-zenworks-zmgexplorer-11.0.xxxx.msi TARGETDIR="C:\Program Files"`

Unable to browse for the image files on the Satellite while taking an image or applying a Preboot bundle to a managed device

Source: ZENworks; Preboot Services and Imaging.

Explanation: While taking an image or applying a Preboot bundle to a managed device, if you are not able to browse for the image files on the Satellite, check for the following message in the device's Message Log (ZENworks Control Center > the Devices tab > Servers or Workstations > click the desired device > Summary):

```
Could not start ZenHttpServer - Port 80 is already in use.
```

Possible Cause: The HTTP server is blocked because the port is in use.
Action: Do the following:

1. Change the port number used by Satellite:
   1a. In ZENworks Control Center, click the **Configuration** tab.
   1b. In the Server Hierarchy panel, select the check box next to the Satellite whose port number needs to be changed.
   1c. Click **Action > Configure Satellite Server**.
       The **Configure Satellite Server** dialog box is displayed.
   1d. In the **Port for Content and/or Collection HTTP Requests** field, specify a new port number.
   1e. Click **OK**.

2. Ensure that the managed device is running on the port specified in Step 1d:
   2a. Open a Web browser on the managed device to the following address: `http://localhost:port_number`.
       A message containing the Novell ZENworks Content Server version is displayed.
   2b. (Conditional) If the ZENworks Content Server version is not displayed, restart the ZENworks Agent or the managed device.

---

### The ZENworks Images stored in the images directory on the Primary Server are not replicated on the Secondary Server or Satellite

**Source:** ZENworks; Preboot Services and Imaging.

**Explanation:** The ZENworks images stored in `$ZENWORKS_HOME\work\content-repo\images` on the Windows Primary Server and in `/var/opt/novell/zenworks/content-repo/images` on the Linux Primary Server are not replicated on the Secondary Server or Satellite.

**Action:** None.

---

### How do I generate a developer log for ZENworks Imaging?

**Source:** ZENworks; Preboot Services and Imaging.

**Action:** Before performing any imaging operation, set the following environment variable in the ZENworks Imaging Maintenance mode:

```bash
export DEVELOPER_LOG=a
```

The **imglog** file is created in the root directory (`/`).

**NOTE:** The log file is available only until the device is rebooted. To retain the log file, you must upload it to an FTP server.

---

### How do I exclude a particular partition from ZENworks Imaging?

**Source:** ZENworks; Preboot Services and Imaging.

**Action:** Before performing any imaging operation, set the following environment variable in the ZENworks Imaging Maintenance mode:
export Exclude_DEVICE=partition_name

How do I prevent ZENworks Third-Party Imaging from restarting in the Auto mode?

Source: ZENworks; Preboot Services and Imaging.
Action: A device is automatically rebooted after the ZENworks Third-Party imaging operation is performed in the Automatic mode. If you want to refer to the worktodolog.txt or worktododebug.txt files, you must prevent the device from rebooting by pressing Ctrl+R at the end the imaging operations.

Image Explorer help opens only in Firefox on Linux devices

Source: ZENworks; Preboot Services and Imaging.
Explanation: When you launch Image Explorer in Linux, then click Help > Contents, the Mozilla Firefox browser is opened by default.
Action: If you want to use any other HTML viewer, modify the ZMGEXP_HELP_BROWSER environment variable to point to the utility of your choice.

The ZENworks icon properties page of a managed device that is in private network displays that the server IP address is not available

Source: ZENworks; Preboot Services and Imaging.
Explanation: When you refresh the ZENworks icon of a managed device that is in a private network, the properties page displays that the server IP address is not available. Consequently, the managed device might not be promoted to Imaging Satellite, or if the managed device is an Imaging Satellite with ProxyDHCP enabled, the device fails to contact the Primary Server and the Imaging operations cannot be performed through the device.
Action: On the managed device, edit the operating_system_drive\windows\system32\drivers\etc\hosts file to add the IP address and the DNS name of the Primary Server to which the device is registered.

The third-party Imaging distro and tools are not immediately replicated on the Satellite

Source: ZENworks; Preboot Services and Imaging.
Explanation: The third-party imaging distro and tools are replicated on the Satellite only during the next ZMD refresh after configuring the Imaging Satellite role.
Action: If you want the third-party imaging distro and tools get immediately replicated on the Satellite, you must refresh the icon.

Unable to take an image of the managed device

Source: ZENworks; Preboot Services and Imaging.
Explanation: In ZENworks Control Center, the following error message might be displayed when you try to browse for and select an image file in the Server and Path Information dialog box during taking an image:

Can't browse the file system on the specified server: com.novell.zenworks.datamodel.exceptions.InternalDataModelException: java.rmi.UnknownHostException: server_name.

Possible Cause: The device running ZENworks Control Center is unable to resolve the server name that you select in the Server Object, IP, or DNS option in the Server and Path Information dialog box to its IP address.

Action: Do the following:

1. If you have a DNS server in your network, ensure that it contains a DNS entry for the server you select in the Server Object, IP, or DNS option in the Server and Path Information dialog box.

If you do not have a DNS server in your network, edit the operating_system_drive\windows\system32\drivers\etc\hosts file on the device running ZENworks Control Center to add the IP address and the DNS name of the server select in the Server Object, IP, or DNS option in the Server and Path Information dialog box.

2. In the Server and Path Information dialog box, try to browse for the image file.

The device might not pick up the assigned imaging task when booted to the Imaging Automatic mode

Source: ZENworks; Preboot Services and Imaging.

Explanation: When a device is booted to the Imaging Automatic mode, it fails to pick up the assigned imaging work. However, the message log in ZENworks Control Center displays that the work was completed successfully and the assigned work is cleared.

Action: Do the following:

1. Boot the device in the Imaging Maintenance mode.

2. At the bash prompt, run the following commands:
   
   zisedit taskstate=0
   zisedit taskid=0

3. In ZENworks Control Center, assign the task again to the device and boot the device to Imaging Automatic mode.

How to enable debug logs?

Source: ZENworks; Preboot Services and Imaging.

Action: To enable the logs, see TID 3418069 in the Novell Support Knowledgebase (http://support.novell.com/search/kg_index.html).
The Novell Proxy DHCP service is automatically stopped on the Imaging Satellite

Source: ZENworks; Preboot Services and Imaging.

Explanation: If you start the Novell Proxy DHCP service on the Windows or Linux Imaging Satellite, the service is automatically stopped during the next device refresh schedule.

Possible Cause: The PXE services are not enabled when the Windows or Linux device is promoted to Satellite with the Imaging role.

Action: Enable the PXE services for the Windows or Linux Imaging Satellite:

1. In ZENworks Control Center, click the Configuration tab.
2. In the Server Hierarchy panel, select the Windows Imaging Satellite, then click Action > Configure Satellite Server.
3. Click the Configure link next to the Imaging check box.
4. In the Configure Imaging Role dialog box, select Enable PXE Services.
5. Click OK.

A new workstation ID is created after restoring image on a non-registered device

Source: ZENworks; Preboot Services and Imaging.

Explanation: From the ZDM 7.x server, if you have taken an image of a device that has the ZDM 7.x agent and the ZENworks Agent with Asset Management installed, and if restore the image to a non-registered device that has non-registered device, a new workstation ID is created for the non-registered device.

Action: Do any of the following:

• **Option 1:** After restoring the image on a non-registered device, perform the following tasks on the device:
  1. In ZENworks Control Center, click the Devices tab > the Workstation folder.
  2. Delete the workstation object.
  3. Boot the device, and run the following command:
     ```
     zac fsg -d
     ```
  4. Reboot the device.

• **Option 2:** Perform the following tasks:
  1. Before taking the image of the device that has the ZDM 7.x agent and the ZENworks Agent with Asset Management installed, do the following on the device:
     a. Run the `zac fsg -d` command.
     b. In the Windows Services window, stop the Novell ZENworks Agent Service and change the service’s Startup Type to Manual.
     c. Reboot the device.
  2. Take the image of the device that has the ZDM 7.x agent and the ZENworks Agent with Asset Management installed.
3. After restoring the image on a non-registered device, do the following on the device whose image you have taken:
   
a. In the Windows Services window, change the **Startup Type** of Novell ZENworks Agent Service to **Automatic**, and start the service.
   
b. Reboot the device.

**novell-pbserv crashes during multicast imaging to 120 or more devices**

Source: ZENworks; Preboot Services and Imaging.

Possible Cause: The OpenSSL library, which is used by the ZENworks Imaging server to communicate over SSL with Tomcat on ZENworks Control Center, crashes.

Action: Do the following on the ZENworks Imaging server:

1. Edit the `%zenworks_home%\conf\preboot\novell-zenimgweb.conf` file to uncomment the following entry, which is beneath the line "#Allow HTTP if HTTPS is not available":

   \[CLEARTEXT=FALSE\]

2. Restart the Novell ZENworks Preboot Service.

**You might encounter an error message prompting you to restart Windows installation when the device boots up after the restoration of the ZENworks or WIM image on a Windows 7 or later**

Source: ZENworks; Preboot Services and Imaging.

Explanation: After restoring a ZENworks or WIM image of a Windows 7 or Windows Server 2008 R2 managed device that was taken by running SysPrep, the device boots up and you are prompted to configure the language, product key, and license agreement. After you configure them, the Windows service starts but the following error message is displayed:

Windows could not complete the installation. To install windows on this computer, restart the installation.

Action: Ignore the error message.

**If you restore an image of Windows on a bare machine that has a ZENworks partition, the machine fails to boot the second time after the image restoration**

Source: ZENworks; Preboot Services and Imaging.

Explanation: If you restore an image of Windows on a bare machine that has a ZENworks partition, the machine successfully boots for the first time after the image has been restored but it fails to boot the second time.
Action: Do the following:

1. Boot the device in the ZENworks Imaging maintenance mode.
2. Run `sidChange -i`.
3. Reboot the device.

**Mounting an NFS partition from the Imaging kernel fails on a device that is booted in the ZENworks Imaging Maintenance mode**

Source: ZENworks; Preboot Services and Imaging.

Explanation: If you try to mount an NFS partition from the Imaging kernel on a device that is booted in the ZENworks Imaging Maintenance mode, the operation fails with errors if you use the following mount partition command:

```bash
mount -t nfs IP_address_of_NFS_server:path_of_NFS_share /mnt/destination_directory
```

The following error messages are displayed:

- `mount.nfs: rpc.statd is not running but is required for remote locking.`
- `mount.nfs: Either use '-o nolock' to keep locks local, or start statd.`
- `mount.nfs: an incorrect mount option was specified`

Action: Execute the mount partition command with the `-o nolock` option

```bash
mount -t nfs -o nolock IP_address_of_NFS_server:path_of_NFS_share /mnt/destination_directory
```

**The SLES or SLED device with SATA drive fails to boot after the restoration of an image**

Source: ZENworks; Preboot Services and Imaging.


**Unable to take an image of a device if the Imaging Satellite is outside the L4 switch and the Primary Server is behind the L4 switch**

Source: ZENworks; Preboot Services and Imaging.

Explanation: If the Primary Server is behind the L4 switch, and the Imaging Satellite and the managed device are outside the L4 switch, you cannot take an image of the managed device from the Imaging Satellite.

Possible Cause: The managed device does not receive the imaging task because the ZENworks Preboot Service (novell-pbserv) on the Imaging Satellite fails to communicate with the Primary Server.

Action: Do the following on the Imaging Satellite:

1. Open the `novell-zenimgweb.conf` file that is located on the Imaging Satellite by using a text editor.
The file is located in the \%ZENworks_Home\%\conf\preboot\ directory on a Windows Imaging Satellite, and in the /etc/opt/novell/zenworks/preboot/ directory on a Linux Imaging Satellite.

2 Append the following entry:

FORCEHTTP=forced

3 Save and close the novell-zenimgweb.conf file.

4 Restart the Novell ZENworks Preboot Service (novell-pbserv).

5 Take the image of the managed device.

**Dell DTK Configuration bundle fails on a device that does not have operating system installed**

Source: ZENworks; Preboot Services and Imaging.

Explanation: During the PXE boot of the device that does not have operating system installed, the Dell DTK Configuration bundle assigned to the device fails with the following message:

No work Assigned.

Action: Do the following on the device:

1 Create a logical disk:
   1a Boot the device into the Dell DTK maintenance mode.
   1b Execute the following command:

   ```
   raidcfg -ctrl -c=0 -ac=cvd -ad=0:0:1 -sz=100MB -r=0 //raid0 configuration with 100 MB size
   ```

2 PXE boot the device.

**Unable to create a Dell partition on a Dell device by using the Dell DTK Configuration bundle**

Source: ZENworks; Preboot Services and Imaging.

Explanation: If you use a Dell DTK Configuration bundle to create a dell partition on a Dell device, the partition creation fails with the following error message:

Can't Load Kernel File

Possible Cause: The Dell DTK Configuration bundle does not contain the latest version of the upimg.bin file.

Action: Perform the following steps:

1 copy upimg.bin from the latest Dell DTK distro that is integrated with ZENworks to the path relative to the TFTP server home directory.

2 Reassign the Dell DTK Configuration bundle to the Dell device.

3 PXE boot the Dell device.
Unable to use chkconfig with the novell-proxydhcp init script on SLES 11 or SLED 11

Source: ZENworks; Preboot Services and Imaging.
Explanation: When you run chkconfig with the novell-proxydhcp init script on SLES 11 or SLED 11, the operation fails with the following message:

```
insserv: Script jexec is broken: incomplete LSB comment.
insserv: missing 'Required-Stop:' entry: please add even if empty.
```
Possible Cause: The error is caused by the version of the jexec script installed on the device. It is a known issue on SLES 11 and SLED 11 devices.
Action: See TID 7010013 in the Novell Support Knowledgebase.

Managed devices are not reconciled to appropriate folders if you restore the image of a different operating system on the devices

Source: ZENworks; Preboot Services and Imaging.
Explanation: If you restore the image of a server-class device on a workstation-class device or vice versa, the device is not automatically reconciled to the appropriate folder in ZENworks Control Center. For example, when you restore the image of a server-class device on a workstation-class device, the device object continues to be displayed in the Servers folder and not in the Workstation folder.
Action: You must move the device object to the appropriate folder.

1. In ZENworks Control Center, click Devices.
2. Click the Servers or Workstations folder that contains the device object you want to move.
3. Select the check box next to the device object you want to move.
4. Click Edit > Move.
   The Move Device dialog box is displayed.
5. Choose the destination folder.
6. Click OK.

SUSE Linux installation or Red Hat Linux installation by using Preboot bundles fails

Source: ZENworks; Preboot Services and Imaging.
Explanation: If you choose to create the AutoYaST or Kickstart bundle in which the AutoYaST XML script or the Kickstart configuration file that contains system variables is accessed by using a protocol, the system variables are not resolved and the bundle is not applied to the managed devices. Consequently, the SUSE Linux installation or Red Hat Linux installation by using the AutoYaST or Kickstart bundle fails.
Action: If the AutoYaST XML script or the Kickstart configuration file contains ZENworks system variables, you must choose to import the AutoYaST XML script or the Kickstart configuration file while creating the AutoYaST or the Kickstart bundle so that the variables can be automatically resolved when the bundle is applied to the managed devices.

Unable to change the preconfigured master Primary Server whose tftp directory changes you want to replicate on all other servers at a specific schedule

Source: ZENworks; Preboot Services and Imaging.
Explanation: You have configured a master Primary Server whose tftp directory changes you want to replicate on all other servers at a specific schedule. Subsequently, if you want to select a different server as the master Primary Server, the following error message is displayed in the TFTP Replication Settings panel when you click Apply after selecting the new server:

Unable to apply the TFTP Replication settings. Remove the circular dependency for the Master Primary Server. For more information, see the Help.

Action: In the TFTP Replication Settings panel, do the following

1. Before changing the master Primary Server for the tftp directory replication, change the TFTP replication schedule for the existing Primary Server to No Schedule.
2. Change the master Primary Server, then configure a new TFTP replication schedule.

When you upgrade a SLES operating system to SLES 11 SP2, an error occurs while loading the shared library files

Source: ZENworks; Preboot Services and Imaging.
Explanation: When you upgrade a SLES operating system to SLES 11 SP2, the shared library file (libhd) version is upgraded from libhd.so.12.34 to libhd.so.15.xx, where xx is the minor version of the installed library. The following error message appears:

libhd.so.12: cannot open shared object file: No such file or directory

Possible Cause: This issue might occur because of one of the following:

- The symbolic link to libhd.so.12.34 breaks when it is upgraded to libhd.so.15.xx
- The hwinfo RPM is updated.

Action: Re-create the libhd.so.12 symbolic link from the server to the libhd.so.15.xx library file in the /usr/lib64 directory.
Unable to upload the tntfs.ko driver file after modifying or replacing the NTFSDriver.conf file

Source: ZENworks; Preboot Services and Imaging.

Action: Do the following:

1. Login to ZENworks Control Center.
2. Click Configuration > Preboot Services > Tuxera High Performance Driver Integration Settings.
3. Re-download the tntfs.ko file by using the link provided.
4. Re-upload the tntfs.ko file.

Error occurs when a local imaging operation is performed on RAM

Source: ZENworks; Preboot Services and Imaging.

Explanation: The size of the image file varies depending on the amount of data that needs to be stored as a backup. This may exceed the available space on the RAM in your system.

Action: To perform a local imaging or a Take Image operation, use a valid mounted partition on your hard disk that can store the complete image.

File name not displayed when an Imaging operation fails

Source: ZENworks; Preboot Services and Imaging.

Explanation: Changes have been made in the Imaging Engine interface to reduce the number of screen refreshes that occur during Imaging operations with the Tuxera driver. One such change is not to show the full filenames during Take Image and Restore Image operations. As a result, for some particular failures, the filename of the current file being backed up or restored may not be displayed on the GUI.

Action: You need to verify the imglog file to detect where the failure occurs during the Take Image or Restore Image operations. Do the following:

1. Enable the developer logs by running the export DEVELOPER_LOG=a command in the Imaging distro mode.
   The logs are stored in the /imglog file.
2. Search for the following strings to find the file on which the failure occurs as follows:
   For Take Image operation: The last occurrence of the lnxfsTuxeraBaseImageToArchive string. This line and the next line contains the path to the file that has failed.
   For Restore Image operation: The last occurrence of the ntfsTuxeraWriteFileFromArchive string. This line contains the path to the file that has failed.

For more information, see TID 7014246.

Screen flickers or gets distorted in a Distro environment

Source: ZENworks; Preboot Services and Imaging.
Troubleshooting Preboot Services and Imaging

Explanation: The screen flickers or gets distorted in a Distro environment.

Action: Set the `nomodeset` kernel parameter.

For example, append="mode=5 splash=silent showopts vga=0x0314 nomodeset".

For more information see *Modifying Kernel Boot Parameters* in *Preparing Imaging Boot CDs, DVDs or bootable USB*.

Unable to differentiate between WAIK and WADK uploads

Source: ZENworks; Preboot Services and Imaging.

Explanation: Before you perform any Third-Party Imaging operation, check to see if the WAIK or WADK uploads are present on the server. You cannot differentiate between WAIK and WADK uploads because when you upload WADK on a server having WAIK installed, WADK overwrites the WAIK is overwritten using the same .zip file name.


File path for Linux: `/srv/tftp/boot/WdsConfig.inf`

File path for Windows: `%ZENWORKS_HOME%\share\tftp\boot\WdsConfig.inf`

Product.Name for WAIK32: Windows 7
Product.Version for WAIK32: 6,1,0,0
Product.Name for WADK32: Windows 8
Product.Version for WADK32: 6,2,0,0

Unable to upload 32-bit and 64-bit ImageX files at the same instance

Source: ZENworks; Preboot Services and Imaging.

Explanation: In the Third-Party Imaging Settings panel in ZENworks Control Center, you cannot upload 32-bit and 64-bit ImageX files in the same instance. Since the binary files for both the ImageX files have the same name (`imagex.exe`), the last uploaded file gets overwritten by the new file.

Action: The 32-bit and 64-bit ImageX binary files have to be uploaded with separate upload instances.

On restarting the server, the `pbserv` or the `novell-zmgprebootpolicy` Imaging services are dead

Source: ZENworks; Preboot Services and Imaging.

Explanation: During the device startup, the Server IP address is being viewed as a non-local IP and is causing the services to be in the unused state. This occurs when Network Manager is enabled on Linux Servers.

Action: Do the following for the services to run correctly:

1. Add the following line in the `/etc/sysctl.conf` file:
ZENworks WADK Imaging works only on hardwares that are supported on Windows 8

Source: ZENworks; Preboot Services and Imaging.
Explanation: WADK has WINPE 4.0 which is based on Windows 8 kernel. So, you need to validate if your system hardware meets the ZENworks WADK Imaging requirements to perform Imaging operations.
Action: To be able to perform Imaging operations, validate your system as follows:

1. Download the coreinfo.exe file from Windows Sysinternal (Download and Usage Information).
2. Run the tool to determine if the system has support for NX, PAE, and SSE2.
3. If your system is reported to support NX, PAE, and SSE2, you can use WADK to image the device. Else, use the compatible WIM mode based on WINPE 3.x.

IMPORTANT: In some 64-bit processors like Intel Xeon, there are two boot modes - Enabled and Capable. In both modes SMBIOS indicates that the processor is a 64-bit processor. However, if the mode is set to Capable, the system works as a 32-bit processor, and the 64-bit WADK does not boot. To use ZENworks Imaging on these 64-bit processors, the 64-bit mode should be set to Enabled in BIOS for 64-bit WADK to boot correctly. For more information, see System Management BIOS (SMBIOS) Reference.

NOTE: For VMware Virtual machines, only 32-bit, 64-bit WAIK or 32-bit, 64-bit WADK boot is applicable.

For more information, see TID 7013318.

The bootcd_tntfs.iso file creation fails on RHEL servers

Source: ZENworks; Preboot Services and Imaging.
Explanation: When you upload the tntfs.zip file on a ZENworks Server and replicate it on all Primary and Satellite Servers, the bootcd_tntfs.iso file creation fails on RHEL devices. This is because the genisoimage RPM file is not installed on RHEL Servers.
Action: Install the latest genisoimage RPM (genisoimage-1.1.9-11.el6.x86_64.rpm) file on RHEL Servers.

Operating System on UEFI devices loses mount points on image restoration

Source: ZENworks; Preboot Services and Imaging.
Explanation: For volume junction points, the GUID of the volume is used to refer to the target volume. For UEFI devices, the GUID is changed to maintain the uniqueness of the partition. As a result, the references in the junction points will not work.

**Windows 8 login screen fails to appear after restoration of Windows 8 images from a Virtual machine on VMwareESX Servers**

Source: ZENworks; Preboot Services and Imaging.

Explanation: When you restore a Windows 8 image from a Virtual Machine on a VMwareESX Server by using the legacy NTFS driver, the system does not boot up to the login screen and a blank screen appears after the restoration.
Documentation Updates

This section summarizes the significant changes made to the Preboot Services and Imaging Reference since the initial release of ZENworks 2017.

June 2017: System Update (Update 1) for ZENworks 2017

<table>
<thead>
<tr>
<th>Location</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section E.3, &quot;Make Mode,&quot; on page 268</td>
<td>Added information about Using Imaging Maintenance Mode Prompt to Make an Image on a Proxy:</td>
</tr>
<tr>
<td></td>
<td>• “Using the Imaging Maintenance Mode Prompt to Make an Image on a Proxy” on page 272</td>
</tr>
<tr>
<td>Section E.4, “Restore Mode,” on page 274</td>
<td>Added information about Using Imaging Maintenance Mode Prompt to restore an Image on a Proxy:</td>
</tr>
<tr>
<td></td>
<td>• “Using the Imaging Maintenance Mode Prompt to Restore an Image Locally” on page 276</td>
</tr>
</tbody>
</table>

January 2018: System Update (Update 2) for ZENworks 2017

<table>
<thead>
<tr>
<th>Location</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 3.13, “ZENworks WinPE Imaging,” on page 157</td>
<td>Added a section that explains about all the features supported for WinPE imaging in ZENworks.</td>
</tr>
<tr>
<td></td>
<td>• Section 3.13, “ZENworks WinPE Imaging,” on page 157</td>
</tr>
<tr>
<td>Section 3.9, “ISDTool,” on page 148</td>
<td>Updated the section with all the commands supported in ZENworks.</td>
</tr>
<tr>
<td></td>
<td>• Section 3.9, “ISDTool,” on page 148</td>
</tr>
</tbody>
</table>